Contents

Preface.................................................................................................................... xi
Intended audience.................................................................................................. xii
Product version.................................................................................................... xii
Release notes....................................................................................................... xii
Changes in this revision ....................................................................................... xii
Referenced documents....................................................................................... xii
Document conventions....................................................................................... xiii
Convention for storage capacity values.......................................................... xiv
Accessing product documentation................................................................... xv
Getting help........................................................................................................ xv
Comments........................................................................................................... xv

1 Overview of Hitachi Universal Replicator.................................................. 1-1
   About Hitachi Universal Replicator............................................................... 1-2
   How Universal Replicator works.................................................................... 1-2
   Universal Replicator copy operations.......................................................... 1-4
      Initial copy operation.................................................................................. 1-4
      Update copy operation............................................................................... 1-4
      Read and write I/O during remote copy...................................................... 1-5
      Differential data management................................................................... 1-5
   Journal volumes.............................................................................................. 1-6
   Pair volumes................................................................................................... 1-7
   Master journal and restore journal............................................................... 1-7
   Pair status...................................................................................................... 1-8
   S-VOL write option....................................................................................... 1-8
   Mirrors........................................................................................................... 1-8
      Splitting mirrors....................................................................................... 1-9
      Resynchronizing a mirror......................................................................... 1-10
      Deleting a mirror....................................................................................... 1-10
   System components...................................................................................... 1-11
      Storage systems....................................................................................... 1-13
      Pairs.......................................................................................................... 1-13
      Data path.................................................................................................. 1-13
      Hitachi Command Suite ......................................................................... 1-14
      Command Control Interface (CCI)............................................................ 1-14
      Consistency groups and journals............................................................. 1-14
2 Requirements and specifications ............................................................ 2-1
   System requirements ................................................................................... 2-2

3 Planning volumes ................................................................................... 3-1
   Plan and design workflow ........................................................................ 3-2
   Assessing business requirements for data recovery .................................. 3-2
      Determining your RPO ........................................................................ 3-3
   Write-workload ........................................................................................... 3-3
      Measuring write-workload .................................................................... 3-4
   Data transfer speed considerations ............................................................ 3-4
   RAID group configuration ......................................................................... 3-4
   Fibre Channel port configuration ............................................................... 3-4
   Sizing journal volumes ............................................................................. 3-5
   Planning journal volumes ........................................................................ 3-5
      Planning journal volumes for delta resync ............................................ 3-6
   Planning journal configuration ................................................................. 3-7
   Planning pair volumes ............................................................................. 3-7
      Maximum number of pairs allowed ....................................................... 3-8
      Calculating maximum number of pairs ............................................. 3-9
   Disaster recovery considerations ............................................................... 3-10
      Host failover software ......................................................................... 3-10
   Planning for using volumes in other storage system models ...................... 3-11
   Sharing UR volumes with volumes used by other products ....................... 3-11
   Adding and removing cache memory and shared memory ......................... 3-11
      Workflow for adding and removing cache memory ................................ 3-11
      Workflow for adding shared memory .................................................... 3-12
      Workflow for removing shared memory ............................................. 3-12
   Planning UR with multiple storage systems ............................................. 3-12
      Registering multiple journals to a CCI consistency group .................... 3-12
   Guidelines for preparing systems for Universal Replicator ...................... 3-17
      System option modes ......................................................................... 3-18

4 Planning the data path ............................................................................. 4-1
   Data path design ....................................................................................... 4-2
   Determining data transfer bandwidth ....................................................... 4-2
      Five sizing strategies ........................................................................ 4-3
      Calculating bandwidth .................................................................... 4-4
         Sizing bandwidth for peak write-workload .................................. 4-4
         Sizing bandwidth for peak rolling average write-workload ............ 4-5
      Latency ............................................................................................. 4-6
Packet loss ............................................................................................ 4-7
Universal Replicator ports ........................................................................ 4-7
Fibre Channel data path requirements ....................................................... 4-8
iSCSI data path requirements ..................................................................... 4-9
Supported remote connection configurations ............................................. 4-11
  Direct connection ...................................................................................... 4-11
  Switch connection ...................................................................................... 4-11
  Extender connection ................................................................................... 4-12

5 Universal Replicator configuration operations........................................5-1
  Configuration workflow ............................................................................. 5-2
    Workflow for 3DC multi-target configuration with three UR sites........... 5-2
    Workflow for 3DC cascade configuration with three UR sites................. 5-3
  Adding remote connections ........................................................................ 5-3
  Creating journals and adding journal volumes .......................................... 5-5
  Assigning an MP unit to a journal ............................................................... 5-8
  Setting the remote replica options ............................................................. 5-9
    Setting the maximum initial copy activities option .................................... 5-9
    Setting the blocked-path monitoring and blocked-path SIM monitoring options... 5-10

6 Universal Replicator pair operations.................................................... 6-1
  Pair operations .......................................................................................... 6-2
  Creating Universal Replicator pairs ............................................................ 6-2
  Checking pair status .................................................................................. 6-6
  Splitting a Universal Replicator pair .......................................................... 6-6
  Splitting the pairs in a mirror ..................................................................... 6-8
    Creating point-in-time copies ................................................................... 6-10
  Resynchronizing a Universal Replicator pair ............................................. 6-10
  Resynchronizing the pairs in a mirror ......................................................... 6-12
  Deleting Universal Replicator pairs ......................................................... 6-13
  Deleting the pairs in a mirror ..................................................................... 6-15

7 Monitoring the Universal Replicator system ...........................................7-1
  Monitoring pair activity, status, and license capacity .................................. 7-2
    Pair status definitions .............................................................................. 7-3
      Additional information on pair status .................................................... 7-7
      PSUS types and behaviors ..................................................................... 7-8
      Suspend conditions for Universal Replicator pairs ................................. 7-9
      PSUE types and behaviors ................................................................... 7-10
    Checking Universal Replicator pair synchronization rate ......................... 7-11
    Viewing Universal Replicator operation history ....................................... 7-12
    Saving pair information to a text file ....................................................... 7-15
    Monitoring I/O and hardware performance with Performance Monitor ....... 7-16
    Monitoring journal (mirror) status .......................................................... 7-16
      Device Manager - Storage Navigator mirror status definitions ............... 7-17
      CCI mirror status definitions ................................................................ 7-17
    Monitoring Universal Replicator remote connections, path status ........... 7-18

8 Maintaining the Universal Replicator system ........................................ 8-1
  Pair maintenance ....................................................................................... 8-2
Changing pair options ......................................................................................8-2
Forcibly deleting pairs.......................................................................................8-3
Releasing the differential data managed in a pool..............................................8-4
Restoring a pair by adding a reserve journal volume.........................................8-5
Restoring a pair without adding a reserve journal volume.................................8-5
Journal and mirror maintenance.......................................................................8-6
Changing options used by journals .................................................................8-6
Changing options used by mirrors ....................................................................8-7
Adding an additional journal volume to an existing journal...............................8-10
Replacing a journal volume with a reserve journal volume...............................8-11
  Adding a reserve journal volume....................................................................8-12
Deleting journal volumes from a journal ..........................................................8-12
Deleting journals ...........................................................................................8-13
Remote path maintenance..................................................................................8-14
  Modifying data-transfer time threshold ..........................................................8-14
  Adding remote paths.......................................................................................8-15
  Deleting remote paths....................................................................................8-16
  Deleting the Universal Replicator relationship ..............................................8-17
Managing power-off for systems and network devices ......................................8-18
  When power stops unexpectedly.....................................................................8-18
    When power is removed from primary or secondary system......................8-19
    When power is removed from network relay devices.................................8-19
  Powering off systems intentionally.................................................................8-19
    Powering off the primary or secondary system............................................8-19
    Powering off primary and secondary systems at the same time.................8-20
  Powering off network relay devices...............................................................8-21

9 Universal Replicator disaster recovery operations ......................................9-1
Overview............................................................................................................9-2
General recovery procedures............................................................................9-2
  Preparing for recovery....................................................................................9-2
  Preparing for file and database recovery.......................................................9-3
  Switching host operations to the secondary site.............................................9-3
  Reversing copy direction from secondary to primary site.............................9-3
  Resuming host operations at the primary site.................................................9-4
Recovery for configurations with multiple primary systems and secondary systems...9-5
  Switching from the primary to secondary site (multiple storage systems).......9-5
  Transferring operations back to the primary site (multiple storage systems)....9-6
Recovery for 3DC configurations with three UR sites.......................................9-6
  Recovery for 3 UR DC multi-target configuration (when the delta resync operation
  is performed)....................................................................................................9-6
    Requirements for performing delta resync in 3DC multi-target configuration
    with three UR sites.......................................................................................9-10
  Recovery for 3 UR DC cascade configuration..................................................9-12
    Recovery when the primary site fails...........................................................9-12
    Recovery when the intermediate site fails.....................................................9-15
    Recovery when the primary-intermediate path fails.......................................9-17
  Recovery for 3DC cascade configuration with three UR sites........................9-17
    Recovery from primary site failure..............................................................9-17
    Recovery from intermediate site failure.......................................................9-18
    Requirements for performing delta resync in 3DC cascade configuration
    with three UR sites.......................................................................................9-18
C Configurations with TrueCopy..................................................................................C-1
  Overview of UR/TC configurations......................................................................C-2
  3DC cascade configuration..................................................................................C-2
    3DC cascade configuration requirements and cautions....................................C-2
    Setting up the 3DC cascade configuration......................................................C-2
  3DC multi-target configuration........................................................................C-3
    3DC multi-target configuration requirements..................................................C-3
    Setting up the 3DC multi-target configuration..................................................C-4
  3DC multi-target configuration using delta resync..............................................C-4
    Additional task for the 3DC multi-target configuration using delta resync......C-4
    Creating the delta resync pair........................................................................C-5
    Setting up remote command devices for delta resync......................................C-6
    Mapping remote command devices to each site..............................................C-7
    Assigning mirrors to remote command devices..............................................C-8
    Releasing remote command device assigned to a mirror...............................C-10
    Conditions for delta resync operations.........................................................C-11
    Performing the delta resync operation............................................................C-12
      In case of delta resync failure.......................................................................C-13
      To prevent errors in case of delta resync failure..........................................C-13

D Configurations with ShadowImage........................................................................D-1
  Overview.............................................................................................................D-2
  Configurations with ShadowImage P-VOLs.......................................................D-2
  Configurations with ShadowImage S-VOLs.......................................................D-4
  Pair status and data currency............................................................................D-5

E Universal Replicator GUI reference......................................................................E-1
  Journals window................................................................................................E-3
  Journal Volumes window....................................................................................E-4
  Journal Properties window..............................................................................E-9
  Create Journals wizard....................................................................................E-11
    Create Journals window..............................................................................E-11
    Select Journal Volumes dialog box................................................................E-13
    Create Journals confirmation window............................................................E-15
  Assign Journal Volumes wizard.......................................................................E-16
    Assign Journal Volumes window................................................................E-16
    Assign Journal Volumes confirmation window..............................................E-19
  Delete Journals window...................................................................................E-21
  Edit Journal Options wizard............................................................................E-21
    Edit Journal Options window.......................................................................E-21
    Edit Journal Options confirmation window..................................................E-22
  Assign MP Unit wizard.....................................................................................E-23
    Assign MP Unit window................................................................................E-23
    Assign MP Unit confirmation window............................................................E-24
  Edit Mirror Options wizard............................................................................E-25
    Edit Mirror Options window........................................................................E-25
    Edit Mirror Options confirmation window....................................................E-26
  Assign Remote Command Devices wizard.......................................................E-28
This document describes and provides instructions for performing Hitachi Universal Replicator (UR) operations on the Hitachi Virtual Storage Platform G200, G400, G600, G800 (VSP G200, G400, G600, G800) and Hitachi Virtual Storage Platform F400, F600, F800 (VSP F400, F600, F800) storage systems.

Please read this document carefully to understand how to use this product, and maintain a copy for reference purposes.

- Intended audience
- Product version
- Release notes
- Changes in this revision
- Referenced documents
- Document conventions
- Convention for storage capacity values
- Accessing product documentation
- Getting help
- Comments
**Intended audience**

This document is intended for system administrators, Hitachi Data Systems representatives, and authorized service providers who install, configure, and operate the VSP G200, G400, G600, G800 storage systems (VSP Gx00 models) and VSP F400, F600, F800 storage systems (VSP Fx00 models).

Readers of this document should be familiar with the following:

- Data processing and RAID systems and their basic functions.
- The VSP Gx00 models or VSP Fx00 models and the Hardware Reference Guide for your storage system model.
- The Hitachi Command Suite software and the Hitachi Command Suite User Guide, or the Hitachi Device Manager - Storage Navigator software and the System Administrator Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models.
- Remote replication and disaster recovery configurations for enterprise storage data centers.

**Product version**

This document revision applies to:

- VSP G200, G400, G600, G800, VSP F400, F600, F800: firmware 83-03-2x or later
- SVOS 6.4.1 or later

**Release notes**

The release notes for this product are available on Hitachi Data Systems Support Connect: [https://support.hds.com/en_us/contact-us.html](https://support.hds.com/en_us/contact-us.html). Read the release notes before installing and using this product. They may contain requirements or restrictions that are not fully described in this document or updates or corrections to this document.

**Changes in this revision**

- Updated the procedure for transferring business operations back to the primary site in Recovery when the primary site fails on page 9-12.
- Updated the procedures and illustrations in Recovery for 3 UR DC multi-target configuration (when the delta resync operation is performed) on page 9-6.

**Referenced documents**

- Hitachi Thin Image User Guide, MK-92RD8011
This document uses the following terminology conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hitachi Virtual Storage Platform G200, G400, G600, G800 (VSP G200, G400, G600, G800) VSP Gx00 models</td>
<td>Refers to all models of the Hitachi Virtual Storage Platform G200, G400, G600, G800 storage systems, unless otherwise noted.</td>
</tr>
<tr>
<td>Hitachi Virtual Storage Platform F400, F600, F800 (VSP F400, F600, F800) VSP Fx00 models VSP F series</td>
<td>Refers to all models of the Hitachi Virtual Storage Platform F400, F600, F800 storage systems, unless otherwise noted.</td>
</tr>
</tbody>
</table>

This document uses the following typographic conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular text bold</td>
<td>In text: keyboard key, parameter name, property name, hardware label, hardware button, hardware switch</td>
</tr>
</tbody>
</table>
This document uses the following icons to draw attention to information:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Note Icon]</td>
<td>Note</td>
<td>Calls attention to important or additional information.</td>
</tr>
<tr>
<td>![Tip Icon]</td>
<td>Tip</td>
<td>Provides helpful information, guidelines, or suggestions for performing tasks more effectively.</td>
</tr>
<tr>
<td>![Important Icon]</td>
<td>Important</td>
<td>Provides information that is essential to the completion of a task.</td>
</tr>
<tr>
<td>![Caution Icon]</td>
<td>Caution</td>
<td>Warns the user of adverse conditions or consequences (for example, disruptive operations).</td>
</tr>
<tr>
<td>![WARNING Icon]</td>
<td>WARNING</td>
<td>Warns the user of severe conditions or consequences (for example, destructive operations).</td>
</tr>
</tbody>
</table>

**Convention for storage capacity values**

Physical storage capacity values (for example, disk drive capacity) are calculated based on the following values:

<table>
<thead>
<tr>
<th>Physical capacity unit</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 kilobyte (KB)</td>
<td>$1,000 \times 10^3$ bytes</td>
</tr>
<tr>
<td>1 megabyte (MB)</td>
<td>$1,000$ KB or $1,000^2$ bytes</td>
</tr>
<tr>
<td>1 gigabyte (GB)</td>
<td>$1,000$ MB or $1,000^3$ bytes</td>
</tr>
<tr>
<td>1 terabyte (TB)</td>
<td>$1,000$ GB or $1,000^4$ bytes</td>
</tr>
</tbody>
</table>
Logical storage capacity values (for example, logical device capacity) are calculated based on the following values:

<table>
<thead>
<tr>
<th>Logical capacity unit</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 block</td>
<td>512 bytes</td>
</tr>
<tr>
<td>1 KB</td>
<td>$1,024 \times 2^{10}$ bytes</td>
</tr>
<tr>
<td>1 MB</td>
<td>$1,024 \times 2^{20}$ bytes</td>
</tr>
<tr>
<td>1 GB</td>
<td>$1,024 \times 2^{30}$ bytes</td>
</tr>
<tr>
<td>1 TB</td>
<td>$1,024 \times 2^{40}$ bytes</td>
</tr>
<tr>
<td>1 PB</td>
<td>$1,024 \times 2^{50}$ bytes</td>
</tr>
<tr>
<td>1 EB</td>
<td>$1,024 \times 2^{60}$ bytes</td>
</tr>
</tbody>
</table>

**Accessing product documentation**

Product documentation is available on Hitachi Data Systems Support Connect: [https://support.hds.com/en_us/documents.html](https://support.hds.com/en_us/documents.html). Check this site for the most current documentation, including important updates that may have been made after the release of the product.

**Getting help**

[Hitachi Data Systems Support Connect](https://support.hds.com/en_us/documents.html) is the destination for technical support of products and solutions sold by Hitachi Data Systems. To contact technical support, log on to Hitachi Data Systems Support Connect for contact information: [https://support.hds.com/en_us/contact-us.html](https://support.hds.com/en_us/contact-us.html).

[Hitachi Data Systems Community](https://community.hds.com) is a new global online community for HDS customers, partners, independent software vendors, employees, and prospects. It is the destination to get answers, discover insights, and make connections. **Join the conversation today!** Go to [community.hds.com](https://community.hds.com), register, and complete your profile.

**Comments**

Please send us your comments on this document: [doc.comments@hds.com](mailto:doc.comments@hds.com). Include the document title and number, including the revision level (for example, -07), and refer to specific sections and paragraphs whenever
possible. All comments become the property of Hitachi Data Systems Corporation.

Thank you!
Overview of Hitachi Universal Replicator

This chapter provides an overview of Hitachi Universal Replicator operations.

- About Hitachi Universal Replicator
- How Universal Replicator works
- Universal Replicator copy operations
- Mirrors
- System components
- Sharing volumes with TrueCopy
- 3DC configurations with three UR sites
About Hitachi Universal Replicator

Hitachi Universal Replicator (UR) enables you to copy the data on volumes at a primary site to volumes at a remote secondary site, providing a solution to avoid cases when the primary data center is affected by a disaster that stops operations for a long period of time. The volumes in the secondary system are asynchronous block-for-block copies of the primary volumes that are consistent with the primary volume data and therefore available for recovering the data on the primary volumes if a failure occurs at the primary site. By providing replication between remote sites, Universal Replicator enables recovery from region-wide disasters.

How Universal Replicator works

In the Universal Replicator system, remote replication is accomplished through the use of journal volumes on the primary and secondary systems.

Universal Replicator copies the journal data from the primary site to secondary site in the following sequence:

1. **Obtain journal**: The primary system writes journal data to the master journal volume. When the host writes the updated data to the P-VOL, the primary system copies the updated data. This copy of the updated data is

---

**Figure 1-1 Basic sequence in Universal Replicator operations**

**Note:** Note the following:

- Universal Replicator does not have a feature to copy the data from one P-VOL to multiple S-VOLs or to copy the data from multiple P-VOLs to one S-VOL.
- If the primary system fails reading a P-VOL, the redundancy of RAID-1, RAID-5, or RAID-6 enables the recovery from the failure. The primary system never reads the S-VOL for data recovery.

---
called the "journal data". The volume that contains the journal data at the primary site is called the "master journal volume". If a P-VOL write operation fails, the primary system does not create the journal data for the failed write operation.

- The host assigns write-sequence numbers to the data sent to the master journal volume.
- Write-sequence numbers and other metadata attached to journal data ensure consistency of the data in the P-VOL.

2. **Journal copy (initial and update copy)** - Journal data is copied from the master journal volume to the restore journal volume. Copying all of the data first is called "initial copy". Copying only the differential data after the initial copy is called "update copy". The volume that restores the journal data in the secondary system is called the "restore journal volume".

- When a read-journal command is issued to the primary system from the secondary system, the primary system transfers the journal data stored in the master journal volume to the restore journal volume at secondary site.
- Data copy occurs on a continual basis unless there is no data in the master journal volume. The request for data from the secondary system is repeated as soon as the previous read operation is completed.

**Tip:** Universal Replicator is "pull" type replication software. Universal Replicator starts copying journal data to secondary site when the secondary system sends an update (when the read-journal command is issued). The primary system operates as the resource for the secondary system's transaction processor.

3. **Journal-restore** - The S-VOL is updated based on the journal data stored in the restore journal volume.

- The journal volume data in the restore journal volume is copied to the S-VOL according to the write sequence numbers, ensuring data consistency.
- When journal restore to the S-VOL is completed, the data in the restore journal volume is discarded.
- When journal restore to the S-VOL is completed, the data in the master journal volume is also discarded.

**Tip:** The primary system discards journal data in the master journal volume when it receives the sequence number of the restore journal, which is attached to the read journal command from the secondary system. This applies also when the primary and secondary systems are connected through a channel extender.
Universal Replicator copy operations

The Universal Replicator copy operations are initial copy and update copy, which each involve underlying operations such as journal processing and differential data management.

Initial copy operation

When the initial copy is executed, all data in the P-VOL is copied in sequence directly to the S-VOL. Primary journal volumes are not used during the initial copy, and the copied data in this operation is referred to as “base journal data”.

- Creating or resynchronizing two or more pairs within the same journal causes the base journal data to be copied to the respective S-VOLS, one at a time. This extends the time required for all operations to be completed.
- An initial copy operation can also be performed to establish the pair without copying any data to the S-VOL, thus avoiding the delay of the initial copy. You can do this when the data in the P-VOL and the data in the S-VOL are already identical, or when creating pairs using empty volumes. After the volume status changes to PAIR, Universal Replicator duplicates all write I/Os to the P-VOLs on the S-VOLs.
- Universal Replicator pair data can also be copied using a TrueCopy initial copy operation. Doing this reduces the time to complete the copy operation. For details, see Planning pair volumes on page 3-7.

Update copy operation

When a host has new or changed information, the following occurs in the primary system:

- The update is written to the P-VOL.
- The update is copied to the master journal along with metadata that includes sequence and other consistency information.
- The secondary system issues the read-journal command (independent of host I/O activity). At this time, the following occurs:
  - Any data in the master journal is sent to the restore journal.
    Journal data is transferred using special I/O operations initiated by the secondary system called remote I/O (RIO). RIO provides the most efficient type of data transfer. Make sure that your channel extenders are capable of supporting RIO.
  - The updated data is copied to the S-VOL.
  - Journal data on the primary and secondary systems is discarded when data consistency is established in the copy.

If an update copy operation fails, the secondary system suspends the affected pair or all pairs in the journal, depending on the type of failure. The
suspended pair or journal returns to Paired status when the primary and secondary volumes are resynchronized.

**Read and write I/O during remote copy**

The primary system reads from the P-VOL when it receives a read I/O command. If the read fails, the redundancy provided by RAID 1, RAID 5, or RAID 6 technology recovers the failure. The primary system does not read the S-VOL for recovery.

When a primary system receives a write I/O command for a P-VOL in PAIR status, the system performs the write operation and performs the update copy operation. The write operation completes independently of the update copy operations on the S-VOL.

The secondary system updates the S-VOL according to the write sequence number in the journal data. This maintains data consistency between P-VOL and S-VOL.

If the P-VOL write operation fails, the primary system reports a unit check and does not create the journal data for this operation. As mentioned, if the update copy operation fails, the secondary system suspends either the affected pair or all Universal Replicator pairs in the journal, depending on the type of failure. When the suspended pair or journal is resynchronized, the primary and secondary systems negotiate the resynchronization of the pairs.

During normal operations, the secondary system does not allow S-VOLs to be online (mounted). Therefore, hosts cannot read from and write to S-VOLs. However, if the S-VOL write option is enabled, write access to an S-VOL is allowed while the pair is split. The pair must be split from the primary system for the option to take effect.

To reduce the overhead associated with remote copy activities and to maximize rate of data transfer, the storage system uses a special write command for initial and update copy operations. This command transfers the control parameters and the fixed-block architecture (FBA) format data for consecutive updated records in a track using a single write operation. It eliminates the overhead required for performing FBA-to-count-key-data (CKD) and CKD-to-FBA conversions.

**Differential data management**

Differential data is the data that is changed in the P-VOL and S-VOL (if permitted) while a pair is split or suspended. This changed data is stored in a track bitmap. When the pair is resynchronized, the primary system merges the P-VOL and S-VOL bitmaps and copies the differential data to the S-VOL.

The required number of bitmap areas is based on the number of volumes being replicated and the size of the volumes. This affects the maximum number of pairs that can be created in the system. If you use a DP-VOL under one of the following conditions, the differential data is managed by the pool to which the UR pair volume is related:
You create a UR pair by using a DP-VOL that is larger than 4,194,304 MB (8,589,934,592 blocks).

You create a UR pair by using a DP-VOL with the Advanced System Settings No. 5 or No. 6 enabled in Device Manager - Storage Navigator. Advanced System Settings No. 5: Manage differential bitmaps in DP pool at pair create and resync operations for 4TB or less TC/UR/GAD pairs. Advanced System Settings No. 6: Manage differential bitmaps in DP pool at pair create operations for 4TB or less TC/UR/GAD pairs.

You resynchronize a UR pair by using a DP-VOL with the Advanced System Settings No. 5 or No. 6 enabled in Device Manager - Storage Navigator.

**Note:** If you enable Advanced System Settings No. 5 or No. 6 in Device Manager - Storage Navigator, the differential data is managed by the pool to which the UR pair volume is related even if the volume is smaller than 4,194,304 MB (8,589,934,592 blocks). This enables the total capacity of the pair volumes to be increased over 1.8 PB. If you want the differential data to be managed by the shared memory again after you create pairs whose total capacity is larger than 1.8 PB, you must reduce the total capacity of the pairs that are smaller than 4,194,304 MB (8,589,934,592 blocks) to 1.8 PB by deleting some pairs. When the differential data is managed by the shared memory, the total capacity of the UR, TC, and GAD pairs is 1.8 PB. For example, if the total capacity of the UR pairs is already 1.8 PB, you cannot create any TC or GAD pairs.

**Journal volumes**

For Universal Replicator operations, journal volumes are required on the primary and secondary systems.

- Updates to the P-VOL are copied to the master journal volume in the primary system. See the illustration in *Master journal and restore journal* on page 1-7.
- Master journal data is copied to the restore journal volume on the secondary system.
- Journal volumes can have different volume sizes and different RAID configurations.
- Only DP-VOLs can be used for journal volumes.
- Volumes to which a path (LU path) is set from a host cannot be registered as journal volumes.
- The host can neither read from nor write to a journal volume.
- You can register two journal volumes in a journal in the primary system and in the secondary system. Best practice is to use one journal volume in each system. If you register two journal volumes in a system, the second journal volume is the reserve (spare) journal volume, which is not used for normal operations (used only in case of failure).

For information on planning journal volumes, see *Planning journal volumes on page 3-5.*
Pair volumes

Original data is stored in the P-VOL and the copy is stored in the S-VOL. The pair can be paired, split, resynchronized, and released. When synchronized, the volumes are paired; when split, new or changed data sent to the P-VOL is not copied to the S-VOL. When resynchronized, changed data is copied to the S-VOL. If a disaster occurs, production operations can be transferred to the S-VOL. When the primary site is functional again, operations can be transferred and data can be copied back to the P-VOL.

The P-VOL remains available to the host for read and write I/O operations. The secondary system rejects write I/Os for the S-VOL unless the write-enable option is specified. Then, write I/O is allowed to the S-VOL while the pair is split. In this instance, S-VOL and P-VOL track maps keep track of differential data and use it to resynchronize the pair.

Master journal and restore journal

Journals help you manage data consistency between multiple P-VOLs and S-VOLs. A journal is a group of one or more data volumes and the related journal volume. Like consistency groups, you can use journals to create multiple pairs, and to split, resynchronize, and release multiple pairs. Journals are required on the primary and secondary systems.

Each data volume and its associated journal volume reside in the same journal.

- The master journal contains master journal volumes and is associated with the P-VOL.
- The restore journal contains restore journal volumes and is associated with the S-VOL.

Each pair relationship between journals is called a "mirror". A mirror ID identifies a pair relationship between journals. When the pair is created, it is assigned a mirror ID.
**Pair status**

Every pair operation changes the pair status of the volumes. Also, when you want to perform an operation, the pair must have a specific status for the operation to run.

You will monitor pair status to ensure that you can perform the desired operation and to ensure that an operation completed successfully.

To become familiar with the operations that result in the pair statuses, please review [Pair status definitions on page 7-3](#).

**S-VOL write option**

When splitting a pair, you can set an option allowing write I/O to the S-VOL. When you resynchronize a split pair whose S-VOL is write-enabled, the secondary system sends the S-VOL track bitmap to the primary system, which merges the P-VOL and S-VOL bitmaps to determine which tracks are out of sync. This ensures proper resynchronization of the pair.

**Mirrors**

The relationship of a master journal and a restore journal is called a "mirror". One master journal corresponds to one mirror.

A mirror is in Active status when it contains only pairs in COPY status (not synchronized with initial copy operation in progress) and pairs in PAIR status (synchronized with initial copy operation completed). Pairs are usually in PAIR status, so mirrors are usually in Active status.

Mirror status changes when an operation is executed to a mirror. Be sure to check the mirror status to confirm that the operation is completed. The following are a few examples of the mirror statuses. For details about mirror status, see [Device Manager - Storage Navigator mirror status definitions on page 7-17](#).

- **Initial**: Data volumes are not registered in the mirror, or deleting the mirror is completed.
- **Active**: The mirror has only pairs that are in COPY or PAIR status.
- **Stopped**: An operation for splitting or deleting the mirror is finished.

**Note:** Universal Replicator pair operations are performed on mirrors instead of individual pairs. Make sure to perform pair split and resync operations for each mirror. Requests to perform a split or resync operation for a pair might be rejected.
Splitting mirrors

When you split a mirror, all of the pairs in the mirror are split, and copy operations of data from the master journal to the restore journal stop. To split a mirror, you must place the mirror in Active status. When mirror splitting is completed, the mirror status becomes Stopped.

Updated data is not reflected to the S-VOL while the pair is split, but only later when the pair is resynchronized. To resynchronize all of the pairs in the mirror, resynchronize the mirror itself.

You can select whether to enable the S-VOL write operation in the Secondary Volume Write option when you split a mirror. If the Secondary Volume Write option is enabled, the host can write data to the S-VOL while the pair is split.
You can also split a mirror after synchronizing the P-VOL and S-VOL. In that case, select **Flush** in **Split Mode**. This allows you to reflect the updated data to the S-VOL when the pair is split. When the secondary system accepts the pair split, all of the journal data that has been held for the pair is written to the S-VOL. If no journal data (update data) comes to the pair for a fixed period of time, the pair status changes to PSUS. When all pairs in the journal are placed in the PSUS status, volume copying is complete, and the mirror status becomes Stopped.

**Tip:** To create a complete copy of the data volumes in the mirror, you need to stop I/O operations from the host. Creating an instantaneous copy-on-demand, and the copy created in this way, is called a "point-in-time copy".

### Resynchronizing a mirror

When you resynchronize a mirror, data copying from the P-VOL to S-VOL in all pairs in the mirror restarts. To resynchronize a mirror, make sure that the mirror status is Stopped.

**Note:** Resynchronize mirrors while I/O load is low. Especially when different types of pairs are mixed in the same consistency group, a mirror resync operation at high I/O load might result in a pair resync failure, with the pair being split (the pair status becomes PSUE).

### Deleting a mirror

When you delete a mirror, all of the pairs in the mirror are deleted, and data copying from the master journal to the restore journal stops. Specify one of the following deletion modes when deleting a mirror:
• **Normal**: The mirror is deleted only when the primary system can change the mirror status to Initial.

• **Force**: The mirror is forcibly deleted even when the primary system cannot communicate with the secondary system.

If the mirror status does not change to Initial after 5 or more minutes from when you start an operation to delete a mirror in Force mode, restart the delete operation in Force mode to ensure all pairs in the mirror are deleted.

After each delete operation in Force mode, wait at least five minutes before you create pairs in the same journal. Otherwise the paircreate operation might fail.

**System components**

As shown in the following figure, a Universal Replicator (UR) system consists of the following components:

- **Primary and secondary storage systems.** The primary storage system contains the primary volumes and is connected to the hosts that access the primary volumes. The secondary storage system is connected to the primary storage system using dedicated data paths. Universal Replicator supports remote copy operations between various storage system models. This document provides instructions for performing UR operations on Hitachi Virtual Storage Platform G200, G400, G600, G800 (VSP G200, G400, G600, G800) and Hitachi Virtual Storage Platform F400, F600, F800 (VSP F400, F600, F800) primary storage systems.

- **Main control units (MCUs) and remote control units (RCUs).** The MCU is the control unit in the primary storage system that controls the P-VOLs of the UR pairs. The MCU communicates with the RCU through the dedicated remote copy connections. The MCU controls the host I/O operations to the P-VOLs as well as the UR remote copy operations between the P-VOLs and S-VOLs. The MCU also manages the UR pair status and configuration information.

  The RCU is the control unit in the secondary storage system that controls the S-VOLs of the UR pairs. The RCU assists in managing the UR pair status and configuration (for example, rejects write I/Os to S-VOLs). The RCU executes the remote copy operations issued by the MCU. The RCUs should be attached to a host system to allow sense information to be reported in case of a problem with a secondary volume or remote storage system and to provide disaster recovery capabilities.

- **Hosts.** The hosts at the primary site are connected to the primary storage system. Hosts at the secondary site are connected to the secondary storage system for use in disaster recovery operations. If it is not possible to have hosts at the secondary site, the host at the primary site must be in communication with the secondary system.

- **Volumes.** The primary volumes (P-VOLs) on the primary storage system are copied to the secondary volumes (S-VOLs) on the secondary system. The P-VOLs contain the original data, and the S-VOLs are the mirrored volumes that contain the backup or duplicate data. The primary and
secondary volumes must have the same format and capacity. During normal UR operations, the P-VOL remains available to all hosts at all times for read and write I/O operations and the secondary storage system rejects all host-requested write I/Os for the S-VOLs. The S-VOL write enable option allows write access to an S-VOL while the pair is split, and the S-VOL and P-VOL differential data is used to resynchronize the pair.

- Universal Replicator software. The UR software must be installed on both the primary and secondary storage systems and is used to perform UR configuration and pair operations.

- Data paths. Dedicated data paths, also called remote copy connections, are used for data transfer between the primary and secondary storage systems. You should establish at least two independent remote copy connections (one per cluster) between each MCU and RCU to provide hardware redundancy for this critical communications path. The VSP Gx00 models and VSP Fx00 models support Fibre Channel and iSCSI remote copy connections.

- Management software for Universal Replicator:
  - Hitachi Command Suite
  - Command Control Interface (CCI)

![Figure 1-3 Universal Replicator components](image-url)

**Figure 1-3 Universal Replicator components**
Storage systems

Universal Replicator operations involve the Hitachi storage systems at the primary and secondary sites.

- The primary system communicates with the secondary system over dedicated remote copy connections.
- The primary system controls the P-VOLs and the following operations:
  - Host I/O write to the P-VOL
  - P-VOL data copy to the master journal
- The secondary system controls the S-VOLs and the following operations:
  - Initial copy and update copy between the P-VOL and Restore Journal.
  - Journal commands to the primary system.
  - Journal data copy from the master to the restore journal.
  - Restore journal data copy to the S-VOL.
  - Pair status management and configuration (for example, rejecting write I/Os to the S-VOLs).
- Each storage system can function simultaneously as a primary and secondary system, managing both P-VOLs and S-VOLs. Because of this, the term main control unit (MCU) is used to refer to the controller of the P-VOL of a pair, and the term remote control unit (RCU) is used to refer to the controller of the S-VOL of a pair.

Pairs

Using Universal Replicator you create pairs of volumes by specifying the primary volumes (P-VOLs) at the primary site that contain the data to be replicated and the secondary volumes (S-VOLs) at the secondary site to which the data on the P-VOLs will be copied.

When you perform Universal Replicator tasks such as creating, splitting, and resynchronizing pairs, the status of the volumes changes to indicate the progress and completion of task.

Data path

The physical transmission link between the primary and secondary systems is called the data path. Universal Replicator commands and data are transmitted through the data path and switches. Universal Replicator requires paths in both directions.

One data path connection in each direction is required. Best practice is to use two or more independent connections to provide hardware redundancy for this critical path. A maximum of eight paths in each direction can be used.

For more information, see Chapter 4, Planning the data path on page 4-1.
Hitachi Command Suite

You can use the Hitachi Command Suite software to access and manage the storage system, including Universal Replicator operations. For details about Hitachi Command Suite, see the *Hitachi Command Suite User Guide*.

Command Control Interface (CCI)

CCI provides a command line interface for accessing and managing the storage system, including Universal Replicator. You can use CCI to automate pair operations using scripts. There are some differences in Universal Replicator operations using CCI and Device Manager - Storage Navigator. For details, see the CCI documentation.

Consistency groups and journals

A CCI consistency group is a group consisting of volumes configured for storage systems in the primary and secondary sites. If you specify a consistency group ID (CTG ID) for a CCI command, you can perform operations on the volumes in a consistency group simultaneously.

A master journal or a restore journal is also a group consisting of volumes configured for storage systems in the primary and secondary sites. You can specify a master journal as one consistency group and a restore journal as another consistency group, and IDs for the consistency groups. By doing so, you can use a CCI command to operate master journal volumes for each master journal, and restore journal volumes for each restore journal. Volumes can be used for each consistency group while the order of write operations between the primary volume and the secondary volume is maintained.

**Caution:**

- The CTG ID of the primary volume and the CTG ID of the paired secondary volume must be the same.
- To avoid incorrect operation, use the same ID for the journal ID and the consistency group ID.

Journals are used in Universal Replicator to guarantee data consistency across multiple pairs. Consistency groups are used in other replication software for the same purpose. The journal group number is the consistency group ID used in CCI. The journal group number can be different in the primary and secondary systems.

The number of consistency groups that can be created depends on the storage system model. Following is the maximum number of consistency groups that can be created for P-VOL's consistency group and S-VOL's consistency group combined:

- VSP G800, VSP F800: 128 (0-127)
- VSP G400, VSP F400, VSP G600, VSP F600: 64 (0-63)
- VSP G200: 16 (0-15)
Sharing volumes with TrueCopy

Like UR, the TrueCopy (TC) remote replication function provides copies of production volumes in a second location. However, unlike UR, the TC S-VOLs are synchronous copies of the P-VOLs, and the secondary storage system is located in the same general region as the primary storage system. Creating a UR backup and a TC backup ensures that a copy in a third location is available in the event that both the primary and secondary sites fail. The TC secondary sites must be closer than the UR secondary sites because TC sites are affected by long distance more than UR sites.

You can combine UR and TC operations in a variety of ways and be prepared in case of failure or disaster. For the configuration combining UR and TC, there are three 3-data-center (3DC) configurations.

**Note:** You can combine UR and TC using the following storage system models: VSP G800, VSP F800, VSP G1000, and HUS VM (3DC multi-target only).

### Overview of 3DC cascade configuration

In the 3DC cascade configuration, data centers are placed at three sites, the primary site, intermediate site, and secondary site. One VSP G800, VSP F800, or VSP G1000 is required for each site. HUS VM is not supported in 3DC cascade configurations.

TC pair is created by using the production volume at the primary site as P-VOL and the volume at the intermediate site near the primary site as S-VOL. Furthermore, a UR pair is created by sharing TC S-VOL as UR P-VOL and uses the volume at the secondary site as S-VOL. To make the I/O response time shorter, place the intermediate site near the primary site. The I/O response time to the host is the total of the TC response time and the journal data creation time at the intermediate site. The following illustration describes this configuration. For details about setting up the 3DC cascade configuration, see 3DC cascade configuration on page C-2.
Overview of 3DC multi-target configuration

In the 3DC multi-target configuration, the data center is placed at the primary site and the two secondary sites. At least one storage system (VSP G800, VSP F800, VSP G1000, or HUS VM) is required at the primary site, intermediate site, and secondary site.

As shown in the following illustration, the P-VOL is paired with the TC S-VOL and the UR S-VOL at separate secondary sites. You can perform disaster recovery by using either the data synchronously copied with TC or the data asynchronously copied with UR. The TC site is at an intermediate distance, and the UR site is located at a greater distance. The following illustration shows this configuration. For details about setting up the 3DC multi-target configuration, see 3DC multi-target configuration on page C-3.

Overview of 3DC multi-target configuration using delta resync

In the 3DC multi-target configuration using delta resync, the data center is placed at the primary site and the two secondary sites. At least one storage system (VSP G800, VSP F800, VSP G1000, or HUS VM) is required at the primary site, intermediate site, and secondary site.
In this configuration, you can bring the S-VOL to a consistent state more quickly after failure because only the missing differential data must be copied. If you create the UR delta resync pairs beforehand, you can synchronize UR S-VOLS by using the UR journal data at the TC secondary site. The TC S-VOL and UR S-VOL are used for creating UR delta resync pairs. The following illustration shows this configuration. For details about setting up the 3DC multi-target configuration using delta resync, see 3DC multi-target configuration using delta resync on page C-4.

**3DC configurations with three UR sites**

You create a 3DC multi-target or 3DC cascade configuration by combining three Universal Replicator sites. A 3DC multi-target configuration involves one primary site and two secondary sites. A 3DC cascade configuration involves a primary site, an intermediate site, and a secondary site.
3DC multi-target configuration with three UR sites

With Universal Replicator, you can set up two secondary sites for one primary site. It is advisable that you create a UR pair that connects the two secondary sites so that the remote copy system created with the host operation site and backup site can be created immediately in the event of a failure or disaster at the primary site.

The following illustration shows the 3DC multi-target configuration with three UR sites:

- UR primary site
- UR secondary site (copies data with a mirror whose ID is an arbitrary number (M in the illustration) from the primary site).
- UR secondary site (copies data with a mirror whose ID is an arbitrary number (N in the illustration) from the primary site).

![Diagram showing 3DC multi-target configuration with three UR sites](image-url)
3DC cascade configuration with three UR sites

With Universal Replicator, you can set up one intermediate site and one secondary site for one primary site. It is advisable that you create a UR pair that connects the primary and secondary sites so that the remote copying system that is created with the host operation site and backup site is configured immediately in the event of a failure or disaster at the intermediate site.

The following illustration shows the 3DC cascade configuration with three UR sites:

- UR primary site (copies data with a mirror whose ID is an arbitrary number (M in the illustration) to the intermediate site).
- UR intermediate site (copies data with a mirror whose ID is an arbitrary number (M in the illustration) from the primary site and copies data with a mirror whose ID is an arbitrary number (N in the illustration) to the secondary site).
- UR secondary site (copies data with a mirror whose ID is an arbitrary number (N in the illustration) from the intermediate site).
3DC multi-target configuration using delta resync with three UR sites

You create a UR pair that connects the two secondary sites so that the remote copy system can be created immediately using the two secondary sites if a failure or disaster occurs at the primary site. A UR pair that is created to make a triangle-shaped remote copy connection among the three sites is called UR delta resync pair. By creating a UR delta resync pair between the two secondary sites in advance, you can transfer the copying operations from between the two secondary sites back to between the primary and secondary sites in a short time when the primary site failure is corrected and the primary site is brought back online.

The following illustration shows the 3DC multi-target configuration using delta resync with three UR sites.

Note: For a 3DC multi-target configuration using delta resync with three UR sites, both the P-VOL and S-VOL of a UR delta resync pair are displayed as secondary volumes in the Remote Replication window (Pair Position column).
3DC cascade configuration using delta resync with three UR sites

You create a UR pair that connects the primary and secondary sites so that the remote copy system created with the host operation site and backup site can be created immediately if a failure or disaster occurs at the intermediate site. A UR pair that is created to make a triangle-shaped remote copy connection among the three sites is called UR delta resync pair. By creating a UR delta resync pair between the primary and secondary sites in advance, you can transfer the copying operations from between the primary and intermediate sites back to between the intermediate and secondary sites in a short time when the intermediate site failure is corrected, and the intermediate site is brought back online.

The following illustration shows the 3DC cascade configuration using delta resync with three UR sites.
Requirements and specifications

This chapter provides the system requirements for Universal Replicator operations.

- System requirements
## System requirements

The following table lists the system requirements for Universal Replicator operations.

### Table 2-1 General system requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage systems</td>
<td>Microcode requirements for connecting VSP Gx00 models or VSP Fx00 models:</td>
</tr>
<tr>
<td></td>
<td>• VSP G200: 83-01-01-20/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP G400, VSP G600: 83-01-01-40/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP G800: 83-01-21-60/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP F400, F600, F800: 83-02-0x or later</td>
</tr>
<tr>
<td></td>
<td>Microcode requirements for connecting VSP Gx00 models or VSP Fx00 models to Hitachi Unified Storage VM (HUS VM):</td>
</tr>
<tr>
<td></td>
<td>• VSP G200: 83-01-21-20/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP G400, VSP G600: 83-01-21-40/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP G800: 83-01-21-60/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP F400, F600, F800: 83-02-0x or later</td>
</tr>
<tr>
<td></td>
<td>• HUS VM: 73-03-39-x0/00 or later, x = 0 or 1</td>
</tr>
<tr>
<td></td>
<td>If you are using a Dynamic Provisioning virtual volume (DP-VOL) with the data direct mapping attribute, you can only connect to VSP Gx00 models or VSP Fx00 models with microcode 83-02-0x or later.</td>
</tr>
<tr>
<td></td>
<td>Microcode requirements for connecting VSP Gx00 models or VSP Fx00 models to VSP G1000:</td>
</tr>
<tr>
<td></td>
<td>• VSP G200: 83-01-21-20/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP G400, VSP G600: 83-01-21-40/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP G800: 83-01-21-60/00 or later</td>
</tr>
<tr>
<td></td>
<td>• VSP F400, F600, F800: 83-02-0x or later</td>
</tr>
<tr>
<td></td>
<td>• VSP G1000: 80-04-xx or later</td>
</tr>
<tr>
<td></td>
<td>For more information, contact Hitachi Data Systems customer support.</td>
</tr>
<tr>
<td>Number of storage systems</td>
<td>• Universal Replicator: One to four storage systems at the primary site, and one to four storage systems at the secondary site.</td>
</tr>
<tr>
<td></td>
<td>• 3DC cascade configuration combined with TrueCopy: one VSP G800, VSP F800, or VSP G1000 at the primary site, intermediate site, and secondary site.</td>
</tr>
<tr>
<td></td>
<td>• 3DC multi-target configuration combined with TrueCopy: at least one VSP G800, VSP F800, VSP G1000, or HUS VM at the primary site, the UR secondary site, and the TC secondary site.</td>
</tr>
<tr>
<td>License keys</td>
<td>• The following license keys are required:</td>
</tr>
<tr>
<td></td>
<td>• Universal Replicator: Universal Replicator must be installed on the storage system that has the UR master journal and the storage system that has the UR restore journal.</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• TrueCopy: TrueCopy is a prerequisite for installing Universal Replicator.</td>
</tr>
<tr>
<td></td>
<td>• Dynamic Provisioning: DP-VOLs are required for the journal volumes.</td>
</tr>
<tr>
<td></td>
<td>• Remote Replication Extended: Remote Replication Extended is required for 3DC configurations.</td>
</tr>
<tr>
<td></td>
<td>• For licensing capacity requirements when Universal Replicator volumes are shared with volumes used by other software products, see Dynamic Provisioning on page B-5.</td>
</tr>
<tr>
<td></td>
<td>• For information on expired licenses or exceeding licensed capacity, see the Hitachi Command Suite User Guide.</td>
</tr>
<tr>
<td>Interfaces</td>
<td>• Hitachi Command Suite:</td>
</tr>
<tr>
<td></td>
<td>• Required on the primary system.</td>
</tr>
<tr>
<td></td>
<td>• Not required on the secondary system, but recommended in order to change Universal Replicator parameters and access the S-VOL for disaster recovery and maintenance.</td>
</tr>
<tr>
<td></td>
<td>• The following roles are required:</td>
</tr>
<tr>
<td></td>
<td>Storage Administrator (Remote Copy), to perform pair operations</td>
</tr>
<tr>
<td></td>
<td>Storage Administrator (System Resource Management), to configure settings</td>
</tr>
<tr>
<td></td>
<td>• CCI:</td>
</tr>
<tr>
<td></td>
<td>• Optional.</td>
</tr>
<tr>
<td></td>
<td>• If CCI is used, a command device is required on the primary and secondary systems. For details, see the Command Control Interface User and Reference Guide.</td>
</tr>
<tr>
<td>Host platforms</td>
<td>UNIX-based and PC server platforms:</td>
</tr>
<tr>
<td></td>
<td>• HP-UX</td>
</tr>
<tr>
<td></td>
<td>• Sun Solaris</td>
</tr>
<tr>
<td></td>
<td>• Windows</td>
</tr>
<tr>
<td></td>
<td>• IBM AIX</td>
</tr>
<tr>
<td></td>
<td>• VMWare ESX</td>
</tr>
<tr>
<td></td>
<td>For details about host platform support, refer to the Hitachi Data Systems interoperability matrix at <a href="https://support.hds.com">https://support.hds.com</a>.</td>
</tr>
<tr>
<td>Data path</td>
<td>The following interfaces are supported:</td>
</tr>
<tr>
<td></td>
<td>• Fibre Channel</td>
</tr>
<tr>
<td></td>
<td>• iSCSI</td>
</tr>
<tr>
<td></td>
<td>Direct, switch, and extender connections are supported. For details, see Supported remote connection configurations on page 4-11.</td>
</tr>
<tr>
<td></td>
<td>When both systems are VSP Gx00 models or VSP Fx00 models, you can use multiple path groups. This is done by</td>
</tr>
</tbody>
</table>
### Path group
- A maximum of 64 path groups can be set in a storage system.
- The range of values for the path group ID is 00-FF (maximum 256 path groups).
- Two path group IDs can be set in a port.
- Protocol: All remote paths in a path group must be the same protocol, either Fibre Channel or iSCSI. Remote paths for Fibre Channel and iSCSI cannot coexist within the same path group.
- If iSCSI is used in a remote path, the Blocked Path Monitoring remote replica option must be set to at least 40 seconds (default). If Blocked Path Monitoring is less than 40 seconds, the path might be blocked due to a delay in the network such as many switches in a spanning tree protocol (STP) network or a long distance connection.
- For a mirror, the path group ID that is used to connect the primary system to the secondary system must also be used to connect the systems in the reverse direction.
- The path group is specified during the create pair operation. It cannot be changed by resynchronization or the swap operation.
- Path groups can be created and specified using CCI. See configuration setting commands in *Command Control Interface User and Reference Guide* and sample configuration definition files in *Command Control Interface Installation and Configuration Guide*.

### Pair volumes
- A P-VOL can be copied to only one S-VOL.
- The P-VOL and S-VOL must be equal in size.
- The maximum size of the P-VOL and S-VOL is:
  - DP-VOL: same as the maximum size of the DP-VOL. For details, see the *Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.
  - Internal volume: 3,145,663 MB (6,442,317,824 blocks)
  - External volume: 4,194,304.000 MB (8,589,934,592 blocks)
- Minimum volume size: 46.875 MB (96,000 blocks)
- A volume (LDEV) from a parity group with accelerated compression enabled cannot be used directly as a pair volume. Such volumes must be used as pool volumes for an HDP or HDT pool.
- The same value must be set for the T10 PI attribute of the P-VOL and the S-VOL.
- You cannot use the NAS Platform system LU as a pair volume.
<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| Virtual LUN volume | • Can be used as data volumes.  
• The P-VOL and S-VOL must be equal in size. |
| Virtual volume | • Can be used as data volumes and journal volumes.  
• Only Dynamic Provisioning virtual volumes can be used as journal volumes. |
| Maximum number of pairs | Limited per storage system. See [Maximum number of pairs allowed on page 3-7](#). |
| CCI consistency group with multiple pairs of storage systems | • For UR systems with multiple storage systems, up to four journals can be registered in each CCI consistency group. For details, see [Registering multiple journals to a CCI consistency group on page 3-14](#).  
• The maximum number of pairs is the total number of journal pairs registered in each CCI consistency group. For details on calculating the maximum number of pairs, see [Maximum number of pairs allowed on page 3-7](#). |
| Supported RAID groups | • RAID 1, RAID 5, and RAID 6 are supported for both data and journal volumes.  
• RAID 1, RAID 5, and RAID 6 can co-exist in the same journal. |
| Cache and nonvolatile storage (NVS) | Must be operable for primary and secondary systems to ensure pair creation success. The secondary system cache must be configured to adequately support UR remote-copy workloads, as well as local workload activity. To determine the appropriate cache capacity to be increased, use the result of the following formula A or B, whichever is smaller:  
A. $1 \text{ GB} \times \text{number of journals}$  
B. $25\%$ of the necessary cache to support the storage capacity |
| Host failover software | Required for disaster recovery. |
| Journal | • Maximum number of journals:  
  • VSP G800, VSP F800: 128* (journal ID: 0-255) if shared memory "Extension2" is implemented. If shared memory "Extension2" is not implemented, you can only set up to 32 journals. If shared memory "Extension3" is not implemented, you can only set up to 64 journals.  
  * Even though 256 IDs are available, you can only use 128 of them.  
  • VSP G400, VSP F400, VSP G600, VSP F600: 64* (journal ID: 0-255) if shared memory "Extension2" is implemented. If shared memory "Extension2" is not implemented, you can only set up to 32 journals.  
  * Even though 256 IDs are available, you can only use 64 of them.  
  • VSP G200: 16* (journal ID: 0-255)  
  * Even though 256 IDs are available, you can only use 16 of them.  
• Preferred number of journals: up to 4 |
<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Maximum number of data volumes in a journal:</td>
</tr>
<tr>
<td></td>
<td>o VSP G800, VSP F800: 8,192 per journal</td>
</tr>
<tr>
<td></td>
<td>o VSP G400, VSP F400, VSP G600, VSP F600: 4,096 per journal</td>
</tr>
<tr>
<td></td>
<td>o VSP G200: 2,048 per journal</td>
</tr>
<tr>
<td></td>
<td>• Maximum number of journal volumes in a journal: 2 per journal. When there are two, one is the reserve (spare) journal volume.</td>
</tr>
<tr>
<td></td>
<td>• Only Dynamic Provisioning virtual volumes can be used as journal volumes.</td>
</tr>
<tr>
<td></td>
<td>• Virtual storage machine volumes cannot be used as journal volumes.</td>
</tr>
<tr>
<td></td>
<td>• Data volumes belonging to different virtual storage machines cannot be registered to the same journal.</td>
</tr>
<tr>
<td></td>
<td>• A DP-VOL with the data direct mapping attribute cannot be registered to a journal.</td>
</tr>
<tr>
<td></td>
<td>• Minimum journal volume size: 1.5 GB</td>
</tr>
<tr>
<td></td>
<td>• Recommended journal volume size: 6 GB or more</td>
</tr>
<tr>
<td></td>
<td>• Journal volume capacity is not included in Universal Replicator capacity cost.</td>
</tr>
<tr>
<td></td>
<td>• Journal IDs cannot be duplicated among the virtual storage machines of VSP G200, VSP G400, VSP G600, and VSP F400, F600 if a virtual storage machine is created.</td>
</tr>
</tbody>
</table>
This chapter provides information and instructions for planning Universal Replicator volumes and storage systems and other important requirements and restrictions.

- Plan and design workflow
- Assessing business requirements for data recovery
- Write-workload
- Data transfer speed considerations
- Sizing journal volumes
- Planning journal volumes
- Planning journal configuration
- Planning pair volumes
- Disaster recovery considerations
- Planning for using volumes in other storage system models
- Sharing UR volumes with volumes used by other products
- Adding and removing cache memory and shared memory
- Planning UR with multiple storage systems
- Guidelines for preparing systems for Universal Replicator
Plan and design workflow

Planning the Universal Replicator system is tied to your organization’s business requirements and production system workload. This means defining business requirements for disaster downtime and measuring the amount of changed data your storage system produces over time. With this information, you can calculate the size of journal volumes and the amount of bandwidth required to transfer update data over the data path network.

The plan and design workflow consists of the following:

- Assess your organization’s business requirements to determine recovery requirements.
- Measure your host application’s write-workload in MB per second and write-input/output per second (IOPS) to begin matching actual data loads with the planned Universal Replicator system.
- Use collected data along with your organization’s recovery point objective (RPO) to size Universal Replicator journal volumes. Journal volumes must have enough capacity to hold accumulating data over extended periods. The sizing of journal volumes can be influenced by the amount of bandwidth you decide to use. These factors are interrelated. You can adjust journal volume size in conjunction with bandwidth to accommodate your needs.
- Use IOPS to determine data transfer speed into and out of the journal volumes. Data transfer speed is determined by the number of Fibre Channel ports you assign to Universal Replicator, and by RAID group configuration. You need to know port transfer capacity and the number of ports that your workload data will require.
- Use collected workload data to size bandwidth for the data path. As mentioned, bandwidth and journal volume sizing, along with data transfer speed, are interrelated. Bandwidth can be adjusted with the journal volume capacity and data transfer speed you plan to implement.
- Design the data path network configuration, based on supported configurations, switches, and the number of ports your data transfer requires.
- Plan data volumes (primary and secondary volumes), based on the sizing of P-VOL and S-VOL, RAID group considerations, and so on.
- Understand operating system requirements for data and journal volumes.
- Adjust cache memory capacity for Universal Replicator.

Some tasks will be handled by Hitachi Data Systems personnel. The planning information you need to address is provided in the following topics.

Assessing business requirements for data recovery

In a Universal Replicator system, when the data path continues to transfer changed data to the secondary site, journals remain fairly empty. However, if a path failure or a prolonged spike in write-data that is greater than
bandwidth occurs, data flow stops. Changed data that is no longer moving to the secondary system builds up in the master journal.

To ensure that journals can hold the amount of data that could accumulate, they must be sized according to the following:

- The maximum amount of time that journals could accumulate data. You develop this information by determining your operation’s recovery point objective (RPO).
- The amount of changed data that your application generates. This is done by measuring write-workload.

**Determining your RPO**

Your operation’s recovery point is the maximum time that can pass after a failure or disaster occurs before data loss is greater than the operation can survive.

For example, if the operation can survive one hour’s worth of lost data, and a disaster occurs at 10:00 am, then the system must be corrected by 11 a.m.

In regards to journal sizing, the journal must have the capacity to hold the data that could accumulated in one hour. If RPO is 4 hours, then the journal must be sized to hold 4-hour’s worth of accumulating data.

To assess RPO, the host application’s write-workload must be known.

With write-workload and IOPS, you or your organization’s decision-makers can analyze the number of transactions write-workload represents, determine the number of transactions the operation could loose and still remain viable, determine the amount of time required to recover lost data from log files or key it in, and so on. The result is your RPO.

**Write-workload**

Write-workload is the amount of data that changes in your production system in MB per second. Write-workload varies according to the time of day, week, month, and quarter, so workload must be measured over an extended period.

With the measurement data, you can calculate workload averages, locate peak workload, and calculate peak rolling averages, which show an elevated average. Using this data you can calculate the amount of data that accumulates over your RPO time, for example, 2 hours. This will be a base capacity for your journal volumes or represent a base amount of bandwidth your system requires.

Whether you select average, rolling average, or peak workload is based on the amount of bandwidth you will provide the data path (which is also determined by write-workload). Bandwidth and journal volume capacity work together and depend on your strategy for protecting data.
Measuring write-workload

Workload data is collected using Hitachi Performance Monitor or your operating system’s performance-monitoring feature. You will use IOPS to set up a proper data transfer speed, which you ensure through RAID group configuration and by establishing the number of Fibre Channel or iSCSI ports your Universal Replicator system requires. Each RAID group has a maximum transaction throughput; the ports and their microprocessors have an IOPS threshold.

Workload and IOPS collection is best performed during the busiest time of month, quarter, and year. This helps you to collect data that shows your system’s actual workloads during high peaks and spikes, when more data is changing, and when the demands on the system are greatest. Collecting data over these periods ensures that the Universal Replicator design you develop will support your system in all workload levels.

Data transfer speed considerations

This topic discusses the speed that data must be transferred in order to maintain the Universal Replicator system your are designing.

The ability of your Universal Replicator system to transfer data in a timely manner depends directly on the following two factors:

• RAID group configuration
• Port configuration

Both of these elements must be planned to be able to handle the amount of data and number of transactions your system will move under extreme conditions.

RAID group configuration

A RAID group can consist of physical volumes with a different number of revolutions, physical volumes of different capacities, and physical volumes of different RAID configurations (for example, RAID-1 and RAID-5). The data transfer speed of RAID groups is affected by physical volumes and RAID configurations.

Fibre Channel port configuration

The Fibre Channel ports on your VSP G200, G400, G600, G800 and VSP F400, F600, F800 systems have an IOPS threshold. Use the performance monitoring information for the number of IOPS your production system generates to calculate the number of Fibre Channel ports the Universal Replicator system requires.

Please see Universal Replicator ports on page 4-7 for details about the type and number of Fibre Channel ports required for your system.
Sizing journal volumes

Journals volumes should be sized to meet all possible data scenarios, based on your business requirements. If the amount of data exceeds capacity, performance problems and suspensions result.

Best practice is to use a capacity of 6 GB or more. Journal volumes cannot be registered if the capacity is less than 1.5 GB.

Procedure

1. Follow the instructions for Measuring write-workload on page 3-4.
2. Use your system’s peak write-workload and your organization’s RPO to calculate journal size. For example:

   RPO = 2 hours
   Write-workload = 30 MB/sec

   Calculate write-workload for the RPO. In the example, write-workload over a two-hour period is calculated as follows:
   30 MB/second x 60 seconds = 1800 MB/minute
   1800 MB/minute x 60 minutes = 108,000 MB/hour
   108000 MB/hour x 2 hours = 216,000 MB

   Basic journal volume size = 216,000 MB (216 GB)

   Journal volume capacity and bandwidth size work together. Also, your strategy for protecting your data can allow you to adjust bandwidth or the size of your journal volumes. For details about sizing strategies, see Five sizing strategies on page 4-3.

   Note: If you are planning for disaster recovery, the secondary system must be large enough to handle the production workload, and therefore, must be the same size as master journals.

Planning journal volumes

In addition to sizing journal volumes, you must also be aware of the following requirements and restrictions:

- Journal volumes consist of two areas: One area stores journal data, and the other area stores metadata for remote copy.
- Journal volume capacity:
  - The displayed journal volume capacity is the master journal capacity and restore journal capacity. The reserve journal volume is not included in the displayed journal volume capacity.
  - Journal volume capacity is not included in accounting capacity.
  - In the GUI documents, the journal volume capacity is called "journal capacity".
  - In the CCI documents, the journal volume capacity is called "capacity for the journal data on the journal volume" and "capacity of the data block size of the journal volume".
• You can register two journal volumes in a journal in the primary system and in the secondary system. Best practice is to use one journal volume in each system.
  - If you register two journal volumes in one system, the second journal volume is the reserve (spare) journal volume, which is not used for normal operations (used only in case of failure).
  - If you register two journal volumes in one system at the same time, the volume with the smaller LDEV ID is the journal volume, and the other volume is the reserve (spare) journal volume.

Planning journal volumes for delta resync

For the 3DC multi-target configuration using delta resync, use the following formula to determine the journal volume capacity in the Universal Replicator primary site (TrueCopy secondary site). Perform the following calculations A and B, and use the larger result:

A. Journal volume capacity > (VH-L − VL-R) × t

where:
  • VH-L: data transfer speed between the host and the primary system
  • VL-R: data transfer speed between the primary system and the secondary system
  • t: the time length of the data transfer peak work load duration

B. Journal volume capacity > (VH-L × t) × 1.5

where:
  • VH-L: data transfer speed between the host and the primary system
  • t: the time it takes until the delta resync operation is performed

In formula B, the quantity (VH-L × t) is multiplied by 1.5 because when updating the UR delta resync P-VOL, delta resync fails if the data capacity of the journal volume at the UR delta resync primary site (TC secondary site) exceeds 70%.

Planning journal configuration

Universal Replicator manages pair operations for data consistency through the use of journals. Universal Replicator journals enable update sequence consistency to be maintained across a group of volumes.

Understanding the consistency requirements for an application (or group of applications) and their volumes will indicate how to structure journals.

For example, databases are typically implemented in two sections. The bulk of the data is resident in a central data store, while incoming transactions are written to logs that are subsequently applied to the data store.
If the log volume “gets ahead” of the data store, it is possible that transactions could be lost at recovery time. Therefore, to ensure a valid recovery image on a replication volume, it is important that both the data store and logs are I/O consistent by placing them in the same journal.

**Planning pair volumes**

The following information can help you prepare volumes for configuration. Also, see system requirements and specifications in Chapter 2, Requirements and specifications on page 2-1 for more information.

- The emulation and capacity for the S-VOL must be the same as for the P-VOL.
- When the S-VOL is connected to the same host as the P-VOL, the S-VOL must be defined to remain offline.
- You can create a Universal Replicator pair using a TrueCopy initial copy, which takes less time. To do this, system option 474 must be set on the primary and secondary systems. Also, a script is required to perform this operation. For more on system option 474 and how to do this operation, see System option modes on page 3-18.
- Universal Replicator supports the Virtual LUN feature. When Virtual LUN LDEVs are assigned to a Universal Replicator pair, the S-VOL must have the same capacity as the P-VOL. For details about Virtual LUN, see the Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models.
- Identify the volumes that will become the P-VOLs and S-VOLs. Note the port, group ID (or iSCSI target ID), and LUN of each volume. This information is used during the initial copy operation.
- If you plan to create multiple pairs at the same time using Device Manager - Storage Navigator, you must plan the S-VOLs ahead of time so that the system will assign the correct S-VOLs to the selected P-VOLs. When you select multiple volumes as P-VOLs, you will specify one S-VOL and the selection method (Interval or Relative Primary Volume) for determining the rest of the S-VOLs to assign to the selected P-VOLs. The system automatically assigns S-VOLs to the selected P-VOLs using the LUN IDs determined by the specified selection method. For details, see Creating Universal Replicator pairs on page 6-2.
- When you create a Universal Replicator pair, you will have the option to create only the relationship, without copying data from P-VOL to S-VOL. You can use this option only when data in the two volumes is identical.

**Maximum number of pairs allowed**

The maximum number of pairs depends on the storage system model. If the calculated number of pairs exceeds this value, the limit will be the maximum for that particular model.

- VSP G800, VSP F800: 8,192 (maximum), 4,096 or fewer (recommended)
• VSP G400, G600, VSP F400, F600: 4,096 (maximum), 2,048 or fewer (recommended)
• VSP G200: 2,048 (maximum), 1,024 or fewer (recommended)

When the volume size is larger than 4,194,304 MB (8,589,934,592 blocks), the bitmap area is not used. Therefore, it is not necessary to calculate the maximum number of pairs when creating UR pairs with DP-VOLs whose size is larger than 4,194,304 MB (8,589,934,592 blocks).

Calculating maximum number of pairs

**Note:** In the calculations below, note the following:

- ceiling(value) indicates that the value in parentheses should be rounded up to the next integer.
- Number of logical blocks indicates volume capacity measured in blocks.

\[
\text{Number of logical blocks} = \frac{\text{Volume capacity (in bytes)}}{512}
\]

To calculate the number of cylinders

Use the following formula:

\[
\text{Number of cylinders} = \left(\text{ceiling} \left( \frac{\text{ceiling} \left( \text{number of logical blocks} / 512 \right)}{15} \right) \right)
\]

To calculate the number of required bitmap areas

Use the following formula:

\[
\text{ceiling} \left( \frac{\text{number of cylinders} \times 15}{122,752} \right)
\]

where:

- number of cylinders \times 15 indicates the number of slots
- 122,752 is the number of slots that a bitmap area can manage

**Note:** Perform this calculation for each volume separately, and then total the bitmap areas. Performing this calculation for multiple volumes can result in inaccuracies. The following examples show correct and incorrect calculations. Two volumes are used: one of 10,017 cylinders and another of 32,760 cylinders.

**Correct calculation**

\[
\text{ceiling} \left( \frac{10,017 \times 15}{122,752} \right) = 2
\]

\[
\text{ceiling} \left( \frac{32,760 \times 15}{122,752} \right) = 5
\]

Total: 7

**Incorrect calculation**

\[
10,017 + 32,760 = 42,777 \text{ cylinders}
\]

\[
\text{ceiling} \left( \frac{42,777 \times 15}{122,752} \right) = 6
\]

Total: 6

The bitmap areas are shared by TC, UR, and global-active device (GAD). Therefore if you want to combine these products, subtract the necessary bitmap areas for each product from the total number of bitmap areas in the
the storage system (65,536) first, and then calculate the maximum number of UR pairs that can be created. For details about calculating the required bitmap areas for each product, see the corresponding user guide.

TrueCopy also uses bitmap areas. Like 3DC cascade configuration, when the same volumes are shared by TC and UR, subtract the necessary bitmap areas for TC from the number of bitmap areas in the storage system regardless of whether the shared volume is a P-VOL or S-VOL. For details about calculating the required number of bitmap areas for TC, see the Hitachi TrueCopy® User Guide.

To calculate the maximum number of pairs

Calculate the maximum number of pairs using the following formula:

\[
\text{Maximum number of pairs} = \text{floor}( \frac{\text{Number of bitmap areas}}{\text{required number of bitmap areas}} )
\]

The number of bitmap areas is determined by the availability of shared memory that was extended for Universal Replicator and the storage system model, as shown in the following table.

<table>
<thead>
<tr>
<th>Extension status of shared memory for UR</th>
<th>Number of bitmap areas in storage systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Extension</td>
<td>Depends on the model:</td>
</tr>
<tr>
<td></td>
<td>• VSP G200: 3,712</td>
</tr>
<tr>
<td></td>
<td>• VSP G400, G600, G800, VSP F400, F600, F800: 0</td>
</tr>
<tr>
<td>With Extension</td>
<td>Depends on the model:</td>
</tr>
<tr>
<td></td>
<td>• VSP G200: 36,000</td>
</tr>
<tr>
<td></td>
<td>• VSP G400, G600, G800, VSP F400, F600, F800: 65,536</td>
</tr>
</tbody>
</table>

Note: The maximum number of pairs depends on the storage system model. If the calculated number of pairs exceeds this value, the limit will be the maximum for that particular model.

- VSP G800, VSP F800: 8,192 (maximum), 4,096 or fewer (recommended)
- VSP G400, G600, VSP F400, F600: 4,096 (maximum), 2,048 or fewer (recommended)
- VSP G200: 2,048 (maximum), 1,024 or fewer (recommended)

Disaster recovery considerations

You begin a disaster recovery solution when planning the Universal Replicator system. The following are the main tasks for preparing for disaster recovery:

- Identify the data volumes that you want to back up for disaster recovery.
- Pair the identified volumes using Universal Replicator.
- Establish file and database recovery procedures.
For more information on host failover error reporting, see the following topic. Also, review Chapter 9, Universal Replicator disaster recovery operations on page 9-1 to become familiar with disaster recovery processes.

Host failover software

Host failover software is a critical component of any disaster recovery effort. When a primary system fails to maintain synchronization of a Universal Replicator pair, the primary system generates sense information. This information must be transferred to the secondary site using the host failover software for effective disaster recovery. CCI provides failover commands that interface with industry-standard failover products.

Planning for using volumes in other storage system models

Universal Replicator supports configurations in which the VSP Gx00 models or VSP Fx00 models are connected to the HUS VM or VSP G1000. By setting the following system, you can transfer the journal data from the VSP Gx00 models or VSP Fx00 models to the HUS VM or VSP G1000, or in the reverse direction.

- Set a remote path between the VSP Gx00 models or VSP Fx00 models (current system) and the HUS VM or VSP G1000 (other system).

- Set the system by following the procedures in this manual. When you use the HUS VM or VSP G1000, the number of the usable volumes and the range of the CU:LDEV numbers of the volumes are different depending on the model of the current storage system, as shown in the following table.

<table>
<thead>
<tr>
<th>Current storage system model</th>
<th>Number of usable volumes</th>
<th>Range of CU:LDEV numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>VSP G200</td>
<td>2,048</td>
<td>00:00 to 07:FF</td>
</tr>
<tr>
<td>VSP G400, VSP F400</td>
<td>4,096</td>
<td>00:00 to 0F:FF</td>
</tr>
<tr>
<td>VSP G600, VSP F600</td>
<td>4,096</td>
<td>00:00 to 0F:FF</td>
</tr>
<tr>
<td>VSP G800, VSP F800</td>
<td>16,384</td>
<td>00:00 to 3F:FF</td>
</tr>
</tbody>
</table>

- If you are connecting VSP Gx00 models or VSP Fx00 models to HUS VM or VSP G1000, see System requirements on page 2-2 for DKCMAIN microcode requirements.
Sharing UR volumes with volumes used by other products

Universal Replicator volumes can be shared with volumes used by other products. Sharing pair volumes enhances replication solutions, for example, when Universal Replicator and ShadowImage volumes are shared.

For planning information, see the following:
- Appendix B, Sharing Universal Replicator volumes on page B-1
- Appendix D, Configurations with ShadowImage on page D-1

Adding and removing cache memory and shared memory

Cache must be operable for the primary system and secondary system, otherwise pairs cannot be created. The secondary system cache should be configured to adequately support Universal Replicator remote copy workloads and any local workload activity. Additional shared memory is prerequisite in both of the primary and secondary system. Perform the following calculations and use the smaller result to add the cache memory capacity for Universal Replicator.

- $1 \text{ GB} \times \text{number-of-journals}$
- $25\%$ of the cache memory mounted on the storage system

You can remove the cache memory/shared memory that is no longer necessary. The following workflows describe how to add or remove the cache memory/shared memory when it is used with UR pairs.

Workflow for adding and removing cache memory

Use the following workflow to add or remove cache memory in a storage system in which UR pairs already exist:

1. Identify the status of the UR volumes in the storage system.
2. If a UR volume is in the COPY status, wait until the status changes to PAIR, or split the UR pair.
   Do not add or remove cache memory when any volumes are in the COPY status.
3. When the status of all volumes has been confirmed, cache memory can be added to or removed from the storage system by your service.
representative. Contact Hitachi Data Systems customer support for adding or removing cache memory.

4. After the addition or removal of cache memory is complete, resynchronize the pairs that you split in step 2.

**Workflow for adding shared memory**

Use the following workflow to add shared memory to a storage system in which UR pairs already exist:

1. Identify the status of the UR volumes in the storage system.
2. If a UR volume is in the COPY status, wait until the status changes to PAIR, or split the UR pair. Do not add shared memory when any volumes are in the COPY status.
3. When the status of all volumes has been confirmed, shared memory can be added to the storage system by your service representative. Contact Hitachi Data Systems customer support for adding or removing cache memory.
4. After the addition of shared memory is complete, resynchronize the pairs that you split in step 2.

**Workflow for removing shared memory**

Use the following workflow to remove shared memory.

**Note:** For the following cases, you do not need to delete the UR pairs in step 2 because there is no dedicated area for UR, such as bit map areas:

- VSP G200: Shared memory is added in Extension2.
- VSP G400, G600, G800: Shared memory is added in Extension4.

1. Identify the status of all volumes in the storage system.
2. If a volume is used by a UR pair, delete the UR pair.
3. If you extended shared memory and used journals exceeding the maximum number, release all registered journals. For the maximum number of journals, see *System requirements on page 2-2*.
4. Shared memory can be removed from the storage system by your service representative. Contact Hitachi Data Systems customer support for adding or removing shared memory.

**Planning UR with multiple storage systems**

A UR system can contain up to four primary systems (VSP Gx00 models, VSP Fx00 models, VSP G1000, or HUS VM) and up to four secondary systems (VSP Gx00 models, VSP Fx00 models, VSP G1000, or HUS VM). Any combination of primary and secondary systems can be used. For example, you can combine four primary systems and four secondary systems, or two primary systems and one secondary system, and so on. In addition, a volume
of a UR pair embedded in the UR system using multiple VSP Gx00 models and VSP Fx00 models can be shared with a TC pair. For details about sharing UR with TC, see Appendix C, Configurations with TrueCopy on page C-1.

The following figure shows a sample configuration.

In this configuration, a time stamp is issued regularly from CCI on the primary host. When data is sent to the secondary storage systems, the systems check the time stamps, which are added when data is written by the hosts to the P-VOLs. The secondary storage systems then restore the data to the S-VOLs in chronological order to ensure that the update sequence is maintained.

Note the following when planning for multiple systems:

• Device Manager - Storage Navigator is required at the primary and secondary sites.
• CCI is recommended on the host at the primary and secondary sites.
• Journal data is updated in the secondary storage system based on the time stamp and the sequence number issued by the host with write
requests to the primary storage system. Time and sequence information remain with the data as it moves to the master and restore journals and then to the secondary volume.

- Disaster recovery can be performed.
- An error in one journal can cause suspension of all journals.
- Restoring data to the secondary storage system is performed when the time stamp of the copied journal is updated. The recommended interval between time stamps is one second.

Consider the following before setting the interval:

- I/O response time slows when time stamps are updating among multiple storage systems. If you shorten the interval, more time stamps are issued, resulting in an I/O response time that is even slower.
- If the interval is lengthened, the amount of time that journal data can accumulate increases, which results in an increased amount of data to be copied.
- None of the above is true during the initial copy or resynchronization. During these operations, lengthening the interval between time stamps does not result in more accumulated journal data, because data restoring takes place regardless of time stamp.

- The recommended method for executing CCI commands is the in-band (host-based) method. This prevents I/O response from deteriorating, which can occur with the out-of-band (LAN-based) method.

- When the pair status in the P-VOL is PAIR, if you specify the S-VOL to split the pair, each storage system copies the latest data from the P-VOL to the S-VOL. Depending on the timing when the time stamp is updated, the time stamp might be different between the storage systems.

- In a configuration in which multiple storage systems in primary and secondary sites are combined, configure the remote copy environment of each storage system as equally as possible. If the following conditions exist, the restoration performance of each journal is degraded, and journal data is accumulated:
  - The copy performance between the primary and secondary sites of some pairs is lower than other storage systems.
  - A problem occurs in a line between pairs.
- It is not possible to register a journal to multiple CCI consistency groups.

### Registering multiple journals to a CCI consistency group

Basically, only one journal should be registered to a CCI consistency group (CTG). However, in the configurations shown in the following figures, a maximum of four journals are registered to a CCI CTG.

In the following figures, multiple journals are registered to a consistency group.
Consistency group #0

Figure 3-1 Configuration of a consistency group with multiple journals (1)
Figure 3-2 Configuration of a consistency group with multiple journals (2)
Guidelines for preparing systems for Universal Replicator

Use the following guidelines to ensure that your storage systems are ready for Universal Replicator:

- Identify the locations where your Universal Replicator primary and secondary data volumes will be located, and then install and configure the storage systems.
- Make sure that the primary and secondary systems are configured for Device Manager - Storage Navigator operations. For more information, see the System Administrator Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models.
- Make sure that the primary and secondary systems are properly configured for Universal Replicator operations, for example, cache memory considerations. See the entry for Cache and Nonvolatile Storage in the requirements table, System requirements on page 2-2.
- Make sure that appropriate system option modes for your Universal Replicator configuration are set on the primary and secondary systems. See System option modes on page 3-18 for more information.
- Make sure that primary systems are configured to report sense information to the host. Secondary systems should also be attached to a host server to enable reporting of sense information in the event of a problem with an S-VOL or secondary system. If the secondary system is
not attached to a host, it should be attached to a primary site host server so that monitoring can be performed.

- If power sequence control cables are used, set the power select switch for the cluster to LOCAL to prevent the primary system from being powered off by the host. Make sure the secondary system is not powered off during Universal Replicator operations.
- Install the Universal Replicator remote copy connections (cables, switches, and so on) between the primary and secondary systems.
- When setting up data paths, distribute them between different storage clusters and switches to provide maximum flexibility and availability. The remote paths between the primary and secondary systems must be separate from the remote paths between the host and secondary system.

System option modes

To provide greater flexibility, the Hitachi storage systems have additional operational parameters called system option modes (SOMs) that allow you to tailor the storage system to your unique operating requirements. The SOMs are set to their default values at installation and can be changed only by your Hitachi Data Systems representative.

The system option modes can be used for several types of UR customizations, including:

- 3DC configuration using delta resync
- Delta resync configuration when you use UR with TC or GAD
- Configuring split options for mirrors

The following table lists and describes the system option modes related to Universal Replicator operations. For a complete list of all SOMs, see the Hardware Guide for your storage system model. Work with your Hitachi Data Systems team to make sure the appropriate SOMs are set on your storage system.

Note: The SOM information might have changed since this document was published. Contact your Hitachi Data Systems representative for the latest SOM information.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| 448  | When the SVP detects a blocked path:  
SOM 448 ON: An error is assumed and the mirror is immediately suspended.  
SOM 448 OFF (default): If the path does not recover within a specified period of time, an error is assumed and the mirror is suspended.  
Note: SOM 448 setting is available only when SOM 449 is set to OFF. |
<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| 449  | This mode is used to enable and disable detection of communication failures between MCU and RCU.  
- SOM 449 ON (default): On MCU side, checking read journal disruption from RCU is disabled, and monitoring read journal failures is disabled on RCU side.  
- SOM 449 OFF: Detecting communication failures between MCU and RCU is enabled.  
**Note:**  
1. The mode applies at sites where disabling the detection of communication failures between MCU and RCU in UR configuration is required.  
2. For TagmaStore USP, the default setting is OFF with versions from 50-03-95-00/00 to 50-04-31-00/00, and is ON with versions 50-04-40-00/00 and later.  
3. When the mode is set to ON, SOM 448 does not work.  
4. The mode setting is not changed by microcode upgrade.  
5. The mode is not effective for remote paths between Initiator port on MCU and Target port on RCU.  
6. While a path from RCU to MCU is disconnected, if the UR pair remains in Suspending or Deleting status, recover it in accordance with the procedure in Recovery from UR Failure in TROUBLE SHOOTING section of Maintenance Manual (for service personnel only). |

| 474  | UR initial copy performance can be improved by issuing a command from CCI to execute a dedicated script consisting of UR initial copy (Nocopy), UR suspend, TC Sync initial copy, TC Sync delete, and UR resync.  
- Mode 474 ON: For a suspended UR pair, a TC (Sync) pair can be created with the same P-VOL/S-VOL so that UR initial copy time can be reduced by using the dedicated script.  
- Mode 474 OFF: For a suspended UR pair, a TC (Sync) pair cannot be created with the same P-VOL/S-VOL. For this, the dedicated script cannot be used  
If the P-VOL and S-VOL are both DP-VOLs, initial copy performance might not improve with SOM 474 set to ON. This is because with DP-VOLs, not all areas in a volume are allocated for UR; therefore not all areas in the P-VOL are copied to the S-VOL. With less than the full amount of data in the P-VOL being copied, the initial copy completes in a shorter time, which might not be improved with SOM 474.  
**Note:**  
1. Set this mode for both primary and secondary storage systems.  
2. When this mode is set to ON:  
  - Execute all pair operations from CCI/BCM.  
  - Use a dedicated script.  
  - Initial copy operation is prioritized over update I/O. Therefore, the processing speed of the update I/O slows down. |
<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>If this mode is set to ON, the processing speed of update I/O slows down by about 15μs per command, version downgrade is disabled, and Take Over is not available.</td>
</tr>
</tbody>
</table>
| 4.   | If this mode is not set to ON for both sides, the behavior is as follows:  
- OFF in primary and secondary storage systems: Normal UR initial copy performance.  
- ON in the primary storage system/OFF in the secondary storage system: TC Sync pair creation fails.  
- OFF in the primary storage system/ON in the secondary storage system: The update data is copied to the S-VOL synchronously. |
| 5.   | While this mode is set to ON, make sure not to perform microcode downgrade to an unsupported version. |
| 6.   | While this mode is set to ON, make sure not to perform the Take Over function. |
| 7.   | This mode cannot be applied to a UR pair that is the second mirror in a URxUR multi-target configuration, URxUR cascade configuration, or 3DC multi-target or cascading configuration of three UR sites. If applied, TC pair creation is rejected with SSB=CBED output. |
| 8.   | Before setting SOM 474 to ON, make sure that SOM 1091 is set to OFF. If SOM 1091 is set to ON, set it to OFF first, and then set SOM 474 to ON. |
| 506  | This option is used to enable Delta Resync with no host update I/O by copying only differential JNL instead of copying all data. The UR Differential Resync configuration is required.  
Mode 506 ON: Without update I/O: Delta Resync is enabled. With update I/O: Delta Resync is enabled.  
Mode 506 OFF: Without update I/O: Total data copy of Delta Resync is performed. With update I/O: Delta Resync is enabled.  
**Note:** Even when mode 506 is set to ON, the Delta Resync may fail and only the total data copy of the Delta Resync function is allowed if the necessary journal data does not exist on the primary storage system used for the Delta Resync operation. |
| 690  | This option is used to prevent Read JNL or JNL Restore when the Write Pending rate on RCU exceeds 60% as follows:  
- When CLPR of JNL-Volume exceeds 60%, Read JNL is prevented.  
- When CLPR of Data (secondary)-Volume exceeds 60%, JNL Restore is prevented.  
Mode 690 ON: Read JNL or JNL Restore is prevented when the Write Pending rate on RCU exceeds 60%.  
Mode 690 OFF: Read JNL or JNL Restore is not prevented when the Write Pending rate on RCU exceeds 60% (the same as before).  
**Note:**  
1. This mode can be set online.  
2. This mode should be set per request by the user. |
<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>If the Write Pending status remains 60% or more on RCU for an extended time, it takes extra time for the initial copy to be completed by making up for the prevented copy operation.</td>
</tr>
<tr>
<td>4.</td>
<td>If the Write Pending status long keeps 60% or more on RCU, the pair status may become Suspend due to the JNL-Vol being full.</td>
</tr>
</tbody>
</table>
| 908 | Changes cache memory (CM) capacity allocated to MPBs with different workloads.  
Mode 908 ON: Difference in CM allocation capacity among MPBs with different workloads is large.  
Mode 908 OFF (default): Difference in CM allocation capacity among MPBs with different workloads is small.  
**Note:**  
1. Apply this SOM to CLPRs used only for UR journals.  
2. Since CM capacity allocated to MPBs with low workload is small, the performance is affected by a sudden increase in workload.  
3. This SOM is effective for a CLPR. Therefore, when setting this SOM to ON/OFF, select target "LPRXX (XX=00 to 31)". For example, even when CLPR0 is defined (CLPR1 to 31 are not defined), select "LPR00" first and then set the SOM to ON/OFF. |
| 1067 | This mode is used to enable microcode downgrade to a version that does not support URxUR (including delta).  
Mode 1067 = ON: Even when a UR pair has been registered, downgrading the microcode to a version that does not support URxUR (including delta) is allowed.  
Mode 1067 = OFF (default): If any UR pair has been registered, downgrading the microcode to a version that does not support URxUR (including delta) is not allowed.  
**Note:**  
1. The mode is applied to enable microcode downgrade to a version that does not support URxUR (including delta) if the configuration where any UR pair has been registered is not URxUR (including delta).  
2. Setting the mode to ON allows microcode downgrade at sites where only 1 mirror is used in URxUR multi-target configuration without delta resync and cascade configuration (L or R site in multi-target, and P or R site in cascade), but the following phenomena occur after microcode downgrade. Make sure that the target DKC does not contain pairs of URxUR configuration.  
Phenomena:  
(a) When the microcode is downgraded at S site (local or remote) in multi-target configuration, the pair between P site and the target S site cannot be resynchronized.  
(b) When the pair between I site and R site in cascade configuration is resynchronized, the pair status cannot change from COPY to PAIR. |
<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(c)</td>
<td>When the microcode is downgraded at R site in cascade configuration, the pair between I site and R site cannot be resynchronized.</td>
</tr>
</tbody>
</table>
Planning the data path

A data path must be designed to manage your organization’s throughput to the secondary site. The bandwidth, number of ports, and data path configuration that you use help ensure that your update data arrives at the secondary site in a time consistent with your organization’s RPO.

This chapter provides instructions for calculating bandwidth and designing the data path network.

- Data path design
- Determining data transfer bandwidth
- Universal Replicator ports
- Fibre Channel data path requirements
- iSCSI data path requirements
- Supported remote connection configurations
Data path design

Before configuring the data paths, you must consider the following:

- The amount of bandwidth required to move data generated by your host application under all I/O conditions. See Determining data transfer bandwidth on page 4-2.
- The ports that will send and receive data. See Universal Replicator ports on page 4-7.
- The Fibre Channel data path requirements. See Fibre Channel data path requirements on page 4-8.
- The iSCSI data path requirements. See iSCSI data path requirements on page 4-9.
- The remote connection configurations that work best for your sites. See Supported remote connection configurations on page 4-11.

Note:

- Before replacing a data path (Fibre Channel or iSCSI), first delete the pairs and delete the remote paths that use the data path to be replaced, and then replace the data path. Do not replace a data path that is being used for remote copy operations.
- Use the same protocol for data paths between a host and a storage system and between primary and secondary storage systems. When different protocols are used in the data paths (for example, Fibre Channel data paths between the host and storage system and iSCSI data paths between the storage systems), make sure the timeout period for commands between the host and the storage system is equal to or greater than the timeout period for commands between the storage systems.

Determining data transfer bandwidth

You configure bandwidth according to the amount of data that will be transferred from the primary system to the secondary system within a certain amount of time.

If the data path network cannot keep pace with the flow of data, the data is saved in the journal until additional bandwidth capacity becomes available. If the journal also cannot keep up, the integrity of the pairs is lost, and a new initial copy must be created.

In general, bandwidth is expensive. Increasing capacity to a journal volume is relatively inexpensive. But the more data that accumulates in the journal, the further the secondary image is from the production volumes. Therefore, sizing bandwidth is a trade-off between expense and keeping secondary volume data within your RPO goals.
Five sizing strategies

The following sizing strategies are provided to help you work out an approach to sizing bandwidth. Be aware that these are not the only strategies you can use.

- **Size bandwidth to peak workload.** This results in the smallest difference between data in the P-VOL and S-VOL. Identify peak workload on the production disks, and then add extra capacity to accommodate packet loss and protocol overhead. RPO is at or near zero when bandwidth is sized to peak workload.

- **Size bandwidth to peak workload rolling average.** The rolling average is less than peak but more than average. This guarantees that at some point data will accumulate in the journal, but most of the time it will not. Your system can afford to journal for the amount of time planned for and still maintain RPO.

- **Size bandwidth to typical workload.** When bandwidth is sized to typical write-workload, and an extended peak workload is experienced, excess write-data is written to journal. This excess data is delayed for subsequent FIFO transmission to the secondary site when network capacity becomes available. Differential data is proportional to the amplitude and duration of the workload surge.

- If you cannot determine a “typical” workload, **sizing should be to the average or mean workload**, plus a small compensation for network overhead. In this scenario, excess data in the journals will be completely emptied to the S-VOL only occasionally. If bandwidth is sized below average write-workload, the journals never fully drain and eventually overflow.

- You can size bandwidth and journal size for long-haul data migration, to be used where data consistency is not required. In this strategy, you **alternate pair status between resync and suspend** in order to “batch copy” point-in-time copies. When pairs are suspended, journals are not used to queue write operations. Rather, a bitmap is used to track which cylinders have changed on the physical disks. For access patterns that favor multiple writes to a relatively small region of disk, this technique can provide especially efficient transfer of data, since multiple writes to one region are not sent each and every time. Only the last update before resync is sent. The disadvantage of this strategy is that it does not guarantee I/O consistency on the secondary system until the resync completes.

Calculating bandwidth

To determine bandwidth for Universal Replicator, write-workload must be measured. Production system workload data is collected using performance monitoring software. Please see **Measuring write-workload on page 3-4**.

When you have collected write-workload data, size your bandwidth according to your sizing strategy. In the following procedures, bandwidth is sized for peak and peak rolling average write-workload.
Sizing bandwidth for peak write-workload

1. Make sure that write-workload data is imported into a spreadsheet tool. Column C in the figure below shows an example of collected raw data over 10-minute segments.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Sample #</th>
<th>Time - 10 min. segments</th>
<th>Raw Data - MB/sec collected per 10 min. segment</th>
<th>30 Min Rolling Ave</th>
<th>60 Min Rolling Ave</th>
<th>24 Hour Rolling Avg</th>
<th>Raw Data Project Growth</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>15.00%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>0:00</td>
<td>0.863</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>0:10</td>
<td>2.81</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>0:20</td>
<td>0.863</td>
<td>1.24</td>
<td>2.17</td>
<td>0.987</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td>0:30</td>
<td>0.45</td>
<td>1.56</td>
<td>2.17</td>
<td>0.518</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>5</td>
<td>0:40</td>
<td>0.813</td>
<td>1.36</td>
<td>2.17</td>
<td>0.935</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>6</td>
<td>0:50</td>
<td>1.63</td>
<td>1.56</td>
<td>2.17</td>
<td>1.875</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>7</td>
<td>1:00</td>
<td>2.81</td>
<td>2.24</td>
<td>2.17</td>
<td>3.232</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>8</td>
<td>1:10</td>
<td>1.58</td>
<td>2.30</td>
<td>2.18</td>
<td>1.817</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>9</td>
<td>1:20</td>
<td>2.06</td>
<td>2.36</td>
<td>2.18</td>
<td>2.358</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>10</td>
<td>1:30</td>
<td>4.57</td>
<td>2.48</td>
<td>2.17</td>
<td>5.256</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>11</td>
<td>1:40</td>
<td>1.13</td>
<td>2.66</td>
<td>2.17</td>
<td>1.300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>12</td>
<td>1:50</td>
<td>2</td>
<td>2.72</td>
<td>2.16</td>
<td>2.300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>13</td>
<td>2:00</td>
<td>3.56</td>
<td>2.30</td>
<td>2.16</td>
<td>4.094</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>14</td>
<td>2:10</td>
<td>2.64</td>
<td>2.26</td>
<td>2.19</td>
<td>3.036</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>15</td>
<td>2:20</td>
<td>2.39</td>
<td>2.34</td>
<td>2.19</td>
<td>2.749</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>16</td>
<td>2:30</td>
<td>2.06</td>
<td>2.17</td>
<td>2.18</td>
<td>2.369</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4-1 Write-workload spreadsheet

2. Locate the highest peak. Based on your write-workload measurements, this is the greatest amount of data transferred during the collection period. It indicates the base amount of data that your bandwidth must be able to handle for near 0 RPO.

Though the highest peak is used for determining bandwidth, you should take notice of extremely high peaks. In some cases a batch job, defragmentation, or other process could be driving workload to abnormally high levels. It is sometimes worthwhile to review the processes that are running. After careful analysis, it might be possible to lower or even eliminate some spikes by optimizing or streamlining high-workload processes. Changing the timing of a process can lower workload.

3. With a base bandwidth value established, make adjustments for growth and a safety factor.

- Projected growth rate accounts for the increase expected in write-workload over a 1, 2, or 3 year period.
- A safety factor adds extra bandwidth for unusually high spikes that did not occur during write-workload measurement but could.
Sizing bandwidth for peak rolling average write-workload

1. Using write-workload data imported into a spreadsheet and your RPO, calculate write rolling-averages.

For example, if RPO time is 1 hour, then 60-minute rolling averages are calculated. Do this by arranging the values in six 10-minute intervals, as follows:

   a. In cell E4 type, `=average(b2:b7)`, and press Enter. (Most spreadsheet tools have an average function.)
      This instructs the tool to calculate the average value in cells B2 through B7 (six 10-minute intervals) and populate cell E4 with that data. (The calculations used here are for example purposes only. Base your calculations on your RPO.)

   b. Copy the value that displays in E4.

   c. Highlight cells E5 to the last E cell of workload data in the spreadsheet.

   d. Right-click the highlighted cells, and the select the Paste option.
      The Microsoft Excel software maintains the logic and increments the formula values initially entered in E4. It then calculates all of the 60-minute averages for every 10-minute increment and populates the E cells, as shown in the following figure (example using Excel). For comparison, 24-hour rolling averages are also shown.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sample</td>
<td>Time - 10 min. segments</td>
<td>Raw Data - MB/sec</td>
<td>Roll 30 Min Rolling Ave</td>
<td>Roll 60 Min Rolling Ave</td>
<td>Roll 24 Hour Rolling Ave</td>
<td>Raw Data Project Growth</td>
</tr>
<tr>
<td>1</td>
<td>#</td>
<td>segments</td>
<td>collected per 10 min.</td>
<td>Ave</td>
<td>Ave</td>
<td>Ave</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>15.00%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>0:00</td>
<td>0.363</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>0:10</td>
<td>2.81</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>0:20</td>
<td>0.358</td>
<td>1.24</td>
<td>2.17</td>
<td>0.987</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td>0:30</td>
<td>0.45</td>
<td>1.56</td>
<td>2.17</td>
<td>0.518</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>5</td>
<td>0:40</td>
<td>0.313</td>
<td>1.36</td>
<td>2.17</td>
<td>0.935</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>6</td>
<td>0:50</td>
<td>1.63</td>
<td>1.56</td>
<td>2.17</td>
<td>1.675</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>7</td>
<td>1:00</td>
<td>2.81</td>
<td>2.24</td>
<td>2.17</td>
<td>3.232</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>8</td>
<td>1:10</td>
<td>1.56</td>
<td>2.30</td>
<td>2.16</td>
<td>1.817</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>9</td>
<td>1:20</td>
<td>2.05</td>
<td>2.36</td>
<td>2.18</td>
<td>2.358</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>10</td>
<td>1:30</td>
<td>4.57</td>
<td>2.48</td>
<td>2.17</td>
<td>5.256</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>11</td>
<td>1:40</td>
<td>1.13</td>
<td>2.66</td>
<td>2.17</td>
<td>1.300</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>12</td>
<td>1:50</td>
<td>2</td>
<td>2.72</td>
<td>2.16</td>
<td>2.300</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>13</td>
<td>2:00</td>
<td>3.56</td>
<td>2.30</td>
<td>2.16</td>
<td>4.094</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>14</td>
<td>2:10</td>
<td>2.64</td>
<td>2.26</td>
<td>2.19</td>
<td>3.036</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>15</td>
<td>2:20</td>
<td>2.39</td>
<td>2.34</td>
<td>2.19</td>
<td>2.749</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>16</td>
<td>2:30</td>
<td>2.06</td>
<td>2.17</td>
<td>2.18</td>
<td>2.369</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 4-2 Rolling averages calculated using 60 minute RPO**

For another perspective, you can graph the data, as shown in **Figure 4-3 60-Minute rolling averages graphed over raw data on page 4-6.**
2. From the spreadsheet or graph, locate the largest or highest rolling average value. This is the peak rolling average, which indicates the base amount of data that your bandwidth must be able to handle.

3. With a base bandwidth value established, make adjustments for growth and a safety factor.
   - Projected growth rate accounts for the increase expected in write-workload over a 1, 2, or 3 year period.
   - A safety factor adds extra bandwidth for unusually high spikes that did not occur during write-workload measurement but could.

Other factors that must be taken into consideration because of their effect on bandwidth are latency and packet loss. These are discussed in the following topics.

**Latency**

Network latency affects replication. It is the amount of data that can be present in the data path. In the event of network failure, a certain number of transmitted records will not yet be resident in the secondary system’s journal because they are still in-route within the data path. During periods of low workload, there might be no records in the path, but during periods of heavy
workload, the network might be fully used. This amount represents the minimum difference between data in the primary and secondary systems.

Packet loss

Packet losses have the effect of reducing overall bandwidth because lost packets must be re-transmitted, which consumes network capacity that would otherwise be occupied by new data traffic. Also, a network can elongate consistency time, since journals are not applied until a contiguous sequence of records has arrived at the secondary site.

Universal Replicator ports

When planning for Universal Replicator operations, consider the following points about the ports on the storage systems:

- The ports can be used for both sending and receiving data. Configure the logical path in both directions, from the primary site to the secondary site and from the secondary site to the primary site. Make sure the number of logical paths is the same in both directions.
- Universal Replicator supports both Fibre Channel and iSCSI ports for remote copy operations.
- The volume of data that can be transmitted between storage systems is limited by the number of ports. You must consider the volume of data to be transferred during peak workloads to ensure that you have enough ports to meet your performance requirements.

For details about performance monitoring and management for the storage systems, see the Performance Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models.

- UR ports are used for the following operations:
  - Connecting the storage system and the host.
  - Sending and receiving the UR commands and data between the primary and secondary systems.

Caution: For a configuration in which UR and UVM share the same port in the same storage system, performing any of the following operations will temporarily halt I/O until the process is completed:

- Deleting either a remote path or a UVM path when both are defined.
- Defining either a remote path or a UVM path when only the other path type has already been defined.

- If the system supports failover for disaster recovery, you should adjust the ports for the primary and secondary storage systems to be about the same size (same data transfer bandwidth).
Fibre Channel data path requirements

For Fibre Channel data paths, direct, switch, and extender connections are supported. Multimode or single-mode optical fiber cables are required on primary and secondary systems. The type of cable and number of switches depends on the distance between primary and secondary sites, as shown in the following table.

<table>
<thead>
<tr>
<th>Distance</th>
<th>Cable type</th>
<th>Data path relay</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 km to 1.5 km (4,920 feet)</td>
<td>Multimode shortwave Fibre-Channel interface cables.</td>
<td>Switch is required between 0.5 km to 1.5 km.</td>
</tr>
<tr>
<td>1.5 km to 10 km (6.2 miles)</td>
<td>Single-mode longwave optical fibre cables.</td>
<td>Not required.</td>
</tr>
<tr>
<td>10 km to 30 km (18.6 miles)</td>
<td>Single-mode longwave optical fibre cables.</td>
<td>Switch is required.</td>
</tr>
<tr>
<td>Greater than 30 km (18.6 miles)</td>
<td>Communications lines are required.</td>
<td>Approved third-party channel extender products are required.</td>
</tr>
</tbody>
</table>

With Fibre Channel connections, no special settings are required.

Direct connections up to 10 km with single-mode longwave Fibre Channel interface cables are supported. Link speed determines the maximum distance you can transfer data and still achieve good performance. The following table shows maximum distances at which performance is maintained per link speed, over single-mode longwave Fibre Channel.

<table>
<thead>
<tr>
<th>Link speed</th>
<th>Distance maximum performance maintained</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Gbps</td>
<td>10 km</td>
</tr>
<tr>
<td>2 Gbps</td>
<td>6 km</td>
</tr>
<tr>
<td>4 Gbps</td>
<td>3 km</td>
</tr>
<tr>
<td>8 Gbps</td>
<td>2 km</td>
</tr>
<tr>
<td>16 Gbps</td>
<td>1 km</td>
</tr>
</tbody>
</table>

This information is illustrated in Figure 4-4 Data path types, switches, and distances on page 4-9. The type of cable determines the type of SFP used for the port. Longwave cables must be connected to longwave SFPs in the storage system and in the switch. Shortwave cables must be connected to shortwave SFPs in the storage system and switch. The default SFP type on the VSP Gx00 models and VSP Fx00 models is shortwave.

Additional switches

When the port on the primary system sends data to the secondary system, the Fibre Channel protocol accommodates a certain number of unacknowledged frames before the sender must stop sending. These are known as buffer credits. As Fibre Channel frames are sent out, available
buffer credits are exhausted. As acknowledgments come back, the supply of buffer credits is replenished. Because it takes longer for acknowledgments to return as distance increases, exhausting the supply of buffer credits becomes increasingly likely as distance increases.

Adding Fibre Channel switches on either end of the replication network provides the additional credits necessary to overcome buffer shortages due to the network latency.

**Figure 4-4 Data path types, switches, and distances**

### iSCSI data path requirements

For iSCSI data paths, direct, switch, and extender connections are supported. The following table describes the considerations for ports and network settings when you configure a system using iSCSI data paths.

<table>
<thead>
<tr>
<th>Item</th>
<th>Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ports</td>
<td>• When the parameter settings for an iSCSI port are changed, the iSCSI connection is disconnected temporarily and then reconnected. Change parameter settings only when the I/O load is low to avoid impact to the system.</td>
</tr>
<tr>
<td></td>
<td>• Although a log might be output in the host if you change the settings of an iSCSI port connected to a host, this does not indicate a failure. In a system that monitors system logs, an alert might be issued. When this happens, change the iSCSI port setting, and then check if the host is reconnected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delayed ACK:</strong> When you use iSCSI for the connection between storage systems, and the same port for the connection to the host, disable the Delayed ACK setting for</td>
</tr>
<tr>
<td>Item</td>
<td>Considerations</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>the port (in the Edit Ports window set Delayed ACK to Disable, default = Enable). If Delayed ACK is set to Enable, it might take time for the host to recognize a volume used by UR pairs. For example, it takes up to 8 minutes for the host to recognize 2,048 volumes. <strong>Selective ACK:</strong> Make sure Selective ACK is enabled for iSCSI ports. Selective ACK is set to Enable by default (Edit Ports window). Do not change this setting. In an environment in which a delay occurs in a line between storage systems, such as long-distance connections, you must set an optimal window size of iSCSI ports in storage systems at the primary and secondary sites after verifying various sizes. The maximum value you can set is 1024 KB. The default window size is 64 KB, so you must change this setting. iSCSI ports do not support the fragmentation (splitting packets) functionality. When the value for the maximum transfer unit (MTU) of a switch is smaller than the MTU value of the iSCSI port, packets are lost, and communication might not be performed correctly. The MTU value for the switch must be the same as or greater than the MTU value for the iSCSI port. For the MTU setting and value, see the switch manual. The MTU value for the iSCSI port must be greater than 1500. In a WAN environment in which the MTU value is smaller than 1500, fragmented data cannot be sent or received. In this environment, set a smaller value for the maximum segment size (MSS) of the WAN router according to the WAN environment, and then connect the iSCSI port. Alternatively, use iSCSI in an environment in which the MTU value is 1500 or greater. A port can be used for connections to the host (target attribute) and to a storage system (initiator attribute). However, to minimize the impact on the system if a failure occurs either in the host or in a storage system, you should connect the port for the host and for the storage system to separate front end modules.</td>
</tr>
<tr>
<td>Item</td>
<td>Considerations</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>be unacceptable, consider using devices for optimizing or accelerating the WAN speed.</td>
</tr>
<tr>
<td></td>
<td>• When iSCSI is used, packets are sent or received using TCP/IP. Because of this, the amount of packets might exceed the capacity of a communication line, or packets might be resent. As a result, performance might be greatly affected. Use Fibre Channel data paths for critical systems that require high performance.</td>
</tr>
</tbody>
</table>

**Supported remote connection configurations**

The remote connection can be configured using direct connection, switch connection, or extender connection. Connect bidirectional data paths as described below. Use the same connection settings from the primary system to secondary system and from the secondary system to the primary system.

**Direct connection**

The following figure shows a direct connection, in which two devices are connected directly together.

- Set Fabric to off, and set topology to FC-AL.

**Switch connection**

The following figure shows a switch connection which fibre cable is connected using a switch.

- Set Fabric to on, and set topology to Point-to-Point. Some switch vendors require F port (for example, McData ED5000).
**Extender connection**

Use channel extender and switch to connect the device in long distance. Make sure that the channel extender can support remote I/Os. Contact Hitachi Data Systems customer support for more information. Best practice is to create at least two independent data paths (one per cluster) between the primary and secondary system for hardware redundancy for this critical element.

- Set Fabric to on, and set topology to Point-to-Point.

---

**Caution:** Data traffic might concentrate on one switch when you perform the following actions:

- Use a switch to connect the primary system and the secondary systems with an extender.
- Gather several remote copy paths in one location.

If you are using a Hitachi switch to make the connection, contact Hitachi Data Systems customer support.
This chapter describes and provides instructions for performing Universal Replicator configuration operations.

- Configuration workflow
- Adding remote connections
- Creating journals and adding journal volumes
- Assigning an MP unit to a journal
- Setting the remote replica options
Configuration workflow

Setup for Universal Replicator using Device Manager - Storage Navigator consists of the following operations. You must have Storage Administrator (Remote Copy) role to perform Universal Replicator operations.

1. Define the Fibre Channel port attributes. For details, see the Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models.
2. Set up remote paths between the primary and secondary systems. See Adding remote connections on page 5-3.
3. Register journal volumes in a journal. See Creating journals and adding journal volumes on page 5-5.
4. Assign an MP unit to a journal. See Assigning an MP unit to a journal on page 5-8.

Workflow for 3DC multi-target configuration with three UR sites

When you create a 3DC multi-target configuration with three UR sites, you must perform the following procedure after step 4 in Configuration workflow on page 5-2.

1. Create a UR pair for the first mirror in the primary site. Specify from 0 to 3 for the mirror ID when you create a UR pair.
2. Wait until the UR pair status has changed to PAIR.
3. Create a UR pair for the second mirror in the primary site. Specify the same master journal volume and P-VOL used for the first mirror. Specify a value from 0 to 3 for the mirror ID. Assign a mirror ID not used in step 1.
4. Wait until the UR pair status has changed to PAIR. To create a 3DC multi-target configuration using the delta resync, perform the following procedure from steps 5 to 7.
5. Create a UR delta resync pair with the S-VOLs in the two secondary sites by doing the following:
   - Specify the S-VOL of the first mirror in the secondary site as the P-VOL.
   - Specify the S-VOL of the second mirror in the secondary site as the S-VOL.
   - Specify from 0 to 3 for the mirror ID. Assign a mirror ID not used in steps 1 and 3.

   **Note:** Specify the P-VOL and S-VOL for the delta resync pair for convenience. When you actually perform a delta resync operation, the failover destination site is used as the P-VOL.

6. Allocate remote command devices for each two mirror IDs in the primary site.
7. Allocate remote command devices for a mirror ID of the UR delta resync pair in each secondary site.
Workflow for 3DC cascade configuration with three UR sites

When you create a 3DC cascade configuration with three UR sites, you must perform the following procedure after step 4 in Configuration workflow on page 5-2.

1. Create a UR pair for the first mirror in the primary site. Specify a value from 0 to 3 for the mirror ID when you create a UR pair.
2. Wait until the UR pair status has changed to PAIR.
3. Create a UR pair for the second mirror in the intermediate site. Specify the restore journal volume and S-VOL for the master journal volume, and P-VOL used in the first mirror. Specify from 0 to 3 for the mirror ID. Assign a mirror ID not used in step 1.
4. Wait until the UR pair status is changed to PAIR. When you set up the delta resync configuration, use steps 5 to 7.
5. Create a UR delta resync pair with the primary and secondary site volumes by doing the following:
   a. Specify P-VOL for P-VOL in the primary site of the first mirror.
   b. Specify S-VOL for S-VOL in the secondary site of the second mirror.
   c. Specify a value from 0 to 3 for a mirror ID. Assign a mirror ID not used in steps 1 and 3.
6. Allocate remote command devices for each two mirror IDs in the primary site. Also allocate remote command devices for the UR delta resync pair's mirror ID.
7. Allocate remote command devices for the mirror ID in the intermediate site.
8. Allocate remote command devices for the mirror ID in the secondary site.

Adding remote connections

You associate the primary and secondary systems in the Universal Replicator relationship and define the remote paths between them in one procedure.
Prerequisite information

- This procedure must be performed on both the primary and secondary systems.
- The primary and secondary systems must already be configured for Universal Replicator operations. For more information, see System requirements on page 2-2.
- The data path must already be set up. For more information, see Chapter 4, Planning the data path on page 4-1.
- The storage system’s serial number, model, and port number is required during this procedure.
- A path group ID is required. This is a group of a maximum of remote paths. For more information, see Path Group item in System requirements on page 2-2.

To add a remote connection

1. Open the Remote Connections window.
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Connections.
   In Device Manager - Storage Navigator: Access the primary system, and click Replication > Remote Connections.

2. In the Remote Connections window, click the Connections (To) tab, and click Add Remote Connection.

3. In the Add Remote Connection window, for Connection Type, select System.

4. In the Remote Storage System box, select the Model of the remote storage system.
5. For **Serial Number**, enter the secondary system serial number.
   Specify the physical serial number, even when using virtual storage
   machine volumes. Do not specify the serial number of the virtual storage
   machine.

6. For **Path Group ID**, select the ID (00-FF) for the path group you want to
   use.

7. For **Minimum Number of Paths**, select 1 for Universal Replicator.

8. For **Select Type**, select the port type, and then select the ports to be
   used for both the local storage system and the remote storage system.
   For an **iSCSI** port, enter the IP address and TCP port number for the
   remote storage system port. To add more than two paths, click **+ Add
   Path**.

   **Tip:** After the remote connection has been established, you can add and
   delete paths as needed using the **Add Remote Paths** window.

9. For **RIO MIH Time**, enter the time interval in seconds that, if exceeded,
   will cause the data transfer operation to be reported as failed by the
   system.
   The recommended RIO MIH Time for the 3DC cascade configuration is 20
   seconds.

   **Tip:** The Remote I/O Missing Interrupt Handler (RIO MIH) is the waiting
   time until the data copy between the storage systems completes.

10. Click **Finish**.

11. In the **Confirm** window, review the settings and enter a task name in the
    **Task Name** box.

12. Click **Apply** to save your settings to the system.

### Creating journals and adding journal volumes

You create journals and add and configure journal volumes in the same
procedure. For adding journal volumes to an existing journal, see **Adding an
additional journal volume to an existing journal on page** 8-10.

### Prerequisite information

- Review the following:
  - **System requirements on page** 2-2
  - **Planning journal configuration on page** 3-6
- The journal’s mirror status must be Active, Stopped, Hold, Holding, or
  Hold(Failure).
- The journal cannot be in use.
- Pair operations involving the journal cannot be in progress.
- Virtual storage machine volumes cannot be used as journal volumes.
Procedure

1. Open the Journals window.
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Journals.
   In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Journals.

2. In the Journals window, click the Journals tab.

3. From the Actions menu, click Journals > Create Journals.

4. In the Create Journals window, for Journal ID, select a journal ID from the list.

5. In the Journal Volume Selection box, click Select Journal Volumes.

6. In the Select Journal Volumes dialog box, from the Available LDEVs table, select the journal volumes to be registered to the journal, and click Add. The volumes are moved to the Selected Journal Volumes table. Virtual storage machine volumes cannot be used as journal volumes. To remove a volume from the Selected Journal Volumes table, select it and click Remove. Click OK when finished.
7. Optional. For **MP Unit**, you can specify an MP unit from **MPB0** to **MPB7**. **Auto** is available when one or more units can be assigned automatically. When **Auto** cannot be selected, the default is the unit with the lowest number.

8. Optional. For **Inflow Control**, you can specify whether to restrict the flow of update I/O to the journal volume. Enabling this setting delays the response to hosts. Also, by restricting the inflow of data to one journal, you can allow other journals with higher-priority data unrestricted inflow.
   - **Enable** restricts inflow.
   - **Disable** does not restrict inflow. When **Disable** is selected and metadata or journal data is full, update I/Os might stop.

9. Optional. For **Data Overflow Watch**, you can specify the number of seconds for the system to monitor write data to the journal volume when the journal volume is full (100%). Range is 0-600 seconds. The default is 60.

10. Optional. For **Cache Mode**, you can specify whether to store journal data in the cache memory on the secondary side (restore journal).
    - **Enable**: Journal data will be stored in the cache. When there is insufficient space in the cache, journal data will also be stored into the journal volume. Enable is available only for journal volumes of RAID-5 or RAID-6.
    - **Disable**: Journal data will not be stored in cache but in the journal volume. Disable is the only setting possible for non-RAID-5 or RAID-6 journal volumes and external volumes.

**Note:** This setting does not effect master journals unless the CCI horctakeover command is used to change a master journal into a restore journal.

11. Click **Finish**.
12. In the Confirm window, review the settings and enter a task name in the Task Name box. To review additional information about the journal, select the journal and click Detail.

13. Click Apply to save your settings to the system.

Assigning an MP unit to a journal

Procedure

1. Open the Journals window.
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Journals.
   In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Journals.
2. Select the Journals tab, and then select the journal to which you will add the MP unit.
3. From the Actions menu, click Journals > Assign MP unit.
4. In the Assign MP Unit window, for MP Unit, select an MP unit from MPB0 to MPB7.
5. Click Finish.
6. In the Confirm window, review the settings and enter a task name in the Task Name box.
7. Click Apply to save your settings to the system.
Setting the remote replica options

You can set the following options using the **Edit Remote Replica Options** window:

- The number of volumes that can be copied concurrently in a single initial copy operation.
- The amount of time to monitor a path blockade.
- The amount of time to monitor the SIMs reported by a path blockade.

Setting the maximum initial copy activities option

You can set the number of volumes that can be copied concurrently during pair creation and pair resynchronization using the **Edit Remote Replica Options** window (range = 1 to 128, default = 64). You can also change this setting later as needed.

Procedure

1. Open the **Replication** window:
   - In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the local storage system, and click **Replication Dashboard**.
   - In Device Manager - Storage Navigator: In the **Explorer** pane, expand the **Storage Systems** tree, expand the target storage system tree, and then click **Replication**.

2. In the **Replication** window, click **Edit Options > Remote Replication**.

3. In the **Edit Remote Replica Options** window, in **Copy Type**, select **UR**.

4. In **Maximum Initial Copy Activities**, enter a value from 1 to 128 as the number of volumes that can be copied concurrently during an initial copy operation. For example, if you specify 64 for **Maximum Initial Copy Activities** and then register 65 pairs concurrently, the local system starts the initial copy operations for the first 64 pairs. The initial copy operation for the 65th pair is started when one of the first 64 pairs becomes synchronized, so that no more than 64 initial copy operations are performed at the same time.

   **Note:**
   - The number of initial copy activities setting might affect the performance of the local storage system depending on the amount of I/O activity and the number of pairs that are registered concurrently.
   - If you specify a large value, the number of pending activities in a remote storage system increases, and the response time of the remote I/Os for the update I/O operations might be affected.

5. Click **Finish**.

6. In the **Confirm** window, check the settings you made, and then enter the task name in **Task Name**.
If you want to open the Tasks window automatically after closing this window, select Go to tasks window for status.

7. Click Apply.
   The task is registered, and the Tasks window appears if Go to tasks window for status was selected.

Setting the blocked-path monitoring and blocked-path SIM monitoring options

You can set the period of time to monitor a blocked path and the time to monitor SIMs that are reported by a blocked path using the Edit Remote Replica Options window. You can also change these settings later as needed.

- Blocked Path Monitoring: range = 2 to 45 seconds
- Blocked Path SIM Monitoring: range = 2 to 100 seconds

**Note:** If iSCSI is used in a remote path, the Blocked Path Monitoring remote replica option must be set to at least 40 seconds (default). If Blocked Path Monitoring is less than 40 seconds, the path might be blocked due to a delay in the network such as many switches in a spanning tree protocol (STP) network or a long distance connection.

**Procedure**

1. Open the Replication window:
   - In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the local storage system, and click Replication Dashboard.
   - In Device Manager - Storage Navigator: In the Explorer pane, expand the Storage Systems tree, expand the target storage system tree, and then click Replication.

2. In the Replication window, click Edit Options > Remote Replication.

3. In the Edit Remote Replica Options window, in Copy Type, select TC.

   You need to select TC to set the time to monitor path blockade, and the settings apply to TC, UR, and GAD operations.

4. In Blocked Path Monitoring, enter a value from 2 to 45 (sec.) as the time to monitor a path blockade.

5. In Blocked Path SIM Monitoring, enter a value from 2 to 100 (sec.) as the time to monitor SIMs that are reported by a path blockade.

6. Click Finish.

7. In the Confirm window, check the settings you made, and then enter the task name in Task Name.
   If you want to open the Tasks window automatically after closing this window, select Go to tasks window for status.

8. Click Apply.
The task is registered, and the **Tasks** window appears if **Go to tasks window for status** was selected.
Universal Replicator pair operations

This chapter provides instructions for performing Universal Replicator pair operations.

- Pair operations
- Creating Universal Replicator pairs
- Checking pair status
- Splitting a Universal Replicator pair
- Splitting the pairs in a mirror
- Resynchronizing a Universal Replicator pair
- Resynchronizing the pairs in a mirror
- Deleting Universal Replicator pairs
- Deleting the pairs in a mirror
Pair operations

You must have Storage Administrator (Remote Copy) role to perform Universal Replicator pair operations. The pair operations are:

- Creating Universal Replicator pairs on page 6-2
- Checking pair status on page 6-6
- Splitting a Universal Replicator pair on page 6-6
- Splitting the pairs in a mirror on page 6-8
- Resynchronizing a Universal Replicator pair on page 6-10
- Resynchronizing the pairs in a mirror on page 6-12
- Deleting Universal Replicator pairs on page 6-13
- Deleting the pairs in a mirror on page 6-15

Creating Universal Replicator pairs

When you create a pair, the initial copy operation copies all data on the P-VOL to the S-VOL. The P-VOL remains available to the host for I/O operations during the initial copy operation.

Prerequisites

- The initial copy must be performed from the primary system.
- S-VOLs must be offline to all hosts.
- The primary and secondary systems and remote paths must be defined. See Adding remote connections on page 5-3 for more information.
- The P-VOL capacity and S-VOL capacity must be the same size (same number of blocks). To view the capacity in blocks, click Options > Capacity Unit > block in the Logical Devices window. If the capacity is displayed in GB or TB, a slight difference in P-VOL and S-VOL capacity might not be displayed.
- Journal volumes must be registered to the journals that are associated with pairs. For details, see Creating journals and adding journal volumes on page 5-5.
- When creating a UR delta resync pair, see Creating the delta resync pair on page C-5 and make sure all of the conditions are met.
- Make sure Performance Monitor is stopped.
- If you want to create multiple pairs at the same time, you must plan the S-VOLs ahead of time so that the system will assign the correct S-VOLs to the selected P-VOLs. When you select multiple volumes as P-VOLs, you will specify one S-VOL and the selection method (Interval or Relative Primary Volume) for determining the rest of the S-VOLs to assign to the selected P-VOLs. The system automatically assigns S-VOLs to the selected P-VOLs using the LUN IDs determined by the specified selection method.
  - Interval: To use Interval, set up the S-VOL LUN IDs according to the interval between their LUN ID numbers. The system will skip the
specified interval between LUN ID numbers when assigning S-VOLs. For example, if you specify LUN ID 01 as the Base Secondary Volume and specify 3 for Interval, LUN ID 04 (01+3) in the secondary system is assigned to the next P-VOL, LUN ID 07 (04 + 3) is assigned to the following P-VOL, and so on.

- **Relative Primary Volume**: To use Relative Primary Volume, set up the S-VOL LUN IDs according to the difference between the LUN ID numbers of the first selected P-VOL and the selected Base Secondary Volume. The difference between these two LUN ID numbers determines the LUN ID of the S-VOL for each P-VOL. For example, if the LUN IDs of the first three selected P-VOLs are 01, 05, and 06 and you set the LUN ID for the Base Secondary Volume to 02, the LUN IDs of the three S-VOLs will be 02, 06, and 07, respectively.

- Review the following points before beginning the procedure:
  - You will select the volumes to be paired by port, GID, and LUN. Make sure to have this information available.
  - You will assign master and restore journals to the P-VOL and S-VOL during the operation.
  - You will assign a mirror ID to the pairs. This identifies the pairs within the journal. A mirror refers to the pair within the journal.
  - If the mirror ID that you will assign to the new pair contains any pairs, the new pair’s volumes must belong to the same primary and secondary systems defined in the mirror.

**Procedure**

1. Open the **Remote Replication** window.
   - In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   - In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.

2. Select the **UR Pairs** tab, and click **Create UR Pairs**.
3. For **Remote Storage System**, select the secondary system’s **Model/Serial Number** and **Path Group ID**.
   - If the mirror contains an existing pair, the same **Model/Serial Number** as the existing pair must be selected.

4. In **Primary Volume Selection**, for **Selection Object**, select the port type for the local storage system.

5. In the **Primary Volume Selection** box, in **LU Selection** select the **Port ID** and **Host Group Name** or **iSCSI Target Alias** of the volumes that will become the P-VOLs of the new pairs. The **Available LDEVs** table only displays volumes that can be used as P-VOLs of UR pairs.

6. In the **Primary Volume Selection** box, in the **Available LDEVs** table select the volume that will become the P-VOL of the pair. You can select multiple volumes.

**Note:**
- When you specify a virtual storage machine volume, specify the physical LDEV ID in the storage system. You cannot specify the virtual LDEV ID.
- You must select data volumes in the same virtual storage machine. Volumes in different virtual storage machines cannot be registered to the same journal.

7. In the **Secondary Volume Selection** box, for **Base Secondary Volume**, select the **Port ID**, **Host Group ID/iSCSI Target ID**, and **LUN ID** for the volumes that will become the S-VOLs for the selected P-VOLs.

   LUN IDs are displayed as hexadecimal numbers by default. For instructions on changing the LUN ID display to decimal, see the System
8. If you selected multiple primary volumes, for **Selection Type** select the method for assigning the S-VOLs, **Interval** or **Relative Primary Volume**. For details, see the **Prerequisites** above this procedure.

9. For **Mirror Selection**, specify the following:
   a. For **Master Journal**, select a number from the list of registered journal IDs. The list excludes already-assigned master and restore journal IDs.
   b. For **Mirror ID**, assign an identifier number for the mirror.
   c. For **Restore Journal**, select a number from the list of registered journal IDs. All journal IDs display (000-0FF).
   d. For **CTG ID**, select a consistency group from the list of those registered in the storage system. An asterisk indicates the CTG is assigned to a pair in the **Select Pairs** table. Assign the same ID for the consistency group as the journal ID for UR.

10. Click **Options** to define the following optional settings:
   a. For **Initial Copy Type**, specify whether to perform the initial copy operation to copy the P-VOL data to the S-VOL. Normally select **Entire**.
      - **Entire** (default): Select **Entire** to establish the pair and copy all P-VOL data to the S-VOL.
      - **None**: Select **None** to establish the pair without copying any data to the S-VOL. Use this option only when the P-VOL and S-VOL are already identical, or when the P-VOL and S-VOL do not yet contain any data (for example, new blank volumes).
      - **Delta**: Select **Delta** only when creating a UR delta resync pair in the delta resync configuration.
   b. For **Initial Copy Priority**, you can specify the scheduling order (1-256) for the initial copy operation. The default is 32.
      If a timeout error occurs, the copy operation might not be executed in the order that you set with Initial Copy Priority. The timeout error can be caused by a CU configuration or remote copy path error. Review the error, release the pair with the error, and then retry the Paircreate operation.
   c. In the **Error Level** list, specify the desired system response if a failure occurs during this operation:
      Select **Mirror** to split all pairs in the failed pair’s mirror. **Mirror** is the default.
      Select **LU** to split only the pair that failed.

11. Click **Add** to move the specified pair or pairs to the **Selected Pairs** table. Repeat the steps above as needed to add pairs with P-VOLs in other ports or host groups and S-VOLs in other ports or remote storage systems.

12. In the **Selected Pairs** table, review the P-VOL and S-VOL details carefully to make sure that the information for each pair is correct.
To change the settings for a pair, select the pair and click **Change Settings**. You can change the S-VOL and pair options, but you cannot change the P-VOL. If you need to change a P-VOL, select the pair and click **Remove** to remove the pair from the Selected Pairs table.

13. When the pair information in the Selected Pairs table is correct, click **Finish**.

14. In the Confirm window, review the settings and enter a task name in the Task Name box.

15. Click **Apply** to save your settings to the system.

Based on the initial copy type you selected, you can verify that the pair status is correct in the Remote Replication window as shown in the following table.

<table>
<thead>
<tr>
<th>Initial copy type</th>
<th>Pair status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entire</td>
<td>COPY</td>
</tr>
<tr>
<td>None</td>
<td>PAIR</td>
</tr>
<tr>
<td>Delta</td>
<td>HOLD or HOLDING</td>
</tr>
</tbody>
</table>

To monitor the progress of the operation, click **File > Refresh** in the menu bar. This updates the information in the list. You can also check the current pair status by using the View Pair Properties window. If you selected **Entire** for the initial copy type, the status will change from COPY to PAIR when the initial copy operation is complete.

### Checking pair status

Every Universal Replicator operation requires that pairs have a specific status. Before performing any operation, check the pair status.

- The status requirements are listed in the prerequisite information for each operation.
- To view a pair’s current status in the GUI and to review the status descriptions, see [Monitoring pair activity, status, and license capacity on page 7-2](#).

### Splitting a Universal Replicator pair

When you split a pair, write-data is no longer sent to S-VOL and the pair is no longer synchronized. Splitting a pair or mirror gives you a point-in-time copy of the P-VOL.

**Prerequisites**

- Pair status must be COPY or PAIR.
- This operation can be performed from the primary or secondary system.
To split multiple pairs at the same time, the pairs must belong to the same mirror. This ensures sequence consistency among S-VOLs in the mirror.

Review the following information before beginning the procedure:

- Splitting the pair when I/O load is low reduces impact on performance. Operations on multiple pairs in the same consistency group with different statuses might result in suspension during periods of heavy write I/O.
- If you split pairs in PAIR status and other than PAIR status in the same mirror, an unexpected suspension might occur during the operation under heavy I/O load conditions. You can estimate whether the I/O load is heavy or not from frequency of host I/Os. This operation should be performed under light I/O load conditions.
- During normal operations, the secondary system rejects write operations to an S-VOL. However, you can enable write operations to the S-VOL while the pair is split by enabling the S-VOL Write option. When this option is enabled and the split pair is resynchronized, the secondary system sends the S-VOL track bitmap to the primary system to ensure proper resynchronization of the pair to the data on the P-VOL. This S-VOL Write option is described in the pair-split procedure.

**Procedure**

1. Open the **Remote Replication** window.
   - In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   - In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.
2. Select the **UR Pairs** tab, and then select the pairs to be split.
3. From the **Actions** menu, click **Remote Replication > Split Pairs**.
4. In the **Split Pairs** window, review the pairs to be split in the **Selected Pairs** table. To remove a pair from the table, select the pair and click **Cancel**.

5. For **Secondary Volume Write**, specify whether data can be written to the S-VOL while the pair is split. This option is available only when you perform the split operation from the primary system.
   - **Enable**: The host can write data to the S-VOL while the pair is split.
   - **Disable**: The host cannot write data to the S-VOL while the pair is split.

6. Click **Finish**.

7. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

8. Click **Apply** to save your settings to the system.

---

**Splitting the pairs in a mirror**

A mirror normally has multiple pairs with the same master and restore journals groups. When you split a mirror, you split all of the pairs in the mirror. As with a normal pair split, data copying is suspended between the primary and secondary journals.
Prerequisites

- Pair status must be Active.
- A mirror can be split from the primary or secondary system.

Procedure

1. Open the **Remote Replication** window.
   In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.

2. Select the **Mirrors** tab, and then select the mirrors to be split.

3. From the **Actions** menu, click **Remote Replication > Split Mirrors**.

4. In the **Split Mirrors** window, review the mirrors that you selected in the **Selected Mirrors** table. To remove a mirror, select the it and click **Cancel**.

5. For **Secondary Volume Write**, specify whether data can be written to S-VOLs in the mirror while it is split.
- **Enable**: The host writes data to S-VOLs in the mirror. Available only when the selected mirror’s Attribute is Master. If Restore, Disable is used automatically.
- **Disable**: The host does not write data to S-VOLs in the mirror.

6. For **Split Mode**, specify whether data is written to S-VOLs in the mirror before the split operation runs.
   - **Flush**: Copies all update data from to S-VOLs in the mirror before the split.
   - **Purge**: Prevents update data from being copied to S-VOLs in the mirror before the split. Uncopied data is copied to the S-VOL when the pair is resynchronized.

7. Click **Finish**.
8. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.
9. Click **Apply** to save your settings to the system.

### Creating point-in-time copies

Universal Replicator allows you to make Point-in-Time (PiT) copies of volumes in the same journal. Point-in-Time describes a copy of data made when you it.

**Prerequisite**
- Mirror status must be active.

**Procedure**
1. Stop all write I/Os from hosts to P-VOLs in the journal.
2. Split the mirror. Make sure to specify **Flush** for **Split Mode**.
3. When the status of all pairs in the journal changes to PSUS, the operation is completed. Resume write I/O to the P-VOLs.

### Resynchronizing a Universal Replicator pair

Resynchronizing a pair updates the S-VOL with differential data that accumulated since the pair was split. After the pair is resynchronized, the S-VOL is again updated using the journals.

**Prerequisites**
- The pair status must be PSUS or PSUE.
- This operation can be performed only from the primary system.
- Pairs suspended by the system (PSUE status) can be resynchronized after the error causing the suspension is corrected.
**Note:** When the pair status is HOLD, HOLDING, or HLDE, the pair is a UR delta resync pair for the delta resync configuration. Delta resync operation is performed when recovering from the failure as a part of mirror resynchronization. When performing delta resync operation, use the Resync Mirrors window.

Review the following information before beginning the procedure:

- The primary system does not resynchronize a pair that is suspended due to an error until the cause of the error is resolved.

**Procedure**

1. Open the **Remote Replication** window.
   - In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   - In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.

2. Select the **UR Pairs** tab, and then select the pairs to be resynchronized.

3. From the **Actions** menu, click **Remote Replication > Resync Pairs**.

4. In the **Resync Pairs** window, review the pairs in the **Selected Pairs** table. You can remove a pair from the table by selecting it and clicking **Cancel**.

5. For **Copy Priority** list, specify the scheduling order for resynchronizing selected pairs, between 1 and 256.

6. For **Error Level**, specify the system response if a failure occurs during this operation.
   - **Mirror**: Splits all pairs in the failed pair’s mirror.
- **LU**: Splits only the specified pair or pairs that failed.

7. Click **Finish**.

8. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

9. Click **Apply** to save your settings to the system.

### Resynchronizing the pairs in a mirror

When you resynchronize a mirror, all of the pairs with the mirror ID are resynchronized, and update data copy to the S-VOL is resumed. Delta resync is performed while resynchronizing mirrors. When resynchronizing mirrors to perform the delta resync operation in a delta resync configuration, see [Conditions for delta resync operations on page C-11](#), and make sure all conditions for delta resync are met.

If you use UR with GAD, it is not necessary to resynchronize mirrors when you perform delta resync. For details, see the *Global-Active Device User Guide*.

#### Prerequisites

- This operation can be performed only from the primary system.
- Mirror status must be Stopped, Hold, Holding, or Hold(Failure).
- Resynchronizing a mirror when I/O load is low reduces impact on performance. In a configuration where pairs with different statuses are mixed in the same consistency group, if mirrors are resynchronized when I/O load is high, operation might be suspended.

#### Procedure

1. Open the **Remote Replication** window.
   
   In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   
   In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.

2. Select the **Mirrors** tab, and then select the mirrors to be resynchronized.

3. From the **Actions** menu, click **Remote Replication > Resync Mirrors**.
4. In the **Resync Mirrors** window, review the mirrors in the **Selected Mirrors** table. You can remove a mirror from the table by selecting it and clicking **Cancel**.

5. Click **Finish**.

6. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

7. Click **Apply** to save your settings to the system.

---

### Deleting Universal Replicator pairs

When you delete a pair, the Universal Replicator relationship between the P-VOL and S-VOL is released. Only the relationship is affected, the data volumes and their data remain.

---

**Caution:** When the P-VOL and S-VOL are physically attached to the same host, take the S-VOL offline before releasing the pair to avoid confusion and possible error when the host is restarted.

---

**Note:** When you delete a UR pair in the 3DC multi-target configuration using delta resync, the UR delta resync pair’s S-VOL is also deleted. When you delete a TC pair in the 3DC multi-target configuration using delta resync, the UR delta resync pair is also deleted.

---

**Prerequisites**

- This operation can be performed from the primary or secondary system.
- Pairs should be in PAIR status to ensure data consistency between volumes. However, a pair can be deleted in any status except Suspending or Deleting.
- In a delta-resync configuration with GAD, delete UR pairs, delta-resync UR pairs, and GAD pairs in that order.
Procedure

1. Open the Remote Replication window.
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Replication.
   In Device Manager - Storage Navigator: In the Storage Systems tree, click Replication > Remote Replication.

2. Select the UR Pairs tab, and then select the pairs to be deleted.

3. From the Actions menu, click Remote Replication > Delete Pairs.

4. In the Delete Pairs dialog box, review the pairs in the Selected Pairs table. To remove a pair from the table, select the pair and click Cancel.

5. For Delete Mode, select Normal for Universal Replicator.

Caution: Please note the following:

- Forced deletion in the primary system causes data that was not yet sent to the secondary system to be deleted.
- Forced deletion in the secondary system causes data that was not yet restored to be deleted.
- If pair status has not changed to SMPL five minutes after you forcibly delete the pair, delete it again.
- Make sure not to re-create the pair in the first five minutes after forcibly deleting it using the same journals (mirrors), even if pair status is SMPL and journal status is Initial. In this case pair creation might fail, and the pair might be suspended.
• A timeout error can occur at the time of a forced deletion if I/O is sent to another pair in the same journal and the pair’s status is PAIR or COPY.

6. Click Finish.
7. In the Confirm window, review the settings and enter a task name in the Task Name box.
8. Click Apply to save your settings to the system.

Deleting the pairs in a mirror

When you delete the pairs in a mirror, data copying between master and restore journals ends.

Prerequisite information

• This operation can be performed from the primary or secondary system.
• When you delete the pairs in a mirror between the intermediate site and the secondary site in a 3DC cascade configuration using 3 UR sites, the mirror status between the primary site and the intermediate site must be Stopped, or the mirror status between the intermediate site and the secondary site must be Stopped.

Caution: In the 3DC multi-target configuration using delta resync, one journal uses two mirrors. Operation results differ depending on whether or not the specified mirror is for the delta resync.

• When the specified mirror's status is Hold, Holding, or Hold (Failure) (when delta resync mirrors are specified), only the specified mirror's UR pairs are deleted.
• When the specified mirror's status is other than Hold, Holding, or Hold(Failure) (when mirrors not for delta resync are specified), delta resync mirror's UR pairs that are not specified are also deleted.

Procedure

1. Open the Remote Replication window.
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Replication.
   In Device Manager - Storage Navigator: In the Storage Systems tree, click Replication > Remote Replication.
2. Select the Mirrors tab, and then select the mirrors to be deleted.
3. From the Actions menu, click Remote Replication > Delete Mirrors.
4. In the **Delete Mirrors** dialog box, review the mirrors in the **Selected Mirrors** table.

5. For **Delete Mode**, specify one of the following:
   - **Normal**: Mirrors are deleted only if the primary system can change the mirror status to Initial.
   - **Force**: Mirrors are forcibly deleted even when the primary system cannot communicate with the secondary system.

6. Click **Finish**.

7. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

8. Click **Apply** to save your settings to the system.

**Note**: If the journal (mirror) status is not Initial—even though you deleted pairs forcibly and five minutes have passed—perform the operation again to delete all pairs registered to the mirror. Do not create pairs with the same journal for at least five minutes, even if the journal status was Initial; otherwise pair creation could fail and the pair would be suspended.
Monitoring pairs, journals, data paths, I/O, and hardware performance is crucial for ensuring that Universal Replicator pairs continue to function correctly.

This topic provides information and instructions for monitoring a Universal Replicator system.

- Monitoring pair activity, status, and license capacity
- Checking Universal Replicator pair synchronization rate
- Viewing Universal Replicator operation history
- Saving pair information to a text file
- Monitoring I/O and hardware performance with Performance Monitor
- Monitoring journal (mirror) status
- Monitoring Universal Replicator remote connections, path status
Monitoring pair activity, status, and license capacity

Monitoring the Universal Replicator system and licensed capacity is essential for maintaining your pairs.

- Each operation requires a specific status or statuses. Before performing a pair operation, check the pair’s status.
- Pair status changes when an operation is performed. Check status to make sure that pairs are operating correctly and that data is updated from P-VOLs to S-VOLs, and that differential data is managed appropriately.

Frequent monitoring of the system is optional but recommended. You can set up automatic e-mail notification from the Device Manager - Storage Navigator for problems found during monitoring.

**Procedure**

1. Open the **Remote Replication** window.
   - In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   - In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.
2. Select the **UR Pairs** tab, and then select the pair that you want to monitor.
3. From the **Actions** menu, click **Remote Replication > View Pair Properties**.
4. In the View Pair Properties window, you can display only the columns you want to see by clicking Filter.

5. To review license capacity, see the Summary area in the Replication window.

**Pair status definitions**

The following table lists and describes the Universal Replicator pair status names. The Device Manager - Storage Navigator pair status name and the CCI pair status name are both displayed in the Device Manager - Storage Navigator Status column. When the names are the same, the CCI pair status name is not displayed.

When checking the status of a pair, click File/Refresh to make sure the most recent information is displayed.

<table>
<thead>
<tr>
<th>HDvM - SN status</th>
<th>CCI status</th>
<th>Description</th>
<th>P-VOL access</th>
<th>S-VOL access</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Unpaired-no HDvM - SN status)</td>
<td>SMPL</td>
<td>The volume is not assigned to a pair and is not in a journal.</td>
<td>Read/Write</td>
<td>Read/Write</td>
</tr>
<tr>
<td>COPY</td>
<td>COPY</td>
<td>The initial copy operation is in progress.</td>
<td>Read/Write</td>
<td>Read Only</td>
</tr>
<tr>
<td>PAIR</td>
<td>PAIR</td>
<td>The pair is synchronized. Updates to the P-VOL are duplicated on the S-VOL.</td>
<td>Read/Write</td>
<td>Read Only</td>
</tr>
<tr>
<td><strong>HDvM - SN status</strong></td>
<td><strong>CCI status</strong></td>
<td><strong>Description</strong></td>
<td><strong>P-VOL access</strong></td>
<td><strong>S-VOL access</strong></td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>-----------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| HDvM - SN displays this status as **PAIR** | PFUL | If data in the journal volume exceeds the threshold (80%), pair status changes to **PFUL**. The pair is not suspended; the copy operation continues. 
If the Inflow Control journal option is set to **Yes** when status changes to **PFUL**, host I/O is delayed because update I/O to the journal volume is delayed. | Read/Write | Read Only |
| **PSUS** | PSUS SSUS | The pair has been split by the user and the P-VOL and S-VOL are no longer synchronized.  
- The primary and secondary systems keep track of journal data discarded during the split operation.  
- When the operation is performed on the primary system, the status of both the P-VOL and S-VOL changes to **PSUS**.  
- When the operation is performed on the secondary system, the status of the S-VOL changes to **PSUS**; the primary system detects this and changes P-VOL status to **PSUS**.  
**SSUS** is the S-VOL’s split status name.  
See also [PSUS types and behaviors on page 7-8](#). | Read/Write | Read Only, but if you select **Enable for Secondary Volume Write** option then split pair from primary site, it is Read/Write (default is **Disable**). |
| **PSUE** | PSUE | The pair is suspended by the system due to an error; it is not synchronized.  
- The primary and secondary systems keep track of journal data discarded during the suspension operation.  
- The primary system keeps track of P-VOL tracks that are updated while the pair is suspended.  
- When a Universal Replicator suspension condition is detected, the primary system changes P-VOL and S-VOL status to **PSUE**. If the secondary system detects the condition, it changes the S-VOL status to **PSUE**; the primary system detects this and changes P-VOL status to **PSUE**.  
See also [PSUS types and behaviors on page 7-8](#). | HDvM - SN: Read/Write 
CCI: Read/Write if no error in P-VOL | Read Only |
<p>| <strong>Suspending</strong> (No equivalent CCI status) | The pair is not synchronized and in transition from the <strong>PAIR</strong> or <strong>COPY</strong> status to <strong>PSUS</strong> or <strong>PSUE</strong> status. | Read/Write | Read Only |
| <strong>Deleting</strong> (releasing) (No equivalent CCI status) | The pair relationship is being deleted. When the operation completes, the status changes to unpaired. | Read/Write | Read Only |</p>
<table>
<thead>
<tr>
<th>HDvM - SN status</th>
<th>CCI status</th>
<th>Description</th>
<th>P-VOL access</th>
<th>S-VOL access</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLD (No equivalent CCI status)</td>
<td>Displayed for a UR delta resync pair in the 3DC multi-target configuration using delta resync. This status indicates that all of the conditions for delta resync are met and the pairs are waiting for delta resync. When used with GAD, this status indicates that delta resync can be executed. If the UR P-VOL status is HOLD, the updated TC or GAD S-VOL data is stored in the master journal volume. Operations allowed on pairs in HOLD status: • Delta resync • Delete pair • Change pair options</td>
<td>Read/Write¹</td>
<td>Read/Write²</td>
<td></td>
</tr>
<tr>
<td>HOLDING³ (No equivalent CCI status)</td>
<td>Displayed for a UR delta resync pair in the 3DC multi-target configuration using delta resync. This status indicates that the pair status is changing to HOLD so that the delta resync pair can be created. When a pair status is HOLDING, no differential data for the delta resync operation exists in the storage system, and it depends on the user whether to perform the delta resync operation. Operations allowed on pairs in HOLDING status: • Delta resync • Delete pair • Change pair options If the delta resync operation is run on a pair in HOLDING status, the operation might fail. If delta resync fails and you specified Entire Copy for the Delta Resync Failure option (Edit Mirror Options window), all of the differential data is copied to the S-VOL. When used with GAD, delta resync is being prepared for execution. Delta resync fails if the status is HOLDING. When used with GAD, specifying Entire Copy for the Delta Resync Failure option (Edit Mirror Options window) is invalid. If delta resync fails, resynchronize the UR pair.</td>
<td>Read/Write¹</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>HLDE (No equivalent CCI status)</td>
<td>Displayed for a UR delta resync pair in the delta resync configuration. • An error occurred on a pair in the HOLD status. • When the P-VOL status is HLDE, the updated S-VOL data of TC or GAD pairs is not stored in the master journal volume.</td>
<td>Read/Write¹</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

Monitoring the Universal Replicator system

Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
<table>
<thead>
<tr>
<th>HDvM - SN status</th>
<th>CCI status</th>
<th>Description</th>
<th>P-VOL access</th>
<th>S-VOL access</th>
</tr>
</thead>
</table>
| (No equivalent HDvM - SN status) | PFUS | This status results when the journal volume becomes full and suspends. Pair status changes from COPY, PAIR or PFUL to PFUS. The UR pair is suspended and the copy operation stops. Make sure to review configuration of the remote path and journal volume.  
- If a Dynamic Provisioning virtual volume (DP-VOL) is used as the UR S-VOL, and the capacity of a pool-VOL is nearly full, the UR status becomes PFUS and the pair is suspended.  
- If the journal option Inflow Control is set to Yes when status changes to PFUS, the pair is not suspended for the time set in the Data Overflow Watch field, even when the journal volume becomes full. During the time it takes for the journal data area to clear, the response to host I/O is delayed.  
See Changing options used by journals on page 8-6 for more information on Data Overflow Watch. | Read/Write | Read Only, but if you select Enable for Secondary Volume Write option then split pair from primary site, it is Read/Write (default is Disable). |
| (No equivalent HDvM - SN status) | SSWS | After the horctakeover or pairsplit -RS command, SSWS is the status of the S-VOL. With this status, data can be written to the S-VOL. The host can write data to an S-VOL whose status is SSWS on the intermediate site or secondary site during the failure recovery. | Read Only | Read/Write |

1. The access conditions to the UR P-VOL depend on the status of the TC or GAD pair that shares volumes with UR.
2. In the 3DC multi-target configuration using delta resync, two mirrors are used. The access conditions to this S-VOL depend on the status of the mirror whose status is not HOLD.
3. HOLDING indicates either that differential data used for a delta resync operation does not exist or that the system cannot judge whether the delta resync can be performed without the differential data.

When differential data does not exist in the secondary TC or GAD site, even after the S-VOL is updated, the differential data might be discarded due to the one of the following reasons:
- The cache or shared memory was added to or removed from the system during maintenance work.
- The system was powered off during maintenance work.
- The UR, TC, or GAD pair was suspended and then resynchronized.
- A disaster or failure occurred in a TC or GAD secondary site, and volumes cannot be accessed.

After the system is back to normal, differential data is stored again in the TC S-VOL if you update the data in the primary site.
The delta resync operation can be executed without differential data if the primary site has not received a data update or if the data in the TC or GAD S-VOL and the UR S-VOL is the same.

Even if the delta resync operation without differential data is executable, the pair status changes to HOLD even when the differential data exists if the conditions for discarding the differential data are satisfied. To change the status of the pair to HOLD, update the data in the primary storage system after the recovery from the condition of the differential data discarding.

If you cannot connect to the secondary site of TC or GAD due to failures or disasters, the transition from HOLDING to HOLD is not performed correctly. When used with GAD, keep updating I/O from the server to GAD P-VOL or S-VOL for about two minutes.

### Additional information on pair status

- When a pair is split by the user or suspended by the system, the primary system notifies the hosts with a service information message (SIM). If SNMP is installed and operational on the storage system, this SIM results in an SNMP trap that indicates the reason for suspension.

- Transitional states occur when a request is accepted to change pair status to PSUS, PSUE, or to delete the pair, but is not yet complete. Transition states are not reported to the host.

- The user or the primary or secondary systems can initiate the PSUS/PSUE status change.

- Only the user can delete a pair.

- When you perform an operation, the system reports final status at the end of the operation.

- If an error causes the status to change to PSUE, the status is reported at the beginning of the transition.

- A pair in Flush mode (remaining primary update data is flushing to the secondary system) remains in Suspending or Deleting status until data in the master and restore journals is the same and the pair is completely split or released. To calculate the time during which the pair remains in Suspending or Deleting status, use the following equation:
  \[ C \times \left( \frac{u}{100} \right) \times 1,024 \div V \]  
  (The unit is seconds)

  where:
  - \( C \) is total capacity (MB) of the master journal volume.
  - \( u \) is the usage rate of data (%) in the master journal volume.
  - \( V \) is data transfer speed (MB/sec) between the primary and the secondary systems.

- When the pair status is COPY, neither cache nor shared memory can be added to or removed from the system. If you need to perform either of these tasks, split the pairs with COPY status, and then resynchronize the pairs when the cache or shared memory operation is completed.
PSUS types and behaviors

The PSUS status can be set by the user or the system and from the primary or the secondary system.

<table>
<thead>
<tr>
<th>PSUS type</th>
<th>Volume PSUS type applies to</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSUS, S-VOL by Operator</td>
<td>P-VOL, S-VOL</td>
<td>The user split the pair from the primary or secondary system, using the S-VOL-writeoption. CCI displays this PSUS type as SSWS.</td>
</tr>
<tr>
<td>PSUS, by MCU</td>
<td>S-VOL</td>
<td>• The secondary system received a request from the primary system to split the pair. • The P-VOL PSUS type is PSUS-S-VOL by Operator. • CCI displays this PSUS type as SSWS.</td>
</tr>
<tr>
<td>PSUS, by RCU</td>
<td>P-VOL, S-VOL</td>
<td>• The primary system suspended the pair after detecting an error condition on the secondary system. • The S-VOL suspend type is PSUE-S-VOL Failure. • CCI displays this PSUS type as PSUE.</td>
</tr>
<tr>
<td>PSUS, Pairsplit-S to RCU</td>
<td>P-VOL</td>
<td>The primary system detected that S-VOL is unpaired after the user released the pair from the secondary system. The pair cannot be resynchronized.</td>
</tr>
<tr>
<td>PSUS, JNL Cache Overflow</td>
<td>P-VOL, S-VOL</td>
<td>The pair was suspended because the journal volume was near capacity. • CCI displays this PSUS type as PFUS or SSWS.</td>
</tr>
</tbody>
</table>

- A pair can be split after the initial copy is complete.
- A pair must be split to perform maintenance on the P-VOL, or to enable write-access on the S-VOL.
- After status changes to PSUS, the primary system performs the following tasks:
  - Stops journal-obtain operations
  - Continues to accept write I/Os from host to P-VOL
  - Keeps track of updated P-VOL tracks
- If you enable the S-VOL write-option when splitting the pair, the secondary system keeps track of updated S-VOL tracks. When the pair is resynchronized, the secondary system sends the S-VOL track bitmap to the primary system, which then merges P-VOL and S-VOL bitmaps to synchronize the tracks.
- A split or suspended S-VOL has a separate consistency status, which indicates the S-VOL’s update sequence consistency with respect to the other S-VOLs in the associated journal. Consistency status displays on the secondary system only. S-VOL consistency status is described below.
Table 7-1 S-VOL consistency statuses

<table>
<thead>
<tr>
<th>Consistency status</th>
<th>Description</th>
</tr>
</thead>
</table>
| Volume             | • Only the current pair was split or suspended.  
|                    | • Update sequence consistency between this S-VOL and other S-VOLS in the associated journal is not ensured.  
|                    | • This S-VOL cannot be used for disaster recovery at the secondary site.  
|                    | • This status is indicated when:  
|                    | ° The pair is split by the user using the Split Pairs window.  
|                    | ° The pair is suspended due to a failure that did not affect the entire journal. |
| Mirror             | • The pair was split or suspended along with the other pairs in the associated mirror.  
|                    | • Update sequence consistency between this S-VOL and other S-VOLS in this mirror is ensured.  
|                    | • This S-VOL can be used for disaster recovery on the secondary system.  
|                    | • This status is indicated when:  
|                    | ° The pair is split using the Split Mirrors window.  
|                    | ° All pairs in the associated mirror are suspended due to a failure that affects the entire group; for example, path failure.  
|                    | ° One pair in the mirror was suspended due to a failure that did not affect the entire group. |

Suspend conditions for Universal Replicator pairs

The following table lists the suspend conditions for Universal Replicator pairs, the storage system that detects the condition, and the volume pairs that are suspended.

<table>
<thead>
<tr>
<th>Suspend condition</th>
<th>Detecting storage system</th>
<th>Suspended pair</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical error was detected in secondary system while selecting journal data that will be restored.</td>
<td>Secondary system</td>
<td>All S-VOLS in journal or affected S-VOL.</td>
</tr>
<tr>
<td>Journal data could not be restored in secondary system due to HW failure, track status, or logical error.</td>
<td>Secondary system</td>
<td></td>
</tr>
</tbody>
</table>

Please refer to related contents for details.

Differential bitmap for each P-VOL is stored in shared memory in the primary system. The differential bitmap for each S-VOL is stored in shared memory in the secondary system. A UR pair that uses a DP-VOL whose size is more than 4,194,304 MB (8,589,934,592 blocks) does not use shared memory. For tracks that include the following journal data, it will be marked within differential bitmap (since it needs to be copied during pair resync):
- Journal data that was created at the primary system and not yet sent to the secondary system. The primary system will mark these P-VOL tracks as "changed" and then delete the journal data.
- Journal data that was sent to the secondary system but not recognized yet. The primary system will mark these P-VOL tracks as "changed" and then delete the journal data. By this, it can be marked as confirmed for journal data that was lost while being sent to the secondary system.
- Journal data that was delivered to the secondary system but not yet restored. The primary system will mark these P-VOL tracks as "changed" and then delete the journal data. By this, it can be marked as confirmed for journal data that was lost while being sent to the secondary system. The primary system will not delete the target journal data from the master journal volume until receiving the restored journal's sequence number that is added to the read journal command from the secondary system.
- P-VOL that was updated by write I/O from the host after the pair was suspended.

**PSUE types and behaviors**

The primary system suspends a pair and changes its status to PSUE when it detects any of the following:

- The user has released the pair on the secondary system.
- An error condition related to the secondary system, S-VOL, or an update operation.
- The primary system is unable to communicate with the secondary system.
- A Universal Replicator suspension condition is detected by the system.

The following describes the types of PSUE status.

<table>
<thead>
<tr>
<th>PSUE Type</th>
<th>Applies To</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSUE, S-VOL Failure</td>
<td>P-VOL, S-VOL</td>
<td>The primary system detected an error during communication with the secondary system or during update copying. S-VOL PSUE type is usually PSUE-S-VOL Failure. CCI might display this condition as SSWS.</td>
</tr>
<tr>
<td>PSUE, MCU IMPL</td>
<td>P-VOL, S-VOL</td>
<td>The primary system could not find valid control information in its nonvolatile memory during IMPL (initial microprogram load). This condition occurs if the primary system is without power for more than 48 hours (power failure and fully discharged backup batteries).</td>
</tr>
<tr>
<td>PSUE, Initial Copy Failed</td>
<td>P-VOL, S-VOL</td>
<td>The pair was suspended before the initial copy operation was complete. The data on the S-VOL is not identical to the data on the P-VOL. CCI might display this condition as SSWS.</td>
</tr>
<tr>
<td>PSUE, MCU P/S OFF</td>
<td>S-VOL</td>
<td>The primary system is powered off. CCI displays this condition as SSUS.</td>
</tr>
</tbody>
</table>
When a pair is suspended, the primary system stops performing journal-obtain operations for the pair but continues to perform the following operations:

- Continues accepting write I/Os for the suspended P-VOL
- Keeps track of the P-VOL cylinders/tracks that are updated
- Keeps track of journal data discarded during the pair suspension. (Both primary and secondary systems do this.)

A split or suspended S-VOL has a separate consistency status that indicates its update sequence consistency with respect to the other S-VOLS in the associated journal. Consistency status is displayed only on the secondary system. Table 7-1 S-VOL consistency statuses on page 7-9 describes S-VOL consistency statuses.

When the pair is resynchronized, the primary and secondary systems perform the following operations:

- The secondary system sends the S-VOL bitmap to the primary system.
- The primary system merges the P-VOL and S-VOL bitmaps to synchronize the tracks.

These actions ensure that all cylinders/tracks containing journal data discarded on the secondary system are resynchronized.

**Checking Universal Replicator pair synchronization rate**

You can check on the percentage of synchronized data between the P-VOL and S-VOL. The synchronization rate is displayed as follows:

- When the volume on the local storage system is a P-VOL, the initial copy progress is displayed.
- When the volume on the local storage system is an S-VOL, the synchronization rate depends on whether the pair is split:
  - If the pair is not split, a hyphen (-) is displayed.
  - If the pair is split, the S-VOL synchronization rate between before and after split is displayed. For example, if the S-VOL content before and after split is the same, 100 is displayed.

Caution: If the pair is split due to initial copy failure, a hyphen (-) is displayed. If initial copy fails, the status **Initial copy failed** is displayed in the View Pair Properties window.

- For the following cases, a hyphen (-) is displayed:
  - When the volume in the local storage system is neither a P-VOL nor an S-VOL.
  - When the volume in the local storage system has one of the following pair statuses: HOLD, HOLDING, or HLDE.
Procedure

1. Open the **Remote Replication** window.
   In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.

2. Click the **UR Pairs** tab, and then select the pair whose rate you want to check.

3. Click **Actions > Remote Replication > View Pair Synchronization Rate**.
   Clicking **Refresh View** displays the latest synchronization rate.

Viewing Universal Replicator operation history

You can view the history of Universal Replicator operations, including the date and time the operation took place, primary and secondary system information, and the type of operation.

**Note:**

- The **History** window displays the most recent 8,192 UR operations.
- The LDEV ID displayed on the **History** window is the physical LDEV ID in the storage system, even if CCI was used to perform operations on volumes in a virtual storage machine.
- The operations displayed on the **History** window include user-requested operations (for example, pair creation) and internal operations (for example, completion of pair creation, pair suspension due to failure).
- If you use 1,000 or more pairs concurrently, some operation history might not be recorded.

**Procedure**

1. Open the **History** window.
   In Hitachi Command Suite:
a. On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Replication Dashboard.

b. Click View History > Remote Replication.

In Device Manager - Storage Navigator:

a. In the Storage Systems tree, click Replication.

b. From the Actions menu, click Remote Replication > View History.

2. In Copy Type, select UR. The most recent 8,192 UR operations are listed in chronological order.

The following table lists and describes the operations displayed in the Description column of the History window.

<table>
<thead>
<tr>
<th>Operation in the Description column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pair definition</td>
<td>A pair was defined.</td>
</tr>
<tr>
<td>Paircreate Start</td>
<td>Creation of the pair was started. When you specify Entire Copy for the Delta Resync Failure option (Edit Mirror Options window), if delta resync fails, all data in the P-VOL is copied to the S-VOL. When copy is started by delta resync failure, Paircreate Start is displayed. When used with GAD, specifying Entire Copy for Delta Resync Failure is invalid.</td>
</tr>
<tr>
<td>Paircreate Complete</td>
<td>Creation of the pair was finished. Paircreate Complete is displayed when the full P-VOL copy operation is completed for any reason, for example, when the delta resync operation fails and the Delta Resync Failure mirror option is set to Entire Copy. Paircreate Complete is also displayed when the copy operation is complete due to delta resync failure. When used with GAD, specifying Entire Copy for the Delta Resync Failure option is invalid.</td>
</tr>
<tr>
<td>Pairresync Start</td>
<td>Restoring of the pair was started.</td>
</tr>
<tr>
<td>Pairresync Complete</td>
<td>Restoring of the pair was finished.</td>
</tr>
<tr>
<td>Pairsplit-r Start</td>
<td>Splitting (Suspending) of the pair was started.</td>
</tr>
<tr>
<td>Pairsplit-r Complete</td>
<td>Splitting (Suspending) of the pair was finished.</td>
</tr>
<tr>
<td>Pairsplit-r (Failure)</td>
<td>The pair was split (suspended) because of a failure.</td>
</tr>
<tr>
<td>Pairsplit-S Start</td>
<td>Release of the pair was started.</td>
</tr>
<tr>
<td>Pairsplit-S Complete</td>
<td>Release of the pair was finished.</td>
</tr>
<tr>
<td>Operation in the Description column</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Status Change by MCU (SMPL to COPY)</td>
<td>The status of the pair was changed from SMPL to COPY because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (SMPL to PAIR)</td>
<td>The status of the pair was changed from SMPL to PAIR because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (COPY to PAIR)</td>
<td>The status of the pair was changed from COPY to PAIR because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (COPY to PSUS/PSUE)</td>
<td>The status of the pair was changed from COPY to PSUS or PSUE because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (PAIR to PSUS/PSUE)</td>
<td>The status of the pair was changed from PAIR to PSUS or PSUE because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (PAIR to SMPL)</td>
<td>The status of the pair was changed from PAIR to SMPL because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (COPY to SMPL)</td>
<td>The status of the pair was changed from COPY to SMPL because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (PSUS/PSUE to SMPL)</td>
<td>The status of the pair was changed from PSUS or PSUE to SMPL because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by MCU (PSUS/PSUE to COPY)</td>
<td>The status of the pair was changed from PSUS or PSUE to COPY because of an operation from the primary system.</td>
</tr>
<tr>
<td>Status Change by RCU (Pairsplit-r Start)</td>
<td>The status of the pair was changed because an operation for splitting a pair started at the secondary system.</td>
</tr>
<tr>
<td>Status Change by RCU (Pairsplit-r Complete)</td>
<td>The status of the pair was changed because an operation for splitting a pair finished at the secondary system.</td>
</tr>
<tr>
<td>Status Change by RCU (PSUS/PSUE to SMPL; Pairsplit-S Start)</td>
<td>An operation for releasing a pair has been started at the secondary system. The status of the pair will change from PSUS or PSUE to unpaired (SMPL).</td>
</tr>
<tr>
<td>Status Change by RCU (COPY to SMPL; Pairsplit-S Start)</td>
<td>An operation for releasing a pair has been started at the secondary system. The status of the pair will change from COPY to unpaired (SMPL).</td>
</tr>
<tr>
<td>Status Change by RCU (PAIR to SMPL; Pairsplit-S Start)</td>
<td>An operation for releasing a pair has been started at the secondary system. The status of the pair will change from PAIR to unpaired (SMPL).</td>
</tr>
</tbody>
</table>
### Saving pair information to a text file

You can save pair status and other information to a tab-delimited TSV file.

**Procedure**

1. Open the **Remote Replication** window.
   - In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Replication**.
   - In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Replication > Remote Replication**.
2. In the **Remote Replication** window, click **More Actions > Export**.
3. If necessary, follow the instructions in the online help.
Monitoring I/O and hardware performance with Performance Monitor

The Performance Monitor software provides detailed information on I/O activity and hardware performance in the VSP Gx00 models and VSP Fx00 models. Storage system usage and performance data that is collected and displayed by Performance Monitor enables you to:

- Identify the optimum timing for performing Universal Replicator copy operations.
- Determine the best locations for the Universal Replicator S-VOLs (for example; parity groups with less frequently accessed volumes to avoid bottlenecks of back-end activity)
- Monitor system performance during Universal Replicator operations and during testing activities.

Use the following procedure to lessen the impact on Universal Replicator operations while Performance Monitor is collecting data for one or more systems on the same internal LAN for the VSP Gx00 models or VSP Fx00 models:

1. If Performance Monitor is collecting high amounts of LDEV data, disabling this activity, if possible, for one or more systems.
2. If Performance Monitor is collecting data for more than three storage systems on the internal LAN, disconnect Performance Monitor, if possible, from one or more systems before using Universal Replicator.
3. After you have disabled LDEV data collection and/or disconnected Performance Monitor wherever possible, then connect to the system using Device Manager - Storage Navigator and launch Universal Replicator.
4. When Universal Replicator operations are completed, exit Universal Replicator and Device Manager - Storage Navigator.
5. Re-enable Performance Monitor data collection.

For further information on Performance Monitor, see Performance Guide.

Monitoring journal (mirror) status

The status of a mirror associated with a journal relates to the pair operations that have been performed on the journal. Monitoring these statuses can help you resolve problems and maintain the Universal Replicator system.

Procedure

1. Open the Journals window.
   - In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Journals.
   - In Device Manager - Storage Navigator: In the Storage Systems tree, click Replication > Journals.
2. In the Journals window, select the journal you want to monitor.
3. Click the **Mirror** tab and view the journal’s status.

### Device Manager - Storage Navigator mirror status definitions

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial</td>
<td>Data volumes are registered in the mirror.</td>
</tr>
<tr>
<td>Active</td>
<td>The mirror has only pairs that are not synchronized with the initial copy operation in progress, or pairs that are synchronized with the initial copy complete.</td>
</tr>
<tr>
<td>Active (Warning)</td>
<td>If a mirror in Active status contains pairs that are split, <strong>Active (Warning)</strong> is displayed. The split pairs must be resynchronized to restore the mirror to the Active status.</td>
</tr>
<tr>
<td>HaltAccept</td>
<td>The mirror status is Active, and some pairs in the mirror are split.</td>
</tr>
<tr>
<td>Halting</td>
<td>The status at the beginning of a mirror-split operation. The status changes immediately to Halting. HaltAccept indicates status of restore journals only.</td>
</tr>
<tr>
<td>Halt</td>
<td>An operation for splitting or deleting the mirror is in progress.</td>
</tr>
<tr>
<td>Stopping</td>
<td>An operation for splitting or deleting the mirror is in progress.</td>
</tr>
<tr>
<td>Stopped</td>
<td>An operation for splitting or deleting the mirror is finished.</td>
</tr>
<tr>
<td>Hold</td>
<td>A UR delta resync pair is created. Delta resync operation is ready. When used with GAD, it is ready for the delta resync operation.</td>
</tr>
<tr>
<td>Holding</td>
<td>An operation for creating a UR delta resync pair is in progress. When used with GAD, delta resync is being prepared for execution. Delta resync execution will fail if the status is HOLDING.</td>
</tr>
<tr>
<td>Hold(Failure)</td>
<td>A failure occurred to a UR pair during the delta resync operation.</td>
</tr>
</tbody>
</table>

### CCI mirror status definitions

CCI mirror statuses appear beside Device Manager - Storage Navigator statuses in the HDvM - SN/CCI format. The following describe CCI statuses.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMPL</td>
<td>The mirror is not used.</td>
</tr>
<tr>
<td>PJNN</td>
<td>The master journal is normal.</td>
</tr>
<tr>
<td>SJNN</td>
<td>The restore journal is normal.</td>
</tr>
</tbody>
</table>

---

*Monitoring the Universal Replicator system*

Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PJSN</td>
<td>The master journal is in normal split status.</td>
</tr>
<tr>
<td>SJSN</td>
<td>The restore journal is in normal split status.</td>
</tr>
<tr>
<td>PJNF</td>
<td>The master journal is full.</td>
</tr>
<tr>
<td>SJNF</td>
<td>The restore journal is full.</td>
</tr>
<tr>
<td>PJSF</td>
<td>The master journal is full and split.</td>
</tr>
<tr>
<td>SJSF</td>
<td>The restore journal is full and split.</td>
</tr>
<tr>
<td>PJSE</td>
<td>The master journal is split due to an error (including link errors).</td>
</tr>
<tr>
<td>SJSE</td>
<td>The restore journal is split due to an error (including link errors).</td>
</tr>
<tr>
<td>PJNS</td>
<td>The master journal is in normal split status (3DC multi-target configuration using delta resync).</td>
</tr>
<tr>
<td>SJNS</td>
<td>The restore journal is in normal status (3DC multi-target configuration using delta resync).</td>
</tr>
<tr>
<td>PJES</td>
<td>The master journal is in split status (3DC multi-target configuration using delta resync) due to a failure cause.</td>
</tr>
<tr>
<td>SJES</td>
<td>The restore journal is in split status (3DC multi-target configuration using delta resync) due to a failure cause.</td>
</tr>
</tbody>
</table>

**Monitoring Universal Replicator remote connections, path status**

Use the following procedure to navigate to remote connection and remote path status. For remote path status definitions and troubleshooting, see Remote path status problems on page 10-3.

**Procedure**

1. Open the Remote Connections window.
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Connections.
   In Device Manager - Storage Navigator: In the Storage Systems tree, click Replication > Remote Connections.
2. Check the Status field.
3. To view more information, click Actions > Remote Replication > View Remote Connection Properties. Remote connection properties including path information displays in the window.
   You can see similar information, along with a graphic representation, in the Remote Connections > Connections (To) tab.
Maintaining the Universal Replicator system

Some maintenance tasks are a response to behavior discovered during system monitoring. However, you can also change certain settings to keep the system in tune with your changing requirements.

This chapter provides information and instructions for maintaining a Universal Replicator system.

- Pair maintenance
- Journal and mirror maintenance
- Remote path maintenance
- Managing power-off for systems and network devices
**Pair maintenance**

You must have Storage Administrator (Remote Copy) role to perform Universal Replicator maintenance operations.

Maintaining pairs consists of the following:

- Changing pair options on page 8-2
- Forcibly deleting pairs on page 8-3
- Restoring a pair by adding a reserve journal volume on page 8-5
- Restoring a pair without adding a reserve journal volume on page 8-5

**Changing pair options**

You can change the following pair options:

- Whether to copy cache-fast-write data to the S-VOL
- The system’s response if a failure occurs in the pair

**Prerequisite information**

- You can change pair options only for pairs in PAIR, PSUS, PSUE, HOLD, HOLDING, or HLDE status.

**Procedure**

1. Open the **Remote Replication** window.
   - In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Replication.
   - In Device Manager - Storage Navigator: In the Storage Systems tree, click Replication > Remote Replication.
2. Select the **UR Pairs** tab, and then select the pair whose options you want to change.
3. From the Actions menu, click Remote Replication > Edit Pair Options.

**Note:** When you select multiple pairs on the UR Pairs tab, Edit Pair Options values might be blank because the selected pairs have different values. When you specify a value, it is set for all selected pairs.

4. In the **Edit Pair Options** window, for **Error Level**, specify the system response if a failure occurs in the pair.
   - Mirror: Splits all pairs in the failed pair’s mirror. Mirror is the default.
   - LU: Splits only the pair that failed.
5. Click **Finish**.
6. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.
7. Click **Apply** to save your settings to the system.

**Forcibly deleting pairs**

You forcibly delete a pair for the following reasons:

- A currently unpaired volume that was previously in a pair is unusable because previous pair information is still in the volume.
- The pair cannot be connected to the secondary system because of a communication error. In this case, delete the pair forcibly in the both the primary and the secondary systems.

**Caution:** The following data will be deleted:

- Data that has not been sent to the secondary system if the pair is forcibly deleted from the primary system.
- Data that has not been restored if the pair is forcibly deleted from the secondary system.

Also, if a pair with the PAIR/COPY status exists in the journal group when forcibly deleting, host I/O to that pair might time out.

**Prerequisite information**

- The volume must be unpaired.

**Procedure**

1. Open the **Logical Devices** window.
   In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, then expand the target storage system tree, right-click **Volumes**, and click **System GUI**.
In Device Manager - Storage Navigator: In the **Storage Systems** tree, click **Logical Device**.

2. Click the **LDEV** tab, and then select the pair that you want to delete forcibly.

3. From the **Actions** menu, select **Remote Replication > Force Delete Pairs (UR Pairs)**.

4. In the **Force Delete Pairs (UR Pairs)** window, ensure that the volume you want to forcibly delete is in the **Selected LDEV** table.

5. Enter a name in the **Task Name** box.

6. Click **Apply** to save your settings to the system.

**Releasing the differential data managed in a pool**

When a UR pair contains a DP-VOL that is larger than 4,194,304 MB (8,589,934,592 blocks), the differential data is managed by the pool to which the pair is related. If differential data management fails due to insufficient pool capacity, you need to release the differential data (pages) managed in the pool. You also need to release pages when you downgrade to a microcode version that does not support UR pairs with volumes larger than 4,194,304 MB.

**Procedure**

1. Delete all UR pairs that use the V-VOL for which you want to release the pages by using the `pairsplit -s` command.

2. Make sure that system option mode 755 is set to OFF. When system option mode 755 is set to ON, you cannot reclaim zero pages. For details
about setting system option modes, contact your Hitachi Data Systems representative.

3. Restore the blocked pool. For details, see the Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models.

4. Release the V-VOL pages by using the CCI `raidcom modify ldev` command or the Reclaim Zero Pages window in Device Manager - Storage Navigator. Releasing pages might take some time. For details, see the Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models.

**Restoring a pair by adding a reserve journal volume**

Use the following procedure to restore a UR pair that was split due to disk failure of the pool and pool volume to which the journal volume belongs. When you use a reserve journal volume, you do not need to delete the UR pair.

**Procedure**

1. Add a reserve journal volume. For details, see Adding a reserve journal volume on page 8-12.

2. Verify that the volume you added is a reserve journal volume:
   - GUI: Use the Journal Volumes window (Type: Reserve Journal).
   - CCI: Use the `raidcom get journal` command.

3. Delete the first journal volume.

4. Resynchronize the pair, and then restore the UR pair.

**Restoring a pair without adding a reserve journal volume**

Use the following procedure to restore a UR pair that was split by disk failure of the pool and pool volume to which the journal volume belongs. If you do not recover the volume and do not use a reserve journal volume, the UR pair must be deleted.

**Procedure**

1. Resolve the problem with the volume, and then resynchronize the pair and restore the UR pair.

   If the problem with the volume is not resolved, perform the following steps:

   a. Delete the UR pair.
   b. Delete the journal volume.
   c. Re-create the journal using a volume that does not have any problems.
   d. Re-create the UR pair.
Journal and mirror maintenance

Maintaining journals and mirror consists of the following operations:

- Changing options used by journals on page 8-6
- Changing options used by mirrors on page 8-7
- Adding an additional journal volume to an existing journal on page 8-10
- Replacing a journal volume with a reserve journal volume on page 8-11
- Deleting journal volumes from a journal on page 8-12
- Deleting journals on page 8-13

Changing options used by journals

Most Universal Replicator pair operations are performed on multiple pairs, which is done using journals. You can change the following options that affect the pairs in journals:

- Inflow Control—allows you to restrict the inflow of data to allow other journals with higher priority data unrestricted inflow
- Data Overflow Watch—establishes a timeout period
- Cache Mode—which you to use journal data in the cache on the secondary system

Prerequisite information

Please be aware of the following when changing journal options:

- Journal options can be changed from either the primary site or the secondary site.
- To change journal options, the status of the journal in the mirror must be one of the following:
  - Initial
  - Stopped
  - Hold
  - Holding
  - Hold(Failure)

Note: In the 3DC configuration using delta resync, journals exists in two mirrors. The journal options cannot be changed if the journal's mirror status is Active and even if the other mirror status is Hold.

Procedure

1. Open the Journals window.
   - In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Journals.
   - In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Journals.
2. Select the **Journals** tab, and then select the journal whose options you want to change.

3. From the **Actions** menu, click **Journals > Edit Journal Options**.

4. In the **Edit Journal Options** dialog box, change the following options as needed.
   - Inflow Control
   - Data Overflow Watch
   - Cache Mode

   For descriptions, see the procedure in [Creating journals and adding journal volumes on page 5-5](#).

   ![Edit Journal Options dialog box](image)

5. Click **Finish**.

6. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

7. Click **Apply** to save your settings to the system.

### Changing options used by mirrors

Most pair operations are performed on multiple pairs. This is done using a journal or mirrors. You can change the following options that affect the pairs in a mirror:

- Path Watch Time: The interval from the time a path becomes blocked to the time when the mirror is suspended.

**Caution:** Except for special circumstances, set the same Path Watch Time value for the mirror's primary side (MCU) and secondary side (RCU). When the primary side (MCU) and secondary side (RCU) are different, the mirrors will not be split (suspended) synchronously. For example, when 5 minutes is set for the mirror's primary side (MCU) and 60 minutes for the secondary side (RCU), the path on the primary side (MCU) will be suspended 5 minutes after the path blockage, but the secondary side (RCU) will be suspended 60 minutes later.
• Path Watch Time Transfer: Transfers the master journal’s Path Watch Time value to the restore journal.
The Path Watch Time Transfer cannot be set at the secondary site. Because the Path Watch Time value needs to be set for the secondary site when performing the delta resync operation, make sure to specify Yes at the primary site of the UR delta resync pair.

• Copy Pace: The pace at which data is copied.
• Transfer Speed: The speed for data transfer.
• Delta Resync Failure: The processing that takes place when the delta resync operation failed.

Prerequisite information
Please be aware of the following when changing mirror options:
• Mirror options can be changed on both primary and secondary systems.
• To change mirror options, the status of the mirror must be one of the following:
  o Initial
  o Active
  o Stopped
  o Hold
  o Holding
  o Hold(Failure)
• When the mirror status is Active, Hold, or Holding, only the Transfer Speed can be changed. When the mirror status is Holding, the Transfer Speed can be changed only if the mirror belongs to the primary system.

Procedure
1. Open the Remote Replication window.
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and then click Remote Replication.
   In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Remote Replication.
2. Select the Mirrors tab, and then select the mirror whose options you want to change.
3. From the Actions menu, click Remote Replication > Edit Mirror Options.
4. In the Edit Mirror Options window, for Path Watch Time, specify the interval from the time a path becomes blocked to the time when the mirror is suspended. Ranges are from 1 to 59 minutes, 1 to 23 hours, or 1 to 30 days. A numeric value is required.
The interval must be the same for master and restore journals in the same mirror, otherwise the journals suspend at different times. See the next step to use this setting for both journals.
Important: If you want a mirror to split immediately after a path becomes blocked, ask Hitachi Data Systems customer support to set system option mode 448 to ON and system option mode 449 to OFF.

5. For Path Watch Time Transfer, specify whether to use the same Path Watch Time value you specified for the master journal for the restore journal. Specify this option in the primary site only.
   - Yes: The Path Watch Time value is also used for the restore journal.
   - No: The Path Watch Time value is not used for the restore journal. No is the default.

6. For Copy Pace, specify the pace for initial copy activity per volume. Specify this option in the primary site only.
   - Slower is the default.
   - If specifying Medium, ensure that write I/O is 10 MB/s or less per parity group. If it exceeds 10 MB/s, pairs might be suspended.
   - If specifying Faster, ensure that I/O will not occur. If update I/O occurs, pairs might be suspended.

7. For Transfer Speed, specify the data transfer line speed in Mbps (megabits per second). You can specify 256, 100, 10, or 3.
   - Use 256 when the transfer speed is 256 Mbps or higher.
   - Use 100 when the transfer speed is 100 to 255 Mbps.
   - Use 10 when the transfer speed is 10 to 99 Mbps.
   - Use 3 when the transfer speed is 3 to 9 Mbps.

Note: This setting does not effect master journals unless the CCI horctakeover command is used to change a master journal into a restore journal.

8. For Delta Resync Failure, specify the processing that takes place when the delta resync operation cannot be performed. Specify this option in the primary site only.
   - Entire Copy: The entire P-VOL is copied to the S-VOL. This is the default. Use Entire Copy if your journals are part of a multiple-journal configuration in a CCI consistency group.
   - No Copy: No processing occurs, and the S-VOL is not updated.
9. Click **Finish**.
10. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.
11. Click **Apply** to save your settings to the system.

**Adding an additional journal volume to an existing journal**

You can add one additional journal volume to a journal. The additional volume is not used unless needed for maintenance or to replace the first one. In the event of pair failure, the additional (backup) journal volume allows you to reduce the time to recover a blocked journal volume.

**Prerequisite information**

- Review the following:
  - System requirements on page 2-2
  - Planning journal configuration on page 3-6
- The journal’s mirror status must be Initial, Active, Stopped, Hold, Holding, or Hold(Failure).
- The journal cannot be in use.
- Pair operations involving the journal cannot be in progress.
- Adding a reserve (spare) journal volume to a journal while remote copy is in progress causes only the journal data area to be used. The metadata area is not used, because it is unavailable. To make the metadata area available in this case, split and resynchronize all pairs in the journal group.
  
  If you extend the journal volume when the journal volume size exceeds 36 GB, you need to restore the journal which is used for the extension to the S-VOL to use the extended capacity. However, it might take some time until the extended capacity becomes ready to be used.
- Virtual storage machine volumes cannot be used as journal volumes.
- Data volumes in the different virtual storage machines cannot be registered to the same journal. When adding journal volumes to a journal, add volumes in the same virtual storage machine as the current journal volumes.

**Procedure**

1. Open the **Journals** window.

   In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Journals**.

   In Device Manager - Storage Navigator: In the Storage System tree, click **Replication > Journals**.

2. Select the **Journal Volumes** tab, and then select the journal to which you are adding journal volumes.

3. From the **Actions** menu, click **Journals > Assign Journal Volumes**.

4. In the **Assign Journal Volumes** window, from the **Unassigned Journal Volumes** table, select the journal volume to be added to the journal, and
then click Add. The selected journal volume moves to the **Assigned Journal Volumes** table.
To remove a volume from the table, select the volume and click **Remove**.

![Image of journal volume management interface](image)

**Note:** Only OPEN-V volumes display in the Unassigned Journal Volumes table.

5. Click **Finish**.
6. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.
7. Click **Apply** to save your settings to the system.

### Replacing a journal volume with a reserve journal volume

When you register two journal volumes in a journal, the second journal volume becomes the reserve journal volume, which is not used for normal operations. For details about reserve journal volumes, see [Journal volumes on page 1-6](#).

**Prerequisites**

- Required role: Storage Administrator (Remote Backup Management)
- An unallocated journal volume that will be the reserve journal volume must be available.

**Procedure**

1. Add a reserve journal volume to the journal. For details, see [Adding a reserve journal volume on page 8-12](#).
2. Delete the journal volume that is in use. For details, see Deleting journal volumes from a journal on page 8-12.

3. Resynchronize the journal.

Adding a reserve journal volume

**Prerequisite**

- An unallocated journal volume that will be the reserve journal volume must be available.

**Procedure**

1. Open the Remote Replication window.
   - In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Replication.
   - In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Remote Replication.

2. In the Mirrors tab, select the Journal ID link for the journal to which you want to add journal volumes.

3. In the Journal Volumes tab, click Assign Journal Volumes.

4. In the Assign Journal Volumes window, from the Unassigned Journal Volumes table, select the journal volume to be added to the journal, and then click Add. The selected journal volume moves to the Assigned Journal Volumes table.
   - To remove a volume from the table, select the volume, and then click Remove.

5. Click Finish.

6. In the Confirm window, review the settings and enter a task name in the Task Name box.

7. Click Apply to save your settings to the system.

Deleting journal volumes from a journal

You can delete journal volumes as needed.

**Prerequisite information**

- A journal volume can be deleted only when one or more of the following conditions exist:
  - If the pair belonging to the mirror in the journal is suspended and a reserve journal volume exists.
  - If the pair belonging to the mirror in the journal is deleted.
- Deleting a journal volume from a journal in which a pair is registered causes the journal volume's LDEVs to become blockaded. You can release the blockade by formatting the LDEVs. For instructions on formatting...
volumes, see the *Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.

- To delete a journal volume, mirror statuses in the journal must be Initial, Stopped, or Hold(Failure), and a reserve volume exists.
- The following table specifies the mirror status required for deleting journal volumes in the 3DC multi-target configuration.

<table>
<thead>
<tr>
<th>Journal status</th>
<th>Other conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mirror ID #1</td>
<td>Mirror ID #2</td>
</tr>
<tr>
<td>Stopped</td>
<td>Stopped</td>
</tr>
</tbody>
</table>
| Stopped        | Hold(Failure)    | • When using 3DC configuration with UR and TC.  
                |                  | • When using 3DC configuration with UR and GAD.  
                |                  | • When using 3DC configuration with 3 UR sites. |

**Procedure**

1. Open the Journals window.
   
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Journals.
   
   In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Journals.

2. Select the Journal Volumes tab, and then select the journal containing the journal volumes to be deleted.

3. From the Actions menu, click Journals > Assign Journal Volumes.

4. From the Assigned Journal Volumes table, select the volumes to be deleted and click Remove.

5. Click Finish.

6. In the Confirm window, review the settings and enter a task name in the Task Name box.

7. Click Apply to save your settings to the system.

**Deleting journals**

**Prerequisite information**

- Journals can be deleted from the primary or secondary system.
- All mirrors in the journal must be Initial status.
- Removing a journal volume from a journal that is registered causes the journal volume's LDEVs to become blockaded. You can release the blockade by formatting the LDEVs.

**Procedure**

1. Open the Journals window.
   
   In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Journals.
In Device Manager - Storage Navigator: In the **Storage System** tree, click **Replication > Journals**.

2. Select the **Journals** tab, and then select the journal to be deleted.

3. From the **Actions** menu, click **Journals > Delete Journals**.

4. In the **Delete Journals** window, make sure the journals you want to delete are listed in the **Selected Journals** table. If you need more information about a journal, select it and click **Detail**. If you need to change the selections, click **Cancel**.

5. When satisfied, click **Finish**.

6. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

7. Click **Apply** to save your settings to the system.

**Remote path maintenance**

This topic provides the following:

- Modifying data-transfer time threshold
- Deleting remote paths on page 8-16
- Deleting the Universal Replicator relationship on page 8-17

**Caution:**

- Do not add or delete a remote connection or add a remote path at the same time that the SCSI path definition function is in use.
- Before replacing a data path (Fibre Channel or iSCSI), first delete the pairs and delete the remote paths that use the data path to be replaced, and then replace the data path. Do not replace a data path that is being used for remote copy operations.

**Modifying data-transfer time threshold**

You can modify the threshold for data transfer to complete. If the threshold value is reached, the system flags the transfer as failing.
Prerequisite information

- This operation can be performed from the primary or secondary system.
- The setting is made in the RIO MIH field on the DKC Options dialog box (RIO MIH--remote I/O missing interrupt handler).

Procedure

1. Open the Remote Connections window.
   - In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Connections.
   - In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Remote Connections.
2. In the Remote Connections window, click the Connections (To) tab, and then select the secondary system with the data-transfer waiting-time to be changed.
3. From the Actions menu, click Remote Connections > Edit Remote Connection Options.
4. In the Edit Remote Connection Options window, note that Minimum Paths cannot be changed.
5. For RIO MIH Time, specify the amount of time the system waits before a data transfer operation is flagged as failed. The range is from 10-100 seconds; 15 is the default.
6. Click Finish.
7. In the Confirm window, review the settings and enter a task name in the Task Name box.
8. Click Apply to save your settings to the system.

Adding remote paths

You can add remote paths from the primary or secondary system.

Prerequisite information

- Required role: Storage Administrator (Remote Copy)

Procedure

1. Open the Remote Connections window.
   - In Hitachi Command Suite: On the Resources tab, expand the Storage Systems tree, right-click the target storage system, and click Remote Connections.
   - In Device Manager - Storage Navigator: On the Resources tab, expand the Storage Systems tree, and then right-click the target storage system and click Remote Connections.
2. In the Connections (To) tab, select the remote connection you want to delete.
3. Click More Actions > Add Remote Paths to open the Add Remote Paths window.
4. In the **Remote Paths** box, select the port type, and then select the ports to be used for both the local storage system and the remote storage system. For an **iSCSI** port, enter the IP address and TCP port number for the remote storage system port. To add more than two paths, click **+ Add Path**.

5. Click **Finish**.

6. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

7. Click **Apply** to save your settings to the system.

---

**Deleting remote paths**

You can delete remote paths from the primary or secondary system.

**Prerequisite information**

- Before deleting remote paths, make sure that the remaining number of remote paths after deletion will be equal to or greater than the minimum number of paths setting. The **View Remote Connection Properties** window displays the minimum number of paths setting and the current number of remote paths. The delete path operation will fail if the remaining number of paths after deletion is less than the minimum number of paths.

- The primary system administrator can delete remote paths running from the primary system’s port to the secondary system’s port. The secondary system administrator can delete remote paths running from the secondary system’s port to the primary system’s port.

**Procedure**

1. Open the **Remote Connections** window.
   
   In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Connections**.
   
   In Device Manager - Storage Navigator: In the Storage System tree, click **Replication > Remote Connections**.

2. In the **Remote Connections** window, click the **Connections (To)** tab, and then select the remote connections with the remote path you want to delete.

3. From the **Actions** menu, click **Remote Connections > Remove Remote Paths**.

4. In the **Remove Remote Paths** window, in the **Remote Paths** box, check the **Remove** box or boxes for the remote paths to be deleted.
5. Click **Finish**.

6. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

7. Click **Apply** to save your settings to the system.

**Deleting the Universal Replicator relationship**

You can remove the Universal Replicator pair relationship between the primary and secondary systems. Removing the relationship also removes all remote paths between the primary and secondary systems.

**Prerequisite information**

- This operation must be performed on both the primary and secondary systems.

**Procedure**

1. Open the **Remote Connections** window.
   In Hitachi Command Suite: On the **Resources** tab, expand the **Storage Systems** tree, right-click the target storage system, and click **Remote Connections**.
In Device Manager - Storage Navigator: In the Storage System tree, click Replication > Remote Connections.

2. In the Remote Connections window, click the Connections (To) tab, and then select the remote connections you want to delete.

3. From the Actions menu, click Remote Connections > Remove Remote Connection.

4. In the Remove Remote Connections window, in the Selected Remote Connections box, check the Remove box for the remote connection to be deleted. If you need to review more information about a remote path, select it and click Detail. If you need to change the selections, click Cancel.

5. Click Finish.

6. In the Confirm window, review the settings and enter a task name in the Task Name box.

7. Click Apply to save your settings to the system.

Managing power-off for systems and network devices

This topic explains power management for systems and network relay devices during copy operations. This topic discusses the following:

- How to proceed when power is removed from systems or network relay devices due to some unexpected reason
- How to intentionally power off systems or network relay devices

"Network relay devices" refers to hardware that connects the primary and secondary systems, such as channel extenders and switches.

When power stops unexpectedly

This topic explains what happens when power is removed from systems or network relay devices due to an unexpected reason.
Caution: When a system is powered on, you must wait five (5) minutes before performing Universal Replicator operations. If you do not wait at least 5 minutes, the pairs might be suspended with a failure.

When power is removed from primary or secondary system

- If power is removed from the primary system during remote copy operations, the primary system assumes that a failure has occurred and splits all pairs. When the primary system splits pairs, the secondary system also assumes that a failure occurs and splits all pairs.
- With a 3DC configuration, when you use a UR pair as master journal after power failure in the primary system, resync the UR delta resync pairs first, and then request the host I/O write.
- If power is removed from the secondary system during remote copy operations, the secondary system assumes that a failure has occurred and splits all pairs. When the secondary system splits pairs, the primary system also assumes that a failure occurs and splits all pairs.

When power is removed from network relay devices

If power is removed from a network relay device during remote copy operations, the primary and secondary systems assume that a failure has occurred and split all pairs.

Powering off systems intentionally

This topic explains what should be noted when you intentionally power off systems or network relay devices.

Note: To intentionally power off the primary or secondary system, contact your Hitachi Data Systems account team and ask them to power off the system.

To power off primary and secondary systems at the same time, see Powering off primary and secondary systems at the same time on page 8-20.

Powering off the primary or secondary system

Procedure

1. Ensure that all pairs or mirrors are split and that the status of all pairs is PSUS. Otherwise the pairs could be suspended due to failure.
2. Turn power off.

   In the 3DC multi-target configuration using delta resync, the command device will be blocked associated with the power off. Therefore, a SIM (reference code efd0) indicating the blockage of the device will be reported to a storage system that is connected to the external storage system at another site, other than the site of the storage system that was powered off. Similarly, when you power off the storage system after deleting pairs, you can resume remote copying by following the procedure below.
3. When ready, power on the system.

**Caution:** Wait five (5) minutes after powering on a system before performing Universal Replicator operations; otherwise the pairs could be suspended with a failure.

4. When the system is ready to resume copy operations, in the primary site, resynchronize the pairs that have been split.

5. Confirm that the status of the pairs is COPY or PAIR.

**Correcting errors made when powering off**

If a secondary system remains in Suspending status because you powered-off while the primary system was copying data, delete the pair forcibly in the primary system and in the secondary system, and then re-create the pair.

**Powering off primary and secondary systems at the same time**

The primary system must be powered off before the secondary system is powered off. When you are ready to power the systems on, the secondary system must be powered on before the primary system.

The following is the procedure for powering off the primary and secondary systems at the same time.

**Procedure**

1. Split all pairs that will be affected. For example, if two primary systems and one secondary system are connected to each other and you want to power off one of the primary system and the secondary system, you must split the pairs on all three systems since they are all affected.

2. After the pairs are split, confirm that their status is PSUS at the primary system.

3. Power off the primary system.

4. Power off the secondary system.

5. Power on the secondary system.

6. When the secondary system is ready to resume copy operations, power on the primary system.

**Caution:** Wait five (5) minutes after powering on a system before performing Universal Replicator operations; otherwise the pairs could be suspended with a failure.

7. When the primary system is ready to resume copy operations, resynchronize the pairs that have been split at the primary system. Confirm that the status of the pairs is changed to COPY or PAIR.

After turning power on or off for both the primary system and secondary system at the same time, if the pair status at the primary system is PSUS and the status of the pair at the secondary system is PAIR, suspend the pair from the secondary system. After confirming that the status of the pair on both systems is PSUS, resynchronize the pair from the primary system.
Powering off network relay devices

Procedure

1. Ensure that all pairs or mirrors are split and that the status of all pairs is PSUS.
2. Power off the device.
3. When ready, power on the network relay device.
4. When the network relay device is ready for copy operations, from the primary site, resynchronize the pairs that have been split.
5. Confirm that pair status is COPY or PAIR.
Universal Replicator disaster recovery operations

This chapter provides instructions for performing disaster recovery operations. All disaster recovery operations are performed using Command Control Interface.

- Overview
- General recovery procedures
- Recovery for configurations with multiple primary systems and secondary systems
- Recovery for 3DC configurations with three UR sites
- Recovery for UR/SI configurations
- Recovery for UR/TC configurations
- Recovery from a failure at the primary site and TC secondary site
- Recovery for UR/GAD configurations
Overview

Recovery is the reason for using Universal Replicator and other replication software. With copies of data at a remote location, you can transfer operations to the secondary site, restore lost or damaged information at the primary site, and then restore the copy direction from the primary site to the secondary site.

With copies in multiple remote locations, the level of data security is increased, but recovery procedures can be more complex.

The following is covered in this chapter;

- General recovery procedures on page 9-2
- Recovery for UR/SI configurations on page 9-19

General recovery procedures

A recovery workflow consists of the following:

1. Identify the data volumes that you want to back up, and establish the Universal Replicator pairs.
   See Preparing for recovery on page 9-2.
2. Establish file and database recovery procedures before disaster or failure occurs, as part of the Universal Replicator planning process.
   See Preparing for file and database recovery on page 9-3.
3. Install and configure the host failover software at the primary and secondary sites so that the host operations can be switched between the primary and secondary sites.
4. After a disaster or failure, switch host operations to the secondary site.
   See Switching host operations to the secondary site on page 9-3.
5. Recover the primary site, and then copy the most current data from the secondary site to the primary site.
   See Reversing copy direction from secondary to primary site on page 9-3.
6. Re-establish the pairs and host operations at the primary site.
   See Resuming host operations at the primary site on page 9-4.

Preparing for recovery

The major steps for preparing for disaster recovery are:

- Identify the data volumes that you want to back up for disaster recovery purposes.
- Establish Universal Replicator pairs using these important volumes and P-VOls.
- Establish file and database recovery procedures.
• Install and configure software for host failover between the primary and secondary sites.

Preparing for file and database recovery

Universal Replicator copies data asynchronously using the journal volume. When a UR pair is split due to a failure at the primary site and update data is lost in the journal volume at the primary site, sometimes the S-VOL and P-VOL cannot be matched. In this case, file and database recovery is necessary. File recovery procedures in these circumstances are the same as when a data volume becomes inaccessible due to control unit failure.

Universal Replicator does not provide measures to detect or search for the lost updates. To detect and restore lost updates, use the database log files and other current information at the primary site.

Design your recovery plan so that detection and retrieval of lost updates is performed after the application is started at the secondary site. The detection and retrieval process can take some time.

Prepare for file and database recovery using files for file recovery (for example, database log files that have been verified as current).

Remote copy and disaster recovery procedures are inherently complex. Consult your Hitachi Data Systems account team about recovery procedures.

Switching host operations to the secondary site

Use these instructions for pairs in one or more primary or secondary systems.

The first recovery task is to switch host operations to the secondary site using the CCI horctakeover command.

• The horctakeover command checks the pair status of S-VOLs and splits journals. Splitting the pairs in the journals ensures consistency and usability in the S-VOLs.
• The horctakeover command attempts to resynchronize pairs to reverse P-VOLs and S-VOLs.
• If the horctakeover command runs successfully, host operations are taken over by the secondary site using the S-VOLs. For detailed information about CCI and horctakeover, see Command Control Interface User and Reference Guide.

Reversing copy direction from secondary to primary site

When host operations have been switched to the secondary site, restore the primary site and re-establish the Universal Replicator system from the secondary site to the primary site.

Procedure

1. Restore the primary system and data paths.
2. Bring up the host servers at the primary site.
3. Make sure that all components are operational.
4. Do all of the following, as applicable:
   a. At the primary site, locate P-VOLs whose status is COPY or PAIR. Locate corresponding S-VOLs at the secondary site whose status is SSWS, which indicates that data is being written to the S-VOLs. At the primary site, split these pairs.
   b. At the primary site, locate P-VOLs whose status is other than SMPL. Locate corresponding S-VOLs at the secondary site whose status is SMPL. At the primary site, release the pairs.
   c. At the primary site, locate pairs whose status is SMPL. At the secondary site, release the pairs.
5. On pairs that were split and in which S-VOL status is now SSWS, run the pairresync -swaps command. This reverses P-VOLs and S-VOLs and resynchronizes the pairs. The replication is from the secondary site to the (original) primary site.

   Note: When you run the pairresync -swaps command, you can use the -d option to specify a data volume. However, the command is rejected if the restore journal where the data volume belongs is in Active, Halting, or Stopping status.

6. For S-VOLs whose status is SMPL, re-create the Universal Replicator pairs specifying the S-VOLs as P-VOLs. This creates pairs in which P-VOLs and S-VOLs are reversed.
7. Verify that pair status of all new S-VOLs (which were originally P-VOLs) changes from COPY to PAIR. When the pair status is changed to PAIR, initial copy operations are finished and consistency is maintained.

Data in the secondary site is now reflected on the primary site.

Resuming host operations at the primary site

When Universal Replicator pairs are established in the reverse direction between the secondary and primary sites, you can return host operations to the original configuration. This means resuming host operations at the primary site and reestablishing the original flow of data from primary to secondary systems. The following procedure explains how to resume normal operations at the primary site.

Procedure

1. At both sites, make sure that all components are operational.
2. Make sure that pair status of all P-VOLs and S-VOLs in all Universal Replicator pairs is PAIR.
3. Stop host applications at the secondary site.
4. Issue a request for splitting pairs to master journals (these were originally the restore journals on the secondary site); use the Flush option when splitting pairs. If an error occurs when splitting pairs, fix the error, resume host operations at the secondary site, and then go back to step 1.
5. If no errors occur, wait until suspension finishes. After suspension finishes, check for an S-VOL on the primary site whose status is not PSUS. If such a pair exists, fix the error and go back to step 1 after resuming your business task at the secondary site.

6. When all S-VOLs at the primary site are in PSUS status, data in P-VOLs and S-VOLs are the same. S-VOLs at the primary site are ready for host read/write activity. Resume applications at the primary site.

7. Run the pairresync -swaps command, which reverses P-VOLs and S-VOLs and resynchronizes the pairs. The replication is from the primary site to the secondary site (disaster recovery site).

**Note:** When you run the pairresync -swaps command, you can use the -d option to specify a data volume. However, the command is rejected if the restore journal where the data volume belongs is in Active, Halting or Stopping status.

---

**Recovery for configurations with multiple primary systems and secondary systems**

This topic provides recovery procedures for configurations with multiple primary systems and secondary systems:

- [Switching from the primary to secondary site (multiple storage systems)](on page 9-5)
- [Transferring operations back to the primary site (multiple storage systems)](on page 9-6)

**Switching from the primary to secondary site (multiple storage systems)**

If a disaster or a failure occurs in the primary site in a configuration with multiple primary and secondary systems, the operation continues at the primary site, and data consistency within CCI CTG is maintained. If a disaster or a failure occurs at the primary site, switch the operation from the primary site to the secondary site first.

**Procedure**

1. Switch the operation from the primary site to the secondary site.
2. From the secondary site, specify the swap option to split the pair (pairsplit -RS).
3. Check if the UR S-VOLs of all storage systems at the secondary site are in the SSWS status.
4. Resume the operation at the secondary site using the data volume in the SSWS status of storage systems at the secondary site.
Transferring operations back to the primary site (multiple storage systems)

After operations at the secondary site have resumed, if the other failures are corrected, operations at the primary site can be resumed.

Procedure

1. Make sure that the status of the UR secondary volumes of all secondary systems are SSWS.
2. In the secondary site, specify the swap option to resynchronize the pairs (pairresync -swaps).
3. Switch operation from the secondary site to the primary site.
4. In the primary site, execute the horctakeover command.

Recovery for 3DC configurations with three UR sites

This topic provides recovery procedures for 3DC configurations with three UR sites:

- Recovery for 3 UR DC multi-target configuration (when the delta resync operation is performed) on page 9-6
- Recovery for 3 UR DC cascade configuration on page 9-12
- Recovery for 3DC cascade configuration with three UR sites on page 9-17

Recovery for 3 UR DC multi-target configuration (when the delta resync operation is performed)

In the event of a failure in the primary site, production operations are transferred from the primary site to a secondary site. After the failure is corrected, production operations can be transferred back to the primary site.

Both procedures are explained below. Use CCI for all operations.

**To move business operations to the secondary site**

1. Run the pairsplit -RS command on the pair at the alternative secondary site.
2. Check the execution result of the pairsplit -RS command.
3. Perform the delta resync operation by running the pairresync -swaps command on the delta resync pair.
4. Check the execution result of the pairresync -swaps command.
5. Check the following, and then use the P-VOL at the alternative secondary site to resume business operations:
   - P-VOL of the pair for delta resync at the secondary site changes to the P-VOL of the pair at the primary site.
- Status of the P-VOL for delta resync at the secondary site changes to PAIR.

To transfer business operation back to the primary site, remove the failures at the primary site and the other sites, and then perform the procedure below.

Run the pairsplit -RS command for the pair (mirror ID: M) at the secondary site, and check the result.

Run the pairsync -swaps command for the delta resync pair (mirror ID: P), and check the result.

Verify that the delta resync pair (mirror ID: P) is normal and that the pair status of each volume is PAIR.

Legend

- : normal pair    - - : split pair    - - - - - : delta resync pair
P: primary volume  S: secondary volume
PAIR, PSUS, PSUE, HOLD, SSWS: pair status in each site (Status on CCI)
To transfer business operations back to the primary site

1. Stop business operations at the secondary site.
2. If the secondary site to be reversed and the primary site pair is suspended, resynchronize the pair (pairresync -swaps), and then reverse the pair's primary and secondary volumes.
3. Run the pairsplit -RS command for the pair between the secondary site to be reversed and the primary site.
4. Run the pairresync -swaps in the primary site, which reverses the primary and the secondary volumes to restore and resynchronize the pair.
5. Check the execution result of pairresync -swaps.
6. Resume business operations at the primary site.
Run the `pairresync -swaps` command to replace the primary and secondary of the pair (mirror ID: M) after stopping the operation at the alternative secondary site.

Run the `pairsplit -RS` command for the pair (mirror ID: M) between the primary and alternative secondary sites.

Run the `pairresync -swaps` command for the delta resync pair (mirror ID: N), and check the result.

Legend:

- : normal pair
- : split pair
- : delta resync pair

- P: primary volume
- S: secondary volume

PAIR, PSUS, PSUE, HOLD, SSWS: pair status in each site (Status on CCI)

**Figure 9-1 Configuration when transferring business tasks from the UR secondary site to the primary site (delta resync operation is performed) (1 of 2)**
Figure 9-2 Configuration when transferring business tasks from the UR secondary site to the primary site (delta resync operation is performed) (2 of 2)

Requirements for performing delta resync in 3DC multi-target configuration with three UR sites

**Note:** In a 3DC multi-target configuration with three UR sites, you can perform the delta resync operation only by using CCI. The delta resync operation cannot be performed by using Device Manager - Storage Navigator.

To perform the delta resync operation successfully, the following requirements must be met. If a regular UR pair that does not meet the requirements exists in the journal, even if the UR delta resync pair meets all the requirements, the delta resync pair will be suspended by error.

- There is a UR pair with a mirror ID that is different from the UR delta resync pair in the same journal in the secondary site specified for the delta resync operation (the pairs with mirror ID P and M in Recovery for 3 UR DC multi-target configuration (when the delta resync operation is performed) on page 9-6).
• There is a UR pair with mirror ID that is different from the UR delta resync pair in the same journal in the UR delta resync pair's secondary site (the pairs with mirror ID P and N in Recovery for 3 UR DC multi-target configuration (when the delta resync operation is performed) on page 9-6).

• One of the two pairs is a UR delta resync pair (with the mirror ID P) in HOLD status, and the UR pair between the intermediate and secondary sites (with mirror ID N) is either PAIR, PSUS, or PSUE.

• All of the differential data of the P-VOL and S-VOL is stored in the master journal volume.

**Note:** If this condition is not met, delta resync terminates abnormally. If **Entire Copy** is selected for the **Delta Resync Failure** option (Edit Mirror Options window), this option becomes invalid, no operation is performed, and then the pair status is changed to HLDE. For details about delta resync options, see Edit Mirror Options window on page E-25.

• The path for the UR delta resync pair between the primary and secondary sites is valid.

• In all three sites, remote command device is allocated to the two mirror IDs.

If even one of the above requirements is not met, an error or suspend by error occurs, and the delta resync operation will fail. If the delta resync fails, check the following status. Especially in the following case, delta resync will not be performed because the journal data necessary for the delta resync does not exist.

• After the UR pair between the primary site and the reversed intermediate site is split, the restore journal volume data of the UR delta resync pair in the unreversed secondary site exceeds 70% of the volume capacity as a result of updating the volume in the reversed secondary site.

If the specified UR delta resync pair status is not changed after performing the delta resync operation, the conditions for the delta resync operation described in this section might not be met. In this case, check the status of the UR pair and UR delta resync pair again, and verify whether all of the conditions for the delta resync operation are met. Then execute the delta resync again.

**Note:**

• When the UR delta resync pair is changed to HLDE, you cannot change it back to HOLD by pair resync. Delete the UR delta resync pair, and then create the UR pair again.

• If a suspend by error occurred in the pair specified the delta resync right after performing the delta resync operation, check the pair status and perform the following operation:
  - For UR P-VOL, resync the UR pair that is in suspend by error.
  - For UR S-VOL, delete the UR pair that is in suspend by error, and then create the UR pair again.
Recovery for 3 UR DC cascade configuration

If a disaster occurs in the primary site, business operations can continue by switching operations from the primary site to the secondary or intermediate site.

For recovery instructions, see the following:

- Recovery when the primary site fails on page 9-12.
- Recovery when the intermediate site fails on page 9-15

For secondary site failures, business operations are not affected since the primary and intermediate sites are still operable. Recover the secondary site, and then set up the cascade pairs again.

Recovery when the primary site fails

Recovery operations consist of the following when a failure occurs in the primary site:

- Transfer host operations to the intermediate site.
- Restore the primary site failure and restart business operations.

To recover from primary site failure in a 3DC cascade

1. Run the horctakeover command on the primary-intermediate site pair.
2. Check the execution result.
3. When S-VOL status changes to SSWS status or changes to a P-VOL, start host operations to the volume.
Universal Replicator disaster recovery operations

Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
When you remove failures from the primary site, you can transfer business operations back to the primary site.

To transfer business operations back to the primary site (when the delta resync operation is performed)

1. Stop business tasks at the intermediate site.
2. If the primary-intermediate site pair is suspended, run the horctakeover command on the primary-intermediate site pair. The intermediate-secondary site pair is automatically suspended.
3. Resume business operations using the primary volume in the primary site.
4. Resynchronize the intermediate-secondary site pair.

Legend:

- : PAIR copying direction  
- : SSWS  
- : HOLD  

P: primary volume  
S: secondary volume  
JNL VOL: journal volume
Recovery when the intermediate site fails

Recovery operations consist of the following when a failure occurs in the intermediate site:

- Redirect production data backup
- Recover the intermediate site
- Re-create the cascade configuration

When an intermediate site fails, you need to perform delta resync for disaster recovery, using the primary-secondary site pair as the original pair and the intermediate-secondary site pair as the differential resync pair, to change back to the original cascading configuration.

**To redirect production data backup**, perform the delta resync operation between the primary site P-VOL and secondary site S-VOL.
After you remove failures from the intermediate site, you can set up the original cascade configuration.

**To restore the intermediate site and cascade configuration (when the delta resync operation is performed)**

1. If the primary-intermediate site pair is suspended, resynchronize the pair using the horctakeover command. After the resynchronization, the primary volume and secondary volume of the pair are reversed. The intermediate-secondary site pair is suspended automatically.
2. Delete the primary-secondary site delta resync pair. As a result of this operation, the intermediate-secondary site pair is also deleted.
3. Create a pair between the intermediate and secondary sites. Specify **Entire** for **Initial Copy**.
4. Create a delta resync pair between the primary and secondary sites.

---

**Legend**
- **PAIR copying direction**
- **SSWS**
- **HOLD**

- **P**: primary volume
- **S**: secondary volume
- **JNL VOL**: journal volume
Recovery when the primary-intermediate path fails

When the data path between the primary and intermediate sites fails, the status of journals in these sites might change to Stopping (with pair status changed to Suspending). Stopping status maintains journal data for a delta resync operation.

You can recover in either of the following ways:

- By correcting the problem then resyncing primary-intermediate sites.
- By performing the delta resync between primary-secondary sites

To recover by resynchronizing primary and intermediate sites

1. Delete the delta resync pair between the primary and secondary sites.
2. Confirm that the status of the journal between the primary and intermediate sites is changed to Stop.
3. Remove the path error.
4. Resync the pair between the primary and intermediate sites.

To recover using the delta resync between primary-secondary sites

1. Run the delta resync operation on the delta resync pair set up between the primary and secondary sites.
   This changes the journal status between the primary and intermediate sites.

Recovery for 3DC cascade configuration with three UR sites

- Recovery from primary site failure on page 9-17
- Recovery from intermediate site failure on page 9-18
- Requirements for performing delta resync in 3DC cascade configuration with three UR sites on page 9-18

Recovery from primary site failure

When a failure or disaster occurs in the primary site, business task will be transferred from the primary site to the intermediate site. After correcting the failure in the primary site, the business task will be transferred back to the primary site.

Use the following procedure to transfer host operations back to the primary site.

Procedure

1. Stop host operations at the intermediate site.
2. If the UR pair between the primary and intermediate sites are in suspend status, resync the pair by running the CCI horctakeover command. After the resync, UR P-VOL and S-VOL will be switched. The UR pair between the intermediate and secondary sites will be suspended automatically.
3. Resume host operations by using the P-VOL in the primary site.
4. Resync the UR pair between the intermediate and secondary sites.

**Recovery from intermediate site failure**

When a failure or disaster occurs in the intermediate site, data will be duplicated by connecting the primary and secondary sites. After the intermediate site is recovered, the system will be changed back to the original cascade configuration.

Use the following procedure to change the system back to the original cascade configuration.

**Procedure**

1. If the UR pair between the primary and intermediate sites is suspended, resync the pair.
2. Delete the pair between the primary and secondary sites. The UR delta resync pair between the intermediate and secondary sites will be deleted automatically.
3. Create a UR pair between the intermediate and secondary sites. Specify **Entire** when performing the initial copy operation.
4. To create the delta resync configuration, create a UR delta resync pair between the primary and the secondary sites.

**Requirements for performing delta resync in 3DC cascade configuration with three UR sites**

To perform delta resync operation successfully, the following requirements must be met. Note that the suspended by error will occur if a regular UR pair which does not meet the conditions exists in the journal, even if the UR delta resync pair meets all the requirements.

- There is a UR pair which has a different mirror ID than the UR delta resync pair in the same journal in the primary site (pairs with the mirror ID P and M shown in [3DC cascade configuration with three UR sites on page 1-19](#)).
- There is a UR pair which has a mirror ID different than the UR delta resync pair in the same journal in the UR delta resync pair's secondary site (pairs with the mirror ID P and N shown in [3DC cascade configuration with three UR sites on page 1-19](#)).
- Out of two pairs, one is UR delta resync pair (with the mirror ID P) and in HOLD status, and the other is the UR pair connecting the primary and intermediate sites and in PAIR or PSUE status.
- Out of two pairs, one is UR delta resync pair (with the mirror ID P) and in HOLD status, and the other is the UR pair connecting the intermediate and secondary sites (with the mirror ID P) and in PAIR, PSUS, or PSUE status.
- P-VOL and S-VOL's entire differential data is stored in the master journal volume.
• The path between the primary and secondary sites of the UR delta resync pair is valid.
• Remote command devices are allocated to the two mirror IDs in all the three sites.

If even one of the above requirements is not met, an error occurs and the delta resync operation will fail. Especially in the following cases, delta resync will not be performed because the journal data necessary for the delta resync does not exist.

• After the UR pair between the intermediate site and secondary site is split, the journal volume data of the UR pair between the primary and intermediate sites in the secondary site exceeds 70% of the volume capacity.
• After updating the UR delta resync P-VOL, the journal volume data of the UR delta resync pair in the primary site exceeds 70% of the volume capacity.

Setting options can prevent the error from occurring in the delta resync operations with the cascade configuration with three UR sites, by copying the entire P-VOL data to the S-VOL when entire differential data of the P-VOL and S-VOL is not stored in the master journal. For setting the UR delta resync operation options for the UR delta resync pairs, see Changing options used by journals on page 8-6.

If the specified UR delta resync pair status is not changed after performing the delta resync operation, the conditions for the delta resync operation described in this section might not be met. In this case, check the status of the UR pair and UR delta resync pair again and verify whether all of the conditions for the delta resync operation are met. Then execute the delta resync again.

**Note:** When the S-VOL of the UR delta resync pair is changed to HLDE, you cannot change it back to HOLD by pair resync. Delete the UR delta resync pair, and then create the UR pair again.

### Recovery for UR/SI configurations

See Configurations with ShadowImage S-VOLs on page D-4 for information about the configuration described in this procedure.

You resume host operations to the Universal Replicator S-VOL if a disaster or failure occurs at the primary site where the Universal Replicator P-VOL is shared with a ShadowImage (SI) S-VOL in PSUS status. Then you recover the primary site, and then you resume host operations.

**Procedure**

1. Release the SI pair using the pairsplit -S command.
2. Reverse the copy direction and resync the Universal Replicator pair using the horctakeover command.
3. Reverse the copy direction again on the Universal Replicator pair using the horctakeover command.
4. Delete the Universal Replicator pair using the pairsplit -S command.
5. Create a SI pair from the SI S-VOL to perform copying in the reverse direction. Use the paircreate command.
6. Release the SI pair using the pairsplit -S command.
7. Re-create the original SI pair from the original SI P-VOL to perform copying in the original direction. Use the paircreate command.
8. Split the SI pair using the pairsplit -r command.
9. Re-create the Universal Replicator pair using the paircreate command.

The system becomes the original configuration again.

**Recovery for UR/TC configurations**

The VSP G800, VSP F800, and VSP G1000 storage systems support combined UR/TC configurations. CCI is used for recovering UR/TC configurations.

**Recovery from primary site failure in a 3DC cascade configuration**

If a disaster or failure occurs, business tasks can be transferred by using the TC S-VOLS in the intermediate site. Therefore, if a disaster or failure occurs at the primary site, the first necessary recovery procedure is to switch business tasks from the primary site to the intermediate site. The following procedure explains how to resume business at the intermediate site.

**Procedure**

1. Analyze the consistency of TC S-VOLS at the intermediate site, and verify that the same data as the TC P-VOLs at the primary site is stored.
2. Perform the CCI horctakeover command to the TC pairs.
3. Wait until the status of the TC S-VOLS at the intermediate site changes to SSWS, or the TC S-VOLS become ready to be used as TC P-VOLs. When one of these conditions is met, you can resume business by using these volumes.
4. You can create a provisional disaster recovery configuration by using TC S-VOLS as UR P-VOLs.
   After the primary site is restored, select whether to re-create the 3DC cascade configuration or change to the 3DC multi-target configuration.

**Recovery from primary site failure in a 3DC multi-target configuration**

If a disaster or failure occurs only at the primary site in a 3DC multi-target configuration, you can resume business by using the S-VOL at the TC secondary site. After business tasks are transferred to the TC secondary site, remove the failure at the primary site, and prepare to transfer business tasks back to the primary site.
Use the following procedure to resume business at the TC secondary site.

**Procedure**

1. Delete the UR pairs to which a failure occurred by using the CCI pairsplit command.
2. Execute the CCI horctakeover command to the TC pairs.
3. Resume business at the TC secondary site by using the TC S-VOLs.
4. Check the result of the horctakeover command, and use either of the following procedures (a) or (b):
   
a. When the TC P-VOLs and S-VOLs are not switched and the copy direction is not changed, create UR pairs by using the volumes at the TC secondary site as the UR P-VOL and the volumes at the UR secondary site as the UR S-VOL. Use the CCI paircreate command to create UR pairs.

b. When the TC P-VOLs and S-VOLs are switched and the copy direction is reversed, re-create the UR pairs deleted in step 1. After the UR pairs are re-created, the system configuration is changed from 3DC multi-target to 3DC cascade.

Procedure (a): To transfer business tasks back to the primary site, first remove the failures at the primary and other sites, and then change the system to 3DC multi-target configuration by following the procedure in **Changing to the 3DC multi-target configuration after recovering the primary site on page 9-23**, and then follow the procedure in **Transferring business tasks from the TC secondary site back to the primary site (from 3DC multi-target) on page 9-23**.

Procedure (b): To transfer business tasks back to the primary site, first correct the failures at the primary and other sites, and then follow the procedure in **Transferring business tasks from the TC secondary site back to the primary site (from 3DC multi-target) on page 9-23**.
Universal Replicator disaster recovery operations

Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
Changing to the 3DC multi-target configuration after recovering the primary site

After performing the procedure in Recovery from primary site failure in a 3DC multi-target configuration on page 9-20, when the system is not changed to the 3DC cascade configuration, you can change the configuration to the 3DC multi-target using the TC S-VOL before the failure occurred as the P-VOL after correcting the failure occurred at the primary site. Use the following procedure to change the system to the 3DC multi-target configuration.

Procedure

1. By using the CCI pairresync command, resync the TC pairs and switch the P-VOLs and the S-VOLs.
2. When continuously transferring business tasks back to the primary site, follow the procedure in Transferring business tasks from the TC secondary site back to the primary site (from 3DC multi-target) on page 9-23.

Transferring business tasks from the TC secondary site back to the primary site (from 3DC multi-target)

When changing the system to the 3DC multi-target configuration by removing the failures at the primary and other sites (see Recovery from primary site failure in a 3DC multi-target configuration on page 9-20 and Changing to the 3DC multi-target configuration after recovering the primary site on page 9-23), you can resume business by using the following procedure.
Procedure

1. Delete the current UR pairs (from the TC secondary site to the UR secondary site) by using the CCI pairsplit command.
2. Stop the business task process at the TC secondary site.
3. Execute the CCI horctakeover command to the TC pairs.
4. Resume business at the primary site by using the P-VOLs at the primary site.
5. By using the CCI paircreate command, create the UR pairs. In this case, use the volumes at the primary site as the UR P-VOL and the volumes at the UR secondary volume as the UR S-VOL.

The system configuration will be changed back to the original 3DC multi-target configuration.
The configuration is a provisional 3DC multi-target making the TC secondary site as the business site.

- Delete the UR pairs that exist between the TC secondary site and the UR secondary site by using CCI. Stop the operations at the TC secondary site.

- Perform the horzakeover command to the TC pairs. Resume business at the primary site.

- Create UR pairs between the UR primary site and the UR secondary site by using CCI. The system will be changed back to the 3DC multi-target.

Legend:
- : Copy direction
- : Production site
- : CCI command execution target
Transferring business from the TC secondary site back to the primary site (from 3DC cascade)

When the system is changed to the 3DC cascade configuration by following the procedure in Recovery from primary site failure in a 3DC multi-target configuration on page 9-20, you can transfer business tasks back after removing the failures at the primary and other sites by using the following procedure.

Procedure

1. Stop business task process at the TC secondary site.
2. Execute the CCI horctakeover command to the TC pairs. The configuration is changed back to the original 3DC multi-target.
3. Resume business at the primary site by using the P-VOLs at the primary site.

When the copy direction is reversed by the CCI horctakeover command, the configuration is changed to the 3DC cascade when the primary site is recovered. To transfer business tasks back to the primary site, stop business at the TC secondary site.

Recovery from primary site failure in 3DC multi-target configuration (when performing delta resync)

When a disaster or failure occurs only at the primary site in the 3DC multi-target configuration, you can resume business by using the S-VOLs at the TC secondary site. After business tasks are transferred back to the TC secondary site, remove the failure at the primary site so that business tasks can be transferred back to the primary site.
**Procedure**

1. Execute the CCI horctakeover command to the TC pairs.
2. Resume business at the TC secondary site by using the TC S-VOLs.
3. Verify the result of the horctakeover command.
4. For either case when the TC P-VOLs and the S-VOLs are not switched and the copy direction is not reversed or the TC P-VOLs and the S-VOLs are switched and the copy direction is reversed, perform delta resync to the volumes at the TC secondary site by using the CCI pairresync command. When the delta resync is performed to the volumes at the TC secondary site, the UR volume status will become as described in the following table.

<table>
<thead>
<tr>
<th>UR pairs</th>
<th>Pair status before the delta resync</th>
<th>Pair status after the delta resync</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>P-VOL</td>
<td>S-VOL</td>
</tr>
<tr>
<td>1. UR pairs at the TC primary site and the UR secondary site</td>
<td>PAIR, PSUS, or PSUE</td>
<td>PAIR, PSUS, or PSUE</td>
</tr>
<tr>
<td>2. UR pairs at the TC secondary site and the UR secondary site</td>
<td>HOLD</td>
<td>HOLD</td>
</tr>
</tbody>
</table>

When continuously transferring business tasks back to the primary site, remove the failure at the primary and other sites.
Transferring business tasks from the TC secondary site back to the primary site (when performing delta resync in 3DC multi-target configuration)

When the failures at the primary site and other sites are corrected, you can transfer business back to the primary site.

**Procedure**

1. When the TC pairs are split by a failure, resync the pairs by using the CCI pairresync command, and switch the TC P-VOLs and the S-VOLs.
2. Stop business task process at the TC secondary site.
3. Execute the CCI horctakeover command to the TC pairs.
4. Resume business at the primary site by using P-VOLs at the primary site.
5. When delta resync is performed to the volumes at the TC primary site, the system configuration is changed back to the original 3DC multi-target, and the UR pair volume status becomes as described in the following table.

<table>
<thead>
<tr>
<th>UR pairs</th>
<th>Pair status before the delta resync</th>
<th>Pair status after the delta resync</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>P-VOL</td>
<td>S-VOL</td>
</tr>
<tr>
<td>1. UR pairs at the TC primary site and the UR secondary site</td>
<td>HOLD</td>
<td>HOLD</td>
</tr>
<tr>
<td>2. UR pairs at the TC secondary site and the UR secondary site</td>
<td>PAIR, PSUS, or PSUE</td>
<td>PAIR, PSUS, or PSUE</td>
</tr>
</tbody>
</table>

**Caution:** The UR pair status might not be changed to HOLD due to the failure when correcting the failure occurred at the primary site and transferring business tasks back to the 3DC multi-target configuration. When the P-VOL status at the primary site and the S-VOL status at the secondary site are both HOLD, the status is normal and you can transfer business tasks back to the primary site. When either one of the pair statuses is other than HOLD, business tasks cannot be transferred to the primary site. Perform the above procedure to transfer business tasks back to the primary site after performing corresponding operations according to the pair status described in the following table.

<table>
<thead>
<tr>
<th>Inconsistent pair status</th>
<th>Operation to remove the inconsistent pair status</th>
</tr>
</thead>
</table>
| The pair status at the primary site is COPY and the UR pair status at the secondary site is HOLD. | 1. Ensure that the pair status at the primary site becomes PSUE or PSUS.  
2. Delete the UR pairs from the primary site.  
3. Ensure that all of the pairs that belong to the target journal are deleted.  
4. Create UR delta resync pairs from the primary site to the UR secondary site. |
| The pair status at the primary site is PAIR, and the UR pair status at the secondary site is HOLD. | 1. Delete the UR pairs from the primary site.  
2. Ensure that all of the pairs that belong to the target journal at the primary site are deleted.  
3. Create UR delta resync pairs from the primary site to the secondary site. |
| The pair status at the primary site is PSUS, and the UR pair status at the secondary site is HOLD. | 1. Delete the UR pairs from the primary site.  
2. Ensure that all of the pairs that belong to the target journal at the primary site are deleted.  
3. Create UR delta resync pairs from the primary site to the secondary site. |
| The pair status at the primary site is PSUE, and the UR pair status at the secondary site is HOLD. | 1. Delete the UR pairs from the primary site.  
2. Ensure that all of the pairs that belong to the target journal at the primary site are deleted.  
3. Create UR delta resync pairs from the primary site to the secondary site. |
| The pair status at the primary site is HLDE, and the UR pair status at the secondary site is HOLD. | Change the pairs whose status is HLDE back to HOLD. When changing back, perform the pairsync. |
| The pair status at the primary site is SMPL, and the UR pair status at the secondary site is HOLD. | 1. Delete pairs whose status is HOLD from the UR secondary site.  
2. Create UR delta resync pairs from the primary site to the UR secondary site. |
During the operation with S-VOL at the TC secondary site

**TC/UR primary site**

Failure

#1

**TC secondary site**

The copy direction after performing the CCI horztakeover command depends on the situation.

**UR secondary site**

Restore JNL VOL

#2

S-VOL

**TC/UR primary site**

Failure

#1

**TC secondary site**

S-VOL

**UR secondary site**

Restore JNL VOL

#2

If the TC pair is split by the failure, switch the P-VOL and S-VOL by resynchronizing the TC pair after the primary site is recovered from the failure.

**TC/UR primary site**

UR pair status #1
P-VOL and S-VOL: HOLD
* When the status of either one of the UR pair #1’s volumes is not HOLD, an operation is necessary to correct the abnormal pair status.

**TC secondary site**

#1

**TC/UR primary site**

UR pair status #2
P-VOL and S-VOL: PAIR, PSUS, PSUE

**TC secondary site**

#1

**TC/UR primary site**

TC pair status #3
P-VOL and S-VOL: PAIR

**TC secondary site**

#1

Stop the operations at the TC secondary site. Perform the CCI horztakeover command to TC pair and transfer the volumes in the primary site back to the P-VOL.

**TC/UR primary site**

UR pair status #1
P-VOL and S-VOL: HOLD

**TC secondary site**

#1

**TC/UR primary site**

UR pair status #2
P-VOL and S-VOL: PAIR, PSUS, PSUE

**TC secondary site**

#1

**TC/UR primary site**

TC pair status #3
P-VOL and S-VOL: PAIR

**TC secondary site**

#1

Resume business at the primary site. UR pair will be transformed back to the original status when the delta resync operation to the volumes in the primary site is performed.

**TC/UR primary site**

UR pair status #1: COPY or PAIR
UR pair status #2: HOLD
TC pair status #3: PAIR

**TC secondary site**

#1

Legend:
- Copy direction
- Production site
- CCI command execution target
Recovery from a failure at the primary site and TC secondary site

When a disaster or failure occurs both at the primary site and TC secondary site in the 3DC multi-target configuration, you can resume business by using the S-VOLs at the UR secondary site. After transferring business tasks back to the UR secondary site, correct the failure at the primary site and TC secondary site so that business tasks can be transferred back to the primary site.

Transferring business to the UR secondary site

Use the following procedure to transfer business to the UR secondary site.

**Procedure**

1. Execute the CCI horctakeover command to the UR pairs.
2. Resume business by using the volumes at the UR secondary site.

Transferring business from the UR secondary site back to the primary site

After correcting the failure from the primary site and TC secondary site, use the following procedure to transfer business tasks back to the primary site.
Procedure

1. Split the TC pairs by using the CCI pairsplit command.
2. If the pair resync to switch the UR P-VOLs and the S-VOLs is not performed (UR pairs are split by failure), resync the pairs by using the CCI pairresync command and switch the P-VOLs and the S-VOLs. The original S-VOLs at the UR secondary site become the P-VOLs, and the original P-VOLs at the primary site become the S-VOLs.
3. Stop the business process at the UR secondary site.
4. Execute the CCI horctakeover command to the UR pairs. The UR P-VOLs and the S-VOLs will be switched.
5. Resume business at the primary site by using the P-VOLs at the primary site.
6. Resync the TC pairs by using the CCI pairresync command. The system configuration returns back to the 3DC multi-target.
Business is resumed at the UR secondary site by using the UR S-VOLs.

After removing the failure, split the TC pairs by the CCI command.

When you perform the horstakeover command to the UR pairs, if the UR P-VOLs and the S-VOLs are not switched, perform the CCI command and switch the P-VOLs and the S-VOLs. Stop business at the UR secondary site.

Perform the horstakeover command and switch the UR P-VOLs and the S-VOLs. Resume business at the primary site. Resync the TC pairs.

Legend:
- 
- : Copy direction
- Production site
- CCI command execution target
Recovery for UR/GAD configurations

You can set up UR/GAD configurations on the VSP G800 storage system.

For details about the recovery procedure for UR/GAD configurations, see the Global-Active Device User Guide.
This chapter provides troubleshooting information for Universal Replicator operations.

- General troubleshooting
- Remote path status problems
- Troubleshooting by suspension type
- Troubleshooting hardware problems affecting pairs
- Troubleshooting with CCI
- Service information messages (SIMs)
- Other troubleshooting
- Calling Hitachi Data Systems customer support
**General troubleshooting**

When an error occurs in a Universal Replicator pair operation, an error message with a four-digit error code and description is displayed. An SVP error code might also be included. See *Hitachi Device Manager - Storage Navigator Messages* for details on error codes.

You can download Device Manager - Storage Navigator dump files using the Dump tool. If you are unable to resolve an error, use the tool to copy the dump files to a file, and then contact Hitachi Data Systems customer support for assistance.

The following table provides general troubleshooting information for Universal Replicator.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Manager - Storage Navigator hangs, or Universal Replicator operations do not function properly.</td>
<td>Make sure that the problem is not being caused by the computer or Ethernet hardware or software, and restart the computer. Restarting the Device Manager - Storage Navigator computer does not affect Universal Replicator operations in progress. Make sure that Universal Replicator requirements are met. Make sure that the primary and secondary systems and remote copy connections are powered on, and that NVS and cache are fully operational. Check all of the entered values and parameters to make sure that you entered the correct information on the Device Manager - Storage Navigator computer (for example, secondary system serial number, path parameters, P-VOL and S-VOL IDs). If you are using Performance Monitor, refrain from using it.</td>
</tr>
<tr>
<td>An initiator channel-enable LED indicator (on the control window of the storage system) is off or flashing.</td>
<td>Please call Hitachi Data Systems customer support for assistance.</td>
</tr>
<tr>
<td>Status of pairs or remote paths is not displayed correctly.</td>
<td>Check whether you selected the correct items and options in the Device Manager - Storage Navigator windows.</td>
</tr>
<tr>
<td>A Universal Replicator error message appears on the Device Manager - Storage Navigator computer.</td>
<td>Remove the error cause, and then retry the Universal Replicator operation.</td>
</tr>
<tr>
<td>The status of a remote path is not normal.</td>
<td>Check the path status in the View Remote Connection Properties window, and see <em>Remote path status problems on page 10-3</em>.</td>
</tr>
<tr>
<td>The pair status is suspended.</td>
<td>Check the pair status in the View Pair Properties window, and see <em>Troubleshooting by suspension type on page 10-6</em> for suspend types and corrective action.</td>
</tr>
<tr>
<td>The create pair or resync pair operation resulted in a timeout error.</td>
<td>If the timeout error was caused by a hardware failure, a SIM is generated. See <em>Service information messages (SIMs) on page 10-25</em>. If necessary, call Hitachi Data Systems customer support, and retry Universal Replicator operations after the problem is solved. If no SIM was generated, wait for a while (5 or 6 minutes), and then check the status of the pairs being</td>
</tr>
<tr>
<td>Condition</td>
<td>Recommended action</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>created or resynchronized. If the pair status changed correctly, the failed operation completed after the timeout message was issued. If the pair status did not change as expected, heavy workload might have prevented the Universal Replicator operation from being completed. In this case, retry the Universal Replicator operation when the system has a lighter workload.</td>
<td>• If a timeout error occurs during the paircreate operation, the copy operation might not have been executed correctly in the order specified in the Priority field. A timeout error can be caused by a CU configuration or remote copy path error. Review the error, release the pair with the error, and then retry the paircreate operation.</td>
</tr>
<tr>
<td>A communication error between Device Manager - Storage Navigator and the SVP occurred.</td>
<td>See the <em>Hitachi Command Suite User Guide</em> for instructions.</td>
</tr>
<tr>
<td>Journal volumes are not registered in the journal</td>
<td>The error caused the delete journal operation to suspend. Re-register the journal volumes that belong to the journal, and then delete the journal again.</td>
</tr>
<tr>
<td>The pairresync operation suspends with a warning message.</td>
<td>This is caused when the following two conditions exist:</td>
</tr>
<tr>
<td></td>
<td>• The Preview list contains two or more pairs belonging to the same mirror.</td>
</tr>
<tr>
<td></td>
<td>• Mirror is defined in the Range column for at least one of the above pairs.</td>
</tr>
<tr>
<td></td>
<td>To continue processing, do either of the following:</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the Range column displays LU for all pairs in the same mirror.</td>
</tr>
<tr>
<td></td>
<td>• In the Preview list, delete all but one pair in the same mirror.</td>
</tr>
<tr>
<td>An error occurs when Apply is clicked for a pair operation.</td>
<td>The error code appears in the right-most column of the Preview list. To view detailed information about the error, right click the error code and select Error Detail.</td>
</tr>
<tr>
<td>The pairs cannot be deleted after the pair operations because the pair status changed to Suspending or Deleting.</td>
<td>See <a href="#">Deleting the pairs in a mirror on page 6-15</a> and specify Force for Delete Mode.</td>
</tr>
</tbody>
</table>

**Remote path status problems**

The following table provides troubleshooting information for remote paths between storage systems.

<table>
<thead>
<tr>
<th>Path status</th>
<th>Description</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>This path has been successfully established and can be used for UR copy activities.</td>
<td>None required.</td>
</tr>
<tr>
<td>Path status</td>
<td>Description</td>
<td>Recommended action</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Initialization</td>
<td>Failed</td>
<td>• Make sure that the primary and secondary systems are physically and correctly connected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that you entered the correct secondary system serial number, model, and primary and secondary system port numbers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that the topology settings (fabric, FC-AL, point-to-point) for the local storage system's port and the remote storage system's port are correct.</td>
</tr>
<tr>
<td>Communication</td>
<td>Time Out</td>
<td>• Make sure the secondary system is powered on and that cache is fully functional.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that network relay devices are properly configured and functional. This includes cables, connectors, switches, extender devices, communication lines, and all other devices connected to the extenders.</td>
</tr>
<tr>
<td>Port Rejected</td>
<td></td>
<td>• Delete all paths and secondary systems not in use.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reconfigure the ports, and then add the paths and configure the secondary systems to the primary systems again.</td>
</tr>
<tr>
<td>Pair-Port Rejected</td>
<td></td>
<td>Follow the same corrective actions in Port Rejected.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Mismatch</td>
<td>• Make sure that you entered the correct secondary system serial number and model, and primary and secondary system port numbers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that the topology settings (fabric, FC-AL, point-to-point) for the local storage system's port and the remote storage system's port are correct.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that the data path relay equipment is properly configured and functional, including cables, connectors, switches, extender devices, communication lines, and all other devices connected to the extenders.</td>
</tr>
<tr>
<td>Path status</td>
<td>Description</td>
<td>Recommended action</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invalid Port Mode</td>
<td>The specified port is not configured, or this path already exists.</td>
<td>• Make sure that no two paths between primary and secondary system ports have the same settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that you entered the correct secondary system serial number and model, and primary and secondary system port numbers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that the primary and secondary system ports are configured correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure that the data path relay equipment is properly configured and functional, including cables, connectors, switches, extender devices, communication lines, and all other devices connected to the extenders.</td>
</tr>
<tr>
<td>Communication</td>
<td>The primary system connected to the secondary system successfully, but logical communication timeout occurred.</td>
<td>• Make sure that the secondary system port and the relay equipment are configured correctly.</td>
</tr>
<tr>
<td>Failed</td>
<td></td>
<td>• Make sure that the data path relay equipment is properly configured and functional, including cables, connectors, switches, extender devices, communication lines, and all other devices connected to the extenders.</td>
</tr>
<tr>
<td>In Progress</td>
<td>Paths are being created or deleted, or the port attribute is being changed.</td>
<td>Wait until processing is completed.</td>
</tr>
<tr>
<td>Logical Blockade</td>
<td>Blockaded due to continual path or link failure.</td>
<td>See the following.</td>
</tr>
<tr>
<td></td>
<td>The primary system port does not work.</td>
<td>Repair the port on the primary system, and then restore the path*.</td>
</tr>
<tr>
<td></td>
<td>The secondary system port does not work.</td>
<td>Repair the port on the secondary system, and then restore the path*.</td>
</tr>
<tr>
<td></td>
<td>The path relay equipment does not work.</td>
<td>Repair the path relay equipment, and then restore the path*.</td>
</tr>
<tr>
<td></td>
<td>The connection cable is physically broken.</td>
<td>Replace the broken cable, and then restore the path*.</td>
</tr>
<tr>
<td>Program Error</td>
<td>A program error is detected.</td>
<td>Restore the path*.</td>
</tr>
</tbody>
</table>

* To restore a path, delete and then add the path again. It might be necessary to delete and then add the secondary system again.

To delete the secondary system or path, see Deleting the Universal Replicator relationship on page 8-17 or Deleting remote paths on page 8-16. To re-register, see Troubleshooting 10-5.
<table>
<thead>
<tr>
<th>Suspend type</th>
<th>Applies to</th>
<th>Description</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSUE, by RCU</td>
<td>P-VOL</td>
<td>The primary system suspended a pair because it detected an error condition in the secondary system. The suspend type for the S-VOL is by MCU.</td>
<td>Clear the error condition at the secondary system or S-VOL. If you need to access the S-VOL, release the pair from the primary system. If data in the S-VOL has been changed, release the pair from the primary system and then re create the pair by using the paircreate dialog box. If data in the S-VOL has not been changed, resynchronize the pair from the primary system.</td>
</tr>
<tr>
<td>PSUE, S-VOL Failure</td>
<td>P-VOL</td>
<td>The primary system detected an error during communication with the secondary system or detected an I/O error during update copy. In this case, the suspend type for the S-VOL is usually by MCU.</td>
<td>Check the path status on the DKC Status dialog box (see Remote path status problems on page 10-3). Clear any error conditions at the secondary system and the S-VOL. If you need to access the S-VOL, release the pair from the primary system and then re create the pair by using the paircreate dialog box. If data in the S-VOL has not been changed, resynchronize the pair from the primary system.</td>
</tr>
<tr>
<td>PSUE, MCU IMPL</td>
<td>P-VOL, S-VOL</td>
<td>The primary system could not find valid control information in its nonvolatile memory during the IMPL procedure. This error occurs only if the primary system is without power for more than 48 hours (power failure and fully discharged batteries).</td>
<td>Resynchronize the pair from the primary system. The primary system performs an initial copy operation in response to the pairresync request, so that the entire P-VOL is copied to the S-VOL.</td>
</tr>
<tr>
<td>PSUE, Initial Copy Failed</td>
<td>P-VOL, S-VOL</td>
<td>The primary system suspended this pair during the initial copy operation. The data on the S-VOL is not identical to the data on the P-VOL.</td>
<td>Release the pair from the primary system. Clear all error conditions at the primary system, P-VOL, secondary system, and S-VOL. Restart the initial copy operation by using the Create UR Pairs window.</td>
</tr>
<tr>
<td>Suspend type</td>
<td>Applies to</td>
<td>Description</td>
<td>Recommended action</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PSUE, MCU P/S OFF</td>
<td>S-VOL</td>
<td>The primary system suspended all Universal Replicator pairs because the primary system was powered off.</td>
<td>None. The primary system automatically resynchronizes these Universal Replicator pairs when the primary system is powered on.</td>
</tr>
</tbody>
</table>

**Troubleshooting hardware problems affecting pairs**

The following table provides troubleshooting information for hardware failures affecting Universal Replicator. In addition to the problems described below, hardware failures that affect cache memory and shared memory can cause pairs to be suspended.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Causes of suspension</th>
<th>SIM</th>
<th>Recovery procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary or secondary system hardware</td>
<td>Hardware redundancy has been lost due to some blockade condition. As a result, one of the following could not complete: primary-secondary system communication, journal creation, copy operation, resynchronize operation, staging process, or de-staging process. Journals cannot be retained because some portion of the cache memory or the shared memory has been blocked due to hardware failure. The primary system failed to create and transfer journals due to unrecoverable hardware failure. The secondary system failed to receive and restore journals due to unrecoverable hardware failure. The drive parity group was in correction-access status while the UR pair was in COPY status.</td>
<td>dc0x   dc1x dc2x</td>
<td>Depending on the SIM, remove the hardware blockade or failure. Resynchronize the failed pairs. If a failure occurs during execution of the CCI horctakeover command, S-VOLs in SSWS pair status might remain in the master journal. If these volumes remain, execute the pairresync -swaps command on the S-VOLs whose pair status is SSWS (pairresync is the CCI command for resynchronizing pair and -swaps is a swap option). This operation changes all volumes in the master journal to primary volumes. After this operation, resynchronize the pairs.</td>
</tr>
<tr>
<td>Communication between the primary and secondary systems</td>
<td>Communication between the systems failed because the secondary system or network relay devices were not running. Journal volumes remained full even after the timeout period had elapsed.</td>
<td>dc0x   dc1x</td>
<td>Remove the failure from the primary and secondary systems or the network relay devices. If necessary, increase resources as needed (for example, the amount of cache, the number of paths between primary and secondary systems, the parity groups for journal volumes, etc.). Resynchronize the failed pairs.</td>
</tr>
<tr>
<td>Classification</td>
<td>Causes of suspension</td>
<td>SIM</td>
<td>Recovery procedure</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RIO overload or RIO failure</td>
<td>An unrecoverable RIO (remote I/O) timeout occurred because the system or network relay devices were overloaded. Or, RIO could not be finished due to a failure in the system.</td>
<td>dc2x</td>
<td>Release failed pairs (pairsplit-S). If necessary, increase resources as needed (for example, the amount of cache, the number of paths between primary and secondary system, the parity groups for journal volumes, etc.). Re-create failed pairs.</td>
</tr>
<tr>
<td>Planned power outage to the primary system</td>
<td>The UR pairs were temporarily suspended due to a planned power outage to the primary system.</td>
<td>dc8x</td>
<td>No recovery procedure is required. The primary system automatically removes the suspension condition when the system is powered on.</td>
</tr>
</tbody>
</table>

**Troubleshooting with CCI**

When an error has occurred in Universal Replicator pair operation when using CCI, you can identify the cause of the error by referring to the CCI operation log file. The file is stored in the following directory by default:

/HORCM/log*/curlog/horcmlog_HOST/horcm.log

Where:

- * is the instance number.
- HOST is the host name.

To identify the error code in the log file, open the CCI log file, and find the error code.

Example: 11:06:03-37897-10413- SSB = 2E31, 3703

Error codes appear on the right of the equal symbol (=). The alphanumeric characters on the left of the comma(,) indicates SSB1 (for example, 2E31), and on the right of the comma (,) indicates SSB2 (for example, 3703).

The following tables describe the CCI error codes for Universal Replicator.

**CCI error codes for UR: SSB1 = 2E31, B901, B9E0, B9E1, B9E2, B9E4, D004**

<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3703</td>
<td>A request of UR Pairresync to change the pair status from HLDE to HOLD was rejected because the PIN data exists in the journal volume.</td>
</tr>
<tr>
<td>3704</td>
<td>A request of UR Paircreate was rejected because the emulation types of the specified master journal and of the restore journal are different.</td>
</tr>
<tr>
<td>Error code (SSB2)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>3705</td>
<td>A request of UR Paircreate or UR Pairresync for delta resync was rejected because the version of the secondary storage system does not support the corresponding command.</td>
</tr>
<tr>
<td>3706</td>
<td>A request of UR Paircreate for delta resync was rejected because the specified P-VOL was used as the S-VOL of TrueCopy, and the pair status is not PAIR.</td>
</tr>
</tbody>
</table>
| 3707             | A request of UR Pairresync for delta resync was rejected because of the one of following reasons.  
• The specified P-VOL was the P-VOL of TrueCopy, and the UR pair status was not PAIR.  
• The specified P-VOL was the S-VOL of TrueCopy, and the UR pair status was not SSWS. |
<p>| 3708             | The Universal Replicator pair cannot be created because the specified P-VOL was being shredded. |
| 3709             | A request of UR Paircreate or UR Pairresync for delta resync was rejected because the specifying of the restore journal was incorrect. |
| 370B             | The UR pair cannot be resynchronized (DELTAJNL parameter specifying), because the specified P-VOL is not in the either of HOLD or HOLDRTRANS status. Or, the UR pair cannot be resynchronized (ALLJNL parameter specifying), because the specified P-VOL is not in the either of HOLD, HOLDRTRANS, or NODELTA status. |
| 370C             | A request of Paircreate or Pairresync for a Universal Replicator pair was rejected because the status of the specified master journal or restore journal could not be changed, or the status transition was in progress. |
| 371C             | A request for a UR Paircreate or UR Pairresync was rejected because the TrueCopy pair was either in the status other than suspending or was not used in the 2DC configuration. |
| 3722             | The Paircreate command was rejected because the emulation type of the selected volume is unsupported. |
| 3728             | The Paircreate command was rejected because it was connected with the old model and the specified volume was unsupported. |
| 3729             | A request for UR Paircreate was received. However, the pair could not share the volume with TrueCopy because the Remote Replication Extended program product is not installed in the primary storage system. |
| 372B             | A pair cannot be created because the secondary system does not support the combination of multiple primary and secondary systems. |
| 372C             | The volume is inaccessible because the P-VOL is blocked. |
| 372E             | A request to create or resynchronize a pair in the system that consists of multiple primary and secondary storage systems was rejected because the Remote Replication Extended program product is not installed in the primary storage system. |
| 3737             | The UR pair operation failed because the status of the pair of the other mirror is not settled in the configuration where three UR sites are combined. |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3738</td>
<td>A request for UR pair creation was rejected because the Remote Replication Extended program product was not installed in the primary system.</td>
</tr>
<tr>
<td>3739</td>
<td>The command was rejected because the journal to which the specified S-VOL belongs does not allow the configuration where three UR sites are combined.</td>
</tr>
</tbody>
</table>
| 373D             | A UR pair or a UR pair for delta resync cannot be created. The P-VOL for the pair must meet the following conditions:  
  • A consistency group is not shared among multiple local storage systems and remote storage systems.  
  • The volume is not combined with TrueCopy.  
  • The volume is not combined with global-active device.  
  • The volume is not combined with Volume Migration. |
| 373E             | The pair operation failed because the status of a mirror in the journal in which the specified S-VOL belongs is other than Initial or Stopped. |
| 3744             | A UR pair or a UR pair for delta resync cannot be created. The S-VOL for the pair must meet the following conditions:  
  • A consistency group is not shared among multiple local storage systems and remote storage systems.  
  • The volume is not combined with TrueCopy.  
  • The volume is not combined with global-active device.  
  • The volume is not combined with Volume Migration. |
| 3745             | A request to create a UR pair between the primary site and the intermediate site in a cascade configuration where three UR sites are combined was received. However, the command was rejected since the journal to which the P-VOL belongs does not allow the configuration. |
| 3747             | In the configuration where three UR sites are combined, a request of UR pair resync (journal resync mode) was received. However, since the volume status was being changed, the command was rejected. |
| 3748             | The delta resync pair cannot be created because the status of the pair with the delta resync P-VOL is not PAIR. |
| 3749             | The delta resync cannot be executed because the status of the pair with the delta resync P-VOL does not meet the following requirements:  
  • The volume is the UR P-VOL and the pair status is PAIR, PSUS, PSUE, or SSWS.  
  • The volume is the UR S-VOL and the pair status is SSWS. |
<p>| 374B             | The pair cannot be created because the volume specified as the P-VOL is used as an external volume for nondisruptive migration and Cache Through is set as the cache mode. |
| 374D             | The pair cannot be created because the volume specified as the P-VOL is used as an external volume for nondisruptive migration and also used as a volume for a Volume Migration pair. |
| 3752             | The pair cannot be created because of one of the following: |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3755</td>
<td>The command was rejected because the specified S-VOL is used as an S-VOL in another mirror, and the pair status is not in SSWS status.</td>
</tr>
<tr>
<td>3756</td>
<td>The pair cannot be created because the secondary system does not support the Path Group ID, which was specified as other than 0.</td>
</tr>
<tr>
<td>3759</td>
<td>UR or UR delta resync pair creation failed because the remote storage system does not support the combined configuration of GAD function and UR function.</td>
</tr>
<tr>
<td>375A</td>
<td>The specified secondary system does not support global virtualization.</td>
</tr>
<tr>
<td>375B</td>
<td>The specified primary system does not support global virtualization.</td>
</tr>
<tr>
<td>375C</td>
<td>The pair cannot be created because no virtual LDEV ID is set for the volume specified as the P-VOL.</td>
</tr>
<tr>
<td>375D</td>
<td>The pair cannot be created because no virtual LDEV ID is set for the volume specified as the S-VOL.</td>
</tr>
<tr>
<td>37566</td>
<td>The pair cannot be created because the volume specified as P-VOL is used in a GAD pair.</td>
</tr>
<tr>
<td>37567</td>
<td>The pair cannot be created because the volume specified as S-VOL is used in a GAD pair.</td>
</tr>
<tr>
<td>37568</td>
<td>The pair cannot be created because the volume specified as P-VOL is a GAD reserve volume.</td>
</tr>
<tr>
<td>37569</td>
<td>The pair cannot be created because the volume specified as S-VOL is a GAD reserve volume.</td>
</tr>
<tr>
<td>3756A</td>
<td>The internal process to secure tier memory difference has timed out. Wait 5 minutes, and then retry the operation. If this error occurs again, use Performance Monitor to find and resolve the specific problem. If retrying does not work, contact Hitachi Data Systems customer support.</td>
</tr>
</tbody>
</table>
| 3756B            | A UR pair cannot be created or resynchronized because the bitmap areas are not available for one of the following reasons:  
• There is not enough free space in the shared memory on the primary system.  
• There is not enough free space in the pool of the DP-VOL specified as the P-VOL. |
| 377B             | UR pair creation failed. The P-VOL of the specified UR pair must be the P-VOL of the GAD pair, and the pair status must be PAIR. |
| 377C             | UR pair creation or UR delta resync pair creation failed because the specified mirror ID is used for a GAD pair. |
| 377D             | UR pair creation or UR delta resync pair creation failed because of one of the following:  
• The GAD pair that is combined with the specified P-VOL does not belong to a consistency group. |
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>377E</td>
<td>UR pair creation or UR delta resync pair creation failed because the specified journal is combined with another GAD consistency group.</td>
</tr>
<tr>
<td>377F</td>
<td>The UR delta resync pair could not be created, or the UR pair waiting for delta resync could not be resynchronized.</td>
</tr>
</tbody>
</table>
| 3789              | UR delta resync pair creation failed. The P-VOL and S-VOL of the specified UR delta resync pair must meet both of the following conditions:  
  • The P-VOL of the UR delta resync pair is also used as the P-VOL of a GAD pair.  
  • The S-VOL of the UR delta resync pair is also used with the UR pair that is created in another mirror. |
| 378A              | UR pair creation failed. The following two volumes that are combined with the P-VOL and S-VOL of the specified UR pair must match:  
  • The S-VOL of the GAD pair that is combined with the P-VOL of the specified UR pair.  
  • The P-VOL of the UR delta resync pair that is combined with the S-VOL of the specified UR pair. |
| 378B              | Delta resync failed because the number of UR pairs and UR delta resync pairs are different in the restore journal. Due to the delta resync failure, the UR delta resync pair that is not combined with UR pair was deleted automatically. |
| 378C              | Delta resync failed because the status of the GAD pair that is combined with the specified P-VOL is not SSWS. |
| 378D              | Resynchronization failed because of one of the following:  
  • The GAD pair status is not PAIR, COPY, PSUS, PSUE, or SSWS.  
  • The status of the UR delta resync pair is not HLDE. |
| 37A0              | UR delta resync pair creation failed. The P-VOL of the specified UR delta resync pair must meet one of the following conditions:  
  • The specified P-VOL is the S-VOL of the GAD pair, and the pair status is PAIR.  
  • The specified P-VOL is the P-VOL of the GAD pair, and the I/O mode is Block. |
| 37A1              | UR delta resync pair creation failed. The following two volumes that are combined with the P-VOL and S-VOL of the specified UR delta resync pair must match:  
  • The S-VOL of the GAD pair that is combined with the P-VOL of the specified UR delta resync pair.  
  • The P-VOL of the UR pair that is combined with the S-VOL of the specified UR delta resync pair. |
<p>| 37AE              | In a cascade configuration where the three UR sites are combined, the request to create a UR pair between the primary and intermediate sites was received. However, the command was rejected because another mirror to which the intermediate site belongs in the journal is used as the P-VOL for the UR pair between the intermediate and secondary sites. |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>37AF</td>
<td>Pair creation failed because the volume specified as the P-VOL is a pool volume.</td>
</tr>
<tr>
<td>37B2</td>
<td>Pair creation failed because the volume specified as the P-VOL is an external volume of which data direct mapping attribute is enabled.</td>
</tr>
<tr>
<td>37B3</td>
<td>Pair creation failed because the attribute of the volume specified as the P-VOL is invalid.</td>
</tr>
<tr>
<td>37B6</td>
<td>Pair creation failed because the data direct mapping attribute of the volume specified as the P-VOL is enabled, and the function of the R-DKC firmware version for mapping external volumes larger than 4 TB is not supported.</td>
</tr>
<tr>
<td>37B7</td>
<td>UR pair operation failed. T10 PI attribute settings of the P-VOL and of the S-VOL are different.</td>
</tr>
<tr>
<td>8C19</td>
<td>The pair cannot be created because the specified CTG ID is out of range of supporting.</td>
</tr>
<tr>
<td>8C1A</td>
<td>The pair cannot be created or resynchronized because the specified journal ID is incorrect.</td>
</tr>
<tr>
<td>8C1B</td>
<td>The pair cannot be created because the specified journal ID is out of range of supporting.</td>
</tr>
</tbody>
</table>
| 8C1E             | The pair cannot be created because of the one of following reasons:  
|                  | - The firmware version of the specified primary system does not support connection with the specified secondary system.  
|                  | - The specified primary system does not support connection with the specified secondary system. |
| 8C1F             | The pair cannot be created because the virtual ID is not set for the specified S-VOL. |
| 8C20             | The request to update options was rejected because the specified journal ID or mirror ID is incorrect. |
| 8F00             | The pair cannot be created because the specified volume was an external volume. |
| 8F04             | The command was rejected because an internal logical error occurred. |
| 8F10             | The pair operation failed because the specified P-VOL is one of the following:  
|                  | - An SI S-VOL that is not in PSUS status  
<p>|                  | - An SI volume in Reverse Copy status. |
| 8F11             | The pair cannot be created. The processing of volume migration could not be stopped because the P-VOL was being migrated by Volume Migration. |
| 8F17             | The pair cannot be created because the specified volume was in the state of online from the host. |
| 8F18             | The pair cannot be created because the specified volume was used in a pair on another program product. |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8F19</td>
<td>The pair cannot be created because the emulation type of the specified volume was unusable.</td>
</tr>
<tr>
<td>8F1B</td>
<td>The pair cannot be created because the specified P-VOL is already paired.</td>
</tr>
<tr>
<td>8F1C</td>
<td>The pair cannot be created because the specified P-VOL is not in the PSUS status.</td>
</tr>
<tr>
<td>8F1E</td>
<td>The Universal Replicator pair cannot be created because cache or shared memory is undergoing restoration.</td>
</tr>
<tr>
<td>8F1F</td>
<td>The Universal Replicator pair cannot be created because cache or shared memory is blocking.</td>
</tr>
<tr>
<td>8F21</td>
<td>The pair cannot be created or resynchronized because of the one of following reasons.</td>
</tr>
<tr>
<td></td>
<td>• The specified volume was a TC P-VOL.</td>
</tr>
<tr>
<td></td>
<td>• Unavailable configuration of the status transition.</td>
</tr>
<tr>
<td>8F24</td>
<td>The pair cannot be created because a path between the devices was not created.</td>
</tr>
<tr>
<td>8F25</td>
<td>The pair cannot be created or resynchronized because PIN was existed in the specified volume.</td>
</tr>
<tr>
<td>8F28</td>
<td>The pair cannot be created or resynchronized because it could not access to the specified P-VOL or S-VOL.</td>
</tr>
<tr>
<td>8F29</td>
<td>The pair cannot be created because the specified master journal was unusable.</td>
</tr>
<tr>
<td>8F2B</td>
<td>The pair cannot be created because the protect attribute of the Data Retention Utility was set for the specified P-VOL.</td>
</tr>
<tr>
<td>8F33</td>
<td>The pair cannot be created because the specified volume was used in a pair on the TrueCopy or the ShadowImage.</td>
</tr>
<tr>
<td>8F35</td>
<td>The command to create or resync a UR pair was rejected because the physical volume with the specified P-VOL is blocked.</td>
</tr>
<tr>
<td>8F38</td>
<td>The following programs might not be installed, or the licenses might be expired. Please confirm settings for:</td>
</tr>
<tr>
<td></td>
<td>• TrueCopy</td>
</tr>
<tr>
<td></td>
<td>• Universal Replicator</td>
</tr>
<tr>
<td>8F39</td>
<td>The pair cannot be created because the program product of Universal Replicator is not installed.</td>
</tr>
<tr>
<td>8F46</td>
<td>The pair cannot be created because cache CL2 is in abnormal status.</td>
</tr>
<tr>
<td>8F47</td>
<td>The pair cannot be created because cache CL1 is in abnormal status.</td>
</tr>
<tr>
<td>8F4D</td>
<td>The pair cannot be created or resynchronized due to the following contributing factors:</td>
</tr>
<tr>
<td></td>
<td>• A journal is not registered in the secondary system.</td>
</tr>
<tr>
<td></td>
<td>• A volume in the journal which is registered in the secondary system is blocked.</td>
</tr>
<tr>
<td>Error code (SSB2)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>8F50</td>
<td>The pair cannot be created or resynchronized because the load of the processing was high. Wait about 5 minutes, and then retry the operation.</td>
</tr>
<tr>
<td>8F53</td>
<td>The pair cannot be created because the status of the configuration could not be transited.</td>
</tr>
<tr>
<td>8F58</td>
<td>The pair cannot be created or resynchronized because of the one of following reasons. - The pair status of the specified S-VOL differed from the one of P-VOL. - The state of restore journal differed from the state of master journal.</td>
</tr>
<tr>
<td>8F67</td>
<td>The pair cannot be created because the specified secondary system did not support the external volume.</td>
</tr>
<tr>
<td>8F6D</td>
<td>The pair cannot be created because the specified volume was a command device.</td>
</tr>
<tr>
<td>8FEA</td>
<td>The pair cannot be created because the P-VOL is used for Thin Image.</td>
</tr>
<tr>
<td>8FEC</td>
<td>The pair cannot be created because the P-VOL is used for Thin Image.</td>
</tr>
<tr>
<td>9100</td>
<td>The command cannot be executed because user authentication is not performed.</td>
</tr>
<tr>
<td>B91B</td>
<td>The required shared memory for operating Universal Replicator is not installed.</td>
</tr>
<tr>
<td>B992</td>
<td>The information of the consistency group cannot be retrieved, because Universal Replicator was not installed.</td>
</tr>
<tr>
<td>B9C0</td>
<td>The source of command devise has run out. Set to OFF the command device and to ON again from the LUN Manager.</td>
</tr>
</tbody>
</table>

**CCI error codes for Universal Replicator**

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSB1=B9E1, SSB2=B901</td>
<td>The pair cannot be created because the specified device is a command device.</td>
</tr>
<tr>
<td>SSB1=B9E2, SSB2=B901</td>
<td>The pair cannot be deleted because the mirror ID is invalid.</td>
</tr>
</tbody>
</table>

**CCI error codes for Universal Replicator: SSB1 = B901, B9E0, B9E1, B9E2, B9E4, D004**

<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B900</td>
<td>A status of Universal Replicator pair was acquired at the time of unavailable to use the Universal Replicator during the power-on. Retry the operation.</td>
</tr>
<tr>
<td>Error code (SSB2)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>B902</td>
<td>The pair cannot be created because the mirror ID is invalid.</td>
</tr>
<tr>
<td>B907</td>
<td>The command was rejected because the volume was unpaired.</td>
</tr>
<tr>
<td>B909</td>
<td>The command was rejected because the mirror ID is invalid.</td>
</tr>
<tr>
<td>B90A</td>
<td>The S-VOL hide mode is not supported.</td>
</tr>
<tr>
<td>B90D</td>
<td>The command was rejected because the Universal Replicator program product is not installed.</td>
</tr>
<tr>
<td>B90E</td>
<td>The command was rejected because the path is not set between the systems.</td>
</tr>
<tr>
<td>B910</td>
<td>The settings of the journal option could not be updated.</td>
</tr>
<tr>
<td>B912</td>
<td>The command was rejected because no journal was registered.</td>
</tr>
<tr>
<td>B913</td>
<td>The command was rejected because the system configuration does not allow these operations.</td>
</tr>
<tr>
<td>B920</td>
<td>The pair cannot be created because the system identifier is not correct (left-most number in the 6-digit serial number).</td>
</tr>
<tr>
<td>B94B</td>
<td>The command was rejected because the Universal Replicator configuration was changed. Check the status of the Universal Replicator pair.</td>
</tr>
<tr>
<td>B9F8</td>
<td>The command was rejected because no journal was registered.</td>
</tr>
<tr>
<td>DB02</td>
<td>A request for status change was rejected because the status could not be changed (for example: the pair volumes were not unpaired when the Paircreate was requested; or were in a status other than PSUS when the Pairresync was requested.)</td>
</tr>
<tr>
<td>DB03</td>
<td>A request of Universal Replicator pair status transition was rejected because the pair was in the state of Suspending or Deleting.</td>
</tr>
<tr>
<td>DB07</td>
<td>Universal Replicator pair status cannot be transited during the power-on processing.</td>
</tr>
<tr>
<td>DB08</td>
<td>Universal Replicator pair status cannot be transited during the power-off processing.</td>
</tr>
<tr>
<td>E843</td>
<td>The command was rejected because the CLPR ID of the specified volume differed from the CLPR ID of the journal.</td>
</tr>
<tr>
<td>E866</td>
<td>The specified consistency group ID is already used.</td>
</tr>
<tr>
<td>E869</td>
<td>The operation cannot be performed because the specified restore journal was used in another mirror and the mirror status was Stopping. Retry the operation after the mirror status is changed to a status other than Stopping.</td>
</tr>
<tr>
<td>E86E</td>
<td>You cannot use as data volume because shared memory is not implemented for specified LDEV number.</td>
</tr>
<tr>
<td>E871</td>
<td>The command was rejected because the path between the storage devices for the both-way was not defined. Check whether the bidirectional normal path was defined or not.</td>
</tr>
<tr>
<td>Error code (SSB2)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>E87B</td>
<td>The command was rejected because the specified journal was unregistered.</td>
</tr>
<tr>
<td>E87C</td>
<td>Journal volume is not registered in the specified journal.</td>
</tr>
<tr>
<td>E87D</td>
<td>The command was rejected because the specified volume was not for the Universal Replicator pair.</td>
</tr>
<tr>
<td>E87E</td>
<td>The command was rejected because the specified P-VOL or S-VOL was a journal volume.</td>
</tr>
<tr>
<td>E880</td>
<td>The command was rejected because the emulation type was different between the specified P-VOL or S-VOL and the journal volume.</td>
</tr>
<tr>
<td>E881</td>
<td>The command was rejected because of the power-on processing.</td>
</tr>
<tr>
<td>E882</td>
<td>The command was rejected because the emulation type of the specified master journal or the restore journal was invalid.</td>
</tr>
<tr>
<td>E883</td>
<td>The specified mirror ID or the CTG ID differs from the registered mirror ID or the CTG ID.</td>
</tr>
<tr>
<td>E888</td>
<td>The command was rejected because a volume in the specified journal was used for maintenance.</td>
</tr>
<tr>
<td>E889</td>
<td>The command was rejected because the specified journal was already used in another Universal Replicator's mirror ID.</td>
</tr>
</tbody>
</table>
| E890             | The command was rejected because one of following:  
|                  | • The specified volume is registered in another journal.  
|                  | • The specified volume is registered in the same mirror of the same journal  
|                  | • The volume specified as the S-VOL is registered in another mirror of the same journal. |
| E891             | The command was rejected because the number of pairs that are registered in the specified master journal or restore journal was already reached the maximum number. |
| E897             | The command was rejected because of the one of following reasons.  
|                  | • The specified primary journal and the secondary journal do not permit the configuration combining three Universal Replicator sites.  
|                  | • The specified secondary journal is already used as a secondary journal of another mirror.  
<p>|                  | • The paired journal of the specified mirror is already used by another mirror. |
| E898             | The command was rejected because the specified secondary journal is already a secondary journal in another mirror. |
| E899             | The command was rejected because the path between the storage devices for the both-way was not defined. Check whether the bidirectional normal path was defined or not. |
| E89B             | The command was rejected because the specified master journal or the restore journal remembered the state of connection with another system in the past. Specify another journal, or delete the journal once, and then retry the registration again. |</p>
<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E8A2</td>
<td>The command was rejected because the serial number, model, or path group ID of the specified secondary system is wrong.</td>
</tr>
<tr>
<td>E8A6</td>
<td>The specified journal ID is unregistered.</td>
</tr>
<tr>
<td>E8A7</td>
<td>Journal volume is unregistered on the specified journal.</td>
</tr>
<tr>
<td>E8A8</td>
<td>The command was rejected because the specified volume was not for a Universal Replicator pair or was a volume of another journal.</td>
</tr>
<tr>
<td>E8A9</td>
<td>Universal Replicator copy pair cannot be suspended because of the power-on processing.</td>
</tr>
<tr>
<td>E8B8</td>
<td>The command was rejected because the volume in the specified journal was used for maintenance.</td>
</tr>
<tr>
<td>E8F7</td>
<td>The command was rejected because there are multiple journals in the specified consistency group.</td>
</tr>
<tr>
<td>E8FB</td>
<td>A logic error occurred in the system, and the command was rejected.</td>
</tr>
<tr>
<td>EA00</td>
<td>The command was rejected because the specified P-VOL was already used as an S-VOL.</td>
</tr>
<tr>
<td>EA01</td>
<td>The command was rejected because the specified P-VOL was already used by another Universal Replicator pair.</td>
</tr>
<tr>
<td>EA02</td>
<td>The command was rejected because the specified S-VOL was used as the P-VOL.</td>
</tr>
<tr>
<td>EA03</td>
<td>The command was rejected because the specified P-VOL was already used by another Universal Replicator pair.</td>
</tr>
<tr>
<td>EA07</td>
<td>The command was rejected because the number of the Universal Replicator pair registrations in the primary journal exceeds the upper limit.</td>
</tr>
<tr>
<td>EA08</td>
<td>The command was rejected because the number of Universal Replicator pair registrations in the secondary journal exceeds the upper limit.</td>
</tr>
<tr>
<td>EA09</td>
<td>The command was rejected because the state of master journal was other than Initial, Active, or Stopped.</td>
</tr>
<tr>
<td>EA0A</td>
<td>The command was rejected because the state of restore journal was invalid.</td>
</tr>
<tr>
<td>EA12</td>
<td>The command was rejected because the specified S-VOL was not in SSWS status.</td>
</tr>
<tr>
<td>EA13</td>
<td>The command was rejected because the request was received for the S-VOL as the P-VOL.</td>
</tr>
<tr>
<td>EA15</td>
<td>The command was rejected because the request was received for the P-VOL as the S-VOL.</td>
</tr>
<tr>
<td>EA18</td>
<td>The command was rejected because the pair status was not PSUS.</td>
</tr>
<tr>
<td>EA19</td>
<td>The command was rejected because the state of journal was not Stopped.</td>
</tr>
<tr>
<td>EA1C</td>
<td>The command was rejected because the specified secondary journal was not in the Stopped status.</td>
</tr>
<tr>
<td>Error code (SSB2)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>EA1E</td>
<td>The command was rejected because the request was received for the S-VOL as the P-VOL.</td>
</tr>
<tr>
<td>EA20</td>
<td>The command was rejected because the request was received for the P-VOL as the S-VOL.</td>
</tr>
<tr>
<td>EA22</td>
<td>The command was rejected because the state of journal was not Stopped.</td>
</tr>
<tr>
<td>EA25</td>
<td>The command was rejected because the state of S-VOL was not SSWS.</td>
</tr>
<tr>
<td>EA29</td>
<td>The command was rejected because the state of master journal was other than Active or Stopped.</td>
</tr>
<tr>
<td>EA2C</td>
<td>The command was rejected because the state of restore journal was other than Active or Stopped.</td>
</tr>
<tr>
<td>EA33</td>
<td>The command was rejected because the state of master journal was other than Active.</td>
</tr>
<tr>
<td>EA36</td>
<td>The command was rejected because the state of restore journal was other than Active.</td>
</tr>
<tr>
<td>EA37</td>
<td>The pair suspend request was received but was rejected because the restore journal status was other than Active or Stopped.</td>
</tr>
<tr>
<td>EA3A</td>
<td>The command was rejected because the specified S-VOL was in the state of status transition.</td>
</tr>
<tr>
<td>EA3B</td>
<td>The command was rejected because the specified S-VOL was in the state of Suspending.</td>
</tr>
<tr>
<td>EA40</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the primary system's program product.</td>
</tr>
<tr>
<td>EA41</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the secondary system's program product.</td>
</tr>
<tr>
<td>EA89</td>
<td>The command was rejected because the paircreate or pairresync cannot run with the journal's attribute or mirror status.</td>
</tr>
<tr>
<td>EA8A</td>
<td>The command was rejected because the pair status could not be changed during the power-on or power-off processing.</td>
</tr>
<tr>
<td>EA8B</td>
<td>The command was rejected because the specified volume is used in the system that consists of multiple primary and secondary systems.</td>
</tr>
<tr>
<td>EA95</td>
<td>The command was rejected because the volume specified for the P-VOL was initializing the pool of Dynamic Provisioning.</td>
</tr>
<tr>
<td>EAA2</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the primary system's Universal Replicator. Check the license capacity as well as the related program product.</td>
</tr>
<tr>
<td>EAA3</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the secondary system's TrueCopy. Check the License capacity as well as the related Program product.</td>
</tr>
<tr>
<td>EAA5</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the secondary system's Universal Replicator. Check the license capacity as well as the related program product.</td>
</tr>
<tr>
<td>Error code (SSB2)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>EAA6</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the primary system's TrueCopy. Check the license capacity as well as the related program product.</td>
</tr>
</tbody>
</table>
| EAB6             | A UR pair cannot be created or resynchronized because the bitmap areas are not available for one of the following reasons:  
• There is not enough free space in the shared memory on the primary system.  
• There is not enough free space in the pool of the DP-VOL specified as the P-VOL. |
| EAB7             | The paircreate operation failed because no extended shared memory is installed in the primary system. Install extended shared memory in the primary system and then repeat the operation. |
| EAB8             | A UR pair cannot be created or resynchronized because the bitmap areas are not available for one of the following reasons:  
• There is not enough free space in the shared memory on the secondary system.  
• There is not enough free space in the pool of the DP-VOL specified as the S-VOL. |
| EAB9             | The paircreate operation failed because no extended shared memory is installed in the secondary system. Install extended shared memory in the secondary system and then repeat the operation. |
| EABC             | The pair operation failed because the shared memory is not installed in the specified LDEV number. |
| EAE5             | The command was rejected because the specified P-VOL or S-VOL is in the process of having the capacity changed by Dynamic Provisioning. |
| EAF6             | The command was rejected because the pair was in the state that was unavailable to transit. |
| EB24             | The UR delta resync pair cannot be created because the specified UR S-VOL is in either one of the following statuses:  
• The volume cannot be used as the UR volume for the delta resync operation.  
• The status of the UR pair is other than PAIR. |
| EB25             | The UR delta resync pair cannot be created because the specified UR S-VOL is in either one of the following statuses:  
• The volume cannot be used as the UR volume for the delta resync operation.  
• The status of the UR pair is the status other than PAIR or SUSPEND. |
<p>| EB27             | UR pair creation failed because the GAD S-VOL that is combined with the specified P-VOL is not combined with the UR delta resync pair. |
| EB28             | The command was rejected because the Remote Replication Extended program product was not installed in the secondary system. |
| EB29             | The command was rejected because the delta resync settings are configured to the primary and secondary storage systems. |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EB2D</td>
<td>The command was rejected because shared memory for operating Universal Replicator is not installed.</td>
</tr>
<tr>
<td>EB30</td>
<td>The command was rejected because the specified mirror ID was invalid.</td>
</tr>
<tr>
<td>EB37</td>
<td>The command was rejected because the firmware is being exchanged or the firmware exchange operation is suspended.</td>
</tr>
</tbody>
</table>
| EB48             | The UR delta resync pair cannot be created due to one of the following reasons:  
• The P-VOL of the UR pair is different from the P-VOL of the TrueCopy pair. 
• The serial number of the primary storage system that is recognized by the P-VOL and S-VOL is different. |
| EB4C             | A pair cannot be created because the restore journal was not registered. |
| EB4D             | A pair cannot be created because the master journal was not registered. |
| EB50             | A UR pair creation request was received, but the command was rejected because the specified S-VOL is any of the following statuses:  
• Protected 
• Unavailable 
• ShadowImage S-VOL 
• Reserved volume of ShadowImage 
• Reserved volume of Volume Migration 
• Used by Universal Replicator 
• Belongs to the NAS_Platform_System_RSG resource group (resource group ID = 1023). |
<p>| EB51             | The command was rejected because PIN data existed in the specified S-VOL. |
| EB52             | The command was rejected because the specified S-VOL cannot be accessed. |
| EB53             | The command to create or resync a UR pair was rejected because the physical volume with the specified S-VOL is blocked. |
| EB54             | The pair cannot be created because the specified S-VOL is used as an external volume mapped for online data migration. |
| EB57             | The command was rejected because the specified S-VOL was online from the host. |
| EB58             | The command was rejected because the specified journal volume or S-VOL was reserved or being used in the storage system. Please check the status of the volume. |
| EB59             | The command was rejected because the specified S-VOL was being migrated by Volume Migration. Please check the status of the volume. |
| EB5B             | The command was rejected because the access attribute was set to the specified P-VOL or S-VOL by the Data Retention Utility. |
| EB5C             | The command was rejected because an internal logical error occurred. |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EB5E</td>
<td>The command was rejected because the S-VOL was already paired.</td>
</tr>
<tr>
<td>EB5F</td>
<td>The command was rejected because the program product of Universal Replicator was not installed in the secondary system.</td>
</tr>
<tr>
<td>EB60</td>
<td>The command was rejected because the P-VOL capacity is not the same as the S-VOL’s.</td>
</tr>
<tr>
<td>EB61</td>
<td>The command was rejected because the path between the primary and the secondary systems was not valid.</td>
</tr>
<tr>
<td>EB62</td>
<td>The command was rejected because the specified P-VOL was a command device.</td>
</tr>
<tr>
<td>EB63</td>
<td>The command was rejected because the restore journal was already linked with another journal.</td>
</tr>
<tr>
<td>EB64</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the program product.</td>
</tr>
<tr>
<td>EB65</td>
<td>The command was rejected because of the abnormal end which is related to the charging capacity of the program product.</td>
</tr>
<tr>
<td>EB66</td>
<td>The command was rejected and the retry processing was ordered because P-VOL SUSPENDING was detected when the CCI horctakeover (resync) command was executed.</td>
</tr>
</tbody>
</table>
| EB6C             | The Universal Replicator pair create processing was doubly executed:  
|                  | • There are no problems if the initial copy operation is restarted when the primary system is powered off.  
|                  | • There are no problems if a Universal Replicator pair is created when the primary system is reset. |
| EB6E             | The command was rejected because the Universal Replicator program product was not installed in the primary system. |
| EB70             | The command was rejected because the specified S-VOL is assigned to a copy pair of other program products. |
| EB73             | The command was rejected because the specified S-VOL is the system disk. |
| EB78             | The command was rejected because the specified data volume is a command device. |
| EB79             | The command was rejected because the specified data volume is online. |
| EB7A             | The command was rejected because the journal cache of the restore journal was remained. |
| EB7D             | The command was rejected because the specified S-VOL is an external volume. |
| EB7E             | The pair operation failed because the specified S-VOL is in one of the following statuses.  
|                  | • The specified S-VOL is being used for a ShadowImage pair.  
|                  | • The specified S-VOL is a reserved volume.  
<p>|                  | • Universal Replicator P-VOL and S-VOL are DP-VOL, and the specified S-VOL is the source volume of Volume Migration. |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EB7F</td>
<td>The command was rejected because the emulation type of the specified S-VOL was unsupported.</td>
</tr>
<tr>
<td>EB80</td>
<td>The command was rejected because the specified volume was the V-VOL or the pool-VOL. Please check the status of the volume.</td>
</tr>
<tr>
<td>EB87</td>
<td>The command was rejected because the path from the secondary system to the primary system is not set, or the volume used as the S-VOL is not paired.</td>
</tr>
</tbody>
</table>
| EB88             | The command was rejected because of one of the following:  
|                  | • The specified S-VOL was being used as a ShadowImage S-VOL.  
|                  | • The specified S-VOL was Not Ready, which means that the data drive cannot be used. |
| EB89             | The command was rejected because the emulation types of the specified P-VOL and S-VOL were not the same. |
| EB8A             | The command was rejected because the emulation types of the specified master journal and the restore journal were not the same. |
| EB8E             | The pair cannot be created because the S-VOL is in a LUSE configuration. |
| EB94             | The command was rejected because the specified pair could not transit the status. |
| EB9F             | The command was rejected because the specified S-VOL was not mounted on the secondary system. |
| EBA0             | The command was rejected because the specified S-VOL was not mounted on the secondary system. |
| EBA7             | The command was rejected because the volume specified for the secondary volume was in either one of the following status:  
|                  | • Increasing the capacity by Dynamic Provisioning.  
|                  | • Releasing the page of Dynamic Provisioning.  
|                  | • Initializing the pool of Dynamic Provisioning.  
|                  | • The Data Direct Mapping attribute of Dynamic Provisioning which is not supported for storage system at the primary site is enabled. |
| EBAF             | The command was rejected because the license capacity of the Data Retention Utility in the secondary system exceeds the setting value. Please check the license capacity setting for Data Retention Utility in the secondary system. |
| EBCA             | The command was rejected because the journal restore operation is in progress in the UR pair through another mirror ID.  
|                  | • If the UR pair with another mirror ID is in Suspending status, reissue the request when the pair status is changed to the Suspend status.  
<p>|                  | • If the UR pair with another mirror ID is in the PAIR status, reissue the request after a while. |</p>
<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBCF</td>
<td>The UR Pairresync (journal resync mode that forcibly copies all data) was received because of the UR Pairresync (delta resync) failed. The command was rejected because the UR pair was not in HOLD status.</td>
</tr>
<tr>
<td>EBD9</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the secondary system's TrueCopy. Check the license capacity as well as the related program product.</td>
</tr>
<tr>
<td>EBDB</td>
<td>The command was rejected because the desired capacity exceeded the charging capacity of the secondary system's Universal Replicator. Check the license capacity as well as the related program product.</td>
</tr>
<tr>
<td>EBDC</td>
<td>The command was rejected because the processing load of the storage system is heavy. Please execute the command again after a while.</td>
</tr>
<tr>
<td>EBE0</td>
<td>The command was rejected because the specified S-VOL is already used in a UR delta resync pair.</td>
</tr>
<tr>
<td>EBE1</td>
<td>The command was rejected because all S-VOLs of the specified restore journal were not the another UR's S-VOLs.</td>
</tr>
<tr>
<td>EBE2</td>
<td>The resynchronization of the UR delta resync pair was rejected due to one of the reasons. Perform UR Pairresync (journal resync mode that forcibly copies all data):</td>
</tr>
<tr>
<td></td>
<td>• Update data of TrueCopy (master journal of the UR delta resync pair operation) is inconsistent with the update data of the restore journal of the UR pair.</td>
</tr>
<tr>
<td></td>
<td>• Host I/O is updated for the UR S-VOL.</td>
</tr>
<tr>
<td>EBE5</td>
<td>The command was rejected because the journal volume of specified restore journal was blocked.</td>
</tr>
<tr>
<td>EBFD</td>
<td>The command was rejected because the specified restore journal was not registered.</td>
</tr>
<tr>
<td>F908</td>
<td>The pair cannot be created because of one of the following conditions regarding the specified S-VOL:</td>
</tr>
<tr>
<td></td>
<td>• Virtual access mode is disabled for the volume registered in the mirror, but is enabled for the specified volume.</td>
</tr>
<tr>
<td></td>
<td>• Virtual access mode is enabled for the volume registered in the mirror, but is disabled for the specified volume.</td>
</tr>
<tr>
<td></td>
<td>• The specified volume whose virtual access mode is enabled has an incorrect virtual storage machine's serial number or model.</td>
</tr>
<tr>
<td>F909</td>
<td>The pair cannot be created because of one of the following conditions regarding the specified P-VOL:</td>
</tr>
<tr>
<td></td>
<td>• Virtual access mode is disabled for the volume registered in the journal group, but is enabled for the specified volume.</td>
</tr>
<tr>
<td></td>
<td>• Virtual access mode is enabled for the volume registered in the journal group, but is disabled for the specified volume.</td>
</tr>
<tr>
<td></td>
<td>• The specified volume whose virtual access mode is enabled has an incorrect virtual storage machine's serial number or model.</td>
</tr>
<tr>
<td>F90A</td>
<td>The pair cannot be created because the virtual LDEV ID is not set for the volume specified as the P-VOL.</td>
</tr>
<tr>
<td>Error code (SSB2)</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>F90C</td>
<td>The pair or delta resync pair cannot be created because the specified journal does not match the journal associated with the GAD CTG.</td>
</tr>
</tbody>
</table>

**CCI error codes for Universal Replicator: SSB1 = B912**

<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B96D</td>
<td>The command was rejected because the volume status is SMPL.</td>
</tr>
</tbody>
</table>

**CCI error codes for Universal Replicator: SSB1 = B980**

<table>
<thead>
<tr>
<th>Error Code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B901</td>
<td>The command was rejected because the specified port is for NAS Platform (system LU).</td>
</tr>
<tr>
<td>B903</td>
<td>The command was rejected because the selected resource belongs to NAS_Platform_System_RSG.</td>
</tr>
</tbody>
</table>

**CCI error codes for Universal Replicator: SSB1 = B9E2**

<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B9E0</td>
<td>The command was rejected because the function for deleting pairs forcibly is not supported.</td>
</tr>
</tbody>
</table>

**CCI error codes for Universal Replicator: SSB1 = B9FE**

<table>
<thead>
<tr>
<th>Error code (SSB2)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B902</td>
<td>Journal volumes are not registered in the specified journal.</td>
</tr>
</tbody>
</table>

**Service information messages (SIMs)**

The Hitachi storage systems generate service information messages (SIMs) when service is required. SIMs are generated by the channel and storage path microprocessors and the service processor (SVP) and are classified according to the following severity levels: service, moderate, serious, or acute. All SIMs related to Universal Replicator processing are reported by the SVP.
The following figure shows a typical 32-byte SIM. The six-digit reference code consists of bytes 22, 23, and 13. The reference code identifies the possible error and determines the severity. The SIM type (byte 28) indicates the component that experienced the error. When the value of byte 22 is 21, the SIM is a control unit SIM. When the value of byte 22 is dx (where x is an arbitrary character), the SIM is a device SIM.

<table>
<thead>
<tr>
<th>Byte 22</th>
<th>Byte 23</th>
<th>Severity</th>
<th>Description</th>
<th>System generating the SIM</th>
<th>SVP log file</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>80</td>
<td>Moderate</td>
<td>A remote path is blocked due to failure.</td>
<td>Primary, Secondary</td>
<td>SIM log</td>
</tr>
<tr>
<td>dc</td>
<td>0x</td>
<td>Serious</td>
<td>The P-VOL has been suspended. Path recovery is impossible.</td>
<td>Primary</td>
<td>SIM log</td>
</tr>
<tr>
<td>dc</td>
<td>1x</td>
<td>Serious</td>
<td>The P-VOL has been suspended. A failure has been detected in the primary system.</td>
<td>Primary</td>
<td>SIM log</td>
</tr>
<tr>
<td>Reference code</td>
<td>Severity</td>
<td>Description</td>
<td>System generating the SIM</td>
<td>SVP log file</td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>dc 22 23</td>
<td>Serious</td>
<td>The P-VOL has been suspended. A failure has been detected in the secondary system.</td>
<td>Primary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc 4x</td>
<td>Serious</td>
<td>The P-VOL has been suspended. The pair has been suspended at the secondary system.</td>
<td>Primary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc 5x</td>
<td>Serious</td>
<td>The P-VOL has been suspended. A pair has been released at the secondary system.</td>
<td>Primary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc 6x</td>
<td>Serious</td>
<td>The S-VOL has been suspended. Path recovery is impossible.</td>
<td>Primary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc 7x</td>
<td>Serious</td>
<td>The S-VOL has been suspended. A failure has been detected in the secondary system.</td>
<td>Secondary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc 9x</td>
<td>Serious</td>
<td>A delta resync P-VOL has been suspended. A failure has been detected in the primary system.</td>
<td>Primary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc ax</td>
<td>Serious</td>
<td>A volume used in a P-VOL that is configured in a multiple primary and secondary system combination has been suspended. A failure has been detected in other primary and secondary systems.</td>
<td>Primary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc f1</td>
<td>Serious</td>
<td>The UR Read JNL was interrupted for five minutes. (A failure in the MCU was detected.)</td>
<td>Secondary</td>
<td>SIM log</td>
<td></td>
</tr>
<tr>
<td>dc f3</td>
<td>Serious</td>
<td>The UR Read JNL was interrupted for five minutes. (A failure in the RCU was detected.)</td>
<td>Secondary</td>
<td>SIM log</td>
<td></td>
</tr>
</tbody>
</table>

The following table lists and describes SIMs that do not need immediate intervention but might require intervention later.

**Table 10-2 SIMs for expected status change, no intervention**

<table>
<thead>
<tr>
<th>Reference code</th>
<th>Severity</th>
<th>Description</th>
<th>System generating the SIM</th>
<th>SVP log file</th>
</tr>
</thead>
<tbody>
<tr>
<td>dc 22 23</td>
<td>Moderate</td>
<td>UR M-JNL Meta overflow warning</td>
<td>Primary</td>
<td>SIM log</td>
</tr>
<tr>
<td>dc 4x</td>
<td>Moderate</td>
<td>UR M-JNL Data overflow warning</td>
<td>Primary</td>
<td>SIM log</td>
</tr>
<tr>
<td>dc 5x</td>
<td>Moderate</td>
<td>UR R-JNL Meta overflow warning</td>
<td>Secondary</td>
<td>SIM log</td>
</tr>
</tbody>
</table>

Troubleshooting 10-27
Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
The following table lists and describes service-level SIMs that report expected status changes and require no user intervention.

**Table 10-3 Service SIMs for expected status changes, no intervention required**

<table>
<thead>
<tr>
<th>Reference code</th>
<th>Severity</th>
<th>Description</th>
<th>System generating the SIM</th>
<th>SVP log file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte 22</td>
<td>Byte 23</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>81</td>
<td>Service</td>
<td>The remote path is restored.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>0x</td>
<td>Service</td>
<td>A volume to be used by UR was defined.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>1x</td>
<td>Service</td>
<td>A volume used by UR began copying.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>2x</td>
<td>Service</td>
<td>A volume used by UR completed copying.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>3x</td>
<td>Service</td>
<td>A volume used by UR received a request for suspension.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>4x</td>
<td>Service</td>
<td>A volume used by UR completed a suspension transaction.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>5x</td>
<td>Service</td>
<td>A volume used by UR received a request for deletion.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>6x</td>
<td>Service</td>
<td>A volume used by UR completed a deletion transaction.</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>7x</td>
<td>Service</td>
<td>A volume to be used by UR was defined (placed in PSUS immediately).</td>
<td>Primary, Secondary</td>
</tr>
<tr>
<td>d8</td>
<td>8x</td>
<td>Service</td>
<td>A delta resync volume to be used by UR was defined.</td>
<td>Primary</td>
</tr>
<tr>
<td>Reference code</td>
<td>Severity</td>
<td>Description</td>
<td>System generating the SIM</td>
<td>SVP log file</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>-------------</td>
<td>---------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>d8 9x</td>
<td>Service</td>
<td>A delta resync volume used by UR was redefined.</td>
<td>Primary</td>
<td>SIM log</td>
</tr>
<tr>
<td>d9 zx</td>
<td>Service</td>
<td>A change to an S-VOL was received from the MCU.</td>
<td>Secondary</td>
<td>SIM log</td>
</tr>
<tr>
<td>da zx</td>
<td>Service</td>
<td>A change to an S-VOL was received from the RCU.</td>
<td>Secondary</td>
<td>SIM log</td>
</tr>
<tr>
<td>dc 8x</td>
<td>Service</td>
<td>A volume used by an S-VOL was suspended (PS OFF on the MCU was detected).</td>
<td>Secondary</td>
<td>SIM log</td>
</tr>
</tbody>
</table>

**Other troubleshooting**

**Suspension among journals**

All of the journals in a consistency group can be suspended when an error occurs in one of the journals in the consistency group. This takes place under the following conditions:

- The communications line between the CCI and all primary systems are normal.
- The status of the failed journal is PJSE or PJSF.
- At least one journal in the consistency group is in normal status.

The following is provided for your information when the circumstances above are present:

- When an error occurs, the status of the journal changes from normal to PJSE (suspended by error).
- For an error caused by overflowing capacity, status changes to PJSF.
- When one journal becomes PJSE or PJSF, all other normal journals in PJNN status also become PJSE status.
- If you use CCI and if a journal is in the normal status, it will be shown as PJNN.

Note that if some pairs in the journal become suspended by error but the whole journal does not become suspended, the status of other journals will not change.

**Notification of suspension due to an error (multiple primary and secondary systems)**

When multiple primary systems and secondary systems are combined, an error in one of the journals affects other journals, and pairs are suspended by
the error. A time stamp is issued to all journals, and the error in one of the journals is notified to the other journals as long as data consistency is maintained in the system.

To notify all journals of a failure, the following conditions must be met:

- The line between CCI and all primary systems is operating correctly.
- The status of the failed journal is PJSE or PJSF.
- At least one journal in the CCI consistency group is in normal status.

When all the above conditions are met, an error occurred in a journal is notified to the other journals.

The following explains journal statuses:

- Normal journals are displayed as PJNN in CCI.
- When an error occurs, the journal status changes from PJNN (normal) to PJSE (suspended by error).
- For errors caused by capacity overflow, the status changes to PJSF.
- When one journal changes to PJSE or PJSF, all other normal journals in the PJNN status also change to the PJSE status (suspended by error).

**Note:** When an error occurs in a pair in a journal, if the entire journal is not suspended by the error, the status of the other journals does not change.

**Calling Hitachi Data Systems customer support**

If you need to call Hitachi Data Systems customer support, please provide as much information about the problem as possible, including:

- The circumstances surrounding the error or failure.
- The content of any error messages displayed on the host systems.
- The content of any error messages displayed on Device Manager - Storage Navigator.
- The Device Manager - Storage Navigator configuration information (use the Dump Tool).
- The service information messages (SIMs), including reference codes and severity levels, displayed by Device Manager - Storage Navigator.

The Hitachi Data Systems customer support staff is available 24 hours a day, seven days a week. If you need technical support, log on to Hitachi Data Systems Support Connect for contact information: [https://support.hds.com/en_us/contact-us.html](https://support.hds.com/en_us/contact-us.html)
CLI reference for Universal Replicator

This appendix lists the Universal Replicator operations and provides the corresponding CCI commands.

- CCI commands for UR configuration operations
- CCI commands for UR pair operations
- CCI commands for UR monitoring operations
- CCI commands for UR maintenance operations
- CCI commands for UR consistency group operations
### CCI commands for UR configuration operations

The following table lists the Universal Replicator configuration operations and provides the corresponding CCI commands. For details about the CCI commands, see the *Command Control Interface Command Reference*. 

<table>
<thead>
<tr>
<th>Operation</th>
<th>Options</th>
<th>In HDvM - SN?</th>
<th>CCI command and options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Remote Connection</td>
<td>Remote Storage System</td>
<td>Yes</td>
<td>raidcom add rcu -rcu serial# mcu# rcu# id</td>
</tr>
<tr>
<td>Add Remote Connection</td>
<td>Remote Paths</td>
<td>Yes</td>
<td>raidcom add rcu -cu_free serial# id pid</td>
</tr>
<tr>
<td>Add Remote Connection</td>
<td>RIO MIH Time</td>
<td>Yes</td>
<td>raidcom modify rcu -rcu_option mpth rto rtt[fzd</td>
</tr>
<tr>
<td>Create Journal</td>
<td>Journal ID</td>
<td>Yes</td>
<td>raidcom add journal -journal_id journal ID#</td>
</tr>
<tr>
<td>Create Journal</td>
<td>MP Unit ID*</td>
<td>Yes</td>
<td>raidcom modify journal -mp_blade_id mp#</td>
</tr>
<tr>
<td>Create Journal</td>
<td>Data Overflow Watch*</td>
<td>Yes</td>
<td>raidcom modify journal -data_overflow_watch time</td>
</tr>
<tr>
<td>Create Journal</td>
<td>Cache Mode*</td>
<td>Yes</td>
<td>raidcom modify journal -cache_mode {y</td>
</tr>
<tr>
<td>Edit Journal Options</td>
<td>Data Overflow Watch*</td>
<td>Yes</td>
<td>raidcom modify journal -data_overflow_watch time</td>
</tr>
<tr>
<td>Edit Journal Options</td>
<td>Cache Mode*</td>
<td>Yes</td>
<td>raidcom modify journal -cache_mode {y</td>
</tr>
<tr>
<td>Assign Journal Volume</td>
<td>none</td>
<td>Yes</td>
<td>raidcom add journal -journal_id journal ID#</td>
</tr>
<tr>
<td>Assign MP Unit</td>
<td>MP Unit ID</td>
<td>Yes</td>
<td>raidcom add journal -mp_blade_id mp#</td>
</tr>
<tr>
<td>Edit Remote Replica Options</td>
<td>Copy Type</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Edit Remote Replica Options</td>
<td>Maximum Initial Copy Activities</td>
<td>Yes</td>
<td>none</td>
</tr>
</tbody>
</table>

* When you use Device Manager - Storage Navigator, you can only specify the journal type options (Data Overflow Watch, Cache Mode, Timer Type, Path Blockade Watch, MP Unit) all at once during the create journal operation. When you use CCI, you can specify the journal type options one at a time, and you can modify the journal type options.
## CCI commands for UR pair operations

The following table lists the Universal Replicator pair operations and provides the corresponding CCI commands. For details about the CCI commands, see the Command Control Interface Command Reference.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Options</th>
<th>In HDvM - SN?</th>
<th>CCI command and options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create UR Pairs</td>
<td>LU Selection</td>
<td>Yes</td>
<td>paircreate none</td>
</tr>
<tr>
<td></td>
<td>Base Secondary Volume</td>
<td>Yes</td>
<td>paircreate none</td>
</tr>
<tr>
<td></td>
<td>Mirror Selection</td>
<td>Yes</td>
<td>paircreate none</td>
</tr>
<tr>
<td></td>
<td>CTG ID</td>
<td>Yes</td>
<td>paircreate -f[g] fence [CTG ID]</td>
</tr>
<tr>
<td></td>
<td>Initial Copy Type</td>
<td>Yes</td>
<td>paircreate [-nocopy</td>
</tr>
<tr>
<td></td>
<td>Initial Copy Priority</td>
<td>Yes</td>
<td>paircreate none</td>
</tr>
<tr>
<td></td>
<td>Error Level</td>
<td>Yes</td>
<td>paircreate -nomsg</td>
</tr>
<tr>
<td>Split Pairs</td>
<td>Secondary Volume Write</td>
<td>Yes</td>
<td>pairsplit -rw</td>
</tr>
<tr>
<td>Split Mirrors</td>
<td>Secondary Volume Write</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Split Mode</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Resync Pairs</td>
<td>Copy Priority</td>
<td>Yes</td>
<td>pairresync none</td>
</tr>
<tr>
<td></td>
<td>Error Level</td>
<td>Yes</td>
<td>pairresync -nomsg</td>
</tr>
<tr>
<td>Resync Mirrors</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Delete Pairs</td>
<td>none</td>
<td>Yes</td>
<td>pairsplit -S</td>
</tr>
<tr>
<td>Delete Mirrors</td>
<td>Delete Mode</td>
<td>Yes</td>
<td>none</td>
</tr>
</tbody>
</table>

## CCI commands for UR monitoring operations

The following table lists the Universal Replicator monitoring operations and provides the corresponding CCI commands. For details about the CCI commands, see the Command Control Interface Command Reference.
### CCI commands for UR maintenance operations

The following table lists the Universal Replicator maintenance operations and provides the corresponding CCI commands. For details about the CCI commands, see the Command Control Interface Command Reference.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Options</th>
<th>In HDvM - SN?</th>
<th>CCI command and options</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Pair Properties</td>
<td>none</td>
<td>Yes</td>
<td>pairdisplay -m mode</td>
</tr>
<tr>
<td>View Pair Synchronization Rate</td>
<td>none</td>
<td>Yes</td>
<td>pairdisplay -fc</td>
</tr>
<tr>
<td>View Remote Connection Properties</td>
<td>none</td>
<td>Yes</td>
<td>pairdisplay -m mode</td>
</tr>
<tr>
<td>Edit Pair Options</td>
<td>Error Level</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Force Delete Pairs (UR Pairs)</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Edit Journal Options</td>
<td>none</td>
<td>Yes</td>
<td>raidcom modify journal</td>
</tr>
<tr>
<td>Edit Mirror Options</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Assign Journal Volumes</td>
<td>none</td>
<td>Yes</td>
<td>raidcom add journal -journal_id journal ID#</td>
</tr>
<tr>
<td>Delete Journals</td>
<td>none</td>
<td>Yes</td>
<td>raidcom delete journal -journal_id journal ID#</td>
</tr>
<tr>
<td>Edit Remote Connection Options</td>
<td>RIO MIH Time</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Add Remote Paths</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Remove Remote Paths</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Remove Remote Connections</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Assign Remote Command Devices</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
<tr>
<td>Release Remote Command Devices</td>
<td>none</td>
<td>Yes</td>
<td>none</td>
</tr>
</tbody>
</table>
## CCI commands for UR consistency group operations

The following table lists the Universal Replicator consistency group operations and provides the corresponding CCI commands. For details about the CCI commands, see the Command Control Interface Command Reference.

**Note:** Consistency group commands and options are not available from HDvM - SN.

<table>
<thead>
<tr>
<th>Operation</th>
<th>CCI command and options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserve CTGs</td>
<td>paircreate -f[g] fence[CTG ID]</td>
</tr>
<tr>
<td>Release reserved CTGs</td>
<td>none</td>
</tr>
<tr>
<td>Add pair to the CTG</td>
<td>paircreate -f[g] fence[CTG ID]</td>
</tr>
<tr>
<td>Split pairs specifying the CTG (no reservation time)</td>
<td>pairsplit -S</td>
</tr>
<tr>
<td>Resync pairs per unit of a consistency group</td>
<td>pairresync -f[g] fence[CTG ID]</td>
</tr>
<tr>
<td>Delete pairs per unit of a consistency group</td>
<td>pairsplit -S</td>
</tr>
</tbody>
</table>
Sharing Universal Replicator volumes

This appendix describes the interoperability requirements for Universal Replicator volumes.

- Volume types that can be shared with Universal Replicator
- Data Retention Utility
- Dynamic Provisioning
- Global-active device
- Global storage virtualization
- LUN Manager
- Resource Partition Manager
- Thin Image
- Universal Volume Manager
- Virtual LUN
- Volume Migration
**Volume types that can be shared with Universal Replicator**

The following table shows whether volumes used by other program products can also be used as Universal Replicator P-VOLs, S-VOLs, and journal volumes.

<table>
<thead>
<tr>
<th>Volumes types and functions</th>
<th>Used as UR P-VOL?</th>
<th>Used as UR S-VOL?</th>
<th>Used as UR journal volume?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Retention Utility</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Volume with Read/Write attribute</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Volume with Protect attribute</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Volume with Read Only attribute</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Volume that is disabled for use as an S-VOL</td>
<td>Yes</td>
<td>Only when executing UR pair resync operation.</td>
<td>No</td>
</tr>
<tr>
<td><strong>Dynamic Provisioning</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual volume</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Virtual volume with the data direct mapping attribute</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Virtual volume with accelerated compression enabled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>pool-VOL</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Dynamic Tiering</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual volume</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>pool-VOL</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>global-active device</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P-VOL</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Quorum disk</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Volume with reservation attribute for S-VOL</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>global storage virtualization</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Volumes in a virtual storage machine</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td><strong>LUN Manager</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Volume to which a path is defined</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Volume to which no path is defined</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Volumes types and functions</td>
<td>Used as UR P-VOL?</td>
<td>Used as UR S-VOL?</td>
<td>Used as UR journal volume?</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Volume to which LUN security is applied</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Resource Partition Manager**

<table>
<thead>
<tr>
<th>Resource Partition Manager volume</th>
<th>Used as UR P-VOL?</th>
<th>Used as UR S-VOL?</th>
<th>Used as UR journal volume?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes (But only for volume that is allocated to a user group)</td>
<td>Yes (But only for volume that is allocated to a user group)</td>
<td>Yes (But only for OPEN-V virtual volume that is allocated to a user group)</td>
<td></td>
</tr>
</tbody>
</table>

**ShadowImage**

<table>
<thead>
<tr>
<th>ShadowImage</th>
<th>Used as UR P-VOL?</th>
<th>Used as UR S-VOL?</th>
<th>Used as UR journal volume?</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-VOL in PSUS status</td>
<td>Yes</td>
<td>Yes$^5, 6$</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL in PSUE status</td>
<td>Yes</td>
<td>Yes$^5, 6$</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL in COPY(RS-R)/COPY status</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL that is also used as a TC P-VOL or S-VOL</td>
<td>Yes</td>
<td>Yes$^5, 6$</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL (none of the above)</td>
<td>Yes</td>
<td>Yes$^2, 5, 6$</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in PSUS status</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in PSUE status</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL (none of the above)</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**Thin Image**

<table>
<thead>
<tr>
<th>Thin Image</th>
<th>Used as UR P-VOL?</th>
<th>Used as UR S-VOL?</th>
<th>Used as UR journal volume?</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-VOL in all statuses except COPY(RS-R)/COPY</td>
<td>Yes</td>
<td>Yes$^3$</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL in COPY(RS-R)/COPY status</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>V-VOL</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>pool-VOL</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**TrueCopy**

<table>
<thead>
<tr>
<th>TrueCopy</th>
<th>Used as UR P-VOL?</th>
<th>Used as UR S-VOL?</th>
<th>Used as UR journal volume?</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-VOL in COPY status</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL in PAIR status</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL in PSUS status</td>
<td>Yes</td>
<td>No$^4$</td>
<td>No</td>
</tr>
<tr>
<td>P-VOL in PSUE status</td>
<td>Yes</td>
<td>No$^4$</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in COPY status</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in PAIR status</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in PSUS status</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in PSUE status</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in SSWS status</td>
<td>Yes</td>
<td>No$^4$</td>
<td>No</td>
</tr>
<tr>
<td>S-VOL in SSWS status</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**Universal Volume Manager**

---

*Sharing Universal Replicator volumes*

*Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*
### Volumes types and functions

<table>
<thead>
<tr>
<th>Volumes types and functions</th>
<th>Used as UR P-VOL?</th>
<th>Used as UR S-VOL?</th>
<th>Used as UR journal volume?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Volume Manager volume</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Virtual LUN</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Virtual LUN volume</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td><strong>Volume Migration</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source volume (when volume migration is in progress)</td>
<td>Yes (But if used as a P-VOL, volume migration stops)&lt;sup&gt;10&lt;/sup&gt;</td>
<td>Yes (But if used as an S-VOL, volume migration stops)&lt;sup&gt;10&lt;/sup&gt;</td>
<td>No</td>
</tr>
<tr>
<td>Source volume (after volume migration is finished)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

### Notes:

1. A volume whose virtual LDEV ID is deleted cannot be used as a UR pair volume.
2. If a DP-VOL is used by both UR and SI, UR pair creation might fail.
3. You cannot specify a volume used as a TI P-VOL as an S-VOL when creating a UR pair. For details about sharing UR and TI volumes, see Thin Image on page B-8.
4. Can be used as an S-VOL only when CCI is used to perform the UR pair resync or horctakeover operation.
5. In a 3DC configuration, do not allocate an SI P-VOL that uses DP-VOL to a UR S-VOL for delta resync.
6. If the UR P-VOL and UR S-VOL are DP-VOLs, the UR S-VOL cannot be used as the SI P-VOL.
7. In a 3DC multi-target or 3DC cascade configuration in which three UR sites are combined, the volume shared with the two UR pairs cannot be used by this software. Also, the volume used in this software cannot be used as the volume shared with the two UR pairs.
8. For details about using UR with GAD, see the Global-Active Device User Guide.
9. The volume is used as the P-VOL of a UR delta resync pair.
10. When the UR pair status is COPY or PAIR, do not perform the volume migration operation; otherwise, the operation is stopped.

### Data Retention Utility

You can create a Universal Replicator pair using volumes that have been assigned the access attribute by the Data Retention Utility (DRU). However, you cannot specify a volume with the "S-VOL Disable" attribute as a Universal Replicator S-VOL.

The following table shows whether the access attribute can be changed or referenced.
Table B-2 Pair status and Data Retention Utility operations

<table>
<thead>
<tr>
<th>UR volume</th>
<th>UR pair status</th>
<th>DRU access attribute change possible?</th>
<th>DRU access attribute reference possible?</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-VOL</td>
<td>Unpaired</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>COPY</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>PAIR</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>PSUS</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>PSUE</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S-VOL</td>
<td>Unpaired</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>COPY</td>
<td>See next table.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>PAIR</td>
<td>See next table.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>PSUS</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>PSUE</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The following table shows when changes can be made to the access attribute when the Universal Replicator P-VOL status is PAIR or COPY.

Table B-3 Whether the access attribute can be changed when the UR P-VOL status is COPY or PAIR

<table>
<thead>
<tr>
<th>UR P-VOL status</th>
<th>Change access attribute to:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Read/Write</td>
</tr>
<tr>
<td>COPY</td>
<td>Yes</td>
</tr>
<tr>
<td>PAIR</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* The access attribute cannot be changed from Device Manager - Storage Navigator.

Dynamic Provisioning

- You can create a Universal Replicator pair by specifying a DP-VOL (Dynamic Provisioning virtual volume).
- DP-VOLs can be used for either the Universal Replicator P-VOL or S-VOL, or both P-VOL and S-VOL.
- When a DP-VOL is used as a Universal Replicator P-VOL or S-VOL, the UR of the allocated pages for the DP-VOL is included in the Universal Replicator licensed capacity. If the actual licensed capacity exceeds the available licensed capacity, you can use Universal Replicator for 30 days. After 30 days, Universal Replicator pairs can only be split or released.
- When specifying a DP-VOL that has allocated pages to a Universal Replicator S-VOL, be aware that used pool capacity will become temporarily larger than the actual capacity, because pages must be reallocated in the DP-VOL. Therefore, before creating the pair:
- Make sure that DP-VOL pool capacity is sufficient.
- Make sure that the pool-VOLs, which are added to a pool, are not blocked. If the pool-VOLs are blocked, restore the volume status and then create the pair.

- You can use DP-VOLs that are also used by ShadowImage or that are in a Volume Migration migration plan. To do so, proceed as follows:
  a. Delete the ShadowImage pair or disable the Volume Migration setting.
  b. Create the Universal Replicator pair.
  c. Re-create the ShadowImage pair or the Volume Migration migration plan.

- Be aware that when a DP-VOL is used as a Universal Replicator S-VOL, you might not be able to update the Universal Replicator S-VOL because the capacity of the pool-VOL is full. In this instance:
  - The pair is suspended.
  - With CCI, the UR pair status changes to PFUS.
  - In Device Manager - Storage Navigator, the UR pair status changes to PSUS.

- When both of the following conditions exist, pages that do not exist in the P-VOL might be assigned to the S-VOL when splitting and then resynchronizing the pair:
  - The copy pace is Faster.
  - The pair is created and the pair status is COPY.

  To delete S-VOL pages that do not exist in the P-VOL, use the Reclaim Zero Pages function for the DP-VOL.

**Global-active device**

In a GAD system, the server accesses the primary site and GAD secondary site simultaneously and shares the same data between the two sites (at campus distance). If a failure occurs at one of the sites, you can continue operations at the other site. However, if a failure occurs at both sites, for example due to a large-scale disaster, you will not be able to continue operations with the data redundancy provided only by GAD.

To manage this situation, you can implement a three-data-center (3DC) configuration by combining GAD and Universal Replicator (UR). This configuration is called a GAD+UR configuration. If there is a failure at both the primary site and the GAD secondary site, the GAD+UR configuration enables you to continue operations using the UR secondary site (at metro distance).

When using GAD with UR, configure the system as follows:

- Specify the GAD P-VOL as the UR P-VOL.
- Specify the GAD S-VOL as the P-VOL of the UR delta resync pair.
The following figure shows a GAD+UR configuration. This configuration must always be used when you use GAD and UR.

In a GAD+UR configuration:

- The P-VOL of the GAD pair functions as the P-VOL of the UR pair.
- The S-VOL of the GAD pair functions as the P-VOL of the UR delta resync pair.
- The UR S-VOL has two mirror IDs, one for the UR pair, and one for the UR delta resync pair.
- The UR delta resync pair consists of the GAD S-VOL at the GAD secondary site and the UR S-VOL at the UR secondary site. This UR delta resync pair allows you to synchronize the UR pair S-VOL by using the journal data at the GAD secondary site in the event of a failure at the primary site.

For details about the GAD+UR configuration, see the *Global-Active Device User Guide*.

**Global storage virtualization**

Pairs can be created using volumes in a virtual storage machine. Please note the following:

- Though Device Manager - Storage Navigator displays the virtual LDEV ID of a volume belonging to a virtual storage machine, make sure when
performing pair operations in Device Manager - Storage Navigator that
you specify the physical LDEV ID in the storage system.

- A volume’s virtual ID used with Universal Replicator cannot be deleted.

LUN Manager

- LUN Manager operations do not affect Universal Replicator operations. Volumes that are under secure ports or are assigned to host groups or iSCSI targets can also be assigned to Universal Replicator pairs. Volumes that are assigned to Universal Replicator pairs can be protected by LUN Manager.

- Universal Replicator S-VOLs cannot be accessed by any UNIX or PC server host except when the pair is split.

Resource Partition Manager

You can specify Resource Partition Manager volumes as Universal Replicator P-VOL and S-VOL as long as they belong to the same resource group. For journal volumes, use a Resource Partition Manager OPEN-V virtual volume.

For more information, see the *Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.

Thin Image

Universal Replicator pair volumes can be shared with Thin Image (TI) P-VOLs, but there are limitations on how they can be used together.

- A UR P-VOL or S-VOL can be used as a TI P-VOL.
- A UR P-VOL or S-VOL that is part of a delta resync configuration with TrueCopy can also be used as a TI P-VOL.
- A TI P-VOL cannot be specified as an S-VOL when creating a UR pair. However, you can specify a TI P-VOL as an S-VOL when creating a delta resync UR pair in a 3DC multi-target or 3DC cascade configuration with three UR sites.

Configurations with TI volumes

The following illustrations show UR configurations with TI.
The UR pair must be created before the secondary site TI pair.

Figure B-1 UR basic configuration with TI

- TC pair (campus distance)
- UR pair (metro distance)

Figure B-2 3DC cascade configuration with TI

- The TC pair must be created before the intermediate TI pair.
- The UR pair must be created before the secondary site TI pair.
• You can create either the TC pair or the primary site TI pair first.
• The TC pair must be created before the secondary site TI pair (campus distance).
• The UR pair must be created before the secondary site TI pair (metro distance).
• The TC, UR, and UR delta resync pairs must be created before the secondary site TI pairs.

• You can create a primary site TI pair before or after the delta resync pairs.

• For the 3DC multi-target delta resync configuration and the 3DC cascade delta resync configuration with three UR sites, first you need to create the 3DC multi-target configuration or the 3DC cascade configuration. (You need to create the UR pairs before the TI pair in a "URxUR" 3DC delta configuration. You do not need to create the UR delta resync pair before the TI pairs at the secondary site.)

**Universal Volume Manager**

You can create Universal Replicator pairs using Universal Volume Manager volumes.

For more information, see the *Hitachi Universal Volume Manager User Guide*. 

*Figure B-4 Delta Resync configuration with TI*
Virtual LUN

- Universal Replicator supports the Virtual LUN feature, which allows you to configure custom-size LUs that are smaller than standard-size LUs. When custom-size LUs are assigned to a Universal Replicator pair, the S-VOL must have the same capacity as the P-VOL.
- To perform Virtual LUN operations on a pair’s P-VOL and S-VOL, the pair must be deleted and the volumes’ status returned to SMPL.

Volume Migration

You can specify the Universal Replicator P-VOL or S-VOL as Volume Migration source volumes. However, when the UR pair status is COPY or PAIR, do not perform the volume migration operation; otherwise, the operation is stopped.

Universal Replicator pair volumes and journal volumes cannot be used as Volume Migration target volumes.
Configurations with TrueCopy

This appendix provides information about combining Universal Replicator and TrueCopy operations. For details about TrueCopy, see the *Hitachi TrueCopy® User Guide*.

- Overview of UR/TC configurations
- 3DC cascade configuration
- 3DC multi-target configuration
- 3DC multi-target configuration using delta resync
Overview of UR/TC configurations

Universal Replicator and TrueCopy can share the same data volumes. By combining UR and TC you can extend disaster recovery options to a third data center.

The terms "P-VOL" (primary volume) and "S-VOL" (secondary volume) are used for TC volumes as well as UR volumes.

3DC cascade configuration

The 3DC cascade configuration places a data center at each of the three sites: the primary site, intermediate site, and secondary site.

3DC cascade configuration requirements and cautions

- One VSP G800, VSP F800, or VSP G1000 is required at the each of the three sites of primary, intermediate, and secondary. When there is more than one storage system at each site, the 3DC cascade cannot be configured.
- CCI is recommended at all three sites.
- Hitachi Device Manager - Storage Navigator is required at all three sites.
- The primary site requires the following:
  - Host application
  - TrueCopy
  - TC primary volume (P-VOL), the primary production volume
  - The TC P-VOL fence level (Primary Volume Fence Level) must be Secondary Volume Data.
- The intermediate site requires the following:
  - TrueCopy
  - Universal Replicator
  - TC S-VOL, which is also the UR P-VOL
  - UR master journal
- The secondary site requires the following:
  - Universal Replicator
  - UR S-VOL
  - UR restore journal
- Differential data is used to resynchronize a suspended TC or UR pair.
- When the TC pair is resynchronized, the UR pair in PAIR or COPY status is automatically split by the system.

Setting up the 3DC cascade configuration

Use the following procedure to set up the 3DC cascade configuration.
Procedure

1. Install and set up TC and UR on the required systems.
2. Create a TC pair on the primary system with the S-VOL at the intermediate site. For instructions, see the Hitachi TrueCopy® User Guide.
3. When the TC pair status is PAIR, change the TC S-VOL to UR P-VOL, and then create the UR pair on the primary system.
   The mirror ID must be set between 1 and 3.

Note: Before the UR pair status changes to PAIR, the TC pair must be changed to PAIR. If you indicate to change the UR pair status to PAIR before the TC pair status is changed to PAIR, the request will be rejected.

3DC multi-target configuration

The 3DC multi-target configuration places data centers at the primary site and two secondary sites.

3DC multi-target configuration requirements

- At least one storage system at the primary site, TC secondary site, and UR secondary site. The 3DC multi-target configuration can also be used with multiple storage systems at the primary and secondary sites. However, 3DC multi-target configurations using delta resync are not supported in configurations with multiple primary and secondary systems.
  Supported storage systems for 3DC multi-target configurations: VSP G800, VSP F800, VSP G1000, and HUS VM.
- CCI is recommended at all three sites.
- Hitachi Device Manager - Storage Navigator is required at all three sites.
- The primary site requires the following:
  - TrueCopy
  - Universal Replicator
  - TC primary volume (P-VOL), which is also the UR P-VOL. This is the primary production volume.
  - UR master journal volume
- The TC secondary site requires the following:
  - TrueCopy
  - TC S-VOL
- The UR secondary site requires the following:
  - Universal Replicator
  - UR S-VOL
  - UR restore journal
Setting up the 3DC multi-target configuration

Use the following procedure to set up the 3DC multi-target configuration.

Procedure

1. Install and set up TC and UR on the required systems.
2. Create a TC pair on the primary system. For instructions, see the Hitachi TrueCopy® User Guide.
3. When TC pair status is PAIR, create the UR pair on the primary system. The mirror ID must be set between 1 and 3.

3DC multi-target configuration using delta resync

This configuration places data centers at the primary site and at the two secondary sites.

Additional task for the 3DC multi-target configuration using delta resync

To use the delta resync, you need to perform an additional task by using the following procedure after setting up 3DC multi-target configuration.

Procedure

1. Create the UR delta resync pair.
2. Set up and map remote command devices and external ports in each site. If the delta resync configuration will fail if the remote command devices for the delta resync is not set up. For setting up the remote command devices, see the Hitachi Universal Volume Manager User Guide.
3. Assign mirror IDs to remote command devices. Delta resync configuration will also fail when mirror IDs are not assigned to remote command devices. For assigning mirror IDs to remote command devices, see the related topics. With remote command devices, the TC and UR secondary sites automatically connect with each other, and delta resync is ready. The following figure shows how remote command devices and mirror IDs respond.
Creating the delta resync pair

For creating a UR delta resync pair, all of the following conditions must be met:

- A 3DC multi-target configuration is set up.
- Only one storage system at the primary and the secondary site.
- TC S-VOL's status is PAIR and is used for the UR delta resync P-VOL.
- UR S-VOL's status is PAIR and is used for the UR delta resync S-VOL.
- Between the mirror IDs 1 and 3, UR delta resync pair uses another mirror ID than the one used by the regular UR S-VOL.
- The consistency group is not used in UR pair.
- The conditions when using the TC volumes as UR P-VOL or S-VOL as described in Volume types that can be shared with Universal Replicator on page B-2 are met.
- SOM 506 is set to ON at each site. SOM 506 is set to ON by default.
- When creating multiple UR delta resync pairs, all the above conditions must be met and all the UR delta resync pairs in the journal must use the same mirror ID.
**Procedure**

1. Install and set TrueCopy and Universal Replicator.
2. Create TC pair at the primary system.
3. After the TC pair status become PAIR, create UR pair at the primary system.
4. Create the UR delta resync pair.
   Specify TC pair S-VOL to UR delta resync pair P-VOL, UR pair S-VOL to UR delta resync pair S-VOL.
   When creating UR delta resync pair, select different mirror ID (Mirror ID 1 to 3) than the mirror ID which was used in step 3.

**Setting up remote command devices for delta resync**

To perform delta resync, remote command devices must be set and mirror IDs must be allocated to remote command devices.

To set up the remote command devices, the following conditions must be met:

- Two command devices are set on each site: the primary site, the TC secondary site, and the UR secondary site. For more information about setting up the command device, see the *Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.
- External path is set up between the sites. For more information about setting up the external path, see the *Hitachi Universal Volume Manager User Guide*.

For more information about setting up the remote command device, see the *Hitachi Universal Volume Manager User Guide*.

To allocate mirror IDs to remote command devices, the following conditions must be met:

- Create a 3DC multi-target configuration and UR delta resync pairs.
- Remote command devices are set up between each site. For more information about setting up the remote command devices, see the *Hitachi Universal Volume Manager User Guide*.
  For more information about allocating mirror IDs to remote command devices, see the related topics.

The following figure shows the configuration of the external paths, command devices, and remote command devices.
To set up remote command devices:

1. Map remote command devices to each site.
2. Assign mirror IDs to remote command devices.

### Mapping remote command devices to each site

#### Procedure

1. Configure LU paths between ports at each site.
   For more information about setting up LU path, see the *Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.

2. Set up command devices at all sites.
   For more information about command device settings, see the *Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.

3. On each site, map a command device to a device on one of the other sites.
For more information about mapping the remote command devices, see the *Hitachi Universal Volume Manager User Guide*.

Thus:

- Each site must have two command devices mapped via two different ports to the other two sites.
- Each site must also have two remote command devices mapped-to via different ports from the other two sites.

The following illustration shows this command/remote command device configuration with port configuration.

![Illustration of command/remote command device configuration](image)

For the command device's logical device, the attribute in the table is displayed as Command Device in the Logical Device window. Likewise, for the remote command device's logical device, the attribute in the table is displayed as Remote Command Device in the Logical Device window. For more information about the Logical Device window, see the *Provisioning Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.

After mapping the remote command devices is completed, mirror IDs must be assigned to the remote command devices.

**Assigning mirrors to remote command devices**

You assign the mirror IDs used by the configuration’s journals to the remote command devices. This enables UR control information regarding the delta
resync to be transferred and then read at the secondary sites. This is necessary for the delta resync operation.

**Prerequisites**

- Required role: Storage Administrator (Remote Backup Management)
- To assign a mirror to a remote command device, the mirror’s status must be one of the following:
  - Initial, Active, Halt, Stopped, Hold, Holding, or Hold(Failure)
  - To use a mirror in Initial status, it must have mirror ID 0.
- A maximum of 16 mirrors can be shared with a remote command device.
- A maximum of 16 remote command devices can be used for the delta resync operation per storage system.

**Procedure**

1. Open the **Remote Replication** window.
   In Hitachi Command Suite:
   a. On the **Resources** tab, expand the **Storage Systems** tree.
   b. Right-click the target storage system, and click **Remote Replication**.
   In Device Manager - Storage Navigator:
   a. In the **Explorer** pane, expand the **Storage Systems** tree.
   b. Expand the target storage system tree, expand **Replication**, and click **Remote Replication**.
2. Select the **Mirrors** tab, and then select a mirror (or multiple mirrors) to which you will assign the remote command device.
3. From the **Actions** menu, click **Remote Replication > Assign Remote Command Devices**.
4. In the **Available Mirrors** table, select the mirror.
   At the primary site:
   - Assign mirror ID 0 to the remote command device that is mapped to the TC secondary site.
   - Assign the mirror ID used for the UR 3DC multi-target pair to the remote command device that is mapped to the secondary site.
   At the TC secondary site:
   - Assign mirror ID 0 to the remote command device that is mapped to the primary site.
   - Assign the mirror ID used for the UR delta resync pair to the remote command device that is mapped to the secondary site.
   At the UR secondary site:
   - Assign the mirror ID used for the UR 3DC multi-target configuration to the remote command device that is mapped to the primary site.
   - Assign the mirror ID used for the UR delta resync pair to the remote command device that is mapped to the TC secondary site.
5. In **Remote Command Device**, select the remote command device you want to assign.

6. Click **Add**. The mirror to which you assign the remote command device is added to the **Selected Mirrors** table. If you want to remove the added mirror from the **Selected Mirrors** table, select the mirror you want to delete, and then click **Remove**.

7. Click **Finish**.

8. In the **Confirm** window, review the settings and enter a task name in the **Task Name** box.

9. Click **Apply** to save your settings to the system.

10. To check newly assigned remote command devices, see the **Journal Volumes** window > **Remote Command Device** field.
    - If a remote command device is assigned to the mirror, the LDEV number is displayed.
    - If a remote command device is not assigned to the mirror, the field is blank.
    - If a remote command device cannot be assigned to the mirror, a hyphen (-) is displayed.

**Releasing remote command device assigned to a mirror**

This operation is performed on the mirror when releasing the assigned remote command device.

**Prerequisites**

- **Required role**: Storage Administrator (Remote Backup Management)

**Procedure**

1. Open the **Remote Replication** window.
   - In Hitachi Command Suite:
     a. On the **Resources** tab, expand the **Storage Systems** tree.
     b. Right-click the target storage system, and click **Remote Replication**.
   - In Device Manager - Storage Navigator:
     a. In the **Explorer** pane, expand the **Storage Systems** tree.
     b. Expand the target storage system tree, expand **Replication**, and click **Remote Replication**.

2. Select the **Mirrors** tab, and then select the mirror with the remote command device to be deleted.

3. From the **Actions** menu, click **Remote Replication > Release Remote Command Devices**.

4. In the **Release Remote Command Devices** window, review your selection in the **Selected Mirrors** table. If you need to make a change, select **Cancel**.
5. When ready, click **Finish**.
6. In the **Confirm** window, review the settings, and enter a task name in the **Task Name** box.
7. Click **Apply** to save your settings to the system. When **Go to tasks window for status** is checked, the **Task** window is displayed.

**Conditions for delta resync operations**

When you perform the delta resync, it is required that the the 3DC multi-target configuration using the delta resync is established by mapping remote command devices to the each site and assigning the mirror IDs to the remote command devices. For the delta resync to finish successfully, you must satisfy the following conditions for performing delta resync:

- If a journal necessary for the delta resync does not exist, you cannot perform delta resync.
- The status of the UR delta resync pair's P-VOL is HOLD.
- TC volumes are used as UR P-VOL.
- Required pair and volume statuses:
  - When sharing TC P-VOLs, the UR pair status must be PAIR.
  - When sharing TC S-VOLs, the UR pair status must be SSWS. Check this status after performing the CCI horctakeover command.
  - When UR S-VOL is using two mirror IDs and a mirror ID's S-VOL pair status is HOLD, and the other mirror ID's S-VOL pair status is PAIR, PSUS, or PSUE.
  - In a 3DC multi-target configuration, the number of the regular UR S-VOL and the UR delta resync S-VOL is the same.
- The paths between the UR delta resync pair sites must be valid.

If even one of the above conditions is not satisfied, an error occurs and delta resync will fail. In the following cases, the journal necessary for delta resync does not exist and delta resync will not be performed.

- After creating UR delta resync pair, UR delta resync P-VOL is updated without updating the production volume shared between UR P-VOL and TC P-VOL after creating UR delta resync pair.
- S-VOL is updated after UR pair split.
- After UR pair split, journal data exceeds 70% of the journal volume capacity in the TC secondary site a result of updating P-VOL.
- As a result of updating UR delta resync P-VOL, the journal data exceeds 70% of the journal volume capacity at the UR delta resync primary site.
- When a UR pair has not been suspended and resynchronized for a long time, the data in the restore journal might exceed 70% of capacity. If this happens, old journal data is automatically deleted. In this case, the P-VOL and S-VOL are not synchronized completely by just copying the data, and delta resync will fail. In case of delta resync failure, resynchronize the UR pair.
**Tip:**

- After creating the UR delta resync pair, if the production volume at the primary site is not updated (including the cases when the production volume is not updated after failover or failback), there will be no journal data in the TC secondary site.
- Even if there is no journal data for delta resync in the TC secondary site, you can perform delta resync, but the following two conditions must be met:
  - No data update at all from the host to the primary site, or data update is stopped.
  - The data in the TC secondary site and the UR secondary site is the same. You must resync all of the TC and UR pairs that belong to the target journal in the primary site and change the pair status to PAIR.

In addition, delta resync might not be performed in the following cases because the necessary journal data might get lost:

- Cache memory or shared memory is added or removed by the maintenance operation.
- The storage system is powered off by the maintenance operation.
- TC pair or UR pair is split and then resynchronized.
- The UR pairs in the primary system and the secondary system are resynchronized, and then the P-VOL is updated.
- Disaster or failure occurred in the TC secondary site, and access to the journal volume is impossible.
- Retry operation is caused because the P-VOL update is delayed.
- TC S-VOL update is delayed.
- UR delta resync pair status is changed to HLDE.
  
  In this case, even if the status is changed from HLDE to HOLD, you cannot copy only the differential data by the later delta resync operation. However, you can copy the entire P-VOL data to the S-VOL.

To accumulate journal data after correcting the above conditions, update the primary site data from the host. Even if the status meets all the conditions to perform delta resync without journal data as described in the above tip, the pair status will be changed to HOLDING regardless of the journal existence once the pair status falls in the possibility of no journal status. If the access to the remote command device in the TC secondary site is impossible by failure or disaster, the pair status will not be changed from HOLDING to HOLD.

**Performing the delta resync operation**

You perform the delta resync operation as part of resynchronizing mirrors in case of failure. When performing the delta resync operation, follow the instructions in the related topics. When the delta resync operation is performed, the differential data will be copied from the TC S-VOL to the UR S-VOL.
**In case of delta resync failure**

When the UR pair status is not changed after delta resync, the requirements in the related topics might not meet. In this case, check the status of the TC pair, UR pair, and UR delta resync pair.

**To prevent errors in case of delta resync failure**

If you specify Entire Copy for the Delta Resync Failure option (Edit Mirror Options window) in advance, you can prevent errors from occurring by copying the entire P-VOL data to the secondary volume when the necessary journal data for delta resync is not available. However, the P-VOL data will not be copied to the S-VOL in case of error even if you specify Entire Copy for the Delta Resync Failure option in the following case:

- The UR delta resync S-VOL is assigned to the SI P-VOL or HTI P-VOL.

In the following case, entire data might be copied from the UR delta resync P-VOL to the S-VOL:

- Before performing delta resync, the pair status is changed to PSUS by pair split or PSUE by failure while copying the entire data from the P-VOL to the S-VOL as a UR pair.
Configurations with ShadowImage

Universal Replicator (UR) and ShadowImage (SI) can share the same data volumes to provide multiple copies of data at both the primary and secondary sites.

This appendix provides configurations and information for using ShadowImage with Universal Replicator. For details about ShadowImage, see the *Hitachi ShadowImage® User Guide*.

- Overview
- Configurations with ShadowImage P-VOLs
- Configurations with ShadowImage S-VOLs
- Pair status and data currency
Overview

The main function of Universal Replicator is to provide copies of production volumes in a remote location. Backing up the primary or secondary Universal Replicator volumes using ShadowImage, or backing up the ShadowImage volumes using Universal Replicator, provides additional advantages.

- When sharing the UR primary volume with ShadowImage:
  - On-site data backup is provided in case of a Universal Replicator failure.
  - Multiple copies of production data are provided on the primary site for secondary purposes, such as data analysis, testing and so on.
- Sharing the ShadowImage secondary volume with the Universal Replicator primary volume on the primary site provides a remote copy.
- When ShadowImage is cascaded at the secondary site, data in the ShadowImage secondary volume can be used for testing the Universal Replicator system and for recovery purposes.
  - The ShadowImage secondary volume is available for continuous replication during a test.
  - If a Universal Replicator problem is encountered during an actual recovery procedure, the ShadowImage secondary volume provides a golden copy of the Universal Replicator secondary volume, which can be used to restore the Universal Replicator secondary volume.

Note:

- To split the ShadowImage pairs in a consistency group whose volumes are also used in Universal Replicator pairs, the Universal Replicator pairs must be in PAIR, PSUS, or PSUE status.
- A ShadowImage pair volume can be used with UR volumes if extended.

Universal Replicator data volumes are shared with ShadowImage volumes in specific configurations. The following topics discuss these supported configurations.

Configurations with ShadowImage P-VOLs

A ShadowImage primary volume can be shared with a Universal Replicator primary or secondary volume.

- A ShadowImage primary volume shared with the Universal Replicator primary volume is illustrated below. This configuration allows you to use ShadowImage for on-site data backup in case of a Universal Replicator failure, and to use Universal Replicator to provide remote backup of the ShadowImage primary volume in case of a ShadowImage failure.
A Universal Replicator secondary volume shared with the ShadowImage primary volume is illustrated below. With this configuration, multiple backup copies of the Universal Replicator primary volume can be made on the secondary system.

Caution: When you share a Universal Replicator S-VOL with a ShadowImage P-VOL as shown in the following figure, the restore operation to the Universal Replicator S-VOL takes time. This is especially the case when the ShadowImage pair is in the PSUS(SP)/PSUS status because of the time needed to copy the ShadowImage pair.

Because of the extra time that might be needed, make sure the Universal Replicator journal volume has enough capacity to handle the possible increase in I/O. If journal volume capacity is insufficient, the pair will be suspended because of failure.

Universal Replicator primary and secondary volumes shared with ShadowImage primary volumes is illustrated below. This configuration provides multiple copies of the source volume at the primary and secondary sites.
In the above configurations in which the SI P-VOL is shared, you can only delete UR pairs when the SI P-VOL status is RCPY. The following table shows possibilities of UR pair operations according to the SI P-VOL status.

<table>
<thead>
<tr>
<th>SI P-VOL status</th>
<th>UR pair operations</th>
<th>Switch operations between the primary and secondary sites (horctakeover)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create</td>
<td>Split</td>
</tr>
<tr>
<td>COPY</td>
<td>Yes*</td>
<td>Yes</td>
</tr>
<tr>
<td>PAIR</td>
<td>Yes*</td>
<td>Yes</td>
</tr>
<tr>
<td>PSUS (SP)</td>
<td>Yes*</td>
<td>Yes</td>
</tr>
<tr>
<td>PSUS PSUE</td>
<td>Yes*</td>
<td>Yes</td>
</tr>
<tr>
<td>RCPY</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

* If the UR P-VOL and UR S-VOL are DP-VOLs, the UR S-VOL cannot be used as the SI P-VOL.

Configurations with ShadowImage S-VOLs

The following figure shows a ShadowImage primary volume used as the production volume. A remote Universal Replicator backup copy is made of the ShadowImage secondary volume. The ShadowImage pair must be in PSUS status to perform the Universal Replicator operation.
In this configuration, before creating a UR pair, you must set the SI pair in the PAIR status, split the SI pair, and then set it in the PSUS status. The following table shows possibilities of UR pair operations according to the SI S-VOL status.

<table>
<thead>
<tr>
<th>SI S-VOL status</th>
<th>Create</th>
<th>Split</th>
<th>Resync</th>
<th>Delete</th>
<th>Switch operations between the primary and secondary sites (horctakeover)</th>
</tr>
</thead>
<tbody>
<tr>
<td>COPY</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>PAIR</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>PSUS (SP)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>PSUS PSUE</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RCPY</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Pair status and data currency**

The table below shows whether the data in a shared volume is current, given the combined status.

<table>
<thead>
<tr>
<th>UR pair status</th>
<th>ShadowImage pair status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>COPY(PD)/COPY</td>
</tr>
<tr>
<td>COPY</td>
<td>Not Current</td>
</tr>
</tbody>
</table>

**Figure D-4 Shared UR P-VOL with SI secondary volume**

In this configuration, before creating a UR pair, you must set the SI pair in the PAIR status, split the SI pair, and then set it in the PSUS status. The following table shows possibilities of UR pair operations according to the SI S-VOL status.
Check pair status for shared volumes as follows:

- For Universal Replicator, check status of the primary volume or secondary volume.
- For ShadowImage, check status of the primary volume.

ShadowImage supports multiple secondary volumes for each primary volume. When you check pair status, the system returns status for only one pair—the pair whose secondary volume has the lowest LDEV ID. To see status for the pairs with a different secondary volume, direct a host query to the specific secondary volume using the secondary volume’s LDEV ID in the host command.
Universal Replicator GUI reference

This appendix describes the Universal Replicator windows in Device Manager - Storage Navigator.

- Journals window
- Journal Volumes window
- Journal Properties window
- Create Journals wizard
- Assign Journal Volumes wizard
- Delete Journals window
- Edit Journal Options wizard
- Assign MP Unit wizard
- Edit Mirror Options wizard
- Assign Remote Command Devices wizard
- Release Remote Command Devices window
- View Pair Synchronization Rate window
- Create UR Pairs wizard
- View Pair Properties window
- Split Pairs wizard
- Split Mirrors wizard
- Resync Pairs wizard
- Resync Mirrors wizard
- Delete Pairs wizard
- Force Delete Pairs window
- Delete Mirrors wizard
- Edit Pair Options wizard
Journals window

Use this window to view details about journals and their properties.

Summary

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Journals</td>
<td>Total number of journals, with the maximum number in parentheses.</td>
</tr>
</tbody>
</table>

Journals tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Journals</td>
<td>Opens the Create Journals window.</td>
</tr>
<tr>
<td>Edit Journal Options</td>
<td>Opens the Edit Journal Options window.</td>
</tr>
<tr>
<td>Delete Journals</td>
<td>Opens the Delete Journals window.</td>
</tr>
<tr>
<td>Journal ID</td>
<td>Journal identifier. Clicking the link displays more information about the journal and assigned mirrors and journal volumes.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Indicates whether the journal is Master, Restore, or Initial.</td>
</tr>
<tr>
<td>Number of Journal VOLs</td>
<td>Number of journal volumes registered in the journal.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Journal Capacity</td>
<td>Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all associated volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>MP Unit ID*</td>
<td>MP Unit identifier.</td>
</tr>
</tbody>
</table>
| Encryption*                  | Journal’s encryption status:  
• Enabled: The journal contains encrypted volumes.  
• Disabled: The journal contains unencrypted volumes.  
• Mixed: The journal contains both encrypted and unencrypted volumes.  
  **Note:** Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.  
• - (hyphen): The pool to which the journal volume belongs is an external volume or blocked. |
| Inflow Control*              | Indicates whether the flow of update data to the journal volume is restricted by slowing the response to hosts.                                                                                               |
| Data Overflow Watch*         | Number of seconds the system would monitor write data to the journal volume when the journal volume is full (100%). If Inflow Control is disabled, a hyphen (-) is displayed.                                     |
| Cache Mode*                  | Indicates whether journal data is stored in cache memory in the restore journal.                                                                                                                            |
| More Actions                 | Click to access the following windows:  
• Assign MP Unit wizard  
• Export window                                                                                                                                 |

* These items do not appear in the table by default. To display these items, you must change the column settings for the table.

**Journal Volumes window**

Use this window to view detailed information about individual journals, including the mirrors and journal volumes assigned to it.
### Summary section

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Indicates whether the journal is Master, Restore, or Initial (registered but no pair volumes assigned).</td>
</tr>
<tr>
<td>Number of Journal VOLs</td>
<td>Number of journal volumes registered in the journal, with the maximum number in parentheses.</td>
</tr>
<tr>
<td>Journal Capacity</td>
<td>Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal, with the maximum number in parentheses.</td>
</tr>
<tr>
<td></td>
<td>With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed.</td>
</tr>
<tr>
<td></td>
<td>The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all associated volumes.</td>
</tr>
<tr>
<td></td>
<td>With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed.</td>
</tr>
<tr>
<td></td>
<td>The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>MP Unit ID</td>
<td>MP unit identifier</td>
</tr>
<tr>
<td>Encryption</td>
<td>Journal's encryption status:</td>
</tr>
<tr>
<td></td>
<td>• Enabled: The journal contains encrypted volumes.</td>
</tr>
<tr>
<td></td>
<td>• Disabled: The journal contains unencrypted volumes.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mixed</td>
<td>The journal contains both encrypted and unencrypted volumes. <strong>Note:</strong> Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.</td>
</tr>
<tr>
<td>- (hyphen)</td>
<td>The pool to which the journal volume belongs is an external volume or blocked.</td>
</tr>
<tr>
<td>Inflow Control</td>
<td>Indicates whether flow of update data to the journal volume is restricted by slowing the response to hosts.</td>
</tr>
<tr>
<td>Data Overflow Watch</td>
<td>Number of seconds the system will monitor write data to the journal volume when the journal volume is full (100%). A hyphen (-) is displayed if Inflow Control is disabled.</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Indicates whether journal data is stored in cache memory at the secondary site (restore journal).</td>
</tr>
</tbody>
</table>

### Mirrors tab

From this tab, you can review information about the selected journal’s mirrors.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mirror ID</td>
<td>Mirror identifier.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Indicates whether the journal is Master, Restore, or Initial (registered but no pair volumes assigned).</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror’s status. For definitions, see Monitoring journal (mirror) status on page 7-16.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about the system connected to the system you accessed:</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model and serial number. A hyphen (-) is displayed if the mirror attribute is Initial.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier. A hyphen (-) is displayed if the mirror attribute is Initial.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier specified during pair creation.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all associated volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Remote Command Device                    | LDEV number of the remote command device if it is assigned to the mirror.  
• The column is blank if the remote command device is not assigned to the mirror.  
• A hyphen (-) indicates the remote command device cannot be assigned to the mirror. |
| CTG ID*                                  | Mirror's consistency group identifier. A hyphen (-) indicates there is no consistency group.                                                 |
| CTG Utilization*                         | Indicates whether the consistency group is shared by multiple storage systems.  
• Single: The consistency group consists of a single pair of primary and secondary systems.  
• Multi: The consistency group consists of multiple storage systems.                        |
| Path Watch Time*                         | Interval from the time a path becomes blocked to the time when the mirror is suspended.  
When the status of the mirror's secondary side (RCU) is Hold, Holding, or Hold(Failure), a hyphen (-) is displayed. |
| Path Watch Time Transfer*                | Indicates whether to transfer the master journal's Path Watch Time value to the mirror's secondary side (RCU). When transferred, the Path Watch Time values of the mirror's primary side (MCU) and the secondary side (RCU) will be consistent.  
• Yes: Path Watch Time value will be transferred to the mirror's secondary side (RCU).  
• No: Path Watch Time value will not be transferred to the mirror's secondary side (RCU). |
| Copy Pace*                               | Pace for copying data during initial copy: Slower is the default, Medium, Faster. A hyphen (-) indicates the journal is a restore journal.         |
| Transfer Speed*                          | Data transfer line speed in Mbps (megabits per second): 3, 10, 100, or 256.                                                                    |
| Delta Resync Failure*                    | Processing that takes place in the event of delta resync operation failure.  
• Entire Copy: The entire P-VOL is copied to the S-VOL.  
• No Copy: No processing occurs. The S-VOL is not updated.                                      |
| Split Mirrors                            | Opens the Split Mirrors window.                                                                                                               |
| Resync Mirrors                           | Opens the Resync Mirrors window.                                                                                                               |
| Create UR Pairs                          | Opens the Create UR Pairs window.                                                                                                               |
| More Actions                             | Opens a menu for accessing:  
• Edit Mirror Options window  
• View Remote Connection Properties window  
• Delete Mirrors window  
• Assign Remote Command Devices window  
• Release Remote Command Devices window  
• Export window                                                                   |
These items do not appear in the table by default. To display these items, you must change the column settings for the table.

**Journal Volumes tab**

From this tab, you can view information about the selected journal’s journal volumes.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s identifier consisting of the LDKC number, CU number, and LDEV number. Clicking the link opens the LDEV Properties window.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Name of the journal volume’s LDEV.</td>
</tr>
<tr>
<td>Pool Name (ID)</td>
<td>Identifier consisting of the pool name and the pool ID. Clicking the link opens a window with pool information.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Type of RAID implementation for the journal volume.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Journal volume’s capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>Journal volume’s CLPR ID. The ID displays before the colon; the CLPR name displays after the colon.</td>
</tr>
<tr>
<td>Encryption*</td>
<td>Encryption information:</td>
</tr>
<tr>
<td></td>
<td>• Enabled: The parity group encryption to which the LDEV belongs is enabled, or a V-VOL is associated with a pool in which a pool volume has encryption enabled.</td>
</tr>
<tr>
<td></td>
<td>• Disabled: The parity group encryption to which the LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.</td>
</tr>
<tr>
<td></td>
<td>• Mixed: The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.</td>
</tr>
<tr>
<td></td>
<td>• - (hyphen): The LDEV is an external volume. For DP-VOLs, the pool to which the LDEV belongs is either an external volume or blocked.</td>
</tr>
<tr>
<td>Resource Group Name (ID)</td>
<td>LDEV’s resource group name and identifier. The ID is enclosed in parentheses.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of journal volume:</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>* Journal: journal volume</td>
<td></td>
</tr>
<tr>
<td>* Reserve Journal: reserve journal volume</td>
<td></td>
</tr>
<tr>
<td>Assign Journal Volumes</td>
<td>Opens the Assign Journal Volumes window.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the window for exporting table information.</td>
</tr>
</tbody>
</table>

* This item does not appear in the table by default. To display this item, you must change the column settings for the table. For details, see the *System Administrator Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models*.

**Journal Properties window**

Use this window to view information about the selected journal.

![Journal Properties window](image)

<table>
<thead>
<tr>
<th>Journal ID</th>
<th>001</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP Unit ID</td>
<td>Auto</td>
</tr>
<tr>
<td>Encryption</td>
<td>Enabled</td>
</tr>
<tr>
<td>Inflex Control</td>
<td>Enabled</td>
</tr>
<tr>
<td>Data Overflow Watch</td>
<td>60 Second(s)</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Enabled</td>
</tr>
<tr>
<td>Number of Journal Volumes</td>
<td>1 (Max Allowed: 2)</td>
</tr>
<tr>
<td>Journal Capacity</td>
<td>2000 GB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LDEV ID</th>
<th>LDEV Name</th>
<th>Pool Name (ID)</th>
<th>RAID Level</th>
<th>Capacity</th>
<th>CLPR</th>
<th>Encryption</th>
<th>Resource Group Name (ID)</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>00/001+1</td>
<td>BPN(2)</td>
<td>B(2D+1P)</td>
<td>2000 GB</td>
<td>ON</td>
<td>CLPR</td>
<td>Enabled</td>
<td>meta_resource ...</td>
<td>Jour</td>
</tr>
</tbody>
</table>
### Journal Properties table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>MP Unit ID</td>
<td>MP unit identifier</td>
</tr>
<tr>
<td>Encryption</td>
<td>Journal's encryption information:</td>
</tr>
<tr>
<td></td>
<td>- Enabled: The journal contains encrypted volumes.</td>
</tr>
<tr>
<td></td>
<td>- Disabled: The journal contains unencrypted volumes.</td>
</tr>
<tr>
<td></td>
<td>- Mixed: The journal contains both encrypted and unencrypted volumes.</td>
</tr>
<tr>
<td>Note: Encryption</td>
<td>Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.</td>
</tr>
<tr>
<td></td>
<td>- (hyphen): The pool to which the journal volume belongs is an external volume or blocked.</td>
</tr>
<tr>
<td>Inflow Control</td>
<td>Indicates whether flow of update data to the journal volume is restricted by slowing the response to hosts.</td>
</tr>
<tr>
<td>Data Overflow Watch</td>
<td>Number of seconds the system will monitor write data to the journal volume when the journal volume is full (100%). A hyphen (-) is displayed if Inflow Control is disabled.</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Indicates whether journal data is stored in cache memory at the secondary site (restore journal).</td>
</tr>
<tr>
<td>Number of Journal VOLs</td>
<td>Number of journal volumes registered in the journal, with the maximum number in parentheses.</td>
</tr>
<tr>
<td>Journal Capacity</td>
<td>Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total.</td>
</tr>
</tbody>
</table>

### Journal Volumes table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s identifier consisting of the LDKC number, CU number, and LDEV number. Clicking the link opens the LDEV Properties window.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Name of the journal volume’s LDEV.</td>
</tr>
<tr>
<td>Pool Name (ID)</td>
<td>Identifier consisting of the pool name and the pool ID. Clicking the link opens a window with pool information.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Type of RAID implementation for the journal volume.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Journal volume’s capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>Journal volume’s CLPR ID. The ID displays before the colon; the CLPR name displays after the colon.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Encryption information:</td>
</tr>
<tr>
<td></td>
<td>- Enabled: The parity group encryption to which the LDEV belongs is enabled, or a V-VOL is associated with a pool in which a pool volume has encryption enabled.</td>
</tr>
</tbody>
</table>
### Item Description

- **Disabled:** The parity group encryption to which the LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.
- **Mixed:** The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled.

**Note:** Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.
- **- (hyphen):** The LDEV is an external volume. For DP-VOLs, the pool to which the LDEV belongs is either an external volume or blocked.

### Create Journals wizard

Use this wizard to create journals and add journal volumes.

### Create Journals window

Use this window to create journals and add journal volumes.

![Create Journals window](image)
### Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Journal ID</strong></td>
<td>Identifier for the journal, displayed in ascending order. Blank if no number is available.</td>
</tr>
</tbody>
</table>
| **Journal Volume Selection** | • Select Journal Volumes: Opens the Select Journal Volumes dialog box.  
• Total Selected Journal Volumes: Number of selected journal volumes.  
• Total Selected Capacity: Capacity of selected journal volumes.                                                                                   |
| **MP Unit ID**            | Journal MP unit. Auto can be selected when one or more MP units can be assigned automatically. The default is Auto if it can be selected. If Auto cannot be selected, the default is the MP unit with the lowest number. |
| **Inflow Control**        | Controls the flow of update data to the journal volume by slowing the response to hosts.                                                                                                                   |
|                           | • Enable: The flow is restricted.  
• Disable: The flow is not restricted.                                                                                                              |
| **Data Overflow Watch**   | Number of seconds the system will monitor write data to the journal volume when the journal volume is full (100%). Range is 0-600 seconds. The default is 60.                                                   |
| **Cache Mode**            | Indicates whether to store journal data in cache memory at the secondary site.                                                                                                                                |
|                           | • Enable: Data is stored in cache.  
• Disable: Data is not stored in cache.                                                                                                               |

### Selected Journals table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Journal ID</strong></td>
<td>Identifier for the journal LDEV, displayed in ascending order. Blank of no number is available.</td>
</tr>
<tr>
<td><strong>Number of Journal VOLs</strong></td>
<td>Number of journal volumes registered in the journal.</td>
</tr>
<tr>
<td><strong>Journal Capacity</strong></td>
<td>Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total.</td>
</tr>
<tr>
<td><strong>MP Unit ID</strong></td>
<td>MP unit identifier</td>
</tr>
<tr>
<td><strong>Encryption</strong></td>
<td>Journal's encryption status:</td>
</tr>
</tbody>
</table>
|                           | • Enabled: The journal contains encrypted volumes.  
• Disabled: The journal contains unencrypted volumes.  
• Mixed: The journal contains both encrypted and unencrypted volumes.                                                                                |
|                           | **Note:** Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled. |
Item | Description
--- | ---
• - (hyphen): The pool to which the journal volume belongs is an external volume or blocked.
Inflow Control | Indicates whether the flow of update data to the journal volume is restricted by slowing the response to hosts.
Data Overflow Watch (sec) | Number of seconds the system will monitor write data to the journal volume when the journal volume is full (100%). A hyphen (-) is displayed if Inflow Control is disabled.
Cache Mode | Indicates whether journal data is stored in cache memory at the secondary site (restore journal).
Detail | Opens the Journal Properties window for the selected journal.
Remove | Removes the selected journal from the list.

Select Journal Volumes dialog box

Available LDEVs table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s identifier consisting of the LDKC number, CU number, and LDEV number. Clicking the link opens the LDEV Properties window.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Name of the journal volume’s LDEV.</td>
</tr>
<tr>
<td>Pool Name (ID)</td>
<td>Identifier consisting of the pool name and the pool ID. Clicking the link opens a window with pool information.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Type of RAID implementation for the journal volume.</td>
</tr>
</tbody>
</table>
### Attribute

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Attribute | Displays the attribute:  
  - SLU: Volume with SLU attribute.  
  - (hyphen): The attribute is not set. |

### Capacity

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Journal volume’s capacity.</td>
</tr>
</tbody>
</table>

### CLPR

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLPR</td>
<td>Journal volume’s CLPR ID. The ID displays before the colon; the CLPR name displays after the colon.</td>
</tr>
</tbody>
</table>

### Encryption

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Encryption | Encryption information:  
  - Enabled: The parity group encryption to which the LDEV belongs is enabled, or a V-VOL is associated with a pool in which a pool volume has encryption enabled.  
  - Disabled: The parity group encryption to which the LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.  
  - Mixed: The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled.  
  **Note:** Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.  
  - (hyphen): The LDEV is an external volume. For DP-VOLs, the pool to which the LDEV belongs is either an external volume or blocked. |

### Resource Group Name (ID)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Group Name (ID)</td>
<td>LDEV’s resource group name and identifier. The ID is enclosed in parentheses.</td>
</tr>
</tbody>
</table>

### Selected Journal Volumes table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s identifier consisting of the LDKC number, CU number, and LDEV number. Clicking the link opens the LDEV Properties window.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Name of the journal volume’s LDEV.</td>
</tr>
<tr>
<td>Pool Name (ID)</td>
<td>Identifier consisting of the pool name and the pool ID. Clicking the link opens a window with pool information.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Type of RAID implementation for the journal volume.</td>
</tr>
</tbody>
</table>
| Attribute  | Displays the attribute:  
  - SLU: Volume with SLU attribute.  
  - (hyphen): The attribute is not set. |
| Capacity   | Journal volume’s capacity. |
| CLPR       | Journal volume’s CLPR ID. The ID displays before the colon; the CLPR name displays after the colon. |
| Encryption | Encryption information: |
**Item** | **Description**
--- | ---
- Enabled: The parity group encryption to which the LDEV belongs is enabled, or a V-VOL is associated with a pool in which a pool volume has encryption enabled.
- Disabled: The parity group encryption to which the LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.
- Mixed: The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled.

**Note:** Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.

- (hyphen): The LDEV is an external volume. For DP-VOLs, the pool to which the LDEV belongs is either an external volume or blocked.

| Resource Group Name (ID) | LDEV's resource group name and identifier. The ID is enclosed in parentheses. |

**Create Journals confirmation window**

**Item** | **Description**
--- | ---
Journal ID | Identifier for the journal LDEV, displayed in ascending order. Blank if no number is available. |
Number of Journal VOLs | Number of journal volumes registered in the journal. |
Journal Capacity | Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total. |
MP Unit ID | MP unit identifier |
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption</td>
<td>Journal's encryption status:</td>
</tr>
<tr>
<td></td>
<td>• Enabled: The journal contains encrypted volumes.</td>
</tr>
<tr>
<td></td>
<td>• Disabled: The journal contains unencrypted volumes.</td>
</tr>
<tr>
<td></td>
<td>• Mixed: The journal contains both encrypted and unencrypted volumes.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.</td>
</tr>
<tr>
<td></td>
<td>• - (hyphen): The LDEV is an external volume. For DP-VOLs, the pool to which the LDEV belongs is either an external volume or blocked.</td>
</tr>
<tr>
<td>Inflow Control</td>
<td>Indicates whether the flow of update data to the journal volume is restricted by slowing the response to hosts.</td>
</tr>
<tr>
<td>Data Overflow Watch (sec)</td>
<td>Number of seconds the system will monitor write data to the journal volume when the journal volume is full (100%). A hyphen (-) is displayed if Inflow Control is disabled.</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Indicates whether journal data is stored in cache memory at the secondary site (restore journal).</td>
</tr>
<tr>
<td>Detail</td>
<td>Opens the Journal Properties window for the selected journal.</td>
</tr>
</tbody>
</table>

**Assign Journal Volumes wizard**

Use this wizard to assign journal volumes to a journal.

**Assign Journal Volumes window**

Use this window to assign journal volumes to a journal.
## Unassigned Journal Volumes table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s LDEV identifier: LDKC number, CU number and LDEV number.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Journal volume’s LDEV name.</td>
</tr>
<tr>
<td>Pool Name (ID)</td>
<td>Journal volume’s pool name and ID.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Journal volume’s RAID level.</td>
</tr>
</tbody>
</table>
| Attribute           | Displays the attribute:  
  - JNL VOL: Journal volume.  
  - SLU: Volume with SLU attribute.  
  - (hyphen): The attribute is not set. |
| Capacity            | Journal volume capacity. |
| CLPR                | Journal volume’s CLPR ID and name. |
| Encryption          | Encryption information:  
  - Enabled: The parity group encryption to which the LDEV belongs is enabled, or a V-VOL is associated with a pool in which a pool volume has encryption enabled.  
  - Disabled: The parity group encryption to which the LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.  
  - Mixed: The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled. |
### Assigned Journal Volumes table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s LDEV identifier: LDKC number, CU number and LDEV number.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Journal volume’s LDEV name.</td>
</tr>
<tr>
<td>Pool Name (ID)</td>
<td>Journal volume’s pool name and ID.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Journal volume’s RAID level.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Displays the attribute:                                                                                                           • JNL VOL: Journal volume.                                                                                               • SLU: Volume with SLU attribute.                                                                 • - (hyphen): The attribute is not set.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Journal volume capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>Journal volume’s CLPR ID and name.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Encryption information:                                                                                       • Enabled: The parity group encryption to which the LDEV belongs is enabled, or a V-VOL is associated with a pool in which a pool volume has encryption enabled.</td>
</tr>
<tr>
<td></td>
<td>• Disabled: The parity group encryption to which the LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.</td>
</tr>
<tr>
<td></td>
<td>• Mixed: The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.</td>
</tr>
<tr>
<td></td>
<td>• - (hyphen): The LDEV is an external volume. For DP-VOLs, the pool to which the LDEV belongs is either an external volume or blocked.</td>
</tr>
<tr>
<td>Resource Group Name (ID)</td>
<td>LDEV’s resource group name and ID. The ID is enclosed in parentheses.</td>
</tr>
<tr>
<td>Removable</td>
<td>Wether the journal volumes can be removed (Yes or No). If the mirror status to which the journals belong is Active, the journal volumes cannot be removed.</td>
</tr>
</tbody>
</table>
Assign Journal Volumes confirmation window

### Selected Journal table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
</tbody>
</table>

### Assigned Journal Volumes table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s LDEV identifier: LDKC number, CU number and LDEV number.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Journal volume’s LDEV name.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of journal volume:</td>
</tr>
<tr>
<td></td>
<td>• Journal: journal volume</td>
</tr>
<tr>
<td></td>
<td>• Reserve Journal: reserve journal volume</td>
</tr>
<tr>
<td>Pool Name (ID)</td>
<td>Journal volume’s pool name and ID.</td>
</tr>
<tr>
<td>RAID Level</td>
<td>Journal volume’s RAID level.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Capacity of the journal volume.</td>
</tr>
<tr>
<td>CLPR</td>
<td>CLPR of the journal volume.</td>
</tr>
<tr>
<td>Resource Group Name (ID)</td>
<td>Resource Group Name and ID.</td>
</tr>
</tbody>
</table>

---

Universal Replicator GUI reference

Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Journal volume capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>Journal volume’s CLPR ID and name.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Encryption information:</td>
</tr>
<tr>
<td></td>
<td>• Enabled: The parity group encryption to which the LDEV belongs is</td>
</tr>
<tr>
<td></td>
<td>enabled, or a V-VOL is associated with a pool in which a pool</td>
</tr>
<tr>
<td></td>
<td>volume has encryption enabled.</td>
</tr>
<tr>
<td></td>
<td>• Disabled: The parity group encryption to which the LDEV belongs is</td>
</tr>
<tr>
<td></td>
<td>disabled, or a V-VOL is associated with a pool in which a pool</td>
</tr>
<tr>
<td></td>
<td>volume has encryption disabled.</td>
</tr>
<tr>
<td></td>
<td>• Mixed: The pool to which the LDEV belongs contains both pool</td>
</tr>
<tr>
<td></td>
<td>volumes for which encryption is enabled and pool volumes for</td>
</tr>
<tr>
<td></td>
<td>which encryption is disabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Encryption of data is not ensured in an LDEV with the Mixed</td>
</tr>
<tr>
<td></td>
<td>encryption status. To manage data encryption, use an LDEV for</td>
</tr>
<tr>
<td></td>
<td>which Encryption is Enabled or Disabled.</td>
</tr>
<tr>
<td></td>
<td>• - (hyphen): The LDEV is an external volume. For DP-VOLs, the pool</td>
</tr>
<tr>
<td></td>
<td>to which the LDEV belongs is either an external volume or blocked.</td>
</tr>
<tr>
<td>Resource Group Name</td>
<td>LDEV’s resource group name and ID. The ID is enclosed in parentheses.</td>
</tr>
<tr>
<td>(ID)</td>
<td></td>
</tr>
</tbody>
</table>

**Unassigned Journal Volumes table**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Journal volume’s LDEV identifier: LDKC number, CU number and LDEV number.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Journal volume’s LDEV name.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of journal volume:</td>
</tr>
<tr>
<td></td>
<td>• Journal: journal volume</td>
</tr>
<tr>
<td></td>
<td>• Reserve Journal: reserve journal volume</td>
</tr>
<tr>
<td>Pool Name</td>
<td>Journal volume’s pool name and ID.</td>
</tr>
<tr>
<td>(ID)</td>
<td></td>
</tr>
<tr>
<td>RAID Level</td>
<td>Journal volume’s RAID level.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Journal volume capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>Journal volume’s CLPR ID and name.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Encryption information:</td>
</tr>
<tr>
<td></td>
<td>• Enabled: The parity group encryption to which the LDEV belongs is enabled, or a V-VOL is associated with a pool in which a pool volume has encryption enabled.</td>
</tr>
<tr>
<td></td>
<td>• Disabled: The parity group encryption to which the LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.</td>
</tr>
<tr>
<td></td>
<td>• Mixed: The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled.</td>
</tr>
</tbody>
</table>
**Delete Journals window**

Use this window to delete journals.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Number of Journal VOLs</td>
<td>Number of journal volumes registered in the journal.</td>
</tr>
<tr>
<td>Journal Capacity</td>
<td>Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total.</td>
</tr>
<tr>
<td>Detail button</td>
<td>Opens the Journal Properties window for the selected journal.</td>
</tr>
</tbody>
</table>

**Edit Journal Options wizard**

Use this wizard to change journal options.

**Edit Journal Options window**

Use this window to change journal options.
### Edit Journal Options

This wizard lets you edit one or more properties. Check the box in front of the property you want to edit, and then enter a new value.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inflow Control</td>
<td>Indicates whether the flow of update data to the journal volume is restricted by slowing the response to hosts.</td>
</tr>
<tr>
<td>Data Overflow Watch</td>
<td>Number of seconds the system will monitor write data to the journal volume when the journal volume is full (100%). The field is blank if Inflow Control is disabled.</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Indicates whether journal data is stored in cache memory at the secondary site (restore journal).</td>
</tr>
</tbody>
</table>

#### Item | Description
---|---
<p>| Journal ID | Journal identifier. |
| Attribute | Master, Restore, or Initial (registered but no pair volumes assigned). |
| Number of Journal VOLs | Number of journal volumes registered in the journal. |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal Capacity</td>
<td>Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all associated volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Inflow Control</td>
<td>Indicates whether the flow of update data to the journal volume is restricted by slowing the response to hosts.</td>
</tr>
<tr>
<td>Data Overflow Watch</td>
<td>Number of seconds the system will monitor write data to the journal volume when the journal volume is full (100%). A hyphen (-) is displayed if Inflow Control is disabled.</td>
</tr>
<tr>
<td>Cache Mode</td>
<td>Indicates whether journal data is stored in cache memory at the secondary site (restore journal).</td>
</tr>
</tbody>
</table>

**Assign MP Unit wizard**

Use this wizard to assign an MP unit to a journal.

**Assign MP Unit window**

Use this window to assign an MP unit to a journal.
Assign MP Unit confirmation window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Indicates whether the journal is Master, Restore, or Initial (registered but no pair volumes assigned).</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Number of Journal VOLs</td>
<td>Number of journal volumes registered in the journal.</td>
</tr>
<tr>
<td>Journal Capacity</td>
<td>Capacity of the journal volume registered in the journal. If two journal volumes are registered, the amount of the reserve journal volume is subtracted from the total.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all associated volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>MP Unit ID</td>
<td>MP unit identifier.</td>
</tr>
</tbody>
</table>

**Edit Mirror Options wizard**

Use this wizard to change a mirror’s options.

**Edit Mirror Options window**

Use this window to change the mirror options.

![Edit Mirror Options window](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path Watch Time</td>
<td>Interval from the time a path becomes blocked to the time when the mirror is suspended. The Path Watch Time value can be specified using Minutes, Hours, or Days. The range is 1 to 59 minutes, 1 to 23 hours, or 1 to 30 days.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Path Watch Time Transfer | Indicates whether to transfer the master journal's Path Watch Time value to the mirror's secondary side (RCU). When transferred, the Path Watch Time values of the mirror's primary side (MCU) and the secondary side (RCU) will be consistent.  
- Yes: Path Watch Time value will be transferred to the mirror's secondary side (RCU).  
- No: Path Watch Time value will not be transferred to the mirror's secondary side (RCU). Default value is No. |
| Copy Pace                | Pace for copying data during initial copy: Slower is the default, Medium, Faster.                                                             |
| Transfer Speed           | Data transfer line speed in Mbps (megabits per second): 3, 10, 100, or 256.                                                                      |
| Delta Resync Failure     | Processing that takes place in the event of delta resync operation failure.  
- Entire Copy: The entire P-VOL is copied to the S-VOL.  
- No Copy: No processing occurs. The S-VOL is not updated. Delta Resync Failure cannot be set at the secondary site. Use Entire Copy if your journals are part of a multiple-journal configuration in a CCI consistency group.  
When used with GAD, NO COPY applies regardless of the setting. If delta resync processing fails, no processing is performed and the SVOL is not updated. In that case, resynchronize the UR pair. |

**Edit Mirror Options confirmation window**

- **Task Name:** 151215-EditMirrorOptions
  (Max. 32 Characters)

- **Selected Mirrors**

<table>
<thead>
<tr>
<th>Journal ID</th>
<th>Mirror ID</th>
<th>Attribute</th>
<th>Status</th>
<th>Path Watch Time</th>
<th>Path Watch Time Transfer</th>
<th>Copy Pace</th>
<th>Transfer Speed</th>
<th>Delta Resync Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>0</td>
<td>Master</td>
<td>Active / P2PN</td>
<td>S none</td>
<td>No</td>
<td>Slower</td>
<td>256 Mbps</td>
<td>Entire Copy</td>
</tr>
</tbody>
</table>

- **Edit Mirror Options confirmation window**

- **Item**

<table>
<thead>
<tr>
<th>Journal ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal identifier.</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror identifier.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Indicates whether the journal is Master, Restore, or Initial (registered but no pair volumes assigned).</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror's status.</td>
</tr>
<tr>
<td>Path Watch Time</td>
<td>Interval from the time a path becomes blocked to the time when the mirror is suspended. When the status of the mirror's secondary side (RCU) is Hold, Holding, or Hold(Failure), a hyphen (-) is displayed.</td>
</tr>
<tr>
<td>Path Watch Time Transfer</td>
<td>Indicates whether to transfer the master journal's Path Watch Time value to the mirror's secondary side (RCU). When transferred, the Path Watch Time values of the mirror's primary side (MCU) and the secondary side (RCU) will be consistent.</td>
</tr>
<tr>
<td></td>
<td>- Yes: Path Watch Time value will be transferred to the mirror's secondary side (RCU).</td>
</tr>
<tr>
<td></td>
<td>- No: Path Watch Time value will not be transferred to the mirror's secondary side (RCU).</td>
</tr>
<tr>
<td>Copy Pace</td>
<td>Pace for copying data during initial copy: Slower is the default, Medium, Faster. If the selected journal is a restore journal, a hyphen (-) is displayed.</td>
</tr>
<tr>
<td>Transfer Speed</td>
<td>Data transfer line speed in Mbps (megabits per second): 3, 10, 100, or 256.</td>
</tr>
<tr>
<td>Delta Resync Failure</td>
<td>Processing that takes place in the event of delta resync operation failure.</td>
</tr>
<tr>
<td></td>
<td>- Entire Copy: The entire P-VOL is copied to the S-VOL.</td>
</tr>
<tr>
<td></td>
<td>- No Copy: No processing occurs. The S-VOL is not updated.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>- Model/Serial Number: Storage system’s model and serial number. A hyphen (-) is displayed if the mirror attribute is Initial.</td>
</tr>
<tr>
<td></td>
<td>- Journal ID: Journal identifier. A hyphen (-) is displayed if the mirror attribute is Initial.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier specified at DKC registration.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all associated volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remote Command Device</td>
<td>LDEV number of the remote command device if it is assigned to the mirror.</td>
</tr>
<tr>
<td></td>
<td>• The column is blank if the remote command device is not assigned to the mirror.</td>
</tr>
<tr>
<td></td>
<td>• A hyphen (-) indicates the remote command device cannot be assigned to the mirror.</td>
</tr>
</tbody>
</table>

### Assign Remote Command Devices wizard

Use this wizard to assign remote command devices.

### Assign Remote Command Devices window

Use this window to assign mirrors to remote command devices.

### Available Mirrors table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror identifier.</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror status.</td>
</tr>
</tbody>
</table>
Information setting area

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Command Device</td>
<td>Select the remote command device (LDKC, CU, and LDEV numbers) you want to assign to the mirror.</td>
</tr>
<tr>
<td>Add button</td>
<td>Adds the mirror selected in the Available Mirrors table and the remote command device information selected in the Remote Command Device to the Selected Mirrors table.</td>
</tr>
</tbody>
</table>

Selected Mirrors table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror identifier.</td>
</tr>
<tr>
<td>Remote Command Device</td>
<td>Displays the LDKC, CU, and LDEV numbers of the remote command device selected in Remote Command Device.</td>
</tr>
<tr>
<td>Remove button</td>
<td>Removes the mirror selected in the Selected Mirrors table.</td>
</tr>
</tbody>
</table>

Assign Remote Command Devices confirmation window

Assign Remote Command Devices


Enter a name for the task. Confirm the settings in the list and click Apply to add task in Tasks queue for execution.

Task Name: 140910-AssignRemoteCommandDevice

(Max. 32 Characters)

<table>
<thead>
<tr>
<th>Selected Mirrors</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td></td>
</tr>
<tr>
<td>Mirror ID</td>
<td></td>
</tr>
<tr>
<td>Remote Command Device</td>
<td></td>
</tr>
<tr>
<td>OFF</td>
<td>2</td>
</tr>
</tbody>
</table>

Total: 1

Item                        | Description                                                                                                                                 |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
</tbody>
</table>
### Release Remote Command Devices window

Use this window to release a remote command device from a mirror.

![Release Remote Command Devices window](image)

### Selected Mirrors table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mirror ID</td>
<td>Mirror identifier.</td>
</tr>
<tr>
<td>Remote Command Device</td>
<td>LDKC, CU, and LDEV numbers of the remote command device.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Indicates whether the journal is Master, Restore, or Initial (registered but no pair volumes assigned).</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror’s status.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>- Model/Serial Number: Storage system model and serial number. A hyphen (-) is displayed if the mirror attribute is Initial.</td>
</tr>
<tr>
<td></td>
<td>- Journal ID: Journal identifier. A hyphen (-) is displayed if the mirror attribute is Initial.</td>
</tr>
<tr>
<td>Path group ID</td>
<td>Path group’s identifier.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all associated volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
</tbody>
</table>

**View Pair Synchronization Rate window**

Use this window to view the percentage of synchronized data between P-VOL and S-VOL.

**Item**

Displays the following information about pair volumes in the Local Storage System.

- LDEV ID: LDEV identifier.
- LDEV Name: LDEV name.
- Pair Position: Identifies the volume as primary or secondary.
- Journal ID: Journal identifier.
- Mirror ID: Pair’s mirror ID.
- CLPR: CLPR ID.
- Virtual storage machine: Virtual storage machine’s model type and serial number.
- Virtual LDEV ID: Volume’s virtual LDEV identifier.
- Virtual Device Name: Volume’s virtual device name, in the format:
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>virtual emulation type/number</td>
<td>virtual emulation type/number of virtual LUSE volumes/virtual CVS attribute</td>
</tr>
<tr>
<td>of virtual LUSE volumes/virtual</td>
<td>- Only attributes that are specified display.</td>
</tr>
<tr>
<td>CVS attribute</td>
<td>- “CVS” displays at the end of the device name, if the virtual CVS attribute is specified.</td>
</tr>
<tr>
<td></td>
<td>- A blank indicates no values are specified.</td>
</tr>
<tr>
<td>Virtual SSID</td>
<td>• Virtual SSID: Volume’s virtual SSID. A blank indicates that no virtual SSID is specified.</td>
</tr>
<tr>
<td>Copy Type</td>
<td>Type of pair:</td>
</tr>
<tr>
<td></td>
<td>• UR: Universal Replicator</td>
</tr>
<tr>
<td></td>
<td>• TC: TrueCopy</td>
</tr>
<tr>
<td>Status</td>
<td>Pair’s status. For information, see <a href="#">Pair status definitions on page 7-3</a>.</td>
</tr>
<tr>
<td>Synchronization Rate (%)</td>
<td>Displayed as follows:</td>
</tr>
<tr>
<td></td>
<td>• When the volume on the local storage system is a P-VOL: Initial copy progress is displayed.</td>
</tr>
<tr>
<td></td>
<td>• When the volume on the local storage system is an S-VOL: The synchronization rate depends on whether the pair is split:</td>
</tr>
<tr>
<td></td>
<td>o If the pair is not split, a hyphen (-) is displayed.</td>
</tr>
<tr>
<td></td>
<td>o If the pair is split, the S-VOL synchronization rate between before and after split is displayed. For example, if the S-VOL content before and after split is the same, 100 is displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution:</strong> If the pair is split due to initial copy failure, a hyphen (-) is displayed. If initial copy fails, the status Initial copy failed is displayed in the View Pair Properties window.</td>
</tr>
<tr>
<td></td>
<td>• If the pair volume is queued, (Queuing) is displayed.</td>
</tr>
<tr>
<td></td>
<td>• In the following cases a hyphen (-) is displayed:</td>
</tr>
<tr>
<td></td>
<td>o When the volume in the local storage system is neither a P-VOL nor an S-VOL.</td>
</tr>
<tr>
<td></td>
<td>o When the volume in the local storage system has one of the following pair statuses: HOLD, HOLDING, or HLDE.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• LDEV ID: LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td></td>
<td>• Virtual storage machine: Virtual storage machine’s model type and serial number.</td>
</tr>
<tr>
<td></td>
<td>• Virtual LDEV ID: Volume’s virtual LDEV identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier</td>
</tr>
<tr>
<td>Refresh</td>
<td>Updates the information displayed in the window.</td>
</tr>
</tbody>
</table>
Create UR Pairs wizard

Use this wizard to create UR pairs.

- Create UR Pairs window on page E-33
- Change Settings window on page E-37
- Create UR Pairs confirmation window on page E-39

Create UR Pairs window

Use this window to create pairs.

In this topic, you can view the following tables:

- Settings on page E-33
- Primary Volume Selection on page E-34
- Secondary Volume Selection on page E-35
- Mirror Selection on page E-35
- Options on page E-36
- Selected Pairs table on page E-36

Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Storage System</td>
<td>Selections in the remote system.</td>
</tr>
<tr>
<td></td>
<td>• Model / Serial Number: Select the model and serial number.</td>
</tr>
<tr>
<td></td>
<td>• Path Group ID: Select the ID of the path group.</td>
</tr>
</tbody>
</table>
## Primary Volume Selection

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Selection Object      | Select a port in the local storage system.  
- Fibre: Select when specifying LU for Fibre port.  
- iSCSI: Select when specifying LU for iSCSI port.  
- NAS Platform (User LU): Select when specifying LU for NAS port. Displayed only when NAS modules are installed. This option is not displayed for VSP G200.  
Ports without LUs cannot be selected. If only one port type (Fibre, iSCSI, or NAS platform) has an LU, the port type is selected automatically. |
| LU Selection          |  
- Port ID: Local system's port identifier.  
- Host Group Name: Host group name. Displays only when Fibre port is selected in Port Name.  
- iSCSI Target Alias: Selections for iSCSI target alias. All of the LUNs in the indicated port for Available LDEVs if Any is selected. Displays when iSCSI port is selected for Port Name. |
| Available Primary Volumes | Displayed only for UR pairs.  
- Port ID: Port identifier.  
- Host Group Name / iSCSI Target Alias: Host group name or iSCSI target alias.  
- iSCSI Target Name: Volume's iSCSI target name.  
- LUN ID: LUN identifier.  
- LDEV ID: LDEV identifier.  
- LDEV Name: LDEV name.  
- Pair Position: Identifies the volume as primary or secondary. A blank is displayed if the volume is not used by a pair.  
- Journal ID: Journal identifier. A blank is displayed if the volume is not used by a pair.  
- Mirror ID: Mirror ID. A blank is displayed if the volume is not used by a pair.  
- Provisioning Type: Whether the volume is Basic (internal) or External.  
- Attribute:  
  - ALU: Volume with ALU attribute.  
  - SLU: Volume with SLU attribute.  
  - Data Direct Mapping: Volume with the data direct mapping attribute.  
  - NAS Platform (User LU): User LU for NAS.  
    If the attribute is not set, a hyphen (-) is displayed.  
- Capacity: LDEV's capacity.  
- CLPR: CLPR ID.  
- Encryption: Encryption information.  
  - Enabled: The parity group encryption to which LDEV belongs is enabled, or a V-VOL is associated |
with a pool in which a pool volume has encryption enabled.
- Disabled: The parity group encryption to which LDEV belongs is disabled, or a V-VOL is associated with a pool in which a pool volume has encryption disabled.
- Mixed: The pool to which the LDEV belongs contains both pool volumes for which encryption is enabled and pool volumes for which encryption is disabled.

Note: Encryption of data is not ensured in an LDEV with the Mixed encryption status. To manage data encryption, use an LDEV for which Encryption is Enabled or Disabled.

A hyphen (-) is displayed for an external volume. For DP-VOLs, the pool to which the LDEV belongs is either an external volume or blocked.

- Paired Volume: Paired volume information. A blank is displayed if the volume is not used by a pair.
  - Model / Serial Number: Model and serial number.
  - LDEV ID: LDEV identifier.
  - Port ID: Port identifier of the volume.
  - Host Group ID / iSCSI Target ID: Host group ID or iSCSI target ID.
  - LUN ID: LUN identifier of the volume.

### Secondary Volume Selection

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Base Secondary Volume | Information about Base Secondary Volume.  
  - Port ID: Port identifier.  
  - Host Group ID / iSCSI Target ID: Host group or iSCSI target identifier.  
  - LUN ID: LUN identifier. |
| Selection Type | Default is Interval.  
  - Interval: Interval for allocating S-VOLs.  
  - Relative Primary Volume: S-VOLs paired with P-VOLs relative to LUN or LDEV numbers. |

### Mirror Selection

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Journal</td>
<td>Select the master journal to which you allocate the primary volume. Registered Journal IDs (except for those of restore journals) are displayed.</td>
</tr>
</tbody>
</table>
### Item | Description
--- | ---
Mirror ID | Mirror's identifier.
Restore Journal | Select the restore journal to which you allocate secondary volumes. All journal IDs (000 to 0FF) are displayed.
Current Number of Master Journal Mirrors | Number of mirrors in the master journal.
Total Number of Master Journal Mirrors | Displays the following:
- Number of mirrors in the master journal.
- Number of mirrors added during the Create UR Pairs operation.
- Number of mirrors for the selected volume in Selected Pairs table.
CTG ID | Displays consistency groups registered in the storage system. An asterisk indicates it is assigned to a pair in the Select Pairs table.

### Options

| Item | Description |
--- | --- |
Initial Copy Type | Whether data is copied to the S-VOL during this operation.  
- Entire Volume: Data is copied. The default.  
- None: Data is not copied.  
- Delta: Data is not copied. |
Initial Copy Priority | Scheduling order for the initial copy operation. Range is 1 to 256; default is 32. |
Error Level | Whether to split all pairs in the mirror if a failure occurs during this operation:  
- Mirror: Pairs in the mirror are split.  
- LU: Only the failed pair is split. |

### Selected Pairs table

| Item | Description |
--- | --- |
Local Storage System | Information about volumes in the accessed system.  
- LDEV ID: LDEV identifier.  
- LDEV Name: LDEV name.  
- Port ID: Port identifier.  
- Host Group Name / iSCSI Target Alias: Host group name or iSCSI target alias.  
- iSCSI Target Name: Volume's iSCSI target name.  
- LUN ID: LUN identifier.  
- Journal ID: Journal's identifier.  
- Mirror ID: Mirror identifier. |
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Volume's capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>Volume's CLPR.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Information about the remote system.</td>
</tr>
<tr>
<td>Model / Serial Number</td>
<td>Model and serial number.</td>
</tr>
<tr>
<td>Port ID</td>
<td>Port identifier.</td>
</tr>
<tr>
<td>Host Group ID / iSCSI Target ID</td>
<td>Host group or iSCSI target identifier.</td>
</tr>
<tr>
<td>LUN ID</td>
<td>LUN identifier.</td>
</tr>
<tr>
<td>Journal ID</td>
<td>Journal's identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group ID.</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Consistency group identifier.</td>
</tr>
<tr>
<td>Initial Copy Type</td>
<td>Type of the pair create operation.</td>
</tr>
<tr>
<td>Initial Copy Priority</td>
<td>Scheduling order for pair create operation.</td>
</tr>
<tr>
<td>Error Level</td>
<td>Whether all pairs in the mirror are split if a failure occurs during this operation.</td>
</tr>
<tr>
<td>Change Settings</td>
<td>Opens the Change Settings window.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the specified pair from the table.</td>
</tr>
</tbody>
</table>

**Change Settings window**

Use this window in the pair creation wizard to change options that affect how the pair is created.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Secondary Volume</td>
<td>Select when changing Base Secondary Volume setting.</td>
</tr>
<tr>
<td></td>
<td>• Port ID: Port identifier.</td>
</tr>
<tr>
<td></td>
<td>• Host Group ID / iSCSI Target ID: Host group or iSCSI target identifier.</td>
</tr>
<tr>
<td></td>
<td>• LUN ID: LUN identifier.</td>
</tr>
<tr>
<td></td>
<td>• Interval: Interval.</td>
</tr>
<tr>
<td>Initial Copy Type</td>
<td>Whether data is copied to the S-VOL when the pair is created.</td>
</tr>
<tr>
<td></td>
<td>• Entire Volume: Data is copied. The default.</td>
</tr>
<tr>
<td></td>
<td>• None: Data is not copied. If you choose this option, you should confirm the data be equal between the P-VOL and S-VOL.</td>
</tr>
<tr>
<td></td>
<td>• Delta: Data is not copied. For Universal Replicator delta resync pairs, the status will be changed to HOLD or HOLDING.</td>
</tr>
<tr>
<td>Initial Copy Priority</td>
<td>Scheduling order for the initial copy operation. Range is 1 to 256; default is 32.</td>
</tr>
<tr>
<td>Error Level</td>
<td>Whether to split all pairs in the mirror if a failure occurs during this operation:</td>
</tr>
<tr>
<td></td>
<td>• LU: Only the failed pair is split.</td>
</tr>
</tbody>
</table>
Create UR Pairs confirmation window

Selected Pairs table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Storage System</strong></td>
<td>Information about volumes in the accessed system.</td>
</tr>
<tr>
<td>LDEV ID</td>
<td>LDEV identifier.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>LDEV name.</td>
</tr>
<tr>
<td>Port ID</td>
<td>Port identifier.</td>
</tr>
<tr>
<td>Host Group Name / iSCSI Target Alias</td>
<td>Host group name or iSCSI target alias.</td>
</tr>
<tr>
<td>iSCSI Target Name</td>
<td>Volume's iSCSI target name.</td>
</tr>
<tr>
<td>LUN ID</td>
<td>LUN identifier.</td>
</tr>
<tr>
<td>Pair Position</td>
<td>Identifies the volume as primary or secondary. A blank is displayed if the volume is not used by a pair.</td>
</tr>
<tr>
<td>Journal ID</td>
<td>Journal's identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror identifier.</td>
</tr>
<tr>
<td>Attribute</td>
<td>LDEV attribute.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Volume's capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>Volume's CLPR.</td>
</tr>
<tr>
<td><strong>Remote Storage System</strong></td>
<td>Information about volumes in the system connected to the system you accessed.</td>
</tr>
</tbody>
</table>

Universal Replicator GUI reference
E-39
Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model / Serial Number</td>
<td>Model and serial number.</td>
</tr>
<tr>
<td>Port ID</td>
<td>Port identifier.</td>
</tr>
<tr>
<td>Host Group Name / iSCSI Target Alias</td>
<td>Host group name or iSCSI target alias.</td>
</tr>
<tr>
<td>LUN ID</td>
<td>LUN identifier.</td>
</tr>
<tr>
<td>Journal ID</td>
<td>Journal's identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier.</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Consistency group identifier.</td>
</tr>
<tr>
<td>Initial Copy Type</td>
<td>Type of initial copy operation.</td>
</tr>
<tr>
<td>Initial Copy Priority</td>
<td>Scheduling order for the initial copy operation. Range is 1 to 256; default is 32.</td>
</tr>
</tbody>
</table>
| Error Level                  | Whether to split all pairs in the mirror if a failure occurs during this operation:  
|                              | - Mirror: Pairs in the mirror are split. 
|                              | - Volume: Only the failed pair is split.                                    |

**View Pair Properties window**

Use this window to view the data related to pairs and their volumes.
## Pair Properties

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Local Storage System box | Displays the following information about the volume on the local storage system.  
- LDEV ID (LDEV name): LDEV identifier and name. "---" is displayed for long names. Hover the mouse over "---" to display the complete name.  
- Number of Paths: Number of data paths between primary and secondary systems. Clicking the number displays the path list.  
- Provisioning type, encryption status, T10 PI: The provisioning type, encryption status, and T10 PI attribute of the local storage system's volume. The encryption status is displayed only when the volume encryption is Enabled or Mixed. The T10 PI attribute information is displayed only when the T10 PI attribute is enabled. If ... is displayed, place the cursor on ... to open the hidden contents as a tooltip.  
- Attribute, capacity: Local storage system's volume attribute and capacity. If the volume does not have an attribute, only the capacity is displayed.  
- Journal ID (Encrypted): Journal identifier and encryption status. The encryption status is displayed only when the volume encryption is Enabled or Mixed. If ... is displayed, place the cursor on ... to open the hidden contents as a tooltip.  
- Model/Serial number, CLPR ID:CLPR name: System’s model, serial number, CLPR ID, and CLPR name. |
| Status | Pair’s status. |
| Path Group | Pair’s path group. Clicking the path group number displays the remote path list if the P-VOL is in the Local Storage System. |
| Mirror ID | Pair’s mirror identifier |
| Remote Storage System box | Displays the information about the Remote Storage System.  
- LDEV ID: LDEV identifier and name, which displays when you hover the mouse over it.  
- Port name/Host group ID or iSCSI Target ID/LUN ID: System’s port name, host group ID or iSCSI target ID, and LUN ID. This information is useful when specifying an LDEV ID at pair creation. It does not change, even if you change path settings.  
- Journal ID: Journal identifier.  
- Model/Serial number: System’s model, serial number. |

## Pair Detail

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The pair’s status</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Consistency group identifier</td>
</tr>
<tr>
<td>Error Level</td>
<td>Indicates whether pairs are split if an error occurs. Specified during the create pair procedure.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Secondary Volume Write</td>
<td>Indicates whether data can be written (Enabled) or not written (Disabled) to the S-VOL. The pair must be split for Enabled to display. If the volume accessed is an S-VOL and can be written to, Enabled/Received or Enabled/Not Received is displayed. Indicates whether a write operation is received from the host or not.</td>
</tr>
<tr>
<td>Initial Copy Priority</td>
<td>Initial copy scheduling order. The range is from 0 to 256 in decimal.</td>
</tr>
<tr>
<td>Paired Time</td>
<td>Date and time pair-creation completed.</td>
</tr>
<tr>
<td>Last Update Time</td>
<td>Date and time that the last update was run.</td>
</tr>
<tr>
<td>Pair Copy Time</td>
<td>Time used to copy the P-VOL.</td>
</tr>
<tr>
<td>Local Storage System</td>
<td>• Virtual storage machine: Virtual storage machine’s model type and serial number.</td>
</tr>
<tr>
<td></td>
<td>• Virtual LDEV ID: Volume’s virtual LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• Virtual Device Name: Volume’s virtual device name, in the format: virtual emulation type/number of virtual LUSE volumes/virtual CVS attribute</td>
</tr>
<tr>
<td></td>
<td>- Only attributes that are specified display.</td>
</tr>
<tr>
<td></td>
<td>- &quot;CVS&quot; displays at the end of the device name, if the virtual CVS attribute is specified.</td>
</tr>
<tr>
<td></td>
<td>- A blank indicates no values are specified.</td>
</tr>
<tr>
<td></td>
<td>• Virtual SSID: Volume’s virtual SSID. A blank indicates that no virtual SSID is specified.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>• Virtual storage machine: Virtual storage machine’s model type and serial number.</td>
</tr>
<tr>
<td></td>
<td>• Virtual LDEV ID: Volume’s virtual LDEV identifier.</td>
</tr>
</tbody>
</table>

**Split Pairs wizard**

Use this wizard to split pairs.

**Split Pairs window**

Use this window to split pairs.
### Selected Pairs table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Storage System</strong></td>
<td>Displays the following information about pair volumes in the Local Storage System.</td>
</tr>
<tr>
<td></td>
<td>• LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• LDEV Name: Pair volume LDEV name.</td>
</tr>
<tr>
<td></td>
<td>• Pair Position: Identifies the volume as primary or secondary.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td></td>
<td>• Mirror ID: Mirror identifier.</td>
</tr>
<tr>
<td></td>
<td>• Attribute: LDEV attribute.</td>
</tr>
<tr>
<td></td>
<td>• Capacity: Pair volume capacity.</td>
</tr>
<tr>
<td></td>
<td>• CLPR: CLPR ID.</td>
</tr>
<tr>
<td><strong>Copy Type</strong></td>
<td>Type of pair:</td>
</tr>
<tr>
<td></td>
<td>• UR: Universal Replicator</td>
</tr>
<tr>
<td></td>
<td>• TC: TrueCopy</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Pair status.</td>
</tr>
</tbody>
</table>
Remote Storage System

Displays the following information about pair volumes in the Remote Storage System.

- Model/Serial Number: Storage system model name and serial number.
- LDEV ID: Pair volume LDEV identifier.
- Journal ID: Journal identifier.

Path Group ID
Path group identifier.

CTG ID
Pair’s consistency group identifier

Settings

Secondary Volume Write

Indicates whether data can be written to the S-VOL while the pair is split.

- Enable: Data can be written to the S-VOL. Available only when the selected mirror’s Attribute is Master. If Restore, Disable is used automatically
- Disable: The default. Data cannot be written to the S-VOL.

Split Pairs confirmation window

[Image of Split Pairs confirmation window]
### Selected Pairs table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Storage System</strong></td>
<td>Displays the following information about pair volumes in the Local Storage System.</td>
</tr>
<tr>
<td></td>
<td>- LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>- LDEV Name: Pair volume LDEV name.</td>
</tr>
<tr>
<td></td>
<td>- Pair Position: Identifies the volume as primary or secondary.</td>
</tr>
<tr>
<td></td>
<td>- Journal ID: Journal identifier.</td>
</tr>
<tr>
<td></td>
<td>- Mirror ID: Mirror identifier.</td>
</tr>
<tr>
<td></td>
<td>- Attribute: LDEV attribute.</td>
</tr>
<tr>
<td></td>
<td>- Capacity: Pair volume capacity.</td>
</tr>
<tr>
<td></td>
<td>- CLPR: CLPR ID.</td>
</tr>
<tr>
<td><strong>Copy Type</strong></td>
<td>Type of pair:</td>
</tr>
<tr>
<td></td>
<td>- UR: Universal Replicator</td>
</tr>
<tr>
<td></td>
<td>- TC: TrueCopy</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Pair status.</td>
</tr>
<tr>
<td><strong>Secondary Volume Write</strong></td>
<td>Indicates whether data can be written to the S-VOL when the pair is split.</td>
</tr>
<tr>
<td></td>
<td>A hyphen (-) is displayed if performing the split operation from the secondary system, regardless of the option selected.</td>
</tr>
<tr>
<td><strong>Split Mode</strong></td>
<td>Indicates whether update data is written to S-VOLs in the mirror before the split operation.</td>
</tr>
<tr>
<td></td>
<td>- Flush: Data is copied to S-VOLs.</td>
</tr>
<tr>
<td></td>
<td>- Purge: Data is not copied to S-VOLs until resynchronization.</td>
</tr>
<tr>
<td><strong>Remote Storage System</strong></td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>- Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>- LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>- Journal ID: Journal identifier.</td>
</tr>
<tr>
<td><strong>Path Group ID</strong></td>
<td>Path group identifier.</td>
</tr>
<tr>
<td><strong>CTG ID</strong></td>
<td>Pair’s consistency group identifier</td>
</tr>
</tbody>
</table>

### Split Mirrors wizard

Use this wizard to split mirrors.

### Split Mirrors window

Use this window to split mirrors.
### Selected Mirrors table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror's identifier</td>
</tr>
<tr>
<td>Attribute</td>
<td>Mirror's attribute — Master, Restore, or Initial.</td>
</tr>
<tr>
<td></td>
<td>• Master displays when the P-VOL is paired (initial copy performed).</td>
</tr>
<tr>
<td></td>
<td>• Restore displays when the S-VOL is paired (initial copy performed).</td>
</tr>
<tr>
<td></td>
<td>• Initial displays when neither data volume is paired yet (initial copy not performed).</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror's status.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all data volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Remote Command Device</td>
<td>LDEV number of the remote command device if it is assigned to the mirror. • The column is blank if the remote command device is not assigned to the mirror. • A hyphen (-) indicates the remote command device cannot be assigned to the mirror.</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Consistency group identifier.</td>
</tr>
<tr>
<td>CTG Utilization</td>
<td>Indicates whether the consistency group is shared by multiple storage systems. • Single: The consistency group consists of a single pair of primary and secondary systems. • Multi: The consistency group consists of multiple storage systems.</td>
</tr>
</tbody>
</table>

**Settings**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Volume Write</td>
<td>Indicates whether data can be written to the S-VOL while the pair is split. • Enable: Data can be written to the S-VOL. Available only when the selected mirror’s Attribute is Master. If Restore, Disable is used automatically. • Disable: Data cannot be written to the S-VOL (default).</td>
</tr>
<tr>
<td>Split Mode</td>
<td>Indicates whether update data is written to S-VOLs in the mirror before the split operation. • Flush: Data is copied to S-VOLs. • Purge: Data is not copied to S-VOLs until resynchronization.</td>
</tr>
</tbody>
</table>
### Split Mirrors confirmation window

#### Selected Mirrors table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror’s identifier</td>
</tr>
<tr>
<td>Attribute</td>
<td>Mirror’s attribute — Master, Restore, or Initial.</td>
</tr>
<tr>
<td></td>
<td>• Master displays when the P-VOL is paired (initial copy performed).</td>
</tr>
<tr>
<td></td>
<td>• Restore displays when the S-VOL is paired (initial copy performed).</td>
</tr>
<tr>
<td></td>
<td>• Initial displays when neither data volume is paired yet (initial copy</td>
</tr>
<tr>
<td></td>
<td>not performed).</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror’s status.</td>
</tr>
<tr>
<td>Secondary Volume Write</td>
<td>Indicates whether data can be written to the S-VOL while the pair is</td>
</tr>
<tr>
<td></td>
<td>split.</td>
</tr>
<tr>
<td></td>
<td>• Enable: Data can be written to the S-VOL.</td>
</tr>
<tr>
<td></td>
<td>• Disable: Data cannot be written to the S-VOL.</td>
</tr>
<tr>
<td></td>
<td>A hyphen (-) is displayed if performing the split operation from the</td>
</tr>
<tr>
<td></td>
<td>secondary system, regardless of the option selected.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Split Mode</td>
<td>Indicates whether update data is written to S-VOLs in the mirror before the split operation.</td>
</tr>
<tr>
<td></td>
<td>• Flush: Data is copied to S-VOLs.</td>
</tr>
<tr>
<td></td>
<td>• Purge: Data is not copied to S-VOLs until resynchronization.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group’s identifier.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal.</td>
</tr>
<tr>
<td></td>
<td>With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all data volumes.</td>
</tr>
<tr>
<td></td>
<td>With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Remote Command Device</td>
<td>LDEV number of the remote command device if it is assigned to the mirror.</td>
</tr>
<tr>
<td></td>
<td>• The column is blank if the remote command device is not assigned to the mirror.</td>
</tr>
<tr>
<td></td>
<td>• A hyphen (-) indicates the remote command device cannot be assigned to the mirror.</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Consistency group identifier.</td>
</tr>
<tr>
<td>CTG Utilization</td>
<td>Indicates whether the consistency group is shared by multiple storage systems.</td>
</tr>
<tr>
<td></td>
<td>• Single: The consistency group consists of a single pair of primary and secondary systems.</td>
</tr>
<tr>
<td></td>
<td>• Multi: The consistency group consists of multiple storage systems.</td>
</tr>
</tbody>
</table>

**Resync Pairs wizard**

Use this wizard to resynchronize pairs.

**Resync Pairs window**

Use this window to resynchronize pairs.
**Selected Pairs table**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Storage System</strong></td>
<td>Displays the following information about pair volumes in the Local Storage System.</td>
</tr>
<tr>
<td></td>
<td>• LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• LDEV Name: Pair volume LDEV name.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td></td>
<td>• Mirror ID: Mirror identifier.</td>
</tr>
<tr>
<td></td>
<td>• Attribute: LDEV attribute.</td>
</tr>
<tr>
<td></td>
<td>• Capacity: Pair volume capacity.</td>
</tr>
<tr>
<td></td>
<td>• CLPR: CLPR ID.</td>
</tr>
<tr>
<td><strong>Copy Type</strong></td>
<td>Type of pair:</td>
</tr>
<tr>
<td></td>
<td>• UR: Universal Replicator</td>
</tr>
<tr>
<td></td>
<td>• TC: TrueCopy</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Pair status.</td>
</tr>
<tr>
<td><strong>Copy Priority</strong></td>
<td>Scheduling order for resync operations. The range is from 1 to 256.</td>
</tr>
<tr>
<td><strong>Remote Storage System</strong></td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td><strong>Path Group ID</strong></td>
<td>Path group identifier.</td>
</tr>
<tr>
<td><strong>CTG ID</strong></td>
<td>Pair’s consistency group identifier</td>
</tr>
</tbody>
</table>
### Copy Priority
Scheduling order for resync operations. The range is from 1 to 256.

### Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Error Level| Used to select which pairs are split if an error occurs.  
  • Mirror: All pairs in the mirror are split.  
  • LU: Only the failed pair is split. |

### Resync Pairs confirmation window

**Local Storage System**
Displays the following information about pair volumes in the Local Storage System.
- **LDEV ID**: Pair volume LDEV identifier.
- **LDEV Name**: Pair volume LDEV name.
- **Journal ID**: Journal identifier.
- **Mirror ID**: Mirror identifier.
- **Attribute**: LDEV attribute.
- **Capacity**: Pair volume capacity.
- **CLPR**: CLPR ID.

**Copy Type**
Type of pair:
- **UR**: Universal Replicator
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC: TrueCopy</td>
<td>Pair status.</td>
</tr>
<tr>
<td>Status</td>
<td>Scheduling order for resync operations. The range is from 1 to 256.</td>
</tr>
<tr>
<td>Copy Priority</td>
<td>Which pairs are split if an error occurs.</td>
</tr>
<tr>
<td></td>
<td>• Mirror: All pairs in the mirror are split.</td>
</tr>
<tr>
<td></td>
<td>• LU: Only failed pair is split.</td>
</tr>
<tr>
<td>Error Level</td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td></td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier.</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Pair’s consistency group identifier.</td>
</tr>
</tbody>
</table>

**Resync Mirrors wizard**

Use this wizard to resynchronize mirrors.

**Resync Mirrors window**

Use this window to resynchronize mirrors.
### Selected Mirrors table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror’s identifier</td>
</tr>
</tbody>
</table>
| Attribute                     | Mirror’s attribute — Master, Restore, or Initial.  
  - Master displays when the P-VOL is paired (initial copy performed).  
  - Restore displays when the S-VOL is paired (initial copy performed).  
  - Initial displays when neither data volume is paired yet (initial copy not performed).                                                  |
| Status                        | Mirror’s status.                                                                                                                                                                                              |
| Resync Mode                   | The type of mirror resynchronization to be performed.  
  - Normal: Resynchronizes pairs in the mirror that are in PSUS or PSUE status.                                                                                                                           |
| Remote Storage System         | Displays the following information about pair volumes in the Remote Storage System.  
  - Model/Serial Number: Storage system model name and serial number.  
  - Journal ID: Journal identifier.                                                                                                                                                                       |
| Path Group ID                 | Path group identifier.                                                                                                                                                                                         |
| Number of Data VOLS           | Number of volumes associated with the journal.  
  With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed.  
  The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed. |
| Data Capacity                 | Total capacity of all data volumes.  
  With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed.  
  The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed. |
| Remote Command Device         | LDEV number of the remote command device if it is assigned to the mirror.  
  - The column is blank if the remote command device is not assigned to the mirror.  
  - A hyphen (-) indicates the remote command device cannot be assigned to the mirror.                                                                                       |
| CTG ID                        | Consistency group identifier.                                                                                                                                                                                  |
| CTG Utilization               | Indicates whether the consistency group is shared by multiple storage systems.  
  - Single: The consistency group consists of a single pair of primary and secondary systems.  
  - Multi: The consistency group consists of multiple storage systems.                                                                                                                                  |
<p>| Delta Resync Failure          | Processing that takes place in the event of delta resync operation failure.                                                                                                                                   |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entire Copy</td>
<td>The entire P-VOL is copied to the S-VOL.</td>
</tr>
<tr>
<td>No Copy</td>
<td>No processing occurs. The S-VOL is not updated.</td>
</tr>
</tbody>
</table>

Delete Pairs wizard

Use this wizard to delete pairs.

Delete Pairs window

Use this window to delete pairs.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Storage System</td>
<td>Displays the following information about pair volumes in the Local Storage System.</td>
</tr>
<tr>
<td>LDEV ID</td>
<td>Pair volume LDEV identifier.</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Pair volume LDEV name.</td>
</tr>
<tr>
<td>Pair Position</td>
<td>Indicates whether the volume is a primary or secondary volume.</td>
</tr>
<tr>
<td>Journal ID</td>
<td>Indicates whether the volume is a primary or secondary volume.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Indicates whether the volume is a primary or secondary volume.</td>
</tr>
<tr>
<td>Attribute</td>
<td>LDEV attribute.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Pair volume capacity.</td>
</tr>
<tr>
<td>CLPR</td>
<td>CLPR ID.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy Type</td>
<td>Type of pair:</td>
</tr>
<tr>
<td></td>
<td>• UR: Universal Replicator</td>
</tr>
<tr>
<td></td>
<td>• TC: TrueCopy</td>
</tr>
<tr>
<td>Status</td>
<td>Pair status.</td>
</tr>
<tr>
<td>Delete Mode</td>
<td>Options for deleting pairs. Only Normal is available.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• LDEV ID: Pair volume LDEV identifier.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier.</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Pair’s consistency group identifier.</td>
</tr>
</tbody>
</table>

**Force Delete Pairs window**

Use this window to forcibly delete pairs.

![Force Delete Pairs window](image-url)

**Selected LDEVs**

<table>
<thead>
<tr>
<th>LDEV ID</th>
<th>LDEV Name</th>
<th>Capacity</th>
<th>CLPR</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:00</td>
<td>Basic</td>
<td>10.00 GB</td>
<td>0:CLPR0</td>
</tr>
</tbody>
</table>

**Item**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDEV ID</td>
<td>Pair volume LDEV identifier</td>
</tr>
<tr>
<td>LDEV Name</td>
<td>Name of the pair volume LDEV</td>
</tr>
</tbody>
</table>
### Delete Mirrors wizard

Use this wizard to delete mirrors.

### Delete Mirrors window

Use this window to delete mirrors.

#### Table: Item - Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Capacity of the volume</td>
</tr>
<tr>
<td>CLPR</td>
<td>CLPR ID of the volume</td>
</tr>
</tbody>
</table>

#### Table: Item - Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror’s identifier</td>
</tr>
<tr>
<td>Attribute</td>
<td>Mirror’s attribute — Master, Restore, or Initial.</td>
</tr>
</tbody>
</table>
  * Master displays when the P-VOL is paired (initial copy performed). |
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore</td>
<td>• Restore displays when the S-VOL is paired (initial copy performed).</td>
</tr>
<tr>
<td></td>
<td>• Initial displays when neither data volume is paired yet (initial copy not performed).</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror’s status.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier.</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal.</td>
</tr>
<tr>
<td></td>
<td>With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all data volumes.</td>
</tr>
<tr>
<td></td>
<td>With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Remote Command Device</td>
<td>LDEV number of the remote command device if it is assigned to the mirror.</td>
</tr>
<tr>
<td></td>
<td>• The column is blank if the remote command device is not assigned to the mirror.</td>
</tr>
<tr>
<td></td>
<td>• A hyphen (-) indicates the remote command device cannot be assigned to the mirror.</td>
</tr>
<tr>
<td>CTG ID</td>
<td>Consistency group identifier.</td>
</tr>
<tr>
<td>CTG Utilization</td>
<td>Indicates whether the consistency group is shared by multiple storage systems.</td>
</tr>
<tr>
<td></td>
<td>• Single: The consistency group consists of a single pair of primary and secondary systems.</td>
</tr>
<tr>
<td></td>
<td>• Multi: The consistency group consists of multiple storage systems.</td>
</tr>
<tr>
<td>Delete Mode</td>
<td>Options for deleting pairs</td>
</tr>
<tr>
<td></td>
<td>• Normal: Delete pairs only when the Local Storage System can change both the P-VOL and S-VOL to unpaired volumes.</td>
</tr>
<tr>
<td></td>
<td>• Force: Forcibly deletes pairs regardless of Local Storage System’s ability to change both volumes to unpaired. Force allows host operations to continue.</td>
</tr>
</tbody>
</table>
Delete Mirrors confirmation window

### Item Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal ID</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>Mirror ID</td>
<td>Mirror’s identifier</td>
</tr>
<tr>
<td>Attribute</td>
<td>Mirror’s attribute — Master, Restore, or Initial.</td>
</tr>
<tr>
<td></td>
<td>• Master displays when the P-VOL is paired (initial copy performed).</td>
</tr>
<tr>
<td></td>
<td>• Restore displays when the S-VOL is paired (initial copy performed).</td>
</tr>
<tr>
<td></td>
<td>• Initial displays when neither data volume is paired yet (initial copy not performed).</td>
</tr>
<tr>
<td>Status</td>
<td>Mirror’s status.</td>
</tr>
<tr>
<td>Delete Mode</td>
<td>Shows whether mirrors are deleted forcibly or not.</td>
</tr>
<tr>
<td>Remote Storage System</td>
<td>Displays the following information about pair volumes in the Remote Storage System.</td>
</tr>
<tr>
<td></td>
<td>• Model/Serial Number: Storage system model name and serial number.</td>
</tr>
<tr>
<td></td>
<td>• Journal ID: Journal identifier.</td>
</tr>
<tr>
<td>Path Group ID</td>
<td>Path group identifier.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of Data VOLs</td>
<td>Number of volumes associated with the journal. With the delta resync configuration, the number of data volumes registered to the journal of the mirrors not for delta resync is displayed. The number of volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
<tr>
<td>Data Capacity</td>
<td>Total capacity of all data volumes. With the delta resync configuration, the total capacity of the data volumes registered to the journal of the mirrors not for delta resync is displayed. The total capacity of the data volumes registered to the journal of the delta resync mirrors (whose status is Hold, Holding, or Hold(Failure)) is not displayed.</td>
</tr>
</tbody>
</table>
| Remote Command Device       | LDEV number of the remote command device if it is assigned to the mirror.  
  • The column is blank if the remote command device is not assigned to the mirror.  
  • A hyphen (-) indicates the remote command device cannot be assigned to the mirror. |
| CTG ID                      | Consistency group identifier.                                                                                                                                                                                                                                                                                                                  |
| CTG Utilization             | Indicates whether the consistency group is shared by multiple storage systems.  
  • Single: The consistency group consists of a single pair of primary and secondary systems.  
  • Multi: The consistency group consists of multiple storage systems.                                                                                           |

**Edit Pair Options wizard**

Use this wizard to change pair options.

**Edit Pair Options window**

Use this window to change pair options.
Edit Pair Options

This wizard lets you edit the Error Level of the selected pairs. Select a new value, and click Finish to confirm.

Error Level: **Mirror**

### Item Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Error Level | The pairs that are split if an error occurs.  
  • Mirror: All pairs in the mirror are split.  
  • LU: Only the failed pair is split. |

Edit Pair Options confirmation window

Enter a name for the task: Confirm the settings in the list and click Apply to add task in Tasks queue for execution.

Task Name: **150526-EditPairOptions**  
(Max. 32 Characters)

**Selected Pairs**

<table>
<thead>
<tr>
<th>LDEV ID</th>
<th>LDEV Name</th>
<th>Pair Position</th>
<th>Journal ID</th>
<th>Mirror ID</th>
<th>Attribute</th>
<th>Capacity</th>
<th>CLP</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:14</td>
<td>Primary</td>
<td>000</td>
<td>0</td>
<td>-</td>
<td>1.00 GB</td>
<td>0:C</td>
<td></td>
</tr>
</tbody>
</table>

### Item Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Storage System</td>
<td>Displays the following information about pair volumes in the Local Storage System.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>• LDEV ID:</td>
<td>Pair volume LDEV identifier.</td>
</tr>
<tr>
<td>• LDEV Name:</td>
<td>Pair volume LDEV name.</td>
</tr>
<tr>
<td>• Pair Position:</td>
<td>Indicates whether the volume is a primary or secondary volume.</td>
</tr>
<tr>
<td>• Journal ID:</td>
<td>Journal identifier.</td>
</tr>
<tr>
<td>• Mirror ID:</td>
<td>Mirror identifier.</td>
</tr>
<tr>
<td>• Attribute:</td>
<td>LDEV attribute.</td>
</tr>
<tr>
<td>• Capacity:</td>
<td>Pair volume capacity.</td>
</tr>
<tr>
<td>• CLPR:</td>
<td>CLPR ID.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Level</th>
<th>The pairs that are split if an error occurs:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Mirror:</td>
<td>All pairs in the mirror are split.</td>
</tr>
<tr>
<td>• LU:</td>
<td>Only the failed pair is split.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Remote Storage System</th>
<th>Displays the following information about pair volumes in the Remote Storage System.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Model/Serial Number:</td>
<td>Storage system model name and serial number.</td>
</tr>
<tr>
<td>• LDEV ID:</td>
<td>Pair volume LDEV identifier.</td>
</tr>
<tr>
<td>• Journal ID:</td>
<td>Journal identifier.</td>
</tr>
</tbody>
</table>

| Path Group ID | Path group identifier. |
This glossary defines the special terms used in this document. Click the letter links below to navigate.

#

2DC
two-data-center. Refers to the primary and secondary sites, or data centers, in which TrueCopy (TC) and Universal Replicator (UR) combine to form a remote replication configuration. In a 2DC configuration, data is copied from a TC primary volume at the primary site to the UR master journal volume at an intermediate site, and then replicated to the UR secondary volume at the secondary site. Since this configuration side-steps the TC secondary volume at the intermediate site, the intermediate site is not considered a data center.

3DC
three-data-center. Refers to the primary, intermediate, and secondary sites, or data centers, in which TrueCopy and Universal Replicator combine to form a remote replication configuration. A 3DC configuration can also combine three Universal Replicator sites. In a 3DC configuration, data is copied from a primary site to an intermediate site and then to a secondary site (3DC cascade configuration), or from a primary site to two secondary sites (3DC multi-target configuration).

A

administrative logical unit (ALU)
An LU used for the conglomerate LUN structure, a SCSI architecture model. In the conglomerate LUN structure, all host access is through the ALU, which functions as a gateway to sort the I/Os for the subsidiary logical units (SLUs) grouped under the ALU.
The host requests I/Os by using SCSI commands to specify the ALU and the SLUs grouped under the ALU. An ALU is called a Protocol Endpoint (PE) in vSphere. See also subsidiary logical unit (SLU).

**alternate path**
A secondary path (port, target ID, LUN) to a logical volume, in addition to the primary path, that is used as a backup in case the primary path fails.

**ALU**
See administrative logical unit.

**array**
Another name for a RAID storage system.

**array group**
See RAID group.

**async**
asynchronous

**audit log**
Files that store a history of the operations performed from Device Manager - Storage Navigator and the service processor (SVP), commands that the storage system received from hosts.

**B**

**BC**
business continuity

**BLK, blk**
block

**bmp**
bitmap

**C**

**C/T**
See consistency time (C/T).

**ca**
cache
cache logical partition (CLPR)
Consists of virtual cache memory that is set up to be allocated to different hosts in contention for cache memory.

capacity
The amount of data storage space available on a physical storage device, usually measured in bytes (MB, GB, TB, etc.).

cascade configuration
In a 3DC cascade configuration for remote replication, data is copied from a primary site to an intermediate site and then to a secondary site using TrueCopy and Universal Replicator. See also 3DC.
In a ShadowImage cascade configuration, two layers of secondary volumes can be defined for a single primary volume. Pairs created in the first and second layer are called cascaded pairs.

cascade function
A ShadowImage function that allows a primary volume (P-VOL) to have up to nine secondary volumes (S-VOLs) in a layered configuration. The first cascade layer (L1) is the original ShadowImage pair with one P-VOL and up to three S-VOLs. The second cascade layer (L2) contains ShadowImage pairs in which the L1 S-VOLs are functioning as the P-VOLs of layer-2 ShadowImage pairs that can have up to two S-VOLs for each P-VOL.
See also root volume, node volume, leaf volume, level-1 pair, and level-2 pair.

cascaded pair
A ShadowImage pair in a cascade configuration. See cascade configuration.

shared volume
A volume that is being used by more than one replication function. For example, a volume that is the primary volume of a TrueCopy pair and the primary volume of a ShadowImage pair is a shared volume.

CCI
Command Control Interface

CG
See consistency group (CG, CTG).

CH
channel

channel path
The communication path between a channel and a control unit. A channel path consists of the physical channel path and the remote path.

CHAP
challenge handshake authentication protocol
CL
cluster

CLI
command line interface

CLPR
cache logical partition

cluster
Multiple-storage servers working together to respond to multiple read and write requests.

command device
A dedicated logical volume used only by Command Control Interface to interface with the storage system. Can be shared by several hosts.

configuration definition file
Defines the configuration, parameters, and options of Command Control Interface operations. A text file that defines the connected hosts and the volumes and groups known to the Command Control Interface instance.

consistency group (CG, CTG)
A group of pairs on which copy operations are performed. Specifying a consistency group ID performs a specific operation for all pairs belonging to the consistency group simultaneously while keeping data consistency.

consistency time (C/T)
Shows a time stamp to indicate how close the target volume is to the source volume. C/T also shows the time stamp of a journal and extended consistency group.

control memory
Another name for shared memory.

controller
The component in a storage system that manages all storage functions. It is analogous to a computer and contains a processors, I/O devices, RAM, power supplies, cooling fans, and other sub-components as needed to support the operation of the storage system.

copy-after-write
Point-in-time snapshot copy of a data volume within a storage system. Copy-after-write snapshots only store changed data blocks, therefore the amount of storage capacity required for each copy is substantially smaller than the source volume.

copy pair
A pair of volumes in which one volume contains original data and the other volume contains the copy of the original. Copy operations can be synchronous or asynchronous,
and the volumes of the copy pair can be located in the same storage system (in-system replication) or in different storage systems (remote replication). A copy pair can also be called a volume pair, or just pair.

**CTG**
See *consistency group (CG, CTG)*.

**CTL**
controller

**CU**
control unit

**currency of data**
The synchronization of the volumes in a copy pair. When the data on the secondary volume (S-VOL) is identical to the data on the primary volume (P-VOL), the data on the S-VOL is current. When the data on the S-VOL is not identical to the data on the P-VOL, the data on the S-VOL is not current.

**CYL, cyl**
cylinder

**cylinder bitmap**
Indicates the differential data (updated by write I/Os) in a volume of a split or suspended copy pair. The primary and secondary volumes each have their own cylinder bitmap. When the pair is resynchronized, the cylinder bitmaps are merged, and the differential data is copied to the secondary volume.

**D**

**DASD**
direct-access storage device

**data consistency**
When the data on the secondary volume is identical to the data on the primary volume.

**data path**
The physical paths used by primary systems to communicate with secondary systems in a remote replication environment.

**data pool**
One or more logical volumes designated to temporarily store original data. When a snapshot is taken of a primary volume, the data pool is used if a data block in the primary volume is to be updated. The original snapshot of the volume is maintained by storing the to-be-changed data blocks in the data pool.
DB
  database

DBMS
  database management system

delta resync
  A disaster recovery solution in which TrueCopy and Universal Replicator systems are configured to provide a quick recovery using only differential data stored at an intermediate site.

device
  A physical or logical unit with a specific function.

device emulation
  Indicates the type of logical volume. Open-systems device emulation types provide logical volumes of variable size, called logical units (LUs), that contain ASCII data in FBA format. The open-systems device emulation type is OPEN-V.

DEVN
  device number

DFW
  DASD fast write

DHCP
  dynamic host configuration protocol

differential data
  Changed data in the primary volume not yet reflected in the copy.

disaster recovery
  A set of procedures to recover critical application data and processing after a disaster or other failure.

disk array
  Disk array, or just array, is another name for a RAID storage system.

disk controller (DKC)
  The hardware component that manages front-end and back-end storage operations. The term DKC is sometimes used to refer to the entire RAID storage system.

DKC
  disk controller. Can refer to the RAID storage system or the controller components.

DKCMAIN
  disk controller main. Refers to the microcode for the RAID storage system.
**DKP**
- disk processor. Refers to the microprocessors on the back-end director features of the Universal Storage Platform V/VM.

**DKU**
- disk unit. Refers to the cabinet (floor model) or rack-mounted hardware component that contains data drives and no controller components.

**DMP**
- Dynamic Multi Pathing

**DRU**
- Hitachi Data Retention Utility

**DP-VOL**
- Dynamic Provisioning-virtual volume. A virtual volume with no memory space used by Dynamic Provisioning.

**dynamic provisioning**
- An approach to managing storage. Instead of “reserving” a fixed amount of storage, it removes capacity from the available pool when data is actually written to disk. Also called thin provisioning.

**E**

**EC**
- error code

**emulation group**
- A set of device emulation types that can be intermixed within a RAID group and treated as a group.

**env.**
- environment

**EXG**
- external volume group

**ext.**
- external

**external application**
- A software module that is used by a storage system but runs on a separate platform.
**external port**
A port that is configured to be connected to an external storage system for Universal Volume Manager operations.

**external volume**
A logical volume whose data resides on drives that are physically located outside the Hitachi storage system.

**F**

**failback**
The process of switching operations from the secondary path or host back to the primary path or host, after the primary path or host has recovered from failure. See also failover.

**failover**
The process of switching operations from the primary path or host to a secondary path or host when the primary path or host fails.

**FC**
fibre channel; FlashCopy

**free capacity**
The amount of storage space (in bytes) that is available for use by the host systems.

**FSW**
fibre switch

**FTP**
file-transfer protocol

**G**

**GID**
group ID

**GUI**
graphical user interface

**H**

**HA**
high availability
HACMP
High Availability Cluster Multi-Processing

HDP
Hitachi Dynamic Provisioning software

HDS
Hitachi Data Systems

H-LUN
host logical unit

HORC
Hitachi Open Remote Copy. Another name for Hitachi TrueCopy®.

HORCM
Hitachi Open Remote Copy Manager. Another name for Command Control Interface.

host failover
The process of switching operations from one host to another host when the primary host fails.

host group
A group of hosts of the same operating system platform.

host mode
Operational modes that provide enhanced compatibility with supported host platforms. Used with Fibre Channel ports on RAID storage systems.

host mode option
Additional options for Fibre Channel ports on RAID storage systems. Provide enhanced functionality for host software and middleware.

HRpM
Hitachi Replication Manager

HUR
Hitachi Universal Replicator

IMPL
initial microprogram load
**initial copy**
An initial copy operation is performed when a copy pair is created. Data on the primary volume is copied to the secondary volume.

**in-system replication**
The original data volume and its copy are located in the same storage system. ShadowImage in-system replication provides duplication of logical volumes; Thin Image provides “snapshots” of logical volumes that are stored and managed as virtual volumes (V-VOLs).

**intermediate site (I-site)**
A site that functions as both a TrueCopy secondary site and a Universal Replicator primary site in a 3-data-center (3DC) cascading configuration.

**internal volume**
A logical volume whose data resides on drives that are physically located within the storage system. See also external volume.

**IO, I/O**
input/output

**IOPS**
I/Os per second

**J**

**JNL**
journal

**journal**
In a Universal Replicator system, journals manage data consistency between multiple primary volumes and secondary volumes. See also consistency group (CTG).

**journal volume**
A volume that records and stores a log of all events that take place in another volume. In the event of a system crash, the journal volume logs are used to restore lost data and maintain data integrity.
In Universal Replicator, differential data is held in journal volumes until it is copied to the S-VOL.

**L**

**L1 pair**
See layer-1 (L1) pair.
**L2 pair**
See layer-2 (L2) pair.

**layer-1 (L1) pair**
In a ShadowImage cascade configuration, a layer-1 pair consists of a primary volume and secondary volume in the first cascade layer. An L1 primary volume can be paired with up to three L1 secondary volumes. See also cascade configuration.

**layer-2 (L2) pair**
In a ShadowImage cascade configuration, a layer-2 (L2) pair consists of a primary volume and secondary volume in the second cascade layer. An L2 primary volume can be paired with up to two L2 secondary volumes. See also cascade configuration.

**LBA**
logical block address

**LCU**
logical control unit

**LDEV**
logical device

**LDKC**
See logical disk controller (LDKC).

**leaf volume**
A level-2 secondary volume in a ShadowImage cascade configuration. The primary volume of a layer-2 pair is called a node volume. See also cascade configuration.

**LED**
ligh-emitting diode

**license key**
A specific set of characters that unlocks an application and allows it to be used.

**local copy**
See in-system replication.

**local storage system**
See primary system.

**logical device (LDEV)**
An individual logical data volume (on multiple drives in a RAID configuration) in the storage system. An LDEV may or may not contain any data and may or may not be defined to any hosts. Each LDEV has a unique identifier or “address” within the storage system composed of the logical disk controller (LDKC) number, control unit (CU) number, and LDEV number. The LDEV IDs within a storage system do not change. An LDEV formatted for use by open-system hosts is called a logical unit (LU).
logical disk controller (LDKC)
A group of 255 control unit (CU) images in the RAID storage system that is controlled by a virtual (logical) storage system within the single physical storage system.

logical unit (LU)
A logical volume that is configured for use by open-systems hosts (for example, OPEN-V).

logical unit (LU) path
The path between an open-systems host and a logical unit.

logical volume
See volume.

LU
logical unit

LUN
logical unit number

LUNM
Hitachi LUN Manager

LV
logical volume

M

master journal (M-JNL)
Holds differential data on the primary Universal Replicator system until it is copied to the restore journal (R-JNL) on the secondary system. See also restore journal (R-JNL).

Mb/sec, Mbps
megabits per second

MB/sec, MBps
megabytes per second

MIH
missing interrupt handler

mirror
In Universal Replicator, each pair relationship in and between journals is called a “mirror”. Each pair is assigned a mirror ID when it is created. The mirror ID identifies individual pair relationships between journals.
M-JNL  
master journal

MP  
microprocessor

MP unit  
Unit containing an I/O processor. Performance in the storage system is tuned by allocating a specific MP unit to each I/O-related resource (LDEV, external volume, or journal). Specific units are allocated, or the storage system can automatically select a unit.

MU  
mirror unit

multipathing  
A performance and fault-tolerant technique that uses more than one physical connection between the storage system and host system. Also called multipath I/O.

N  
node volume  
A level-2 primary volume in a ShadowImage cascade configuration. The secondary volume of a layer-2 pair is called a leaf volume. See also cascade configuration.

NVS  
nonvolatile storage

O  
OPEN-V  
A logical unit (LU) of user-defined size that is formatted for use by open-systems hosts.

P  
pair  
Two logical volumes in a replication relationship in which one volume contains original data to be copied and the other volume contains the copy of the original data. The copy operations can be synchronous or asynchronous, and the pair volumes can be located in the same storage system (in-system replication) or in different storage systems (remote replication).
pair status
Indicates the condition of a copy pair. A pair must have a specific status for specific operations. When an operation completes, the status of the pair changes to the new status.

parity group
See RAID group.

path failover
The ability of a host to switch from using the primary path to a logical volume to the secondary path to the volume when the primary path fails. Path failover ensures continuous host access to the volume in the event the primary path fails. See also alternate path and failback.

physical device
See device.

PiT
point-in-time

point-in-time (PiT) copy
A copy or snapshot of a volume or set of volumes at a specific point in time. A point-in-time copy can be used for backup or mirroring application to run concurrently with the system.

pool
A set of volumes that are reserved for storing pool volumes (pool-VOLs) used by Thin Image, Dynamic Provisioning, Dynamic Tiering, or active flash.

pool volume (pool-VOL)
A logical volume that is reserved for storing snapshot data for Thin Image operations or write data for Dynamic Provisioning, Dynamic Tiering, or active flash.

port block
A group of four Fibre Channel ports that have the same port mode.

port mode
The operational mode of a Fibre Channel port. The three port modes for Fibre Channel ports on the Hitachi RAID storage systems are standard, high-speed, and initiator/external MIX.

Preview list
The list of requested operations on Device Manager - Storage Navigator.

primary site
The location of the storage system that contains the original data to be replicated and that is connected to one or more storage systems at the secondary site via remote copy connections. The primary site can also be called the "local site".
The term “primary site” is also used for host failover operations. In that case, the primary site is the location where the production applications are running, and the secondary site is where the backup applications run when the applications at the primary site fail, or when the primary site itself fails.

**primary system**
A storage system at a primary site that contains primary volumes of remote replication pairs. The primary system sends remote I/Os to the secondary system, which contains the secondary volumes of the pairs.

**primary volume**
The volume in a copy pair that contains the original data to be replicated. The data in the primary volume is duplicated synchronously or asynchronously, depending on the copy function, on the secondary volume of the pair.
See also *secondary volume (S-VOL)*.

**P-VOL**
See *primary volume*.

**Q**

**quick format**
The quick format feature in Virtual LUN in which the formatting of the internal volumes is done in the background. This allows system configuration (such as defining a path or creating a TrueCopy pair) before the formatting is completed. To execute quick formatting, the volumes must be in blocked status.

**quick restore**
A reverse resynchronization in which no data is actually copied: the primary and secondary volumes are swapped.

**quick split**
A split operation in which the pair becomes split immediately before the differential data is copied to the secondary volume (S-VOL). Any remaining differential data is copied to the S-VOL in the background. The benefit is that the S-VOL becomes immediately available for read and write I/O.

**quorum disk**
Used to determine the volume in a global-active device pair on which server I/O should continue when a failure occurs in a path or a storage system. The quorum disk is installed in an external storage system.
R

R/W, r/w
read/write

RAID
redundant array of inexpensive disks

RAID group
A redundant array of inexpensive drives (RAID) that have the same capacity and are treated as one group for data storage and recovery. A RAID group contains both user data and parity information, which allows the user data to be accessed in the event that one or more of the drives within the RAID group are not available. The RAID level of a RAID group determines the number of data drives and parity drives and how the data is “striped” across the drives. For RAID1, user data is duplicated within the RAID group, so there is no parity data for RAID1 RAID groups. A RAID group can also be called an array group or a parity group.

RAID level
The type of RAID implementation. RAID levels include RAID0, RAID1, RAID2, RAID3, RAID4, RAID5 and RAID6.

RCP
remote control port

remote copy connections
The physical paths that connect a storage system at the primary site to a storage system at the secondary site. Also called data path.

remote replication
Data replication configuration in which the storage system that contains the original data is in one location, called the primary site, and the storage system that contains the copy of the original data is in a different location, called the secondary site. TrueCopy and Universal Replicator provide remote replication. See also in-system replication.

remote site
See secondary site.

restore journal (R-JNL)
Holds differential data on the secondary Universal Replicator system until it is copied to the secondary volume.

resync
“Resync” is short for resynchronize.

RIO
remote I/O
root volume
A level-1 primary volume in a ShadowImage cascade configuration. The secondary volume of a layer-1 pair is called a node volume. See also cascade configuration.

RPO
recovery point objective

RTC
real-time clock

RTO
recovery time objective

R/W
read/write

S

S/N, SN
serial number

secondary site
The location of the storage system that contains replicated data and that is connected to one or more storage systems at the primary site via remote copy connections. The secondary site can also be called the “remote site”. The term “secondary site” is also used for host failover operations. In that case, the secondary site is the location where the backup applications run when the applications at the primary site fail, or when the primary site itself fails.

secondary system
A storage system at a secondary site that contains secondary volumes of remote replication pairs. The secondary system receives remote I/Os from the primary site, which contains the primary volumes of the pairs.

secondary volume
The volume in a copy pair that contains the copy of the data on the primary volume. See also primary volume.

service information message (SIM)
SIMs are generated by a RAID storage system when it detects an error or service requirement. SIMs are reported to hosts and displayed on Device Manager - Storage Navigator.
service processor (SVP)
The computer inside a RAID storage system that hosts the Device Manager - Storage Navigator software and is used by service personnel for configuration and maintenance of the storage system.

severity level
Applies to service information messages (SIMs) and Device Manager - Storage Navigator error codes.

SI
Hitachi ShadowImage

sidetable
An area of cache memory that is used to store updated data for later integration into the copied data.

SIM
service information message

size
Generally refers to the storage capacity of a memory module or cache. Not usually used for storage of data on disk or flash drives.

SLU
See subsidiary logical unit.

SM
shared memory

SMTP
simple mail transfer protocol

snapshot
A point-in-time virtual copy of a Thin Image primary volume (P-VOL). The snapshot is maintained when the P-VOL is updated by storing pre-update data (snapshot data) in a data pool.

SNMP
simple network management protocol

SOM
system option mode

SSB
sense byte
SSID
(storage) subsystem identifier. SSIDs are used as an additional way to identify a control unit on mainframe operating systems. Each group of 64 or 256 volumes requires one SSID, therefore there can be one or four SSIDs per CU image. For VSP Gx00 models and VSP Fx00 models, one SSID is associated with 256 volumes.

SSL
secure socket layer

steady split
In ShadowImage, a typical pair split operation in which any remaining differential data from the P-VOL is copied to the S-VOL and then the pair is split.

subsidiary logical unit (SLU)
An LU used for the conglomerate LUN structure, a SCSI architecture model. An SLU is an LU that stores actual data. You can use a DP-VOL or snapshot data (or a V-VOL allocated to snapshot data) as an SLU. All host access to SLUs is through the administrative logical unit (ALU). An SLU is called a virtual volume (VVol) in vSphere. See also administrative logical unit (ALU).

S-VOL
See secondary volume.

SVOS
Storage Virtualization Operating System

SVP
See service processor (SVP).

sync
synchronous

system option mode (SOM)
Additional operational parameters for the RAID storage systems that enable the storage system to be tailored to unique customer operating requirements. SOMs are set on the service processor.

T

TB
terabyte

TC
Hitachi TrueCopy
TID
  target ID

total capacity
  The aggregate amount of storage space in a data storage system.

U

update copy
  An operation that copies differential data on the primary volume of a copy pair to the secondary volume. Update copy operations are performed in response to write I/Os on the primary volume after the initial copy operation is completed.

UR
  Hitachi Universal Replicator

USP V/VM
  Hitachi Universal Storage Platform V/VM

USP VM
  Hitachi Universal Storage Platform VM

V

virtual device (VDEV)
  A group of logical devices (LDEVs) in a RAID group. A VDEV typically consists of some fixed volumes (FVs) and some free space. The number of fixed volumes is determined by the RAID level and device emulation type.

Virtual LVI/LUN volume
  A custom-size volume whose size is defined by the user using Virtual LUN. Also called a custom volume (CV).

virtual volume (V-VOL)
  A logical volume that has no physical storage space. Hitachi Thin Image uses V-VOLs as secondary volumes of copy pairs. In Dynamic Provisioning, Dynamic Tiering, and active flash, V-VOLs are referred to as DP-VOLs.

VLL
  Hitachi Virtual LVI/LUN

VLVI
  Hitachi Virtual LVI
VM
volume migration; volume manager

VOL, vol
volume

volume
A logical device (LDEV) that has been defined to one or more hosts as a single data storage unit. An open-systems volume is called a logical unit (LU).

volume pair
See copy pair.

V-VOL
virtual volume

V-VOL management area
Contains the pool management block and pool association information for Thin Image, Dynamic Provisioning, and Dynamic Tiering operations. The V-VOL management area is created automatically when additional shared memory is installed and is required for these program product operations.

W

WAN
wide-area network

WDM
wavelength division multiplexing

WR
write

write order
The order of write I/Os to the primary volume of a copy pair. The data on the S-VOL is updated in the same order as on the P-VOL, particularly when there are multiple write operations in one update cycle. This feature maintains data consistency at the secondary volume. Update records are sorted in the cache at the secondary system to ensure proper write sequencing.

WS
workstation

WWWN
worldwide name
**WWPN**
worldwide port name
Index

B

Business Copy volumes D-1
business requirements, assessing 3-2

C

cables and switches 4-8
Cache and Nonvolatile Storage (NVS) 2-5
cache changes and pair status 7-7
cache-fast-write, options for 8-2
calculating bandwidth 4-3
CCI error codes 10-8
collecting write-workload data 3-3
components 1-11
configuration workflow 5-2
consistency group with multiple systems 2-5
consistency status 7-8, 7-11
copy operations, overview 1-4
creating
  a journal 5-5
  a pair 6-2

D

data path 4-11
description 1-13
  planning workflow 4-2
Data Retention Utility B-4
Data Retention Utility volumes B-2
data transfer speed, planning for 3-4
data transfer threshold, changing 8-14
defining a remote path 5-3
deleting
  a journal 8-13
  a pair 6-13
  a pair forcibly 8-3
  a remote path 8-16
  pairs from a mirror 6-15
the UR relationship 8-17
disaster recovery
general procedures 9-2
  switching host oper. to S-VOL 9-3
  when using multiple storage systems 9-3
Dynamic Provisioning B-5
Dynamic Provisioning volumes B-2
Dynamic Tiering volumes B-2

E

error code 10-2
exporting pair information 7-15

F

fibre channel, additional switches 4-8
file recovery, database recovery 9-3
filtering a list 7-3
forcibly deleting pairs 8-3

G

guidelines for preparing systems 3-17

H

hardware problems 10-7
host failover software 3-10

I
initial copy overview 1-4
interoperability table B-2

J
journal copy 1-3
journal obtain 1-2
journal restore 1-3
journal status definitions 7-17
journal volumes
  adding to a journal 8-10
  deleting from a journal 8-12
  description 1-6
  sizing 3-5
journals
  assigning MP blade to 5-8
  changing options 8-6
  creating 5-5
  deleting 8-13
  description 1-7
  maintenance 8-6
  monitoring 7-16
  planning 3-6

L
latency 4-6
license capacity exceeded 2-3
license capacity, displaying 7-3
license expired 2-3
LUN Manager B-8
LUN Manager volumes B-2

M
maximum initial copy activities, setting 5-9
measuring write-workload 3-4
mirror ID explained 1-7
mirrors
  changing options 8-7
  splitting 6-8
monitoring
  journals 7-16
  operations history 7-12
  pairs 7-1
  remote connections, paths 7-18
  synchronization rate 7-11
  moving operations to S-VOL 9-3
  MP blade, assigning 5-8
  multiple storage systems, disaster recovery for 9-3

N
network relay devices, powering off 8-21

P
packet loss 4-7
pair
  creating 6-3
  deleting 6-14
  deleting forcibly 8-3
  maintenance 8-2
  operations history 7-12
  operations workflow 6-2
  options for system response to failure 8-2
  resynchronizing 6-11
  split option, changing 8-2
  splitting 6-7
  status and changing cache or shared memory 7-7
  status definitions 7-3
  troubleshooting 10-6
pair volumes
  description 1-7
  planning considerations 3-7
  path group 2-4
  point-in-time copy 6-10
  ports
  planning 4-7
  power off, managing 8-18
  prerequisites for
    adding journal vols to a journal 8-10
    creating a pair 6-2
    defining port attributes 5-4, 5-5
    deleting a pair 6-13
    deleting pairs from a mirror 6-15
    resynchronizing a mirror 6-12
    resynchronizing a pair 6-10
    splitting a mirror 6-9
    splitting a pair 6-6

Index-2
Hitachi Universal Replicator User Guide for Hitachi Virtual Storage Platform Gx00 and Fx00 Models
primary site recovery
    resuming operations    9-4
PSUE types    7-10
PSUS types    7-8

R
RAID groups, planning    3-4
RAID levels supported    2-5
remote path status, troubleshooting    10-3
remote paths
    deleting    8-16
    monitoring    7-18
    troubleshooting    10-3
remote replica options, setting    5-9
requirements    2-2
resynchronizing
    a mirror    6-12
    a pair    6-10
reverse copy direction to primary site    9-3
RIO MIH    5-5
role required for operations    5-2
rolling averages and cycle time    4-5
RPO    3-3

S
S-VOL, taking over host operations    9-3
saving pair information    7-15
Service Information Messages    10-25
ShadowImage volumes    B-3, D-1
shared memory changes, and pair status    7-7
sharing secondary volumes    D-4
sharing volumes    D-1
SIMs    10-25
sizing bandwidth    4-2
splitting a pair    6-6
strategies for sizing bandwidth    4-3
suspended journals    10-29
switches    4-8
system option modes    3-18
system requirements    2-2

T
technical support    10-30
Thin Image    B-8
ThinImage volumes    B-3

tracking journal data    7-8
troubleshooting remote paths    10-3

U
UR
    removing pair relationship    8-17
    set up    5-4

V
Virtual LUN    B-12
Virtual LUN volumes    B-4
Volume Migration    B-12
volume types    B-2
volumes, other program products    B-1

Index-3